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HOOFDSTUK 1

Inleiding

Dit document is de officiële gebruikershandleiding van Quantum GIS. De software en hardware beschreven in
dit document zijn in de meeste gevallen geregistreerde handelsmerken waarop wetgeving bestaat. Quantum GIS
is uitgebracht onder de GNU General Public Licentie. Vind meer informatie op de website van Quantum Gis
http://www.qgis.org.

De gebruikte details, data, resultaten enz. in dit document zijn geschreven en gecontroleerd met de beste kennis
en inzet voorhanden van auteurs en uitgevers. Toch kunnen er inhoudelijk fouten voorkomen.

Er kunnen geen rechten of garanties ontleend worden aan dit document. De auteurs, redacteuren en uitgevers zijn
niet verantwoordelijkheid of aansprakelijk voor fouten en eventuele gevolgen daarvan. U bent wel altijd welkom
om deze fouten door te geven zodat deze gecorrigeerd kunnen worden.

Dit document is gemaakt met reStructuredText. De broncode in de vorm van reST broncode is beschikbaar
via github en via internet als HTML en PDF via http://documentation.qgis.org. Ook kunnen er vertaalde ver-
sies van dit document in verschillende formaten gedownload worden van het documentatie gedeelte van het
QGIS project. Voor meer informatie over hoe je kunt bijdragen aan dit document en de vertaling ervan, bezoek:
http://www.qgis.org/wiki/.

Koppelingen in dit Document

Dit document bevat interne en externe koppelingen. Door een interne koppeling te selecteren zul je naar een ander
gedeelte van het document springen, bij het selecteren van een externe koppeling wordt een internet adres geopend.
Interne en externe koppelingen worden blauw weergegeven en worden door de standaardbrowser afgehandeld. In
HTML vorm worden beide koppelingen identiek weergegeven.

Auteurs en redactie van de Gebruikers-, Installatie- en Ontwikkelhandleiding:

Tara Athan Radim Blazek Godofredo Contreras Otto Dassau Martin Dobias
Peter Ersts Anne Ghisla Stephan Holl N. Horning Magnus Homann
Werner Macho Carson J.Q. Farmer Tyler Mitchell K. Koy Lars Luthman
Claudia A. Engel Brendan Morely David Willis Jürgen E. Fischer Marco Hugentobler
Larissa Junek Diethard Jansen Paolo Corti Gavin Macaulay Gary E. Sherman
Tim Sutton Alex Bruy Raymond Nijssen Richard Duivenvoorde Andreas Neumann

Sponsors

Het bijwerken van de gebruikershandleiding is gesponsord door Kanton Solothurn, Zwitserland.

Copyright (c) 2004 - 2013 QGIS Ontwikkelteam

Internet: http://www.qgis.org

Licentie van dit of document

Iedereen heeft het recht om dit document te kopiëren, verspreiden en aan te passen onder de voorwaarden van de
GNU Free Documentation License, Version 1.3 of een latere versie gepubliceerd door de Free Software Founda-
tion; De Voor- en achterkant en de inhoudelijke indeling van het document dient gelijk te blijven. Een kopie van
de licentie is toegevoegd in Appendix GNU Free Documentation License.
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HOOFDSTUK 2

Conventies

Deze sectie beschrijft een aantal uniforme stijlen voor deze handleiding. De volgende conventies worden gebruikt
in deze handleiding:

GUI-conventies

De GUI conventie-stijlen zijn bedoeld om de vertoning in de GUI zo goed mogelijk na te bootsen. Zodoende kan
een gebruiker snel binnen de QGIS applicatie vinden wat er in de handleiding getoond wordt.

• Menu opties: Kaartlagen → Rasterlaag Toevoegen... of Beeld → Werkbalken → Digitaliseren

• Knop in werkbalk: Rasterlaag Toevoegen

• Knop in dialoog: [Opslaan als standaard]

• Dialoogvenster titel: Laag Eigenschappen

• Tabblad: Algemeen

• Aanvinkvak: (Her)teken

• Keuzerondje: Postgis SRID EPSG ID

• Selecteer een numerieke waarde:

• Selecteer een alphanumerieke waarde:

• Blader naar een bestand:

• Selecteer een kleur:

• Schuiver:

• Tekst invoer:

Een schaduw geeft aan dat het om een aanklikbaar GUI-component gaat.

Tekst- en toetsenbord-conventies

De handleiding bevat ook stijlen voor teksten, toetsenbordcommando’s en codes waarmee verschillende zaken,
zoals klassen en functies, worden aangegeven. Ze komen niet overeen met de werkelijke vertoning.

• Hyperlinks: http://qgis.org

• Toetscombinaties: Geef de snelkoppeling Ctrl+B, betekent houd de Ctrl-toets ingedrukt en druk op de
B-toets.

• Bestandsnaam: lakes.shp

• Naam van een klasse: NewLayer

• Functie: classFactory

3
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• Server: myhost.nl

• Invoer door gebruiker: qgis --help

Regels met programmacode wordt getoond in een lettertype met vaste breedte

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

Platformspecifieke instructies

Meerdere aanwijzigen voor verschillende platformen kunnen worden opgenomen binnen 1 regel tekst: Selecteer

Bestand → Afsluiten QGIS → Afsluiten om QGIS af te sluiten.

Dit betekent dat je in Linux, Unix en Windows klikt op het menu Bestand en daarna op Afsluiten in het geopende
menu, terwijl je in Macintosh OSX klikt ophet menu QGIS, en daarna op Afsluiten in het geopende menu. Aan-
wijzingen waarbij meer tekst nodig is kunnen ook als een lijst worden weergegeven:

• doe dit;

• doe dat;

• doe iets anders.

of als paragrafen.

Doe dit en dit en dit. Doe daarna dit en dit en dit en dit en dit en dit en dit en dit en dit en dit en dit.

Doe dat. Doe daarna dat en dat en dat en dat en dat en dat en dat en dat en dat en dat en dat en dat en dat en dat
en dat en dat en dat en dat en dat en dat en dat en dat en dat.

Schermvoorbeelden in de handleiding zijn gemaakt op verschillende platforms; het platform wordt aangegeven
door de platform-icoontjes achter de beschrijving van de afbeelding.
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Voorwoord

Welkom in de wondere wereld van Geografische Informatie Systemen (GIS)!

Quantum GIS (QGIS) is een open source GIS systeem. Het project is ontstaan in mei 2002 en werd in juni 2002
als project op SourceForge geplaatst. De belangrijkste doelstelling van QGIS is om GIS beschikbaar en betaalbaar
te maken voor iedereen met toegang tot een computer. Op dit moment is QGIS beschikbaar voor Windows, OS X
en diverse op Unix gebaseerde systemen zoals linux. QGIS maakt gebruik van de Qt toolkit (http://qt.nokia.com)
en is geschreven in de C++ programmeertaal. Hierdoor heeft QGIS een toegankelijke en herkenbare uitstraling
(GUI) en werkt het snel en soepel.

QGIS is een eenvoudig te gebruiken GIS met uitgebreide functionaliteit voor het werken met geografische data
en kaarten. In het begin was QGIS enkel een viewer maar momenteel ondersteund QGIS een grote hoeveelheid
raster en vector formaten en is het in staat om met een geavanceerde plugin architectuur snel nieuwe functies en
formaten te ondersteunen.

QGIS is ontwikkeld onder de GNU Public License (GPL). Ontwikkelen of Deze licentie staat iedereen toe de
broncode te bekijken en te bewerken en garandeert de vrije beschikbaarheid van GIS software die door iedereen
kan worden aangepast of uitgebreid. Een actuele versie van de licentie dient te zijn meegeleverd met elke kopie
van QGIS. De licentie is ook te lezen in Bijlage GNU General Public License.

Tip: Meest recente Documentatie
De laatste versie van dit document kan altijd gevonden worden op http://download.osgeo.org/qgis/doc/manual/, of
in het documentatie gedeelte van de QGIS webpagina op http://www.documentation.qgis.org

3.1 Introductie GIS

Een Geografisch Informatie Systeem (GIS) (Mitchel 2005 Literature and Web References) is een collectie software
waarmee het mogelijk is geografische gegevens te maken, visualiseren en bewerken. Geografische gegevens zijn
gegevens waarbij informatie gekoppeld is aan een plaats op de aarde, zoals een latitude/longitude of een X,Y
coordinaat. Geografische gegevens worden ook wel ruimtelijke gegevens genoemd. Andere acroniemen voor
geografische gegevens zijn: geodata, GIS data, kaarten, geometrie, locatiegegevens en coordinaatgegevens.

Toepassingen die gebruik maken van geografische gegevens kennen een veelheid van functies. Kaartproductie
is een van de meest gebruikte toepassingen. Een kaartproductie programma of toepassing gebruikt geografische
gegevens om deze te presenteren als kaart die kan worden bekeken op een computerscherm of op een papieren
afdruk. Toepassingen kunnen statische kaarten of dynamische kaarten produceren. Dynamische kaarten kunnen
vervolgens weer worden gebruikt op een andere computer of op het internet.

Vaak wordt ten onrechte aangenomen dat GIS enkel bedoeld is voor het produceren van kaarten. Er zijn echter
ontelbare analyse functies waarmee ruimtelijke gegevens kunnen worden gebruikt of verrijkt. Denk hierbij bi-
jvoorbeeld aan:

1. Afstanden berekenen tussen locaties

2. De oppervlakte bepalen (b.v. in vierkante meters) binne een bepaalde geografische regio
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3. welke geografische objecten andere overlappen

4. De hoeveelheid overlap bepalen tussen objecten

5. Het aantal objecten bepalen die binnen een bepaalde afstand van object voorkomen

6. enzovoort...

Deze functionaliteiten lijken vanzelfsprekend, maar deze kunnen eindeloos worden toegepast en gecombineerd.
De resultaten van deze analyses kunnen in de vorm van een kaart worden getoond, maar verschijnen ook in
tabelvorm in managementrapportages die de besluitvorming ondersteunen welke van invloed kunnen zijn op ons
dagelijks leven.

Recente ontwikkelingen zoals locatie-gebaseerde diensten beloven nog veel meer nieuwe mogelijkheden, maar
de meesten zullen toch altijd zijn gebaseerd op een combinatie van kaarten en analyse. Bijvoorbeeld: Je hebt
een smartphone die gebruik maakt van positiebepaling. Met de juiste software kan een smartphone je vertellen
hoe ver je verwijderd bent van je favoriete restaurant of winkel. Hoewel dit een noviteit lijkt, worden in essentie
geografische gegevens verwerkt tot een eenvoudig resultaat dat precies laat zien wat relevant is.

3.1.1 Is dit dan allemaal zo nieuw?

Nee. Er zijn veel apparaten waarmee voor mobiele toepassingen geografische diensten worden aangeboden. Veel
mobiele software is als open source beschikbaar. Het concept is niet nieuw. GPS ontvangers komen algemeen
beschikbaar maar zijn al tientallen jaren in het bedrijfsleven in gebruik. Op dezelfde manier zijn kaartproductie
en analyse toepassingen al vele tientallen jaren als software te koop, in hoofdzaak voor overheden, defensie en het
bedrijfsleven.

De vernieuwing zit hem in hoe apparaten en toepassingen de laatste tijd worden gebruikt en door wie. Traditioneel
waren geografische gegevens vooral het domein van hoogopgeleide specialisten, cartografen en tekenaars. Dankzij
de verwerkingskracht van moderne computers en de beschikbaarheid van open source softeare is het voor hobby-
isten, professionals internet ontwikkelaars en studenten nu ook mogelijk om tegen lage kosten te experimenteren
en te werken met geografische gegevens. Iedereen kan GIS leren.

Hoe worden ruimtelijke gegevens opgeslagen? In het kort: Er zijn twee soorten formaten die op dit moment in
geografische toepassingen het meest gebruikt worden. Deze formaten zijn een aanvulling op de algemeen bekende
tabelformaten.

3.1.2 Rastergegevens

Een van de twee meestgebruikte soorten ruimtelijke gegevens formaten is het “raster”. Voorbeelden van rasters
zijn afbeeldingen. Voor geografische systemen bevatten deze afbeeldingen vaak luchtfoto’s. Hoogtemodellen en
grondwaterstanden zijn andere voorbeelden van gegevens die als raster kunnen worden gerepresenteerd. Er zijn
echter beperkingen.

Een raster is vaak rechthoekig en bestaat uit cellen of, in het geval van afbeeldingen uit pixels. Rasters hebben een
vast aantal rijen en kolommen.Elke cel heeft een numerieke waarde en vertegenwoordigt een gebied, (bijv. 30 bij
30 meter).

Meerdere overlappende rasters worden gebruikt om afbeeldingen meer dan een kleur te geven. (b.v. een raster voor
rode, een voor groene en een voor blauwe waarden kan worden gecombineerd om een kleurenbeeld te maken).
Luchtfoto’s bevatten vaak gegevens in meerdere “banden”. Elke band is in essentie een overlappend raster waar
in een golflengte (van licht) is opgeslagen. Een groot raster neemt meer bestandsruimte in beslag.

Een raster met kleinere cellen biedt meer details maar neemt meer ruimte in beslag op de harde schijf. Het is zaak
de juiste balans te vinden tussen de benodigde grootte in relatie tot beschikbare opslagruimte en de grootte inzake
analysefuncties of kaartvervaardiging.

3.1.3 Vectorgegevens

Vectorgegevens worden ook gebruikt in GIS toepassingen.In het kort: vectoren zijn een manier om een locatie
te beschrijven op basis van een coordinaten. Elke coordinaat refereert aan een geografische locatie middels een
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systeem van x,y coordinaten.

Vectoren kunnen worden afgebeeld op een Cartesisch vlak, een plat vlak met de bekende x- en y- as. Hoogst-
waarschijnlijk heb je hier al tijdens wiskunde op de middelbare school kennis mee gemaakt. Het afbeelden met
behulp van x- en y-assen op een plat vlak wordt ook gebruikt bij grafieken en vind je ook terug in de statistiek. In
essentie is een vectorkaart een vorm van een grafiek.

Er zijn verschillende manieren en methoden om geografische coordinaten af te beelden, afhankelijk van de be-
hoefte. Dit is een studie op zich en wordt gevat in de principes van kaartprojecties.

Vectorgegevens zijn er in beginsel in drie vormen; opeenvolgend in complexiteit en de volgende gebaseerd op de
eerdere vorm.

1. Punten - Een enkelvoudig coordinaat (x y) waarmee een discrete geografische locatie wordt aangeduid (in
het engels: point)

2. Lijnen - Meerdere coordinaten (x1 y1, x2 y2, x2 y4, ... xn yn) verbonden in bepaalde volgorde, als het
tekenen van een lijn van Punt(x1 y1) naar Punt(x2 y2) enzovoort. De lijnen tussen deze punten zijn de
lijnsegmenten. Deze hebben een lengte en de lijn heeft een richting gebaseerd op de volgorde van punten.
Technisch gesproken is een lijn twee verbonden coördinaten, daar waar een reeks lijnen meerdere verbonden
lijnstukken zijn.

3. Polygonen - Wanneer lijnen en meervoudige lijnen aan elkaar worden gekoppeld en het laatste punt valt
samen met het eerste punt, dan noemen we dit een polygoon of vlak (in het engels: polygon). Een driehoek,
cirkel rechthoek of vierkant zijn allemaal polygoonvormen of vlakken. Een belangrijke eigenschap van
polygonen is dat ze een oppervlakte hebben.

3.1. Introductie GIS 7
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Functionaliteit

QGIS biedt veel algemene GIS functionaliteit middels standaard funtionaliteit en plugins. Bij deze een kort
overzicht van functionaliteit onderverdeeld over zes categorieën.

4.1 Bekijken van data

Men kan een groot aantal veelgebruikte vector- en rasterformaten in verschillende coördinatensystemen inlezen,
bekijken en over elkaar heen leggen, zonder dat men deze eerst moet omzetten naar een intern of ander veelge-
bruikt formaat. Ondersteunde formaten zijn:

• Spatiale tabellen en views uit databases zoals PostGIS, SpatiaLite en MSSQL Spatial, vector formaten
ondersteund door de OGR functie bibliotheek, waaronder ESRI shapefiles, MapInfo, SDTS, GML en vele
andere, zie Werken met Vector Data.

• Raster- en afbeeldingsformaten ondersteund door de functie bibliotheek GDAL (Geospatial Data Abstrac-
tion Library), waaronder GeoTiff, Erdas Img., ArcInfo Ascii, Grid, JPEG, PNG en vele andere, zie Werken
met Raster data.

• GRASS raster en vector formaten vanuit de GRASS database (location/mapset), zie GRASS GIS Integration.

• Spatiale data die via internet services wordt aangeboden waaronder de OGC-compliant Web Map Service
(WMS) of de Web Feature Service (WFS), zie Working with OGC Data.

• OpenStreetMap data, zie OpenStreetMap.

4.2 Bevragen van gegevens en het maken van kaarten

Men kan kaarten maken en interactief spatiale gegevens bevragen via een gebruiksvriendelijke interface. Handige
tools die dit ondersteunen zijn o.a.:

• QGIS browser

• Gelijktijdige CRS-transformatie

• Layouter manager

• Overzichtskaart

• Favoriete plaatsen (Spatial Bookmarks)

• Identificeren/Selecteren van objecten

• Bewerk/Bekijk/Zoek attribuutwaarden van objecten

• Toevoegen van labels/annotatie aan objecten

• De weergavestijl wijzigen van vector and raster objecten

• Het toevoegen van een grid laag - nu via de fTools plugin en Decoratie

9
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• Gebruik van kaartattributen als noordpijl, schaalbalk en een copyright label

• Opslaan en weer openen van projecten

4.3 Creeer, bewerk, beheer en exporteer data

Je kunt vector kaarten maken, bewerken, onderhouden en exporteren in en naar verschillende formaten. Om raster
formaten te kunnen bewerken en deze om te zetten naar andere formaten kan men het beste de GRASS interface
gebruiken. QGIS biedt het volgende:

• Middelen om door OGR ondersteunde vector formaten te digitaliseren

• Creeer en bewerk shapefiles en GRASS vector lagen

• Georefereer afbeeldingen met de Georeferencer plugin

• GPS tools om GPS informatie van/naar GPX formaat te importeren/exporteren. Er is ook ondersteuning
om andere GPS formaten direct te kunnen inlezen/schrijven naar GPS apparaten. (onder Linux, is usb:
toegevoegd aan de lijst van ondersteunde GPS toestellen)

• Bekijk en bewerk gegevens van OpenStreetMap

• Maak lagen aan in PostGIS vanuit shape bestanden met de SPIT plugin

• Verbeterde ondersteuning van PostGIS tabellen

• Beheer attribuutwaarden van vector data met de nieuwe attributen tabel (zie Werken met de Attributen Tabel)
of de Table Manager plugin

• Sla screenshots op als gegeorefereerde afbeeldingen

4.4 Analyseer data

Men kan verschillende spatiale analyses uitvoeren op PostGIS en andere door OGR ondersteunde formaten ge-
bruikmakende van de fTools plugin. QGIS bied momenteel aan vector analyses, sampling, geoprocessing, geome-
trie en database beheer tools. Men kan ook de geïntegreerde GRASS tools gebruiken, die de volledige set van
meer dan 400 modules van GRASS functionaliteit bevat (zie GRASS GIS Integration). Of gebruik SEXTANTE
die QGIS voorziet van een krachtig geospatiaal analyse framework waarmee eigen en derde partijen algoritmes
kunnen worden aangeroepen vanuit QGIS zoals GDAL, SAGA, GRASS, fTools en meer (zie SEXTANTE).

4.5 Publiceer kaarten op het Internet

Met QGIS kan een zogenaamde mapfile van kaartgegevens geëxporteerd worden waarmee de kaart zoals men
deze heeft geconfigureerd binnen QGIS kan publiceren als kaart op internet via een webserver waarop UMN
MapServer is geinstalleerd. QGIS kan behalve als WMS, WMS-C of als WFS, WFS-T client ook als WMS of
WFS server gebruikt worden (zie Werken met OGC Data).

4.6 QGIS functionaliteit uitbreiden met plugins

QGIS kan aangepast worden aan jouw speciale behoeften door gebruik te maken van de plugin architecture en
uitbreidingen te kiezen. QGIS biedt daarnaast de mogelijkheid om functionaliteit uit te breiden door zelf plugins
te maken. Men kan zelfs besluiten om een nieuwe GIS applicatie te maken gebruik makende van C++ of Python!
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4.6.1 Standaard Plugins

1. Voeg Tekstgescheiden kaartlagen toe (Laad en toon tekstbestanden waarbij velden, gescheiden door een
scheidingsteken, x & y coordinaten bevatten)

2. Coordinaat Prikker (Geeft de coordinaten in verschillende CRS via de muis)

3. DB Manager (voor het uitwisselen, bewerken en bekijken van kaartlagen en tabellen; uitvoeren van SQL
queries)

4. Diagram overlay (Het plaatsen van diagrammen in vector lagen)

5. Dxf2Shp Converter (Converteert DXF naar Shape bestanden)

6. GPS gereedschap (Voor het laden en importeren van GPS-data)

7. GRASS (GRASS GIS integratie)

8. GDALTools (Integreer GDAL Tools in QGIS)

9. Georeferencer GDAL (Georefereren van raster m.b.v. GDAL)

10. Heatmap gereedschap(Genereert raster heatmaps (hittekaart) vanuit punt gegevens)

11. Interpolatie-plugin (interpoleert op basis van vector punten laag)

12. Mapserver Export (Export een QGIS project bestand naar een MapServer map file)

13. Offline Editing (Offline wijzigen en synchroniseren met database toestaan)

14. OpenStreetMap plugin (Viewer en editor voor OpenStreetmap data)

15. Oracle Spatial GeoRaster ondersteuning

16. Plugin Installer (Download en installeer QGIS python plugins)

17. Raster terrain analyse plugin (Terrein analyses gebaseerd op Raster)

18. Road graph plugin (Netwerk analyse voor het bepalen van de kortste route)

19. SPIT (Importeer Shapebestanden in een PostgreSQL/PostGIS database)

20. SQL Anywhere Plugin (Sla vector lagen op in een SQL Anywhere database)

21. Zonal statistics plugin (berekent aantal, som, gemiddeld van raster voor elke polygoon van een vector laag)

22. Ruimtelijke Query Plugin (voor het maken van ruimtelijke queries voor vector lagen)

23. eVIS (Bekijk afbeeldingen die gekoppeld zijn aan vector objecten)

24. fTools (Gereedschapskist van vector analyse en beheer tools)

4.6.2 Externe Python Plugins

Het aantal python plugins die wordt aangeboden door gebruiker waarmee de QGIS functionaliteit uitgebreid kan
worden welke wordt via de officiële PyQGIS gebruikers repository, groei continue en deze kunnen erg eenvoudig
gevonden en geinstalleerd worden via de Python Plugin Installer (Zie Loading an external QGIS Plugin).

4.7 Wat is er nieuw in versie 1.8

Deze versie is onderdeel van onze ‘cutting edge’ serie. Deze versie bevat nieuwe onderdelen en de programma
interface is uitgebreid ten opzichte van QGIS 1.0.x en QGIS 1.7.0. We raden aan om deze versie te gebruiken
boven voorgaande versies.

In deze versie zijn honderden foutmeldingen opgelost en vele nieuwe onderdelen en verbeteringen toegevoegd die
in deze handeleiding worden beschreven.

QGIS Browser
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Een onderdeel in QGIS, die ook buiten QGIS als losse applicatie kan worden gebruik. Met de browser kun je
makkelijk door je bestandensysteem zoeken en ook database connecties (PostGIS, WFS etc.) opeen, waarbij je
deze vooraf kunt bekijken en middels drag en drop, (slepen en neerzetten) deze kaartgegevens kunt toevoegen aan
het kaartbeeld.

DB Manager

De DB manager is nu officieel een onderdeel van QGIS core. Je kunt kaartlagen van QGIS Browser in de DB
manager slepen waarmee je een kaartlaag in een spatiale database kunt zetten. Wanneer je een spatiale tabel van
de ene spatiale database naar een andere sleept zal deze daarin worden geïmporteerd. Je kunt de DB manager
gebruiken om een SQL-queries uit te voeren en het resultaat daarvan zien door deze aan het kaartbeeld toe te
voegen. Je kunt ook tabellen aanmaken, wijzigen verwijderen en leegmaken en deze naar een andere database
schema verplaatsen.

Terrein Analyse Plugin

Een nieuwe standaard plugin is toegevoegd voor het doen van terrein analyses (helling, hellingoriëntatie, reliëf-
schaduw, reliëf en ruwheids index).

Nieuwe symboollaag typen

• Lijnarcering vulpatroon

• Puntarcering vulpatroon

• Ellipsen renderen (tekent ellipsen maar ook rechthoeken, driehoeken, kruizen)

Nieuwe plugin repository

Let op, de oude plugin repositories worden niet langer ondersteund; de schrijvers van plugins wordt vrien-
delijk verzocht om hun plugins toe te voegen aan de nieuwe repository. Bekijk de lijst van QGIS Plugins op
http://plugins.qgis.org/plugins/.

Meer nieuwe functionaliteit

• Ondersteuning voor het nesten van projecten waarbij een project (+inhoud) onderdeel uitmaakte van een
ander project

• Groeps selectie: De optie om lagen te groeperen tot een groep

• Berichten log: Je kunt de berichten in de gaten houden die QGIS aanmaakt tijdens het starten en tijdens
gebruik

• GUI instellingen: De gebruikers interface van QGIS kan eenvoudig worden aangepast door schermonderde-
len (zoals panelen en werkbalken) in de applicatie te verbergen

• De Actie Tool is nu beschikbaar vanuit de werkbalk Attributen en geeft de mogelijkheid om een actie uit te
voeren voor een vector object waarop je klikt

• Nieuwe schaal selectie : Selecteer een schaal van een lijst van voorgedefinieerde schalen

• Verschuif naar Selectie tool: Verschuif de kaart naar geselecteerd(e) object(en); veranderd niet de schaal

• Kopiëer en plak stijlen tussen lagen

• Het menu waarmee je het Ruimtelijk Referentie Systeem (CRS) kunt selecteren is bijgewerkt

• Definieer een Legenda-onafhankelijke tekenvolgorde

• Ondersteuning voor MSSQL Spatial - Je hebt nu ook Microsoft SQL Server spatiale databases gebruiken in
QGIS

• Print Composers meerdere regels op legenda onderdelen is mogelijk door gebruik te maken van een speciaal
karakter

• Labeling is nu mogelijk op basis van expressies

• Heatmap Plugin - een nieuwe basis plugin is toegevoegd voor het genereren van raster heatmaps (hit-
tekaarten) vanuit punt gegevens

• De gebruikersinterface van GPS live tracking is sterk gewijzigd en vele verbeteringen zijn eraan toegevoegd
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• Het menu is iets ander ingedeeld - Er zijn nu aparte menu’s voor Vector, Raster, Web en vele plugins zijn
aangepast zodat deze kunnen worden opgestart vanuit de Vector, Raster of het Web menu

• Verspring Curve - een nieuwe digitaliseer hulpmiddel waarmee je de nieuwe ligging van een lijn/vlak in een
richting kunt laten verspringen t.o.v. de oorspronkelijke ligging

• Nieuwe hulpmiddelen Geometrieën verdichten en Ruimtelijke index aanmaken toegevoegd in het Vector
menu

• De Export/toevoegen geometry kolom hulpmiddel kan nu gegevens exporteren met de CRS van de laag,
CRS van het project of de ellipsoïde gemeten lengten

• Model/view gebaseerde boom voor regels in regels gebaseerde rendering

• Verbetering van Favoriete Plaatsen (Spatial Bookmarks)

• Nieuwe plugin metadata in metadata.txt

• Refactoring van de postgres data provider: ondersteuning van willekeurige sleutelveld (inclusief niet-
numerieke en meerdere kolommen), ondersteuning voor het opvragen van bepaald geometrie type en/of
srid in QgsDataSourceURI

• Toegevoegd gdal_fillnodata aan GDALTools plugin

• Ondersteuning voor PostGIS TopoGeometry datatype

• Python bindings voor vector veld symbool laag en generieke verbeteringen aan de Python bindings (pro-
gramma interface)

• Een Benchmark programma is toegevoegd

• Toegevoegd Row cache voor attributen tabel

• UUID generation widget voor attribuut tabel

• Toegevoegd ondersteuning voor views die bewerkt kunnen worden van Spatiale databases

• Toegevoegd Expressie gebaseerde widget in de veld calculator

• Aanmaken van event lagen in analysis lib gebruik makende van linear referencing

• Laden/opslaan van stijlen in de nieuwe symbologie renderer van/naar een SLD document

• QGIS Server kan ook dienen als WFS Server

• WFS ondersteuning is nu een standaard functionaliteit van QGIS

• De mogelijkheid om WKT geometry over te slaan wanneer gekopieerd word van attribuut tabellen

• Ondersteuning voor het rechtsstreeks laden van kaartgegevens uit zipped en gzipped bestanden

• De QGIS test suite zal iedere nacht alle ingebouwde unit testen uitvoeren op belangrijke OS systemen

• Je kunt de tegelgrootte opgeven voor WMS lagen
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Beginnen

Dit hoofdstuk geeft een snel overzicht van de installatie van QGIS, voorbeeld data die gedownload kan worden
van de QGIS web pagina en een eerste simpele GIS-sessie waarbij raster en vector kaartlagen zichtbaar worden
gemaakt.

5.1 Installatie

Het installeren van QGIS is eenvoudig. Er zijn standaard installatiepakketten beschikbaar voor MS Windows
en Mac OS X. Voor GNU/Linux distributies bestaan er zogenaamde binary packages (rpm and deb) of software
repositories die toegevoegd en daarmee gedownload kunnen worden m.b.v. de installatie manager. De laatste
informatie over binary packages is beschibaar op de QGIS website onder http://download.qgis.org.

5.1.1 Installatie vanuit broncode

Wanneer je QGIS vanuit de broncode wilt opbouwen zie de installatie instructies. Deze worden gedis-
tribueerd met de QGIS broncode in een bestand met de naam ‘INSTALL’. Deze is ook online beschikbaar zie
https://github.com/qgis/Quantum-GIS/blob/master/INSTALL

5.1.2 Installatie op een extern medium

Het is mogelijk om QGIS op een USB stick of een ander extern medium te zetten met plugins, persoonlijke
instellingen en data. Dit kan door gebruik te maken van de –configpath optie als extra opstart argument mee
te geven die het standaardpad (bijv. ~/.qgis onder linux) die gebruikt word voor de gebruikersconfiguratie en
instellingen (QSettings gebruikt dan nl. dit pad).

5.2 Voorbeeld Data

De gebruikershandleiding bevat voorbeelden die gebaseerd zijn op de QGIS voorbeeld dataset.

Het installatiepakket voor Windows, bevat de optie om ook de QGIS voorbeeld dataset te downloaden. Wanneer
die optie wordt aangevinkt, zal de data worden gedownload en geplaatst onder Mijn Documenten in een folder
genaamd GIS Database. Je kunt uiteraard de Windows Explorer gebruiken om deze folder ergens anders neer te
zetten. Wanneer je de optie niet hebt aangevinkt om de voorbeeld database te downloaden tijdens de installie van
QGIS, kan men

• GIS data gebruiken die je al hebt;

• de voorbeeld dataset downloaden van de QGIS website http://download.qgis.org; of

• de installatie verwijderen en QGIS opnieuw installeren, maar deze keer met de data download optie
aangevinkt, maar doe die alleen als je problemen had met de voorgaande keuzes.
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Voor GNU/Linux en Mac OSX is de voorbeeld dataset nog niet beschikbaar via RPM, deb of dmg pack-
ages. Download de voorbeeld dataset door het gecomprimeerd bestand qgis_sample_data als ZIP of TAR archief
te dowloaden van http://download.osgeo.org/qgis/data/ en pak deze vervolgens uit met unzip of untar op jouw
systeem. De Alaska dataset bevat de GIS data die is gebruikt in de voorbeelden en in de screenshots van de ge-
bruikershandleiding. Ook is er een kleine GRASS database gebruikt in de voorbeelden. De gebruikte projectie
voor de qgis voorbeeld dataset is Alaska Albers Equal Area met als lengte-eenheid de Engelse lengtemaat feet (1
ft=0.305 m). De EPSG code is 2964.

PROJCS["Albers Equal Area",
GEOGCS["NAD27",

DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,

AUTHORITY["EPSG","7008"]],
TOWGS84[-3,142,183,0,0,0,0],
AUTHORITY["EPSG","6267"]],

PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],

UNIT["degree",0.0174532925199433,
AUTHORITY["EPSG","9108"]],

AUTHORITY["EPSG","4267"]],
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER["standard_parallel_1",55],
PARAMETER["standard_parallel_2",65],
PARAMETER["latitude_of_center",50],
PARAMETER["longitude_of_center",-154],
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

Wanneer je QGIS wilt gebruiken als de grafische gebruikersinterface om te werken met GRASS databases, kun
je ook voorbeeld gegevens vinden (Spearfish en South Dakota) op de officiele GRASS GIS website van GRASS
http: //grass.osgeo.org/download/data.php.

5.3 Voorbeeld Sessie

Nu QGIS is geinstalleerd en je beschikt over voorbeeldgegevens, kunnen we het gebruik van QGIS demonstreren
via een eenvoudige sessie. We zullen kaartgegevens in raster- en vectorformaat laden en zichtbaar maken. We
gebruiken daarvoor de landcover raster laag qgis_sample_data/raster/landcover.img en de vector-
laag lakes qgis_sample_data/gml/lakes.gml.

5.3.1 Start QGIS

• Start QGIS door “QGIS” in te typen op de commando regel, of door deze te starten vanuit het Applicaties
menu.

• Start QGIS vanuit het Start menu of vanuit de snelkoppeling op je bureaublad of door te dubbelklikken
op een QGIS project.

• Dubbelklik op het icoontje van QGIS in de Applicatie folder.

5.3.2 Laad een raster- en vectorkaart uit de voorbeeld dataset

1. Klik op het icoon Rasterlaag Toevoegen.

2. Ga naar de folder qgis_sample_data/raster/, selecteer het ERDAS Img bestand
landcover.img en klik op [Open].

16 Hoofdstuk 5. Beginnen

http://download.osgeo.org/qgis/data/


QGIS User Guide, Release 1.8

3. Wanneer het bestand niet in de lijst voorkomt, controleer dan of het juiste bestandstype is geselecteerd in
dit geval “Erdas Imagine Images (*.img, *.IMG)”.

4. Klik vervolgens op het icoon Vectorlaag Toevoegen.

5. De Bestand dient te worden geselecteerd als Databron in de dialoog Vectorlaag toevoegen. Klik op de
knop**[Bladeren]** om het vectorbestand te selecteren.

6. Ga naar de folder qgis_sample_data/gml/, selecteer “GML” als bestandstype, selecteer het GML
bestand lakes.gml en klik op [Open], klik in het menu Toevoegen Vector op [OK] .

7. Zoom een beetje in op een gebied met enkele meren.

8. Dubbelklik op de kaartlaag lakes in het lagen panel aan de linkerkant, om de dialoog Eigenschappen te
openen.

9. Selecteer het tabblad Stijl en selecteer blauw als vulkleur.

10. Selecteer het tabblad Labels en vink de optie Toon labels aan. Kies als Veld te gebruiken voor labels,
het veld NAMES.

11. Om de leesbaarheid van de labels te vergroten, kun je er een witte buffer omheen tekenen. Deze staat
onderin het menu, gebruik eventueel de schuifbalk aan de rechterkant van dit tabblad of maak het scherm

van de dialoog Laag Eigenschappen groter. Vink vervolgens de optie Labels met buffer en kies 3 als
waarde voor Grootte van buffer.

12. Klik op [Apply], en controleer of het resultaat er goed uitziet, klik tenslotte op [OK].

U ziet hoe eenvoudig het is om Raster en Vector gegevens te tonen in QGIS. Laten we verder gaan om meer te
leren over de beschikbare functionaliteit, eigenschappen en mogelijke instellingen en hoe deze te gebruiken.

5.4 Het starten en afsluiten van QGIS

In Voorbeeld Sessie heb je geleerd hoe je QGIS kunt starten. Dit komt nogmaals aan bod en we zullen ook laten
zien dat QGIS opgestart kan worden met extra opties op de opdrachtregel.

• Er vanuitgaande dat het pad naar QGIS is opgenomen in PATH, kun je QGIS opstarten door: qgis op
de opdrachtregel in te typen of door te dubbelklikken op de snelkoppeling naar de QGIS applicatie op het
bureaublad of in het applicatiemenu.

• Start QGIS door in het Start-menu of via een snelkoppeling op het bureaublad, of dubbelklik op een
QGIS project bestand.

• Dubbelklik op het icoon van QGIS in je Applicatie folder. Wanneer je QGIS wilt opstarten vanuit een
terminal-venster, start deze dan op met: /pad-naar-installatie-executable/Contents/MacOS/Qgis.

Om QGIS af te sluiten, klic in het menu Bestand QGIS → Afsluiten Om QGIS af te sluiten, of gebruik
de toetsencombinatie Ctrl+Q.

5.5 Commando Regel Opties

QGIS ondersteund een aantal opties die meegegeven kunnen worden wanneer deze gestart worden vanaf de
opdrachtregel. Om een lijst van argumenten te zien die je op de opdrachtregel mee kunt geven gebruik geef qgis
--help op de opdrachtregel. Het te gebruikte statement voor QGIS en het resultaat is hieronder weergegeven:

qgis --help
Quantum GIS - 1.8.0-Lisboa ’Lisboa’ (exported)
Quantum GIS (QGIS) is a viewer for spatial data sets, including
raster and vector data.
Usage: qgis [options] [FILES]
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options:
[--snapshot filename] emit snapshot of loaded datasets to given file
[--width width] width of snapshot to emit
[--height height] height of snapshot to emit
[--lang language] use language for interface text
[--project projectfile] load the given QGIS project
[--extent xmin,ymin,xmax,ymax] set initial map extent
[--nologo] hide splash screen
[--noplugins] don’t restore plugins on startup
[--nocustomization] don’t apply GUI customization
[--optionspath path] use the given QSettings path
[--configpath path] use the given path for all user configuration
[--help] this text

FILES:
Files specified on the command line can include rasters,
vectors, and QGIS project files (.qgs):
1. Rasters - Supported formats include GeoTiff, DEM

and others supported by GDAL
2. Vectors - Supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using
the PostGIS extension

Tip: Voorbeeld gebruik argumenten opdrachtregel
Je kunt QGIS starten door een of meerdere gegevensbestanden te geven op de opdrachtregel. Bijvoorbeeld
wanneer je je in de folder qgis_sample_data bevindt kun je QGIS starten en tegelijkertijd een raster en een
vectorbestand openen tijdens het opstarten met de volgende opdracht: qgis ./raster/landcover.img
./gml/lakes.gml

Opdrachtregel optie --snapshot

Deze optie geeft de mogelijkheid om een shapshot (een plaatje) te schieten in PNG formaat van de huidige view.
Dit is een handige optie wanneer je heel veel projecten hebt en je snel snapshots wilt aanmaken van de projecten.

Standaard genereerd deze een PNG bestand met een resolutie van 800x600 pixels. Dit kan worden aangepast door
de opties --width en --heightmee te geven op de opdrachtregel. Een bestandsnaam kan worden meegegeven
achter --snapshot.

Opdrachtregel optie --lang

Gebaseerd op de ingestelde standaard taal van je systeem zal QGIS opstarten in die taal. Wanneer je echter
toch QGIS in een andere taal wilt opstarten dan kun je dit doen door een taalcode mee te geven bijvoorbeeld:
--lang=it start QGIS in het italiaans. Een lijst van de huidige ondersteunde talen met taalcode is gegeven op
http://hub.qgis.org/wiki/quantum-gis/GUI_Translation_Progress

Opdrachtregel optie --project

Het opstarten van QGIS met een bestaand projectbestand is ook mogelijk. Voeg aan de opdrachtregel de optie
--project gevolgd door het QGIS project bestand waarmee je QGIS wilt openen.

Opdrachtregel optie --extent

Met deze optie kun je precies geografische gebied aangeven dat je in direct na het opstarten in beeld wilt zien.
De volgende coordinaten van de linker onderhoek en de rechterbovenhoek dienen gescheiden met een comma als
volgt ingegeven te worden:

--extent xmin,ymin,xmax,ymax

Opdrachtregel optie --nologo

Hiermee start je QGIS op zonder het eerste intro scherm van QGIS te zien.

Opdrachtregel optie --noplugins
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Wanneer het opstarten problemen geeft en je denkt dat dit veroorzaakt wordt door plugins, kun je deze optie
meegeven zodat de plugins niet direct worden bijgeladen tijdens het opstarten. De plugins zullen wel beschikbaar
en te starten zijn vanuit de QGIS Plugins Manager.

Opdrachtregel optie --nocustomization

Met deze opdrachtregel optie zullen bestaande GUI aanpassingen niet worden toegepast tijdens het opstarten.

Opdrachtregel optie --optionspath

Je kunt meerdere configuraties maken met welke instellingen QGIS opstart. Zie ref:gui_options waar de opslag
van de voorkeursinstellingen van QGIS voor de verschillende platforms worden opgeslagen. Je kunt op dit moment
niet een bestand aanmaken dus je hebt eerst een bestaande configuratie nodig die je vervolgens copieert naar een
andere en vervolgens de instellingen van QGIS aanpast, bij het afsluiten worden de instellingen naar het nieuwe
configuratiebestand opgeslagen.

Opdrachtregel optie --configpath

Deze optie lijkt sterk op voorgaande optie, maar daarbij wordt ook het standaard pad /.qgis overschreven voor de
voorkeursinstellingen van QGIS en dwingt QSettings om in plaats daarvan gegeven folder te gebruiken. Gebruik
van deze optie geeft gebruikers de mogelijkheid om de QGIS installatie met alle plugins en instellingen op een
USB-stick te zetten en van daaruit op te starten.

5.6 Projecten

De staat van een QGIS sessie wordt beschouwd als een project. QGIS werkt met één project tegelijkertijd. In-
stellingen kunnen betrekking hebben op het project, maar ook standaardinstellingen betreffen voor nieuwe pro-

jecten (zie Opties). QGIS kan de huidige staat opslaan in een project bestand met de menu opties Bestand →
Project opslaan of Bestand → Project opslaan als....

Laad een opgeslagen project in de huidige QGIS session met Bestand → Open Project... of Bestand → Open
Recente Projecten.

Wanneer je de huidige sessie wilt opschonen en met een nieuwe wilt beginnen, kies Bestand → Nieuw Project.
Beide menu opties zullen met de vraag komen of je de laatste wijzigingen wilt opslaan, wanneer er wijzigingen
zijn geweest sinds de laatste keer dat je het project hebt opgeslagen of geopend.

De informatie die wordt opgeslagen in een projectbestand zijn:

• De toegevoegde kaartlagen

• De eigenschappen van elke laag, inclusief symbologie

• Gebruikte coordinatensysteem voor het kaartbeeld

• De grootte en inhoud van de kaart zoals je deze het laatst zag

Het projectbestand wordt opgeslagen in XML formaat, wat een formaat is dat men ook buiten QGIS eenvoudig kan
bewerken, maar dan moet je wel voorzichtig zijn met wijzigingen. De opbouw van het XML bestand is gewijzigd
met het uitkomen van nieuwe versies van QGIS. De kans is groot dat delen van oudere projectbestanden op een
gegeven moment niet meer goed functioneren. Om hiervan op de hoogte te worden gehouden kan men in het
tabblad Algemeen tab under Instellingen → Opties het volgende aanvinken:

Geef een waarschuwing om project op te slaan indien nodig

geef een waarschuwing bij het openen van een projectfile uit een oudere versie van QGIS
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5.7 Eindproducten

Er zijn verschillende manieren om eindproducten te maken vanuit je QGIS sessie. We hebben al een manier be-
sproken in Projecten opslaan als een project bestand. Hier is een voorbeeld van andere manieren om eindproducten
te genereren:

• Menu optie Bestand → Opslaan als afbeelding... opent een bestandsdialoog waarmee je de naam, het pad
en een afbeeldingstype (PNG of JPG formaat) kunt selecteren waarmee deze wordt opgslagen. Er wordt
automatisch een world file toegevoegd die de afbeelding een goede georeferentie meegeven.

• Menu optie:menuselection:Bestand –> Nieuwe Print Layouter opent een nieuw scherm waarmee je
een nieuwe kaartlayout kunt maken waarin het kaartbeeld kan worden verwerkt om deze vervolgens af te
drukken (zie Print Composer).
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Gebruikersinterface van QGIS

Wanneer QGIS start zal de volgende gebruikersinterface getoond worden (de nummers 1 tot 5 in het geel refereren
naar 5 belangrijke onderdelen van de gebruikersinterface):

Figuur 6.1: QGIS GUI with Alaska sample data

Notitie: Dit kan enigszins afwijken afhankelijk onder welk platform QGIS draait en welke window manager je
gebruikt of hoe deze is ingesteld.

De QGIS gebruikersinterface is onderverdeeld in 5 gebieden:

1. Menubalk

2. Werkbalk

3. Legenda

4. Kaartbeeld

5. Statusbalk

Deze vijf onderdelen worden in de volgende subparagrafen in detail beschreven. Daarnaast wordt in twee sub-
paragrafen de snelkoppelingen en de context helpfunctie beschreven.
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6.1 Menubalk

De menubalk biedt toegang to verschillende QGIS functies vanuit een standaard hierarchisch opgebouwd menu.
De hoofdmenu’s en een samenvatting van enkel menu-opties die zich daarin bevinden worden hieronder gegeven
samen met van elk daarvan het icoon van de daarbij behorende knop op de werkbalk en bijbehorende snelkoppel-
ing.Snelkoppelingen kunnen nu ook geconfigureerd worden (de hier beschreven snelkoppelingen zijn standaard
ingesteld), gebruik de menuoptie Snelkoppelingen bewerken onder het hoofdmenu Extra.

Alhoewel de meeste menu opties een corresponderende knop hebben op een werkbalk en andersom zijn de menu’s
toch anders ingericht dan de werkbalken. De werkbalk die de functie bevat wordt hieronder gegeven voor elke
menuoptie als een aanvinkvakje. Voor meer informatie over functies en werkbalken zie Werkbalk.

6.1.1 Bestand

Menu Optie Snelkoppeling Referentie Werkbalk

Nieuw Project Ctrl+N zie Projecten Bestand

Open Project Ctrl+O zie Projecten Bestand
Open Recente Projecten → zie Projecten

Project opslaan Ctrl+S zie Projecten Bestand

Project opslaan als Ctrl+Shift+S zie Projecten Bestand

Opslaan als afbeelding see Eindproducten

Nieuwe print Layouter Ctrl+P zie Print Composer Bestand

Layouter manager zie Print Composer Bestand
Print Layouter → zie Print Composer

Afsluiten Ctrl+Q
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6.1.2 Bewerken

Menu Optie Snelkop-
peling

Referentie Werkbalk

Ongedaan maken Ctrl+Z zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Opnieuw Ctrl+Shift+Zzie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Kaartobjecten knippen Ctrl+X zie Het digitaliseren van een
bestaande kaartlaag

Digitaliseren

Kaartobjecten kopiëren Ctrl+C zie Het digitaliseren van een
bestaande kaartlaag

Digitaliseren

Kaartobjecten Plakken Ctrl+V zie Het digitaliseren van een
bestaande kaartlaag

Digitaliseren

Object toevoegen Ctrl+. zie Het digitaliseren van een
bestaande kaartlaag

Digitaliseren

Object(en) Verplaatsen zie Het digitaliseren van een
bestaande kaartlaag

Digitaliseren

Geselecteerd(e) Object(en)
Verwijderen

zie Het digitaliseren van een
bestaande kaartlaag

Digitaliseren

Versimpel Object zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Ring Toevoegen zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Onderdeel Toevoegen zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Verwijder Ring zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Verwijder Onderdeel zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Object vervormen zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Verspring Curve zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Kaartobjecten splitsen zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Geselecteerde objecten
samenvoegen

zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Attributen van geselecteerde
objecten samenvoegen

zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Knooppunt-gereedschap zie Het digitaliseren van een
bestaande kaartlaag

Digitaliseren

Puntsymbolen roteren zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren
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Na het activeren van de Bewerken modus Bewerken aan/uitzetten voor een geselecteerde vector kaartlaag, zal er een
extra menu optie Toevoegen zijn toegevoegd in het menu Bewerken afhankelijk van het type vector (punt, lijn
of polygoon).

6.1.3 Bewerken (extra)

Menu Optie Snelkoppeling Referentie Werkbalk

Object toevoegen zie Het digitaliseren van een bestaande kaartlaag Digitaliseren

Object toevoegen zie Het digitaliseren van een bestaande kaartlaag Digitaliseren

Object toevoegen zie Het digitaliseren van een bestaande kaartlaag Digitaliseren

6.1.4 Beeld

Menu Optie Snelkoppeling Referentie Werkbalk

Kaart verschuiven Kaart
Navigatie

Kaart verschuiven naar
selectie

Kaart
Navigatie

Inzoomen Ctrl++ Kaart
Navigatie

Uitzoomen Ctrl+- Kaart
Navigatie

Selecteren → zie Selecteren en deselecteren van
objecten

Attributen

Objecten Identificeren Ctrl+Shift+I Attributen
Opmeten → zie Meten Attributen

Volledig uitzoomen Ctrl+Shift+F Kaart
Navigatie

Op Kaartlaag Inzoomen Kaart
Navigatie

Inzoomen Op Selectie Ctrl+J Kaart
Navigatie

Laatste Zoomniveau Kaart
Navigatie

Zoom naar Volgende Kaart
Navigatie

Zoom naar Ware Grootte Kaart
Navigatie

Decoraties → zie Decoraties

Kaart Tips Attributen

Nieuwe Favoriet Ctrl+B zie Favoriete Plaatsen Attributen

Toon Favorieten Ctrl+Shift+B zie Favoriete Plaatsen Attributen

Bijwerken Ctrl+R Kaart
Navigatie

Tile schaalschuif zie Tilesets Tile schaal
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6.1.5 Kaartlagen

Menu Optie Snelkoppeling Referentie Werkbalk
Nieuw → zie Het aanmaken van een nieuwe Vectorlaag Kaartlagen bewerken
Kaartlagen en groepen inbedden ... zie Projecten in een project

Vectorlaag Toevoegen Ctrl+Shift+V zie Werken met Vector Data Kaartlagen bewerken

Rasterlaag Toevoegen Ctrl+Shift+R zie Raster data laden in QGIS Kaartlagen bewerken

PostGIS Laag Toevoegen Ctrl+Shift+D zie PostGIS kaartlagen Kaartlagen bewerken

Spatialite-laag Toevoegen Ctrl+Shift+L zie SpatiaLite Kaartlagen Kaartlagen bewerken

MSSQL Spatial-Laag Toevoegen Ctrl+Shift+M zie MSSQL Spatial kaartlagen Kaartlagen bewerken

WMS-Laag Toevoegen Ctrl+Shift+W zie WMS Client Kaartlagen bewerken

Toevoegen Tekengescheidentekst kaartlaag zie Delimited Text Plugin Kaartlagen bewerken

Creëer nieuwe GPX laag zie GPS Plugin Kaartlagen bewerken

Oracle GeoRaster Toevoegen zie Oracle GeoRaster Plugin Kaartlagen bewerken

SQL Anywhere Laag Toevoegen zie SQL Anywhere Plugin Kaartlagen bewerken

WFS-Laag toevoegen Kaartlagen bewerken

Kopiëer stijl zie Tabblad Stijl

Plak stijl zie Tabblad Stijl

Open attributentabel Attributen

Wijzigingen opslaan Digitaliseren

Bewerken aan/uitzetten Digitaliseren
Opslaan als...
Selectie opslaan als vectorbestand... zie Werken met de Attributen Tabel

Laag/lagen verwijderen Ctrl+D
Instellen laag-CRS Ctrl+Shift+C
Project CRS van kaartlaag overnemen
Eigenschappen
Query...

Labels

Toevoegen aan Overzichtskaart Ctrl+Shift+O Kaartlagen bewerken

Alles aan Overzichtskaart Toevoegen

Verwijder Alles Van Overzichtskaart

Toon Alle Lagen Ctrl+Shift+U Kaartlagen bewerken

Verberg Alle Lagen Ctrl+Shift+H Kaartlagen bewerken
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6.1.6 Instellingen

Menu Optie Snelkoppeling Referentie Werkbalk
Panelen → zie Panelen en Werkbalken
Werkbalken → zie Panelen en Werkbalken
Volledig scherm aan/uit Ctrl-F

Projectinstellingen ... Ctrl+Shift+P zie Projecten

Aangepaste CRS ... zie Aangepaste Coördinaten Referentie Systeem
Stijl Manager... zie Stijl Manager

Snelkoppelingen bewerken ...
Aanpassingen ... zie Aanpassingen
Opties ... zie Opties

‘Snapping’-opties ...

6.1.7 Plugins

Menu Optie Snelkoppeling Referentie Werkbalk

Python Plugins Ophalen zie QGIS Plugins

Plugin-manager... zie Managing Plugins
Python Console
GRASS → zie GRASS GIS Integration GRASS

6.1.8 Vector

Menu Optie Snelkoppeling Referentie Werkbalk
Analyse Gereedschappen → zie fTools Plugin
Coördinaat Klikken → zie Coordinate Capture Plugin
Datamanagement Gereedschappen → zie fTools Plugin
Dxf2Shp → zie Dxf2Shp Converter Plugin Vector
Geometrie Gereedschappen → zie fTools Plugin
Geoprocessing Gereedschap → zie fTools Plugin
GPS → zie GPS Plugin Vector
Onderzoeksgereedschap → zie fTools Plugin
Road Graph → zie Road Graph Plugin
Ruimtelijke Query → zie Spatial Query Plugin Vector

6.1.9 Raster

Menu Optie Snelkoppeling Referentie Werkbalk
Rasterberekeningen zie Rasterberekeningen
Georeferencer → zie Georeferencer Plugin Raster
Heatmap → zie Heatmap Plugin Raster
Interpolatie → zie Interpolation Plugin Raster

Terrein Analyse zie Raster Terreinanalyses Plugin
Gebiedsstatistieken → zie Zonal Statistics Plugin Raster
Projecties → zie GDAL Tools Plugin
Conversie → zie GDAL Tools Plugin
Extractie → zie GDAL Tools Plugin
Analyse → zie GDAL Tools Plugin
Allerlei → zie GDAL Tools Plugin
GdalTools instellingen zie GDAL Tools Plugin
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6.1.10 Database

Menu Optie Snelkoppeling Referentie Werkbalk
DB manager → zie DB Manager Plugin Database
eVis → zie eVis Plugin Database
Offline Bewerken → zie Offline Editing Plugin Database
Spit → zie SPIT Plugin Database

6.1.11 Web

Menu Optie Snelkoppeling Referentie Werkbalk
MapServer Export ... → zie MapServer Export Plugin Web
OpenStreetMap → zie OpenStreetMap OpenStreetMap

6.1.12 Help

Menu Optie Snelkoppeling Referentie Werkbalk

Inhoudsopgave F1 Help

What’s This? Shift+F1 Help
API documentatie

QGIS start pagina Ctrl+H

QGIS op updates controleren

Info

QGIS Sponsors

De hierboven genoemde Menubalk items zijn standaard allemaal aanwezig onder de KDE window managers.
Onder GNOME ontbreekt het hoofdmenu Instellingen en deze kunnen hier gevonden worden:

Projectinstellingen Bestand
Opties Bewerken
Snelkoppelingen bewerken ... Bewerken

Stijl Manager... Bewerken

Aangepaste CRS ... Bewerken
Panelen → Beeld
Werkbalken → Beeld
Volledig scherm aan/uit Beeld
Tile schaalschuif Beeld
GPS-informatie Beeld

6.2 Werkbalk

De werkbalken geven toegang tot de meeste functies die je ook terugvindt in de menu-structuur. Elke knop op de
werkbalk heeft ook een tooltip, informatie die na een tijdje automatisch verschijnt wanneer je de muisaanwijzer
er even boven houdt.

Elke werkbalk kan verplaatst worden en zowel verticaal als horizontaal geplaatst worden waar jij wilt, tussen de
menubalk bovenin en de statusbalk onderin. Daarnaast kun je werkbalken tijdelijk verwijderen via het popup-
menu, die verschijnt wanneer je de rechtermuisknop indrukt wanneer de muisaanwijzer zich boven een werkbalk
bevindt (zie ook Panelen en Werkbalken).

Tip: Werkbalken weer terugzetten
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Wanneer je per ongeluk al je werkbalken hebt verwijderd, dan kun je ze weer terugzetten
via de menukeuze Instellingen → Werkbalken →. Wanneer een werkbalk verdwenen is on-
der Windows, wat blijkbaar wel eens gebeurt, dan kun je dat ook oplossen door de registry key
\HKEY_CURRENT_USER\Software\QuantumGIS\qgis\UI\state te verwijderen uit de registry.
Wanneer je vervolgens QGIS opnieuw start zullen de werkbalken weer zichtbaar zijn.

6.3 Legenda

Het paneel met de legenda bevat een lijst met alle geladen kaartlagen in het project. Het aanvinkvakje voor elke
laag kan gebruikt worden om een laag aan of uit te zetten.

Een laag kan na selectie hoger of lager in de lijst gezet worden door deze te slepen met ingedrukte linker-
muisknop. Hoe hoger in de lijst, hoe later deze laag getekend wordt. De bovenste kaartlaag wordt dan ook
over alle andere kaartlagen getekend.

Lagen in het Legenda venster, kunnen georganiseerd worden in groepen. Er zijn twee manieren om dit te doen:

1. Start, door in de legenda op de rechtermuisknop in te drukken, het snelmenu op en kies daarin voor Groep
toevoegen.Vervolgens kun je de groep een naam geven en op Enter drukken.

2. Selecteer enkele lagen, start met de rechtermuisknop het snelmenu vanuit het paneel van de legenda en kies
Groep geselecteerd. De geselecteerde lagen zullen automatisch aan de nieuwe groep worden toegevoegd.

Om een laag uit een groep te halen kun je deze eruit slepen, of door een laag in een groep te selecteren en dan via
de rechtermuis het snelmenu te openen en te kiezen voor Maak hier een toplevel item van. Een groep kan groepen
bevatten.

Met het aanvinkvakje kun je ineens de zichtbaarheid van alle lagen die behoren tot die groep aan- of uitzetten.

De inhoud van het snelmenu, die je met de rechtermuisknop kunt oproepen voor een geselecteerde legenda object,
is afhankelijk van wat voor laag je selecteert. Deze is anders voor vector of raster kaartlagen en wanneer het een
GRASS vector laag betreft ontbreekt de menu-optie bewerken aan/uitzetten. Zie section Digitizing and editing a
GRASS vector layer voor informatie hoe je GRASS vector kaartlagen kunt bewerken.

Snelmenu onder rechtermuisknop voor raster lagen

• Zoom naar laagextent

• Zoom naar beste schaal (100%)

• Toon in overzichtskaart

• Verwijder

• Instellen laag-CRS

• Project CRS van kaartlaag overnemen

• Eigenschappen

• Hernoem

• Kopiëer stijl

• Nieuwe Groep toevoegen

• Alles uitklappen

• Alles inklappen

• Vernieuw volgorde tekenen

Aanvullen, volgens laagpositie en selectie

• Maak hier een ‘top level’ item van

• Groep geselecteerd
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Snelmenu onder Rechter muisknop voor vector lagen

• Zoom naar laagextent

• Toon in overzichtskaart

• Verwijder

• Instellen laag-CRS

• Project CRS van kaartlaag overnemen

• Open attributentabel

• Bewerken aan/uitzetten (niet beschikbaar voor GRASS lagen)

• Opslaan Als...

• Selectie opslaan als...

• Query

• Aantal kaartobjecten tonen

• Eigenschappen

• Hernoem

• Kopiëer stijl

• Nieuwe Groep toevoegen

• Alles uitklappen

• Alles inklappen

• Vernieuw volgorde tekenen

Aanvullen, volgens laagpositie en selectie

• Maak hier een ‘top level’ item van

• Groep geselecteerd

Snelmenu onder rechtermuisknop voor laag groepen

• Zoom naar groep

• Verwijder

• Instellen groep-CRS

• Hernoem

• Nieuwe Groep toevoegen

• Alles uitklappen

• Alles inklappen

• Vernieuw volgorde tekenen

Het is mogelijk om meer dan een laag of groep tegelijkertijd te selecteren door de Ctrl -toets vast te houden tij-
dens het selecteren van lagen met de linkermuisknop. Je kunt dan ineens alles wat je geselecteerd hebt verplaatsen
naar een groep.

Je kunt ook meer dan een laag en/of groep tegelijkertijd verwijderen door deze te selecteren met ingehouden Ctrl
-toets en daarna de toetsencombinatie Ctrl+D te gebruiken. Dan zullen alle geselecteerde lagen en/of groepen
verwijderd worden van de legenda met kaartlagen.
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6.3.1 Werken met de Legenda onafhankelijke volgorde van lagen

Sinds QGIS versie 1.8 is er een paneel waarmee je de tekenvolgorde onafhankelijk van de legenda kunt aangeven.
Dit paneel kan geactiveerd worden via de menu’s Instellingen → Panelen en activeer Laag volgorde. Bepaal
de tekenvolgorde van de lagen in het paneel Laag Volgorde. Vervolgens kun je in de legenda de groepen anders
indelen, waarbij deze lagen toch in de goede volgorde worden getekend (zie figure_layer_order). Wanneer onderin

het panel van de legenda, het aanvinkvak Rendervolgorde controleren uitgezet wordt, dan geldt alleen de
tekenvolgorde van de legenda.

Figuur 6.2: Define a legend independent layer order

6.4 Kaartbeeld

Het kaartbeeld is deel van QGIS waar het resultaat van de QGIS - de kaarten worden getoond! De kaart die getoond
word is afhankelijk van de geladen vector en rasterkaarten (zie volgende onderwerpen voor meer informatie hoe
kaartlagen geladen worden). Men kan het kaartbeeld verschuiven of erop inzoomen of uitzoomen. Men kan er
verschillende dingen doen met het kaartbeeld. De legenda van kaartlagen en het kaartbeeld hebben een sterke
relatie met elkaar. Het kaartbeeld veranderd direct wanneer je lagen in de legenda wijzigt.

Tip: Het kaartbeeld in/uitzoomen met het muiswieltje
Met het muiswieltje kun je in- en uitzoomen op de kaart. Plaats de muisaanwijzer in het kaartbeeld en roll het
wieltje naar voren (van je af) om in te zoomen en achteruit (naar je toe) om uit te zoomen. De plaats van de
muisaanwijzer is de plaats waar het in/uitzoomen gebeurd. Je kunt het gedrag van de muiswieltje instellen in het
Opties menu Instellingen → Opties in het tabblad Kaart gereedschap.

Tip: Verschuiven van het kaartbeeld met de pijltjestoetsen en de spatiebalk
Je kunt de pijtljestoetsen gebruiken om het kaartbeeld te verschuiven. Plaats de muisaanwijzer in het kaartbeeld
en druk op de toets met het linkerpijltje/rechterpijltje om het kaartbeeld naar west/oost te verschuiven of pijltje
omhoog/pijltje omlaag om deze naar noord/zuid te verschuiven. Maar je kunt ook de spatiebalk gebruiken om
het kaartbeeld te verschuiven! Hou deze ingedrukt en met de muisaanwijzer kun je het kaartbeeld verschuiven in
gewenste richting.
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6.5 Statusbalk

De statusbak laat o.a. de huidige positie in kaartcoordinaten zien. Wanneer je de muisaanwijzer over kaart heen-
beweegt, worden de coordinaten van de muisaanwijzer direct getoond. Links van de plaats waar de coordinaten
wordt getoond op de statusbalk is een knop waarmee je kunt wisselen tussen Cooordinaat en Extents. De Extents
laat de coordinaten van linkeronderhoek en rechterbovenhoek zien van wat er in het kaartbeeld getoond wordt
welke veranderd wanneer je het kaartbeeld wijzigt door deze te verschuiven of door in/uitzoomen.

Naast het getoonde coordinaat wordt de schaal getoond. Hier kun je de huidige schaal zien van het kaartbeeld.
Sinds QGIS 1.8 is er ook een keuzelijst van voorgedefinieerde schalen toegevoegd van schaal 1:500 tot 1:1000000.
Behalve dat je een schaal kunt kiezen kun je hier ook zelf een schaal ingeven waarna het kaartbeeld in die schaal
getoond zal worden.

Op de statusbalk bevindt zich ook een voortgangsbalkje waarmee de voortgang kan worden gezien wanneer het
kaart opnieuw wordt opgebouwd (het renderen van de kaart). In enkele andere gevallen wordt de voort- gangsbalk
ingezet voor het tonen van de voortgang van andere processen die meer tijd in beslagnemen, zoals het verzamelen
van statistieken over rasterlagen.

Wanneer er een nieuwe plugin of een update van een plugin beschikbaar is zal dit bekend worden gemaakt via
de statusbalk. Aan de rechterkant van de statusbalk kan men via een aanvinkvakje aangeven of je het opnieuw

opbouwen van het kaartbeeld even wilt stoppen (zie Renderen onderaan). Het icoontje stopt onmiddeling het
renderen van de kaart.

Helemaal aan de rechterkant van de statusbalk kan men de EPSG code van het huidige gebruikte coordinaten
referentie systeem zien. Daarnaast bevindt zich een icoontje waarmee je direkt toegang hebt tot het tabblad
Ruimtelijk Referentie Systeem van het menu Projectinstellingen zodat je deze kunt bekijken/aanpassen.

Tip: Rekenen met de correcte schaal in het kaartbeeld
Wanneer je QGIS voor het eerst start, worden standaard de eenheid graden gebruikt en worden de coordinaten
in graden weergegeven. Men kan de eenheid omzetten van graden naar meters in het tabblad Algemeen onder
Instellingen → Projectinstellingen of je kunt de project coordinaten referentie systeem wijzigen via het icoontje

CRS status helemaal aan de rechterkant van de statusbalk. Wanneer het nieuwe coordinaten referentie systeem
in de definitie een eenheid bevat, bijvoorbeeld ’+units=m’, dan wordt de gebruikte eenheid van het kaartbeeld hier
ook direct door aangepast.
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HOOFDSTUK 7

Algemeen Gereedschap

7.1 Snelkoppelingen toetsenbord

QGIS heeft voor veel functies standaard snelkoppelingen. Deze worden in Menubalk beschreven. Daarnaast geeft
de menu optie Instellingen → Snelkoppelingen bewerken ... de mogelijkheid om de standaard snelkoppelingen
aan te passen en nieuwe toe te voegen, voor QGIS functies die nog geen snelkoppeling hebben.

Figuur 7.1: Define shortcut options (KDE)

Configuratie van snelkoppelingen is erg eenvoudig. Selecteer een actie van de lijst, selecteer [Aanpassen], [Niet
gebruiken] of [Als standaard zetten]. Wanneer je tevreden bent over je configuratie, dan kun je deze opslaan als
een XML file en laden in een andere QGIS installatie via dit menu.

7.2 Contextuele help

Wanneer je hulp nodig hebt over een specifiek onderwerp, kun je in veel dialogen/menu’s op de [Help] knop
drukken. De help knop in plugins die door derden zijn ontwikkeld, kunnen verwijzen naar speciaal daarvoor
gemaakte webpagina’s.

7.3 Renderen

QGIS zal standaard automatisch de zichtbare lagen opnieuw opbouwen, renderen, wanneer nodig. De volgende
gebeurtenissen zullen het verversen van het kaartbeeld starten:

• Toevoegen van een kaartlaag

• Verschuiven of in/uitzoomen
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• Het wijzigen van de grootte van het QGIS programma venster

• Het wijzigen van de zichtbaarheden van een laag of lagen

QGIS geeft je op een aantal manieren controle op het renderings-proces.

7.3.1 Schaalafhankelijk Tonen

Met schaalafhankelijk tonen is het mogelijk om de minimum en maximum schalen in te stellen waarbij een
laag zichtbaar dient te zijn. Om schaalafhankelijk tonen int te stellen open de dialoog Eigenschappen door te

dubbelklikken op een kaartlaag in de legenda. In het tabblad Algemeen kan men het aanvinkvakje Gebruik
schaalafhankelijk tonen aanvinken en vervolgens de minimum en maximum schaalwaarden invullen waarbinnen
de kaartlaag zichtbaar dient te zijn.

Je kunt deze waarden achterhalen door het kaartbeeld eerst in te zoomen tot je de kaart net niet/wel wilt zien en
dan de bijbehorende schaal af te lezen van de statusbalk.

7.3.2 Controle over het renderen van de kaart

Men kan op de volgende manieren meer controle krijgen over het renderen van het kaartbeeld:

Uitstellen van het Renderen

Om het renderen uit te stellen, vink het aanvinkvakje Render uit in de rechteronderhoek van de sta- tusbalk.

Wanneer het aanvinkvakje Render niet is aangevinkt, zal QGIS het kaartbeeld niet opnieuw opbouwen in de
gebeurtenissen die beschreven zijn in Renderen. Voorbeelden wanneer je het opnieuw opbouwen van de kaart wilt
uitstellen:

• Na het toevoegen van veel kaartbladen wil je deze eerst van symbologie voorzien en de tekenvolgorde
instellen

• Na het toevoegen van een of meer grote kaartlagen wil je eerst instellen bij welke schalen deze getekend
mag worden

• Na het toevoegen van een of meer grote kaart lagen wil je eerst in zoom en op een bepaald gebied voordat
deze getekend wordt

• Een combinatie van bovenstaande redenen

Het weer aanvinken van Render zal onmiddelijk het opnieuw opbouwen van het kaartbeeld starten.

Instelling Toevoegen Laag Optie

Er is ook de mogelijkheid om niet direkt de kaart opnieuw te tekenen na het toevoegen van nieuwe kaartlagen.
Dit betekent dat het aanvinkvakje voor de zichtbaarheid van nieuw toegevoegde lagen, standaard niet zal zijn
aangevinkt. Om deze optie in te stellen kies de menuoptie Instellingen → Opties → en open het tabblad Rendering.

Ontvink het aanvinkvakje Standaard zullen nieuw toegevoegde lagen aan de kaart direct worden afgebeeld.
Elke laag die hierna wordt toegevoegd, zal standaard uit staan (onzichtbaar) in de legenda.

Het renderen stoppen

Om het tekenen van de kaart te stoppen druk op de ESC toets. Dit zal het tekenen van de kaart onderbreken waarbij
de kaart slechts gedeeltelijk getekend is. Het kan even duren voordat het tekenen stopt na het indrukken van de
ESC toets.

Notitie: Het is momenteel niet mogelijk om het renderen te stoppen - dit is tijdelijk uitgeschakeld in de op qt4
gebouwde versie aangezien dit kon leiden tot problemen als een vastlopende applicatie.

34 Hoofdstuk 7. Algemeen Gereedschap



QGIS User Guide, Release 1.8

Bijwerken van het kaartbeeld tijdens het Renderen

Men kan gebruik maken van een optie om kaartgegevens al te tekenen tijdens het inlezen en opbouwen van
kaartgegevens. Standaard, laat QGIS nog geen objecten van een laag zien totdat het inlezen en opbouwen van
de kaartlaag is afgerond. Om kaartgegevens te tekenen tijden het lezen ervan, kies de menuoptie Instellingen →
Opties Open het tabblad. Rendering. Zet het aantal objecten alvorens de kaart te hertekenen op een geschikte
waarde om tijdens het inlezen de kaart al te zien opbouwen. Wanneer de waarde op 0 staat zal de kaartlaag pas
getoond worden wanneer deze volledig is opgebouwd. Het instellen van een te lage waarde zal resulteren in een
traag opbouwende kaart omdat de kaart bijna continue moet worden bijgewerkt. Een voorgestelde waarde om mee
te beginnen is 500.

Beinvloeden van de kwaliteit van het renderen

Er zijn twee opties waarmee men de kwaliteit van het renderen kan beinvloeden. Kies de menuoptie Extra →
Opties open het tabblad Rendering en vink of ontvink de volgende aanvinkvakjes.

• Maak de lijnen minder rafelig ten koste van de tijd dat het tekenen kost

• Problemen met fout (gevulde) polygonen oplossen

7.4 Meten

Men kan direct beginnen te meten binnen geprojecteerde coordinaten systemen zoals het UTM of het Nederlandse
RijksDriekhoek stelsel. Wanneer de geladen kaartlaag echter een geographisch coordinatensysteem betreft, die
gebruik maakt van lengtegraden/breedtegraden, dan zal het resultaat van gemeten lengtes en op- pervlaktes in
eerste instantie onjuist zijn. Om dit op te lossen moet er eerst een meer toepasselijk coordinaten systeem ingesteld
worden (zie Werken met Projecties). Alle onderdelen die gebruikt worden om te meten gebruiken dezelfde snap-
ping opties van het digitaliseer gereedschap. Dit is vooral handig wanneer je bestaande lijnen en vlakken van
vectorlagen wilt opmeten.

Om een meetgereedschap te kiezen selecteer en kies vervolgens het gereedschap dat je wilt gebruiken.

7.4.1 Het meten van lengte, oppervlakte of hoek

QGIS kan de directe afstand meten tussen twee punten of via de gedefinieerde ellipsoide oftewel de aardkrom-
ming, van gebruikt coordinaten systeem. Om dit in te stellen, kies de menuoptie Instellingen → Opties. Open
het tabblad Kaart gereedschap en kies de juiste ellipsoide voor afstandsberekeningen. Men kan hier ook de kleur
van de rubberband en de voorkeuren voor te gebruiken eenheden voor lengtematen en hoeken instellen. Met de
rubberband wordt het flexibele meetlint bedoelt waarmee de afstanden kunnen worden opgemeten. Men kan nu
het meetgereedschap gebruiken door te klikken in het kaartbeeld. Het menu opmeten verschijnt waarbij zowel de
lengtes van de lijnsegmenten als de totale lengte wordt getoond. Gebruik de rechtermuisknop om te stoppen met
meten.

Je kunt ook oppervlaktes meten. In het menu opmeten, komt dan de totale oppervlakte te staan. Ook in dit
geval zal de meettool naar objecten van de geselecteerde vectorlaag proberen te snappen, tenminste wanneer voor
die laag een snapping tolerantie is ingesteld. (Zie Het instellen van de Snapping Toleranties en Zoek Radius).
Wanneer men nauwkeurig oppervlakte wilt opmeten, zet dan eerst voor een laag de snapping tolerantie, en se-
lecteer dan vervolgens die laag. Vervolgens kan men nu precies oppervlaktes inmeten waarbij elke muisklik naar
de dichtsbijzijnde hoek of lijn van geselecteerde laag zal springen, wanneer deze zich binnen ingestelde tolerantie
bevindt.

Men kan ook hoeken opmeten, selecteer Hoek Opmeten. De muisaanwijzer veranderd in een kruisje. Zet
eerst twee punten de basislijn om vervolgens met het derde punt de relatieve hoek t.o.v. de basislijn op te meten.
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Figuur 7.2: Measure Distance (KDE)

Figuur 7.3: Measure Area (KDE)

Figuur 7.4: Measure Angle (KDE)
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7.4.2 Selecteren en deselecteren van objecten

De QGIS werkbalk bevat functionaliteit waarmee men objecten kan selecteren in het kaartbeeld. Om een of

meerdere objecten te selecteren klik op en kies de gewenste selectie functie:

• Selecteer objecten

• Selecteer objecten binnen rechthoek

• Selecteer objecten binnen polygoon

• Selecteer objecten door vrije selectie

• Selecteer objecten binnen straal

Om de huidige selectie van geselecteerde objecten ongedaan te maken klik op Objecten uit alle layers deselecteren.

7.5 Decoraties

De kaartdecoraties van QGIS zijn het Copyright Label, de Noordpijl en de Schaalbalk. Ze worden gebruikt om de
kaart te decoreren door kaartelementen toe te voegen.

Notitie: Voor QGIS 1.8 dezelfde functionaliteit was beschikbaar via de Decoraties Plugin.

7.5.1 Copyright Label

Copyright label plaatst een Copyright label met je eigen tekst op de kaart.

Figuur 7.5: The copyright Dialog

1. Selecteer via het menu Beeld → Decoraties → Copyright Label. De dialoog opent (zie fig-
ure_decorations_1).

2. Geef de tekst die geplaatst dient te worden op de kaart. Je kunt daarbij HTML gebruiken zoals getoond in
het voorbeeld

3. Geef aan waar het copyright label geplaatst moet worden op de kaart met de keuzelijst Plaats ‘RechtsOnder’

4. Zorg ervoor dat het aanvinkvak Copyright Label tonen aangevinkt is

5. Klik op [OK]
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In het voorgaande voorbeeld (standaard) plaatst QGIS het copyright symbool gevolgd door de datum rechtsonder
in het kaartbeeld.

7.5.2 Noordpijl

Noordpijl plaatst een simpele noordpijl op de kaart. Momenteel is er slechts 1 stijl beschikbaar.

Figuur 7.6: The North Arrow Dialog

7.5.3 Schaalbalk

Schaalbalk plaatst een eenvoudige schaalbalk op de kaart. De stijl en de plaats kan worden aangepast
evenals de labels van de Schaalbalk.

Figuur 7.7: The Scale Bar Dialog

QGIS ondersteunt alleen het tonen van de schaal in dezelfde lengteenheid als die van de kaart. Wanneer de eenheid
van je lagen in meters zijn kun je niet een schaalbalk maken in feet . Zo kun je ook geen schaalbalk in meters
tonen wanneer de gebruikte kaart als eenheid in graden wordt getoond.

Toevoegen van een schaalbalk:

1. Selecteer via het men Beeld → Decoraties → Schaalbalk The dialoog opent (zie figure_decorations_3)

2. Kies de plaatsing met de keuzelijst Plaats ‘RechtsBoven’

3. Kies de stijl in de keuzelijst Schaalbalkstijl ‘Waardeaanduiding Boven’

4. Kies de kleur van de balk via het kleurenpalet achter Schaalbalkkleur of laat deze op zwart staan

5. Zet de grootte van de schaalbalk en het label Grootte van de balk

6. Zorg ervoor dat het aanvinkvak Schaalbalk gebruiken is aangevinkt
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7. Geef aan of de schaalbalk automatisch naar gehele getallen verspringt wanneer de kaart van grootte wijzigd

door het aanvinkvak Klik automatisch naar gehele getallen tijdens het aanpassen van de grootte aan te
vinken

8. Klik op [OK]

Tip: Decoratie Instellingen
Wanneer je een QGIS project opslaat, zullen de wijzigingen die je hebt gemaakt aan Noordpijl, Schaalbalk en
Copyright mee worden opgeslagen in het projectbestand en teruggezet worden bij het openen van het project.

7.6 Annotatie Functies

De Tekst Annotatie functies in de werkbalk Attributen geven de mogelijkheid om een tekstballon ergens in het
kaartbeeld te plaatsen. Gebruik de Annotatie functie en klik ergens in het kaartbeeld.

Figuur 7.8: Annotation text dialog

Wanneer men dubbelklik op de ballontekst heeft men verschillende mogelijkheden om deze aan te passen. Er
is een tekstvak waar men de tekst mee kan aanpassen. Men kan kiezen of het de tekst verbonden is aan een
kaartlokatie of dat deze steeds op dezelfde plaats blijft staan ook al verschuifd men de kaart. Men kan het tekst
item verplaatsen door de marker of de ballontekst naar een andere plek te slepen. De gebruikte icoontjes zijn
onderdeel van het gis thema, maar worden ook in de andere thema’s gebruikt.

De Verplaats Annotatie functie wordt gebruikt om de annotatie te verplaatsen in het kaartbeeld.

7.6.1 Formulier annotatie

Het is mogelijk om je eigen annotatie formulieren te maken en te gebruiken. De functie Formulier annotatie
kan gebruikt worden om de attributen van een vector laag te tonen in een speciaal daarvoor door jezelf ontworpen
formulier in de QT designer (zie figure_custom_annotation). Dit is hetzelfde formulier dat wordt gebruikt voor
de identiteit tool, maar dan gebruikt als annotatie. Zie ook de QGIS blog http://blog.qgis.org/node/143 voor meer
informatie.

Notitie: Wanneer je de toetsencombinatie Ctrl+T gebruikt terwijl een annotatie functie actief is (verplaats
annotatie, tekst annotatie, formulier annotatie), dan wisselt het tekstitem van zichtbaar naar onzichtbaar en ander-
som.
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Figuur 7.9: Customized qt designer annotation form

7.7 Favoriete Plaatsen

De Engelse term ’Spatial Bookmarks’ is vrij vertaald naar ’Favoriete Plaatsen. Je kunt met Favoriete Plaatsen
aangeven waar je later (vaker) terug wilt keren.

7.7.1 Aanmaken van Favoriete Plaats

Hoe je een favoriete plaats aanmaakt:

1. Zoom in op een gebied naar keuze.

2. Selecteer de menu optie Beeld → Nieuwe Favoriet ... of gebruik de snelkoppeling Ctrl-B.

3. Geef een beschrijvende naam waaronder je de Favoriete plaats op wilt slaan (tot 255 tekens).

4. Klik op Enter om de Favoriete plaats toe te voegen of [Verwijderen] om de Favoriete plaats te verwi-
jderen.

Men kan meerdere favorieten onder dezelfde naam opslaan.

7.7.2 Werken met Favoriete Plaatsen

Om een Favoriet te gebruiken of te beheren, kies de menu optie Beeld → Toon Favorieten. De dialoog Favoriete
Plaatsen geeft de mogelijkheid om snel te springen naar die opgeslagen favoriete plaats of om een Favoriete plaats
te verwijderen. Je kunt de naam of de positie van een Favoriete plaats niet wijzigen.

7.7.3 Verplaatsen naar een Favoriete Plaats

Vanuit de dialoog Ruimtelijke Favorieten ..., kies de favoriete plaats door deze te selecteren en druk daarna op de
knop [Zoom naar]. Je kunt ook naar een Favoriete plaats springen door hierop te dubbelklikken.
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7.7.4 Verwijderen van een Favoriete Plaats

Om een favoriete plaats te verwijderen vanuit de dialoog Ruimtelijke Favorieten ... selecteer de favoriet en druk op
[Verwijder]. Bevestig gemaakte keuze in het vervolgschermpje door op [Ja] te drukken of maak het verwijderen
alsnog ongedaan door te drukken op [Nee] .

7.8 Projecten in een project

Wanneer je de inhoud van een ander project wilt opnemen in een project kun je kiezen voor menuselec-
tion:Kaartlagen –> Kaartlagen en groepen inbedden.

7.8.1 Inbedden van lagen

De volgende dialoog maakt het inbedden.van lagen van een ander project mogelijk:

1. Gebruik om een ander project te selecteren van de Alaska dataset.

2. Selecteer het projectbestand grassland. Je kunt de inhoud van het project zien (zie figure_embed_dialog).

3. Druk op Ctrl en selecteer de lagen grassland en regio’s. De lagen zijn nu toegevoegd in de kaartlegenda
en het kaartbeeld.

Figuur 7.10: Select layers and groups to embed

Wanneer de ingebedde kaartlagen bewerkbaar worden gemaakt kun je eigenschappen als Stijl en Labeling van
deze lagen niet aanpassen.

Verwijderen van ingebedde lagen

Klik met de rechtermuis op de ingebedde lagen en selecteer Verwijder.
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QGIS Configureren

QGIS is zeer goed te configuren via het menu Extra. Kies tussen Panelen, Werkbalken, Project instellingen, Opties
en Aanpassingen.

8.1 Panelen en Werkbalken

Via het menu Panelen→ kun je QGIS panelen aan of uitzetten. Via het menu Werkbalken→ kun je werkbalken
toevoegen of verwijderen in de ruimte gereserveerd voor werkbalken in QGIS.

Figuur 8.1: The Panels and Toolbars menu

Tip: Het activeren van Kaartoverzicht in QGIS
In QGIS kun je een paneel activeren die een overzichtskaart toon met de volledige extent van de toegevoegde lagen.
Activeer deze via Extra → Panelen. Binnen de overzichtskaart wordt een rechthoek getoond die overeenkomt met
de gebiedsgrenzen van het getoonde kaartbeeld. Labels worden niet getoond in de overzichtskaart ook al zijn
de lagen zo ingesteld dat er labels moeten worden getoond. Wanneer je het rode vierkant in de overzichtskaart
versleept met ingehouden linkermuisknop, zal het kaartbeeld zich overeenkomstig aanpassen.

Tip: Toon Logboekmeldingen
Vanaf QGIS versie 1.8 is het mogelijk om gegenereerde logboekmeldingen te bekijken. Deze kan geactiveerd

worden door het aanvinkvakje Logboekmeldingen in het menu Extra → Panelen aan te vinken. De meldingen
die worden gegeneerd tijdens het opstarten en gebruik van QGIS kunnen bekeken worden onder de tabbladen
Algemeen en Plugins.
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8.2 Projectinstellingen

Je kunt instellingen voor een project wijzigen via Extra → Projectinstellingen of Bestand → Projectin-
stellingen.... Deze bevat:

• Onder het tabblad Algemeen kan men het volgende instellen; de projecttitel, de selectie- en achtergrondkleur,
de laageenheden, de precisie (aantal decimalen van coördinaten) en of paden relatief of absoluut moeten
worden opgeslagen. De te gebruiken eenheden kan alleen worden ingesteld wanneer gelijktijdige CRS
transformatie is uitgeschakeld (onder tabblad Ruimtelijk Referentie Systeem).

• In het tabblad Ruimtelijke Referentie Systeem (CRS) kun je de gewenst CRS voor dit project instellen. Daar-
naast kun je instellen dat gelijktijdige CRS transformatie moet worden gebruikt wanneer er lagen aanwezig
zijn met verschillende CRS.

• In het derde tabblad Identificeerbare Lagen kun je instellen welke lagen zullen reageren wanneer Objecten
Indentificeren wordt gebruikt. (zie de paragraaf Kaartgereedschap van :ref‘gui_options‘ waarin het gebruik
hiervan wordt uitgelegd.)

• In het tabblad OWS-Server kun je de QGIS mapserver Service Capabilities instellen, de Extent en welke

CRS er gebruikt kan worden als ook de WFS Capabilities. Na het activeren van het aanvinkvakje
:guilabel: WKT geometrie aan feature info response toevoegen kun je de WMS lagen bevragen.

8.3 Opties

Voor het instellen van globale instellingen van QGIS gebruik de dialoog Opties. Open deze via het menu Extra
→ Opties. De volgende tabbladen zijn beschikbaar:

8.3.1 Tabblad Algemeen

• Geef een waarschuwing om project op te slaan indien nodig

• Geef een waarschuwing bij het openen van een projectfile uit een oudere versie van QGIS

• Wijzig de Selectie- en Achtergrondkleur

• Wijzig de QGIS thema Stijl

• Wijzig het icoon thema (kies tussens ‘default’, ‘classic’ en ‘gis’)

• Wijzig de icoon grootte naar 16, 24 of 32 pixels.

• Wijzig grootte lettertype menu

• Bepaal dubbelklik actie in legenda (kies tussen ‘open laagproperties’ en ‘open’) attributen tabel.

• Laagnamen in hoofdletters in legenda

• Toon classificatie-attribuutnamen in legenda

• Raster iconen aanmaken in legenda

• Verberg het openingsscherm tijdens opstarten

• Tips tonen tijdens het opstarten

• Identificeer-resultaten naar een ‘dock-window’ (QGIS herstart vereist)

• Snapping instellingen openen in een ‘dock-window’ (QGIS herstart vereist)

• Attribuut tabel openen in een ‘dock window’ (QGIS herstart vereist)
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• PostGIS lagen toevoegen door dubbelklikken en selectie in uitgebreide modus

• Voeg nieuwe lagen toe aan geselecteerde of huidige groep

• Kopiëer geometrie in WKT representatie van attributentabel

• Attributen tabel gedrag (kies tussen ‘Alle attributen tonen’ (standaard) ‘Geselecteerde objecten tonen’,
‘Toon objecten in huidig kaartvenster’)

• Attributentabel rijcache

• Zet de Weergave van NULL waarden

• Suggereer raster sublagen .Enkele rasterformaten ondersteunen sublagen - deze worden sub-
datasets in GDAL genoemd. Een voorbeeld is het netcdf bestandsformaat - wanneer er veel netcdf vari-
abelen zijn, dan ziet GDAL elke variabele als een subdataset. De optie wordt gebruikt om controle te
krijgen hoe om te gaan, tijdens het laden van, een rasterfile die sublagen bevat. De volgende keuzes zijn
mogelijk:

– ‘Altijd’: altijd vragen (wanneer er sublagen aanwezig zijn)

– ‘indien nodig’: vraag wanneer de laag geen bandlagen maar wel sublagen heeft

– ‘Nooit’: geen vragen, laad geen sublagen

– ‘Laad alles’: geen vragen gewoon alle sublagen laden

• Zoek naar geldige items in het browser dock De optie ‘extensie controleren’ zorgt voor het sneller
laden van een folder, wat veel tijd kan kosten wanneer gecontroleerd wordt op bestandsinhoud met de keuze
‘bestandinhoud controleren’ en er veel bestanden aanwezig zijn (tientallen of honderden).

• Zoek naar de inhoud van gecomprimeerde (zip) bestanden in het browser-dock Deze optie is ook
aanwezig voor het sneller laden van de inhoud van een folder. De volgende keuzes zijn aanwezig:

– ‘Basisscan’ controleert op basis van bestandsextensie of deze ondersteund wordt door een van de
‘drivers’

– ‘Volledige Scan’: opent elk bestand om te controleren of deze valide is

– ‘Passthru’: gebruik deze optie maar niet, deze zal verwijderd zijn in de volgde versie van QGIS

8.3.2 Tabblad GDAL

GDAL is een functiebibliotheek voor het kunnen inlezen converteren van veel rasterformaten. In dit tabblad kun
je instellen welke GDAL functiebibliotheek gebruikt moet worden in het geval er meerdere versies aanwezig zijn.

8.3.3 Tabblad Plugins

• Toevoegen Pad(en) om voor additionele C++ pluginbibliotheken te zoeken.

8.3.4 Tabblad Rendering

• Standaard zullen nieuw toegevoegde lagen aan de kaart direct worden afgebeeld

• Zet het Aantal objecten alvorens de kaart te hertekenen.

• Gebruik de cache voor tekenen indien mogelijk om het opnieuw tekenen te versnellen

• Maak de lijnen minder rafelig ten koste van de tijd dat het tekenen kost

• Problemen met fout (gevulde) polygonen oplossen
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• Nieuwe generatie symbologie gebruiken voor tekenen

• Bepaal de standaard Raster instelling voor visualisatie: ‘RGB-band selectie’ Gebruik standaard afwijk-
ing en ‘Contrastverhoging’

• Toevoegen/verwijderen van Pad(en) voor Scalable Vector Graphic (SVG)-symbolen

Aanvullend kun je bepalen of de paden die gebruikt worden voor SVG symbologie met absolute of relatieve paden
dienen te worden opgeslagen via het tabblad Algemeen van het menu Extra → Projectinstellingen menu.

8.3.5 Tabblad Kaart gereedschap

• De Modus instelling bepaald mede voor welke lagen ‘Objecten Identificeren’ werkt. Wanneer gekozen
wordt voor ‘Van bovenaf’ of ‘Van bovenaf, stop bij eerste’ in plaats van ‘Huidige laag’ zal deze voor
meerdere lagen werken (zie ook het onderdeel Projecten in de Project instellingen om in te stellen welke
lagen door ‘Objecten Identificeren’ getoond zullen worden bij selectie.

• Open object formulier, als er slechts 1 object wordt geprikt

• Bepaal de Zoekradius voor de indentificatie van objecten en het vertonen van kaarttips als een percentage
van de kaart breedte

• Zet de Ellipsoïde voor afstandsberekeningen

• Geef de Rubberband kleur voor het meetgereedschap

• Zet het aantal te gebruiken Decimale posities

• Basis eenheid bewaren

• Geef de Voorkeurs meeteenheden (‘meters of voet’)

• Geef de Voorkeur hoekeenheden (‘Graden’, Radialen’ of ‘Gon’)

• Zet het Muiswielgedrag op (‘Zoom’, ‘Zoom en recenter’, ‘Zoom naar muis cursor’, ‘Niets’)

• Stel de Zoom factor in voor het muiswiel

8.3.6 Tabblad Overlays

• Kies het Plaatsingsalgoritme voor labels, symbolen and diagrammen (kies tussen ‘Middelpunt
(snelst)’, ‘Chain’, ‘Popmusic tabu chain’, ‘Popmusic tabu’ en ‘Popmusic chain’)

8.3.7 Tabblad Digitaliseren

• Wijzig de Lijnkleur en Lijndikte van de Rubberband

• Zet de Standaard ‘snap’-modus (‘Naar hoekpunt’, Naar segment’, ‘Naar hoekpunt en segment’)

• Zet de Standaard ‘snapping’-tolerantie in kaarteenheden of pixels

• Zet de zoekradius voor hoekpuntaanpassingen in ‘kaart eenheden’ of ‘pixels’

• Markers alleen gebruiken voor geselecteerde objecten heeft betrekking op het tonen ervan

• Wijzig de Markerstijl naar (‘Kruis’ (standaard), ‘Semi transparente cirkel’ of ‘Niets’) en de Mark-
ergrootte.

• Geen attribuut-popus na het aanmaken van elk kaartobject tonen
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• Laatst ingevoerde attribuutwaarden gebruiken

• Valideer geometriën tijdens het bewerken van complexe lijnen/polygonen bestaande uit veel punten kan dat
dit het tekenen vertraagd. Dit komt omdat de standaard validatie ‘QGIS’ veel tijd kan kosten. Om het
tekenen te versnellen tijdens het editen kan gekozen worden voor de optie ‘GEOS’ of om de validatie uit
te zetten. De validatie met GEOS is veel sneller maar het nadeel is dat deze alleen het eerste geometrie
probleem rapporteert.

De volgende 3 opties hebben betrekking op de tool Verspring Curve, zie Geavanceerd Digitaliseren, waarmee je
de vorm van de versprongen lijn kan beïnvloeden.

• Verbindingsstijl voor de curve offset

• guilabel:Kwadrantsegmenten voor curve offset

• Hoeklimiet voor curve offset

8.3.8 Tabblad CRS

Het CRS tabblad is onderverdeeld in twee delen. Het eerste deel geeft de mogelijkheid de standaard CRS in te
stellen voor nieuwe projecten.

• Selecteer een CRS voor Altijd dit CRS gebruiken voor nieuwe projecten.

• Gelijktijdige CRS-transformatie gebruiken

Het tweede deel geeft de mogelijkheid of er een actie volgt nadat, een nieuwe laag is aangemaakt, of wanneer een
laag zonder CRS wordt geladen.

• Vraag om CRS

• Gebruik huidige project CRS

• Gebruik het standaard CRS zoals hieronder getoond

8.3.9 Tabblad Locale

• Systeem locale negeren en Te gebruiken locale

• Informatie over gedetecteerde systeem locale

8.3.10 Tabblad Netwerk

• Gebruik een proxy voor internettoegang en geef de ‘Host’, ‘Poort’, ‘Gebruiker’ en ‘Wachtwoord’.

• Geef het Proxy type naar behoefte.

– Default Proxy: Proxy wordt bepaald gebasseerd op de huidige applicatie proxy set

– Socks5Proxy: Een generieke proxy die voor meerdere connectie protocollen. Ondersteund TCP, UDP,
directe verbinding op poort (binnenkomende connecties) en autenticatie.

– HttpProxy: Gebruikt de “CONNECT” opdracht, ondersteund alleen uitgaande TCP connecties; on-
dersteund autenticatie.

– HttpCachingProxy: Gebruikt normale HTTP opdrachten, deze is alleen goed bruikbaar bij het gebruik
van HTTP requests

– FtpCachingProxy: Gebruikt een FTP proxy, die alleen goed bruikbaar is in de context van FTP re-
quests

• Geef de Cache instellingen (pad en grootte)
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Figuur 8.2: Proxy-settings in QGIS

• Geef een WMS zoekadres, het standaard adres is http://geopole.org/wms/search?search=\%1\&type=rss

• Geef de Timeout for netwerkaanvraagen (ms) - standaard ingesteld op 60000

Het uitsluiten van enkele URLs die geen gebruik maken van proxy-settings (zie Figure_Network_Tab) kan gedaan
worden door op de knop [Toevoegen] te drukken. Dubbelklik daarna op de zojuist aangemaakte URL-veld en geef
de URL die je wilt uitsluiten van het gebruiken van de proxy. Uiteraard kun je met de knop [Verwijderen] de
geselecteerde URL verwijderen uit de lijst.

Wanneer je meer gedetailleerde informatie nodig hebt over de verschillende proxy set-
tings, verwijzen we naar de handleiding QT functie bibliotheek documentatie zie
http://doc.trolltech.com/4.5/qnetworkproxy.html#ProxyType-enum.

Tip: Het gebruik van Proxies
Het gebruiken van proxies kan soms erg lastig zijn. Gebruik de ‘trial and error’ methode om de verschillende
proxy typen te testen en controleer of deze voor jou werken.

Je kunt de opties wijzigen naar behoefte. Enkele aanpassingen hebben echter een herstart van QGIS nodig voordat
deze effectief worden.

• instellingen worden opgeslagen in het tekstbestand: $HOME/.config/QuantumGIS/qgis.conf

• de instellingen worden opgeslagen in: $HOME/Library/Preferences/org.qgis.qgis.plist

• instellingen worden opgeslagen in de windows registry onder:

\HKEY\CURRENT_USER\Software\QuantumGIS\qgis

8.4 Aanpassingen

De tool Aanpassingen is een nieuw onderdeel van QGIS versie 1.8.. Hiermee kun je bijna elke element aan-
/uitzetten in de QGIS gebruikersinterface. Dit kan erg handig zijn wanneer veel plugins geinstalleerd zijn die je
nooit gebruikt en die veel schermruimte innemen.

QGIS Aanpassingen is onderverdeeld in vijf groepen. Onder Docks vind je ‘dockable windows’. Dockable
windows zijn applicaties die gestart kunnen worden als een losstaand window maar die ook kunnen worden in-

gebed in het window van de QGIS applicatie zelf.(zie ook Panelen en Werkbalken). Onder Menus kun je menu

onderdelen verbergen. Onder Status Bar kun je onderdelen zoals de coördinaten informatie uitzetten. Onder

48 Hoofdstuk 8. QGIS Configureren

http://doc.trolltech.com/4.5/qnetworkproxy.html#ProxyType-enum


QGIS User Guide, Release 1.8

Figuur 8.3: The Customization dialog

Toolbars kun je iconen van de QGIS werkbalken (de)activeren en onder Hulpmiddelen kun je ook knoppen
en bijbehorende dialogen verbergen.

Met Schakel naar widgets in de hoofdapplicatie kun je klikken op elementen in QGIS die je wilt verbergen
waarna deze ook direct springt naar de bijbehorende entry in het Aanpassingen dialoog (zie figure_customization).
Je kunt ook verschillende sets van instellingen voor verschillende soorten gebruikers opslaan. Om de wijzigen toe
te passen is een herstart van QGIS nodig.
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Werken met Projecties

QGIS geeft gebruikers de mogelijkheid om een globale en projectbrede CRS (Coördinaten Referentie Systeem)
toe te voegen aan lagen die zelf geen CRS bevatten. Het is ook mogelijk om zelf een custom coördinaten referentie
systeem te maken en het ondersteund gelijktijdige CRS transformaties van vector- en rasterkaartlagen. Dit geeft
de gebruiker de mogelijkheid om lagen die verschillende CRS bevatten over elkaar heen te projecteren.

9.1 Overzicht Ondersteuning van Projecties

QGIS ondersteund ongeveer 2700 bekende CRS. De definities van al deze Coordinaat Referentie Systemen zijn
opgeslagen in een SQLite database die onderdeel is van een QGIS installatie. Normaal gesproken hoeven deze
beschrijvingen niet te worden aangepast. Dit kan zelfs er voor zorgen dat hierdoor de ondersteuning van projecties
faalt. Custom CRS worden opgeslagen in een gebruikers database. Zie het onderdeel Aangepaste Coördinaten
Referentie Systeem voor informatie over het beheer van custom coördinaten referentie systemen.

De beschikbare CRS in QGIS zijn gebaseerd op definities die zijn gepubliceerd door de European Petroleum
Search Group (EPSG) en het Institut Geographique National de France (IGNF) die grotendeels zijn opgenomen in
de spatiale referentie tabellen die gebruikt worden in GDAL. De EPSG ID zijn aanwezig in de database en kunnen
gebruikt worden om een CRS te selecteren in QGIS.

Om de gelijktijdige CRS transformatie te gebruiken, dienen alle kaartlagen zelf een coordinaat referentie systeem
te bevatten of moet er een globale of een projectbrede CRS gedefinieerd te zijn (gebruikt voor alle kaartlagen zon-
der CRS). Voor PostGIS lagen gebruikt QGIS de spatiale referentie die gebruikt is tijdens het aanmaken van de
laag. Voor kaartgegevens die ondersteund worden door OGR, gaat QGIS uit van de aanwezigheid van onderdelen
die de CRS definitie bevatten. Voor Shapefiles betekent dit dat er een bestand aanwezig moet zijn die de Well
Known Text (WKT) beschrijving van een CRS bevat. Dit projectiebestand heeft dezelfde basis naam als de shape-
file en wordt gevolgd door de bestandsextensie ‘.prj’. Voorbeeld, naast een shapefile met de naam alaska.shp
dient ook een bijbehorend projectbestand met de naam alaska.prj te bestaan.

Wanneer je een nieuw CRS selecteert, zal de gebruikte lengte-eenheid mee veranderen in het tabblad Algemeen
van de Projectinstellingen dialoog onder het menu Bestand (Gnome, OSX) of Extra (KDE, Windows) menu.

9.2 Een Projectie Definiëren

QGIS gebruikt voor elk nieuw project de globale standaard projectie. De standaard globale CRS na installatie van
QGIS is EPSG:4326 - WGS 84 (proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs). Deze
globale CRS kan worden gewijzigd gebruik makende van de knop [Selecteren...] in het eerste deel waarmee
de Standaard Coördinaten Referentie Systeem te gebruiken voor nieuwe projecten (bijvoorbeeld het Nederlands
RD systeem) zoals getoond in figure_projection_1. Deze keuze zal opgeslagen worden voor gebruik in volgende
QGIS sessies.

Wanneer je kaartlagen gebruikt die geen CRS bevatten, dan zul je moeten definiëren welke CRS QGIS moet
gebruiken voor deze lagen. Dit kan met een globale of een project CRS in het CRS tabblad onder Bewerken →
Opties (Gnome) of Extra → Opties (KDE, Windows, OSX).
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Figuur 9.1: CRS tab in the QGIS Options Dialog

De opties getoond in figure_projection_1 zijn:

• Vraag om CRS

• Gebruik huidige project CRS

• Gebruik het standaard CRS zoals hieronder getoond

Wanneer je de coördinaten referentie systeem voor een bepaalde laag zonder CRS informatie wilt definiëren, dan
kun je dat doen in het tabblad Algemeen van de dialoog eigenschappen van de -raster (zie Tabblad Algemeen) en
vectorlaag (see Tabblad Algemeen). Wanneer je laag al een CRS heeft, zal dit getoond worden als in figuur Vector
Layer Properties Dialog .

Tip: CRS in de kaartlegenda
Met de rechtermuis op een laag klikken in de Kaartlegenda (zie Legenda) geeft twee CRS snelkoppelingen In-
stellen laag CRS zal direct de Ruimtelijk Referentie Systeem Keuze openen (zie figure_projection_2). Project
CRS van laag overnemen zal de project CRS instellen en gelijk maken aan de CRS van geselecteerde laag

9.3 Gelijktijdige CRS transformatie gebruiken

QGIS ondersteund gelijktijdige CRS transformatie voor zowel raster- als vectorkaartgegevens, deze is echter stan-

daard niet geactiveerd. Vink het aanvinkvakje Gelijktijdige CRS transformatie gebruiken an in het tabblad

CRS van de Projectinstellingen dialog.

Er zijn drie manieren om dit dialoog te openen:

1. Selecteer Projectinstellingen van het menu Bewerken (Gnome) of Extra (KDE, Windows, OSX).

2. Klik op de CRS status icoon in de linkeronderhoek van de statusbalk.

3. Zet Gelijktijdige CRS transformatie standaard aan, door in het tabblad CRS van de Opties dialoog en de
checkbox| Gelijktijdige CRS transformatie gebruiken aan te vinken.
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Wanneer je al een laag geladen hebt, en je wilt gelijktijdige CRS transformatie gebruiken, dan kun je het beste

het tabblad CRS van de Projectinstellingen dialog openen, een CRS selecteren en daarna de optie Gelijktijdige

CRS transformatie gebruiken aanvinken. Het CRS status icoon zal niet langer uitgegrijsd zijn en alle lagen
zullen geprojecteerd worden naar de CRS dit getoond wordt naast het icoon.

Figuur 9.2: Projection Dialog

Het tabblad CRS van de Projectinstellingen dialoog bevat vijf belangrijke onderdelen zoals getoond in Fig-
ure_projection_2 die hieronder worden beschreven.

1. Gelijktijdige CRS-Transformatie gebruiken - dit aanvinkvakje wordt gebruikt om de gelijktijdige CRS
transformatie te (de)activeren. Wanneer uit, zal elke laag getekent worden gebruik maken van de de coör-
dinaten zoals gelezen van de gegevensbron en de onderstaande beschreven componenten zijn daarbij uit-
geschakeld. Wanneer aan, zullen de coördinaten van elke laag worden geprojecteerd naar het coördinaten
referentie systeem zoals ingesteld voor het kaartbeeld.

2. Coördinaten Referentie Systeem - dit is een lijst van alle CRS die ondersteund worden door QGIS, in-
clusief geografische, geprojecteerde en zelf gedefiniëerde coördinaten referentie systemen. Om een CRS in
te stellen, selecteer deze uit de lijst door de bijbehorende lijst uit te klappen en de CRS te selecteren. De
actieve CRS is voorgeselecteerd.

3. Proj4 text - dit is de CRS tekst gebruikt door de Proj4 projectie engine. Deze tekst is alleen-lezen en wordt
gegeven ter informatie.

4. Filter - wanneer de EPSG code bekend is, of de identifier of de naam ven een Coördinaten Referentie
Systeem, kun je gebruik maken van een zoekterm om deze te vinden. Geef de EPSG code, de identifier of
de naam als zoekterm.

5. Recent gebruikte coördinatenreferentiesystemen - wanneer je bepaalde CRS vaker gebruikt, dan zullen
deze getoond worden onder in de tabel van de Projectie Dialoog. Klik op een van deze knoppen om de
daarbijhorende CRS te selecteren.
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Tip: Projectinstellingen Dialog
Wanneer je de Projectinstellingen dialoog opent via het menu Bewerken (Gnome) of Extra (KDE, Windows,
OSX), dan moet je het tabblad CRS selecteren om de CRS instellingen te bekijken.

Het openen van de dialoog vanuit het icoon CRS status zal direct het tabblad CRS openen.

9.4 Aangepaste Coördinaten Referentie Systeem

Indien QGIS niet het coördinaten referentie systeem levert die je nodig hebt, kun je zelf een CRS maken. Om

een CRS te maken kies Aangepaste CRS via het menu Bewerken (Gnome) of Extra (KDE, Windows, OSX).
Zelf gemaakte CRS worden opgeslagen in een QGIS gebruikers database. Deze database bevat ook de Favoriete
Plaatsen (spatial bookmarks) en andere eigen instellingen.

Figuur 9.3: Custom CRS Dialog

Om zelf een CRS in QGIS te maken, betekent dat je wel de Proj.4 projectie functie bibliotheek moet snap-
pen. Om te beginnen, verwijzen we naar Cartographic Projection Procedures for the UNIX Environment - A
User’s Manual by Gerald I. Evenden, U.S. Geological Survey Open-File Report 90-284, 1990 (beschikbaar via
ftp://ftp.remotesensing.org/proj/OF90-284.pdf ).

Deze handleiding beschrijft het gebruik van proj.4 en de daarbijhorende ‘command line utilities’. De car-
tografische parameters die gebruikt worden voor proj.4 worden beschreven in de gebruikershandleiding en
deze kunnen ook worden gebruikt in QGIS.

De Aangepaste Coordinaten Referentie Systeem Definitie dialoog heeft slechts twee parameters nodig om een
gebruikers CRS te maken:

1. een beschrijvende naam en

2. de cartographische parameters in PROJ.4 formaat.

Om een nieuwe CRS te maken, klik op de knop Nieuw en geef een beschrijvende naam en de CRS parameters.

Daarna kun je deze CRS opslaan door de klikken op de knop Opslaan.

Let daarbij op dat Parameters moet beginnen met +proj= om een nieuw coördinaten referentie systeem te maken.

Je kunt de gegeven CRS parameters testen om te zien of deze goede resultaten geeft door de klikken op de knop
[Bereken] binnen het Test gedeelte en door de in te geven CRS parameters te plakken in het veld Parameters.
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Geef daarna de bekende coördinaten in WGS84 lat/long waarden in de velden Noord en Oost. Klik op [Bereken]
en vergelijk de resultaten met de bekende waarden in jou coördinaten referentie systeem.
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QGIS Browser

De QGIS Browser is een nieuw paneel in QGIS waarmee je eenvoudige door je database kunt browsen. Je hebt
daarbij toegang tot vector bestanden (bijv. ESRI shapefiles of MapInfo bestanden), databases (bijv. PostGIS of
MSSQL Spatial) en WMS/WFS webservices. Je kunt ook GRASS data bekijken (hoe deze data in QGIS in te
lezen zie GRASS GIS Integration).

Figuur 10.1: Qgis browser as a standalone application to view metadata, preview and attributes

Gebruik QGIS Browser om vooraf de gegevens te bekijken. Met de ‘drag en drop’ functie kun je eenvoudig
gegevens in je kaart en in de legenda slepen.

1. Activeren van het QGIS Browser paneel: Klik met de rechtermuis op een werkbalk en selecteer Browser.

2. Sleep het paneel in het paneel van de legenda.

3. Selecteer het tabblad Browser.

4. Browse in je database en kies de folder shapefiles van qgis_sample_data.

5. Selecteer met ingehouden Shift toets airport.shp en alaska.shp .

6. Sleep met ingehouden linkermuisknop deze selectie de kaart in.

7. Selecteer een laag open het snelmenu met de rechtermuisknop en kies Project CRS van laag overnemen.
Voor meer informatie zie Werken met Projecties.
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8. Selecteer Volledig uitzoomen om de lagen zichtbaar te maken.

De QGIS Browser kan ook gebruikt worden als een losse applicatie.

Opstarten van qgis browser

• Geef “qbrowser” in op de opdracht prompt.

• Start QGIS browser vanuit het Startmenu of via de snelkoppeling op het bureaublad, of door te dubbelk-
likken op een QGIS projectbestand.

• QGIS browser is nog niet beschikbaar in de Applicatie folder. Echter deze kan eenvoudig
beschikbaar worden gemaakt. In Finder gebruik Ga → Ga naar map... en gebruik deze om de
folder‘‘/Applications/QGIS.app/Contents/MacOS/bin‘‘ te openen. Gebruik de toetscombinatie option
- command en sleep qbrowser.app met ingehouden linkermuisknop naar de Applicatie folder. Hiermee
maak je een link aan waarmee de QGIS browser gestart kan worden.

In figure_browser_standalone_metadata kun je de uitgebreidde functionaliteit van de Qgis browser applicatie zien.
Het tabblad Param geeft de details de database connecties van bijvoorbeeld PostGIS of MSSQL Spatial. Het
tabblad Metadata bevat algemene informatie over het bestand (zie Tabblad Metadata). Met het tabblad Preview
kun je de inhouden van bestanden bekijken zonder deze eerst te importeren in je QGIS project. Het is ook mogelijk
de attribuutvelden te bekijken via het tabblad :guilabel:‘Attributes.
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Werken met Vector Data

11.1 Ondersteunde Formaten

QGIS gebruikt standaard de OGR functie-bibliotheek om vectorgegevens te kunnen lezen van, en te schri-
jven naar ESRI Shapefiles, MapInfo en Microstation bestandsformaten; PostGIS, SpatiaLite, Oracle Spa-
tiale databases en vele andere formaten. De vector gegevens kunnen ook geladen worden vanuit gecom-
primeerde zip en gzip-archiefbestanden waarbij gegevens dan alleen gelezen kunnen worden in QGIS. Op het
moment van schrijven van dit document worden, 69 vector formaten ondersteund door de OGR functiebib-
liotheek (zie OGR-SOFTWARE-SUITE Literature and Web References). De volledige lijst is beschikbaar op
http://www.gdal.org/ogr/ogr_formats.html. QGIS ondersteund ook GRASS vector en PostgreSQL middels stan-
daard plugins.

Notitie: Niet alle genoemde formaten zullen zomaar werken in QGIS voor verschillende redenen. Sommige
formaten vereisen de aanwezigheid van externe commerciele funktiebibliotheken. Of een formaat wordt niet on-
dersteund door GDAL/OGR functiebibliotheek die is opgebouwd in voor het gebruikte besturingssysteem. Alleen
die formaten die goed zijn getest zullen verschijnen in de lijst van bestandtypen wanneer men een vectorbestand
in QGIS wilt inlezen. Overige niet geteste formaten kunnen worden geladen door *.* te selecteren.

Het werken met GRASS vector gegevens is beschreven in GRASS GIS Integration.

Dit deel beschrijft hoe je kunt werken met enkele veelvoorkomende vectorformaten: ESRI shapefiles, PostGIS
lagen en Spatialite lagen. Veel van de beschikbare gebruikerfuncties in QGIS werken precies hetzelfde voor
ondersteunde vectorformaten. Dit is een uitgangspunt geweest bij het ontwerp van QGIS en betreft o.a. de
volgende functies, het identificeren, het selecteren, het toevoegen van labels en het werken met attributen.

11.1.1 ESRI Shapefiles

Het standaard vector bestandsformaat dat gebruikt wordt in QGIS is de ESRI Shapefile. De ondersteuning hiervoor
wordt mogelijk gemaakt door de OGR Simple Feature Library ( http://www.gdal.org/ogr/ ).

Een shapefile bestaat uit meerdere bestanden. De volgende drie zijn noodzakelijk:

1. .shp bestand die de geometrieen van de objecten bevat.

2. .dbf bestand die de attribuutwaarden bevat in dBase formaat.

3. .shx het index bestand.

Shapefiles kunnen ook een bestand bevatten met de bestandsextensie .prj , het projectiebestand die informatie
over het gebruikte coordinatensysteem bevat. Alhoewel een projectie bestand erg handig is, is het niet noodza-
kelijk. Een shapefile dataset kan daarnaast nog meer bestanden bevatten. Voor verdere details, bekijk de ESRI
technisch specificaties op http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf.
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Het laden van een Shapefile

Om een shapefile te laden, open QGIS en klik op het icoontje Vectorlaag Toevoegen in de werkbalk of gebruik
de snelkoppeling Ctrl+Shift+V. Dit zal een nieuw scherm openen (zie figure_vector_1).

Figuur 11.1: Add Vector Layer Dialog

Uit de beschikbare opties selecteer het keuzerondje Bestand. Klik vervolgens op de knop [Bladeren]. Dit
zal een standaard bestandskeuze menu openen (zie figure_vector_2) waarmee je kunt bladeren naar de gewenste

shapefile of een andere door QGIS ondersteund vectorformaat. De keuzelijst Bestandstypen geeft de
mogelijkheid om te filteren op door OGR ondersteunde bestandsformaten.

Je kunt ook, indien gewenst de karakterset codering, oftewel de encoding meegeven voor de te openen shapefile,
(CP1252 is de latijnse karakterset veelal gebruikt in westerse talen).

Figuur 11.2: Open an OGR Supported Vector Layer Dialog

Selecteer een shapefile uit de lijst en selecteer de knop [Open] zodat deze geladen wordt in QGIS. Figure_vector_3
toont QGIS na het laden van de shapefile alaska.shp.

Tip: Kleuren van kaartlagen
Wanneer je een kaartlaag toevoegt, zullen de objecten getoond worden in een willekeurige kleur. Wanneer je meer
dan een kaartlaag toevoegd, zal elke kaartlaag een andere kleur krijgen.

Eenmaal geladen, kun je kaartlaag bestuderen met de kaart navigatie functies. Om de symbologie van een kaart-
laag te wijzigen, open het scherm: guilabel:Laag Eigenschappen door te dubbelklikken op de naam van de kaart-
laag in de legenda, of door de laag te selecteren en met de rechtermuis het snelmenu op te roepen en daarin te
kiezen voor Eigenschappen. Zie ook Tabblad Stijl voor meer informatie over het toekennen van symbologie aan
Vector kaartlagen.
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Figuur 11.3: QGIS with Shapefile of Alaska loaded

Tip: Het laden van kaartlagen en projecten van exerne drives onder OS X
Onder OS X, worden de extern toegevoegde USB-sticks en externe harde schijven niet getoond onder Bestand
→ Open Project zoals men zou verwachten. Er wordt gewerkt aan een oplossing die beter aansluit op de OSX-
standaard open/opslaan menu om dit te verhelpen. Je kunt echter, als tijdelijke oplossing, ‘/Volumes’ invullen
bij Bestandsnaam en op return drukken. Vervolgens kun je nu ook de externe gekoppelde geheugeneenheden,
zoals USB sticks, benaderen.

Verbeteren van de performance van Shape

Om de performance van het werken met shapefiles te verbeteren, kun je een spatiale index maken. Een spatiale
index zal er voor zorgen dat het kaartbeeld veel sneller getekend wordt zodat je ook sneller kunt in- en uitzoomen
of het beeld kunt verschuiven. Spatiale indexen gebruikt door QGIS hebben de bestandsnaamextensie .qix.

Gebruik volgende stappen om een index te maken:

• Laad een shapefile.

• Open het menu Laag Eigenschappen door in de legenda te dubbelklikken op de naam van de shapefile of na
selectie in de legenda, met de rechtermuisknop het snelmenu te openen en hierin Eigenschappen te kiezen.

• In het tabblad Algemeen selecteer de knop [Ruimtelijke index maken].

Problemen bij het laden van een shape .prj bestand

Wanneer je een shapefile laad met een .prj bestand en QGIS is niet in staat om het Coordinate referentie systeem
van dat bestand te lezen, dan kun je zelf handmatig de goede CRS projectie zetten binnen het tabblad Algemeen
van het scherm Laag Eigenschappen voor die laag. Dit is nodig omdat het gegeven definies in het .prj bestanden
vaak niet alle benodigde projectie parameters bevatten, die gebruikt worden in QGIS en gegeven zijn in de lijst
van de CRS dialoog.

Om die reden wordt er bij het aanmaken van een nieuwe shapefile met QGIS, twee verschillende projectie be-
standen aangemaakt. Een .prj bestand met een kleiner aantal projectie parameters, compatibel met ESRI soft-
ware, en een .qpj bestand, die een uitgebreidere set van parameters bevat van de gebruikte CRS. Wanneer QGIS
een .qpj bestand aantreft, zal deze gebruikt worden in plaats van het .prj bestand.
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11.1.2 Het laden van MapInfo gegevens

Om MapInfo gegevens te laden, druk op het icoontje Vectorlaag Toevoegen in de werkbalk of gebruik snelkop-
peling Ctrl+Shift+V om het menu vectorlaag toevoegen te openen. Wijzig het bestandstype filter naar Be-
standstype MapInfo Bestand [OGR] en selecteer het MapInfo bestand die je wilt laden.

11.1.3 Het laden van ArcInfo Binary Coverage

Om een ArcInfo Binary Coverage te laden, druk op het icoontje Vectorlaag Toevoegen in de werkbalk of gebruik
snelkoppeling Ctrl+Shift+V om het menu Vectorlaag toevoegen te openen. Selecteer nu eerst de status van

keuzerondje Map. Wijzig vervolgens in de keuzelijst Type Arc/Info Binary Coverage . Navigeer
vervolgens naar de folder die de Arc/Info Coverage bestanden bevat en selecteer deze.

Op de zelfde wijze kun je ook de vector bestanden in het UK National Transfer formaat laden, die eveneens zijn
opgeslagen in een folder als bestanden in het TIGER formaat van het US Census Bureau.

11.1.4 PostGIS kaartlagen

PostGIS kaartlagen zijn opgeslagen in een PostgreSQL database. Het voordeel van PostGIS zijn de spatiale
indexering, filters en de uitgebreidere bevraagmogelijkheden waarin PostGIS voorziet. Wanneer men gebruik
maakt van PostGIS, werken vector functies zoals het selecteren en het identificeren van objecten meer accuraat
dan met OGR lagen in QGIS.

Een Connectie maken met PostGIS

De eerste keer wanneer je een PostGIS database wilt openen, moet er eerst een connectie met de Post-
greSQL database gemaakt worden die de spatiale gegevens bevat. Begin met het selecteren van het icoontje

PostGIS-laag Toevoegen in de werkbalk, of selecteer de menuoptie PostGIS-laag Toevoegen... van het menu
Kaartlagen of gebruik de snelkoppeling Ctrl+Shift+D. Het menu PostGIS Tabel(len) Toevoegen zal vervol-
gens geopend worden. Dit menu kun je ook openen vanuit het menu Vectorlaag Toevoegen waarbij je de status
van het keuzerondje Database.aanzet. Druk eerst op de knop [Nieuw] om toegang te krijgen tot de connec-
tie manager, vervolgens opent het menu Nieuwe PostGIS-verbinding aanmaken. De verplichte velden voor het
opzetten van een verbinding zijn:

• Naam: Een naam voor deze verbinding. Kan gelijk zijn aan de Database

• Service: Service parameter die gebruikt kan worden als alternatief voor Host/Poort (en eventueel ook
Database). Dit kan gedefinieerd worden in de pg_service.conf

• Host: Naam van de database host. De naam van de host moet dezelfde zijn als waarmee je deze kunt vinden
via een telnet verbinding of hoe je deze kunt pingen. Wanneer de database op dezelfde computer staat als
QGIS, gebruik hier dan ‘localhost’.

• Poort: Poort nummer waar de PostgreSQL database naar luistert. De standaardpoort is 5432.

• Database: Naam van de database.

• SSL mode: De instelling van het opzetten van een beveiligde SSL verbinding met de server. De perfor-
mance van het opbouwen van kaarten in QGIS is overigens veel beter door SSL uit te schakelen. Dit zijn de
opties:

– uitschakelen: alleen verbinden zonder SSL versleuteling

– toestaan: probeer een verbinding zonder SSL versleuteling, als dat mislukt probeer dan met SSL

– voorkeur (=standaard): probeer een verbinding met SSL versleuteling, als dat mislukt probeer dan een
verbinding zonder SSL;
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– vereist: alleen verbinden met SSL versleuteling.

• Gebruikersnaam: Gebruikersnaam om toegang te krijgen tot de database.

• Wachtwoord: Wachtwoord die hoort bij Gebruikersnaam om toegang te krijgen tot de database.

Optioneel kunnen de volgende aanvinkvakjes worden aangevinkt:

• Gebruikersnaam Opslaan

• Wachtwoord Opslaan

• Alleen in de geometrie-kolommen kijken

• Alleen in het ‘publieke’-schema kijken

• Ook tabellen zonder geometrie tonen

• Gebruik ’estimated table statistics’

Wanneer alle veldparameters en opties zijn gezet, kun je de connectie testen met de knop [Test Verbinding].

Tip: QGIS Gebruikersinstellingen en beveiliging
Afhankelijk van je besturingssysteem kan de opslag van wachtwoorden in de instellingen voor QGIS een beveilig-
ingsrisico vormen. De opslag van gebruikersinstellingen voor QGIS hangt af van je besturingssysteem:

• , voor linux worden de instellingen opgeslagen in je thuismap in .qgis/.

• , voor windows worden de instellingen opgeslagen in de registry.

Laden van een PostGIS kaartlaag

Na het aanmaken van een verbinding met een of meerdere PostgreSQL databases, kun je een kaartlaag laden
vanuit de PostgreSQL database. Uiteraard moet deze wel eerst kaartgegevens bevatten. Zie Het importeren van
gegevens in PostgreSQL voor een uitleg hoe je gegevens in een PostGis database kunt inlezen.

Doe de volgende stappen, om een kaartlaag te laden vanuit PostGIS:

• Wanneer het venster PostGIS Tabel(len) toevoegen nog niet open is, selecteer in de werkbalk de knop
PostGIS-laag Toevoegen.

• Kies een aangemaakte verbinding vanuit de keuzelijst en druk op [Verbinden].

• Vink aan of ontvink het keuzevakje Ook tabellen zonder geometrie tonen

• Optioneel kun je het keuzevakje Zoek opties aanvinken om een selectie te maken van objecten die
geladen dienen te worden of gebruik de knop [Query maken] om het venster te openen waarmee je een
Query kunt opbouwen.

• Vind de laag/lagen die je wilt laden uit de lijst van beschikbare tabellen met gegevens.

• Selecteer deze door er op te klikken. Je kunt meerdere lagen selecteren door de Shift toets in te drukken
tijdens het klikken. Zie Zoekopdrachtbouwer voor meer informatie over het gebruik van de PostgreSQL
Query Builder hoe je een query kunt maken voor een gegevenslaag.

• Klik op de knop [Toevoegen] om de laag toe te voegen aan de legenda en het kaartbeeld.

Tip: PostGIS Lagen
Normaal gesproken bevat een PostGIS laag een geometrieveld. Maar vanaf versie 0.9.0 is het ook mogelijk om in
QGIS PostGIS lagen zonder geometrieveld te laden. Daarnaast is het ook mogelijke om gedefinieerde SQL Views
te laden. Dit biedt krachtige mogelijkheden om gegevens visueel weer te geven. Zie de PostgreSQL handleiding
voor informatie over het aanmaken van SQL Views.
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Enkele details over PostgreSQL layers

Dit deel bevat enkele details over hoe QGIS toegang heeft tot PostgreSQL lagen. Meestal geeft QGIS een lijst van
database tabellen die geladen kunnen worden en laad deze wanneer je deze selecteert. Maar wanneer je problemen
hebt om een PostgreSQL tabel te laden in QGIS, kan de onderstaand informatie helpen om de meldingen van QGIS
te begrijpen zodat je een aanwijzing hebt wat je moet veranderen aan de PostgreSQL tabel of aan de View definitie
zodat QGIS deze alsnog kan laden.

QGIS vereist dat PostgreSQL tabellen een uniek sleutelveld bevatten voor de te laden laag. In QGIS, moet deze
tabel van het type int4 zijn, een integer (geheel getal) met een grootte van 4 bytes. Als een alternatief kan het veld
ctid gebruikt worden als sleutelveld. Wanneer in een tabel 1 van deze velden ontbreekt zal in plaats daarvan het
veld oid worden gebruikt. De performance zal verbeteren door een index te definieren op het sleutelveld. (opm.
Sleutelvelden krijgen automatisch een index in PostgreSQL).

Wanneer de PostgreSQL laag een view betreft, bestaan dezelfde vereisten, maar views hebben geen sleutelvelden
of velden met regels die ervoor zorgen dat deze uniek zijn. In dat geval zal QGIS proberen een veld te vinden
die is afgeleid van een daarvoor bruikbaar tabelveld. QGIS zal deze proberen af te leiden vanuit de SQL definitie
van de view. Er zijn echter enkele onderdelen van SQL die QGIS niet herkend onder ander het gebruik van tabel
aliasen (pseudoniem) en afgeleide velden die zijn aangemaakt door SQL functies.

Wanneer er niet een goed veld kan worden gevonden, zal QGIS de tabel niet als laag laden. Wanneer dat het geval
is kun je dit oplossen door de SQL View te wijzigen zodat deze een een veld bevat die gebruikt kan worden als
sleutelveld (van type int4 en een sleutelveld of een veld waarbij er voor gezorgd is dat deze unieke waarden bevat
en waarvoor een index is gedefinieerd).

11.1.5 Het importeren van gegevens in PostgreSQL

Gegevens kunnen op een aantal verschillende manieren geimporteerd worden in PostgreSQL gebruik makende
van de SPIT plugin of met opdrachtregel programma’s shp2pgsql of ogr2ogr.

SPIT Plugin

QGIS heeft standaard ook de plugin die SPIT heet (Shapefile naar PostGIS Import Tool). SPIT kan gebruikt
worden om meerdere shapefiles in een keer te laden in PostGIS en ondersteund ook schemas. Zie SPIT Plugin
voor meer informatie.

shp2pgsql

PostGIS heeft een stuk gereedschap genaamd shp2pgsql dat gebruikt kan worden om shapefiles te laden in een
PostGIS database. Om bijvoorbeeld een shapefile met de naam lakes.shp te laden in een PostgreSQL database
genaamd gis_data, gebruik de volgende opdracht:

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data

Dit maakt een nieuwe tabel aan genaamd lakes_new in de database gis_data. De nieuwe tabel zal een
spatiale referentie ID (SRID) bevatten van 2964. Zie Werken met Projecties voor meer informatie over Spatiale
Referentie Systemen en projecties.

Tip: Exporteren van gegevens uit PostGIS
Net zoals de functie shp2pgsql is er ook een functie waarmee je PostGIS tabellen kunt exporteren naar shape:
pgsql2shp. Deze functies vormen een standaard onderdeel van een PostGIS distributie.
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ogr2ogr

Naast shp2pgsql en SPIT is er nog een manier om geografische gegevens in PostGIS in te lezen: ogr2ogr. Dit is
een onderdeel van de GDAL.

Geef de volgende opdracht om een shapefile te importeren in PostGIS:

ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres \
password=topsecret" alaska.shp

Dit zal de shapefile alaska.shp importeren in de PostGIS-database postgis als gebruiker postgres met het
wachtwoord topsecret op host server myhost.de.

Opm. OGR (GDAL) moet gebouwd zijn met ondersteuning voor PostgreSQL om te kunnen werken met PostGIS.
Je kunt dit controleren m.b.v. volgende opdracht

ogrinfo --formats | grep -i post

Wanneer je PostgreSQL’s COPY -opdracht wilt gebruiken in plaats van de standaard INSERT INTO opdracht

kun je dat doen door de volgende omgevingsvariabele in te stellen (tenminste voor en ):

export PG_USE_COPY=YES

ogr2ogr maakt geen spatiale index aan in tegenstelling tot shp2pgsl die dat wel doet. Deze moet nadien, als
extra handeling, alsnog handmatig worden aangemaakt met de normale SQL-opdracht CREATE INDEX (zoals
beschreven in de volgende paragraaf Verbeteren van de Performance).

Verbeteren van de Performance

Het opvragen van gegevens uit een PostgreSQL database kan vertragend werken, zeker over een netwerk. Je
kunt het tekenen echter een stuk sneller maken door er voor te zorgen dat er een PostGIS spatial index is aange-
maakt voor elke laag uit de PostgreSQL database. PostGIS ondersteund het aanmaken van een zogenaamde GiST
(Generalized Search Tree) index zodat de spatiale zoekopdrachten een stuk sneller uitgevoerd worden.

De opdracht voor het aanmaken van een GiST index is:

CREATE INDEX [indexname] ON [tablename]
USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );

Voor grote tabellen kan het aanmaken van een index veel tijd kosten. Wanneer de index is aangemaakt dient deze
gevolgd te worden door de opdracht VACUUM ANALYZE. Zie de PostGIS documentatie (POSTGIS-PROJECT
Literature and Web References) voor meer informatie.

Hier volgt een voorbeeld hoe je een GiST index kunt aanmaken:

gsherman@madison:~/current$ psql gis_data
Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms
\h for help with SQL commands
\? for help with psql commands
\g or terminate with semicolon to execute query
\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes
gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);
CREATE INDEX
gis_data=# VACUUM ANALYZE alaska_lakes;
VACUUM
gis_data=# \q
gsherman@madison:~/current$
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11.1.6 Vector kaartggegevens die de 180° lengtegraad overschrijden

Veel GIS pakketten zullen verkeerd omgaan met het aanmaken van vector kaarten, met een geografisch referentie
systeem (lengte-/breedtegraden), wanneer deze de 180 lengtegraad lijn overschrijden. Wanneer ze zo’n kaart
openen in QGIS, zullen we zien dat twee plaatsen die dicht bij elkaar liggen, ver uit elkaar getoond worden. In
Figure_vector_4 ligt, het kleine puntje helemaal aan de linkerkant van het kaartbeeld (de Chatham Islands), in
werkelijkheid aan de rechterkant van de Nieuw Zeeland’s hoofdeilanden.

Figuur 11.4: Map in lat/lon crossing the 180° longitude line

Dit probleem kan men oplossen door de lengtegraden te transformeren gebruik makende van Post-
GIS, en de ST_Shift_Longitude functie (zie http://postgis.refractions.net/documentation/manual-
1.4/ST_Shift_Longitude.html). De transform functie leest elke coördinaat van de geometrie van elk object
en wanneer de lengtegraad < 0° telt deze er 360° bij op. Het resultaat zal een 0° - 360° versie zijn van de gegevens
die afgedrukt worden op een 180° gecentreerde kaart.

Figuur 11.5: Crossing 180° longitude applying the ST_Shift_Longitude function

Gebruik

• Importeer gegevens in PostGIS (Het importeren van gegevens in PostgreSQL) bijvoorbeeld door gebruik te
maken van de PostGIS Manager plugin of de SPIT plugin

• Geef de volgende opdracht op de SQL opdrachtregel van PostGIS (dit is een voorbeeld waar “TABEL” de
echte naam is van je PostGIS tabel)

gis_data=# update TABLE set the_geom=ST_shift_longitude(the_geom);

• Wanneer alles goed ging, zou je nu een bevestiging moeten ontvangen van het aantal objecten die bijgewerkt
zijn. Daarna kan deze tabel geladen worden en zie je het verschil (Figure_vector_5)
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11.1.7 SpatiaLite Kaartlagen

Wanneer je gegevens van een SpatiaLite database wilt laden, selecteer het icoontje SpatiaLite-laag Toevoegen op

de werkbalk of door de menu-optie SpatiaLite-laag Toevoegen... te selecteren onder het hoofdmenu Kaartla-
gen of via de sneltoets Ctrl+Shift+L. Een menu zal openen waarin je een nieuwe verbinding met een Spatialite
database kunt aanmaken of een bestaande verbinding die bekend is bij QGIS kunt kiezen in een keuzelijst. Om
een nieuwe connectie aan te maken selecteer de knop [Nieuw], vervolgens kun je via een bestandsverkenner de
SpatiaLite database vinden, wat vaak een bestand is die meestal de bestandsextensie :file‘.sqlite‘ heeft.

Wanneer je een vectorlaag wilt opslaan in SpatiaLite formaat kun je dit doen door een vectorlaag in de legenda
te selecteren en dan met de rechtermuis het snelmenu te openen en daarin Opslaan als te selecteren. Geef een
naam voor de aan te maken database, geef ‘Spatialite’ als formaat en de CRS (Coordinaten Referentie Systeem).
Je kunt ook ‘SQLite’ als formaat selecteren en de volgende opdracht in het veld OGR data source creation op-
tion SPATIALITE=YES meegeven. OGR weet dan dat deze een SpatiaLite database moet aanmaken. Zie ook
http://www.gdal.org/ogr/drv_sqlite.html.

QGIS ondersteund ook het bewerken van gegevens via Views in SpatiaLite.

Het maken van een nieuwe SpatiaLite kaartlaag

Wanneer je een nieuwe SpatiaLite laag wilt aanmaken, ga naar Het aanmaken van een nieuwe Spatialite Laag.

Tip: SpatiaLite data management Plugins
Voor het beheren van SpatiaLite gegevens kun je een aantal Python plugins gebruiken: QSpatiaLite, SpatiaLite
Manager of DB Manager (standaardplugin, aanbevolen). Deze kunnen gedownload en geïnstalleerd worden met
de Plugin Installer.

11.1.8 MSSQL Spatial kaartlagen

QGIS ondersteund standaard ook het MS SQL 2008. De MSSQL Spatial-laag toevoegen is beschikbaar in de
werkbalk en ook beschikbaar in QBrowser waarbij je gegevens eenvoudig met ‘drag and drop’ kunt importeren.

11.2 Het Vector Eigenschappen Menu

Het menu Laag Eigenschappen voor een vector laag geeft in informatie over de laag, instellingen van de stijlen en
de label opties. Wanneer de Vector laag geladen is vanuit een PostgreSQL/PostGIS database, kun je ook de SQL
opdracht aanpassen waarmee deze laag is opgehaald door het Query Builder venster te starten onder het tabblad
Algemeen. Om toegang te krijgen tot het menu Laag Eigenschappen kun je dubbelklikken op een kaartlaag in de
legenda of een laag selecteren en met de rechtermuisklik het snelmenu openen en de menuoptie Eigenschappen
selecteren.

11.2.1 Tabblad Stijl

Sinds QGIS 1.4.0 is het mogelijke twee soorten symbologie naast elkaar te gebruiken, waarbij de nieuwe ver-
beterde symbologie de oude zal gaan vervangen. In QGIS 1.8.0 is de nieuwe symbologie de standaard geworden
die verder verbeterd is en nieuwe functionaliteit bevat.

Een beschrijving van de oude symbologie is beschikbaar in Oude Symbologie.

Er zijn drie soorten symbologie: markering symbolen (voor punten), lijn symbolen (voor lijnen) en vulling en
buitenlijn symbolen (voor polygonen). Symbolen kunnen bestaat uit een of meerdere symbool lagen. Het is mo-
gelijk om een symbool een kleur te geven, dan krijgen alle symboollagen die kleur. Je kunt voor een symboollaag
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Figuur 11.6: Vector Layer Properties Dialog

de kleur vastzetten - die kleur wordt dan niet mee gewijzigd bij het wijzigen van de kleur van een symbool. Op
die manier kun je symbolen maken die bestaan uit meerdere kleuren. Op dezelfde manier kun je ook de lijndikte
voor lijnsymbolen voor alle lagen tegelijk wijzigen of voor 1 laag vastzetten. Dit werkt ook voor de grootte en de
hoek van symboollagen.

Beschikbare typen symbool lagen

• Punt lagen

– Tekst markering: puntsymbool met tekst.

– Simpele markering: puntsymbool op basis van voorgecodeerde symbolen.

– SVG markering: puntsymbool op basis van een SVG afbeelding.

– Ellipse marker: Ellipsvormig puntsymbool op basis van attribuutwaarden.

– Vector veld marker: Vectoren als symbologie op basis van attribuutwaarden.

• Lijn lagen

– Lijn decoratie: Voeg een lijn decoratie toe, bijvoorbeeld een pijlpunt om de lijn een richting te geven.

– Lijn markering: Een lijn die opgebouwd wordt met op regelmatige afstanden een markering symbool.

– Simpele lijn: Een ‘normale’ opgebouwde lijn (met een gezette lijndikte, kleur en penstijl/lijnarcering).

• Polygoon lagen

– Centroïde vulling: Plaats op de centroïde van een polygoon een voorgecodeerd markeringsymbool.

– SVG vulling: Vul het polygoon op met een SVG symbool.

– Simpele vulling: Een ‘normaal’ opgebouwde polygoon ( met een gezette vulkleur, arcering en een
dikte van de buitenlijn).

– Lijnpatroonvulling: Vul het polygoon met een lijnpatroon.

– Puntpatroonvulling: Vul een polygoon met een puntpatroon.

– Buitenlijn: Lijn met decoratie: Voeg een lijn decoratie toe, bijvoorbeeld een pijltje om de richting
vand de lijn mee aan te geven.

– Buitenlijn: Markeringslijn: Gebruik een voorgecodeerd markeringssymbool om daarmee de grens
van een vlak mee op te bouwen.
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– Buitenlijn: Simpele lijn: Geef de buitenlijn die de grens van een vlak aangeeft een breedte, een kleur
en een penstijl/lijnarcering.

Kleurverlopen

Kleurverlopen worden gebruikt om makkelijk te kunnen kiezen uit heel veel kleuren die gebruikt worden tijdens
het opbouwen van de kaart. De kleuren van gebruikte symbolen worden toegekend vanuit de kleurverlopen.

Er zijn drie typen kleurverlopen:

• Gradiënt: Waarbij de ene kleur langzaam overvloeit naar een andere kleur.

• Random: Genereer willekeurig/’at Random’ kleuren van uit een gespecificeerd kleurenpalet.

• ColorBrewer: Maak een kleurenspectrum aan vanuit een kleurenschema en een gedefinïeerd aantal
kleurenklassen.

Kleurverlopen kunnen worden gezet in het tabblad Kleurverloop van het menu Stijl manager door op de knop
[Toevoegen] te drukken en een type kleurverloop te kiezen (zie vector_style_manager).

Stijlen

Een stijl groepeert een set van verschillende symbolen en kleurverlopen. Je kunt in zo’n stijlengroep je favoriete
symbolen vastleggen en deze gebruiken zonder deze symbolen telkens opnieuw weer op te bouwen. Stijlonderde-
len (symbolen en kleurverlopen) hebben altijd een naam waarmee ze kunnen worden opgevraagd uit de stijlen. Er
is minimaal één standaard stijl in QGIS (die aangepast kan worden) en de gebruiker kan daarnaast stijlen toevoe-
gen. In het onderste deel van het tabblad Stijl zijn vier knoppen aanwezig voor het beheer van Stijlen: Gebruik
[Terug naar Standaard Stijl] om terug te gaan naar je standaard stijl, [Opslaan als Standaard] om de huidige
stijl op te slaan als standaard stijl, [Stijl laden...] om je stijl op te laden en [Stijl Opslaan...] om de ingestelde
stijl op te slaan. Laagstijlen kunnen ook gekopiëerd worden van de ene laag naar een andere. Selecteer een laag

en kies via het menu Kaartlagen → Kopiëer stijl en selecteer vervolgens een andere laag. Kies vervolgens

Kaartlagen → Plak stijl.

Renderers

De Renderer is verantwoordelijk voor het opbouwen van het kaartbeeld waarbij de objecten met de goede symbol-
ogie wordt getekend. Er zijn vier soorten Renderers: Enkel Symbool, Categoriëen (in de oude symbologie werd
deze unieke kleuren genoemd), gradueel en Regel-gebaseerd. Er is geen continue kleuren renderer aangezien
deze in feite een speciale variant van de Graduele renderer is. De graduele gecategoriseerde renderer kan wor-
den aangemaakt door een combinatie van een symbool en een kleurverloop te kiezen. Werken met de Nieuwe
Symbologie

In het tabblad:guilabel:Stijl kun je kiezen uit vijf soorten Renderers: Enkel Symbool, Categoriën, Gradueel, Regel-
gebaseerd en Puntverplaatsing. Voor elk vectortype (punten, lijnen en polygonen) zijn vector symboollaag typen
beschikbaar (zie vector_symbol_types). Afhankelijk van de gekozen renderer, zal het tabblad stijl verschillende
opties en instellingen bevatten, die in de volgende paragrafen worden beschreven. Het menu van de nieuwe sym-
bologie bevat ook de knop [Stijlen Manager] die toegang geeft tot de Stijlen Manager (zie vector_style_manager).
De Stijlen Manager biedt de mogelijkheid om bestaande symbolen te verwijderen en om nieuwe toe te voegen.

Tip: Selecteer en wijzig meerdere symbolen
Met de nieuwe symbologie kun je meerdere symbolen selecteren en via de rechtermuis kun de kleur, transparantie,
de grootte en de dikte van de buitenlijnen aanpassen.

De Enkel Symbool Renderer

De renderer Enkel Symbool wordt gebruikt om alle objecten van een kaartlaag te presenteren met een enkel door
de gebruiker toegekend symbool. De eigenschappen die kunnen worden gewijzigd in het tabblad Stijl is deels
afhankelijk van het type kaartlaag, maar voor alle typen geldt de volgende opbouw.Links bovenin het tabblad,
kun je de voorvertoning zien van het huidige symbool. Onderin het tabblad is een lijst van symbolen die reeds
aangemaakt zijn voor de huidige stijl, klaar om te gebruiken door deze te selecteren uit de lijst. Het huidige
symbool kan worden aangepast gebruik makende van de knop [Eigenschappen] onder het voorbeeld van het
symbool, waarmee het venster Symbooleigenschappen kan worden geopend, of de knop [Aanpassen] rechts van
de voorvertoning, die het standaard Kleuren dialoogvenster opent.
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Figuur 11.7: Single symbol line properties

In het tabblad Stijl kun je de transparatie van de laag instellen en aangeven of je millimeters of kaarteenheden
wilt gebruiken voor de schaalgrootte. Daarnaast kun je ook de schaalgrootte en rotering instellen die afhankelijk
is van attribuutwaarden van diezelfde laag.Deze is beschikbaar onder de knop [Geavanceerd] naast de knop
[Stijl opslaan...]). Daarin kun je via de keuzelijst Symboollagen... kiezen waarmee een menu opent waarin je
kunt aangeven in welke volgorde de symboollagen moet worden opgebouwd (wanneer het symbool bestaat uit
meerdere lagen).

Na het symbool te hebben aangepast kan deze worden opgeslagen en worden toegevoegd aan de lijst van huidige
stijl symbolen (gebruik makende van de knop [Stijl opslaan...]) zodat deze in de toekomst weer gebruikt kan
worden. In het vervolgmenu Sla laageigenschappen op als stijlbestand dat verschijnt na het indrukken van de
knop [Stijl opslaan] kun ervoor kiezen om de stijl van de laag op te slaan in een QGIS stijl bestand (.qml) of als
SLD bestand (.sld). Een SLD (Styled Layer Descriptor) is een open standaard formaat voorgeschreven door het
OGC, die o.a. ook wordt gebruikt door geoserver. Voor de export mogen alle renderstijlen gebruikt worden, maar
wanneer een SLD stijl bestand wordt geimporteerd zullen deze worden omgezet naar de simpele symbolen of
de regelgebaseerde renderstijl. categoriën of graduele renderstijlen worden daarbij omgezet naar regelgebaseerde
renderstijlen. Wanneer je dat wilt voorkomen kun je de stijl het beste opslaan als .qml bestand, maar het is aan de
andere kant ook een eenvoudige manier om de renderstijl snel om te zetten.

De Categoriën Renderer

De Categoriën Renderer wordt gebruikt om alle objecten van een laag te tekenen met één symbool met een kleur
die afhankelijk is van een attribuutwaarde van diezelfde laag. Het tabblad Stijl geeft je de mogelijkheid om een
keuze te maken uit:

• Een kolom (uit de lijst van attribuutvelden)

• Het symbool (gebruik makende van het Symbool selectie menu)

• De kleuren (uit de lijst van de kleurverlopen)

Met de knop [Geavanceerd] die zich rechtsonder in het menu bevindt, kun je instellen welke velden gebruikt
kunnen worden voor de rotatie of voor de schaalgrootte van het symbool afhankelijk te maken van de veldwaarde.
Daarbij kun je eenvoudig een veld kiezen in een keuzelijstje van velden die je daar eventueel voor kunt gebruiken.

Het voorbeeld in figure_symbology_2 toont de categoriën rendering dialoog gebruikt voor de laag rivers van
de QGIS sample dataset.

Je kunt zelf een nieuwe kleurverloop aanmaken door onderin de lijst van kleurverlopen te kiezen voor Nieuw
kleurverloop.... In het venster dat opent kun je vervolgens een kleurverlooptype selecteren uit: Gradiënt, Random
of ColorBrewer. Na het drukken op de knop [OK] kun je vervolgens ook meerdere ‘stops’ in het kleurverloop
opnemen. Zie figure_symbology_3 die een voorbeeld toont van een zelf gemaakte kleurverloop.

De Graduele Renderer

De Graduele Renderer wordt gebruikt om voor een laag aan de hand van een enkel symbool de classificatie weer
te geven aan de hand van de kleuren die afhankelijk is van een attribuutwaarde.

Net als de Categoriën Renderer, kun je hiervoor de rotatie en de grootte afhankelijk maken van attribuutwaarden.
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Figuur 11.8: Categorized Symbolizing options

Figuur 11.9: Example of custom gradient color ramp with multiple stops

Figuur 11.10: Graduated Symbolizing options
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Net als de categoriën Renderer, heeft het tabblad Stijl de selectiemogelijkheden:

• Een kolom (uit de lijst van attribuutvelden)

• Het symbool (Gebruik makende van het Symbool selectie menu)

• The colors (using the Color Ramp list)

Aanvullend kun je het aantal klassen kiezen en ook welke modus je wilt gebruiken voor de Klassificatie. De
beschikbare modus zijn:

• Gelijke Interval

• Quantilen

• Natuurlijke Grenzen (Jenks)

• Standaard Afwijking

• Mooie Grenzen

De lijst in het onderste deel van het tabblad Stijl somt de klassen op met hun bereik, labels en symbolen die voor
het renderen worden gebruikt.

Het voorbeeld in figure_symbology_4 toont de dialoog van de Renderer Gradueel voor de laag rivers van de
QGIS voorbeeld dataset.

De Regel-gebaseerde Renderer

De Regel-gebasseerde Renderer wordt gebruikt om objecten van een laag te tonen waarbij gebruikte kleuren
afhankelijk zijn van toegepaste regels. Deze regels zijn gebasseerd op SQL opdrachten. Je kunt ook de Zoekop-
drachtbouwer gebruiken om deze te maken. De dialoog geeft de mogelijkheid om met een filter te groeperen of
verschalen en je kunt besluiten of je symboollagen wilt gebruiken of dat de eerste regel waaraan voldaan wordt
gebruikt wordt.

Het voorbeeld in figure_symbology_5 toont de dialoog van een Regel-gebaseerde renderer voor de laag rivers
van de QGIS voorbeeld dataset.

Om een nieuwe regel toe te voegen aan de regelgebaseerde rendering, dubbelklik op een regel in de lijst of druk
op de [+] knop waarna de dialoog Regel eigenschappen opent waarmee je dat kunt doen. Druk in de dialoog op

de knop waarmee de Expressie-string bouwer opent waarmee je expressies kunt maken. Dubbelklik eerst
op >-Velden en Waarden waarna je de attribuutvelden ziet. Om een attribuutveld toe te voegen, dubbelklik op
het veld in de lijst van >-Velden en Waarden.Je kunt de verschillende velden, waarden en functies gebruiken om
daarmee een expressie op te bouwen of je kunt dit direct doen door dit in het tekstblok van expressie in te typen
(zie Veld berekening).

Figuur 11.11: Rule-based Symbolizing options
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De Punt Verplaatsing Renderer

Deze Punt Verplaatsing Renderer biedt de mogelijkheid om alle objecten te zien ook al staan er meerdere op exact
de zelfde positie. Wanneer dat het geval is worden deze op afstand in een circel eromheen geplaatst zodat ze toch
zichtbaar zijn.

Figuur 11.12: Point displacement dialog

Symbooleigenschappen

Het symbooleigenschappen menu geeft de gebruiker de mogelijkheid om de eigenschappen van het te renderen
symbool aan te passen. Linksonder in het menu, kun je een voorbeeld zien van het huidige symbool zoals deze
getekend zal worden op de kaart. Boven het voorbeeld bevindt zich de lijst van symboollagen. Om het menu
Symbooleigenschappen te openen, klik op de knop [ Wijzigen...] in het tabblad Stijl van het menu Laag
Eigenschappen.

Het menu geeft de mogelijkheid om lagen toe te voegen of te verwijderen, de volgorde van lagen te wijzigen of
om symboollagen vast te zetten zodat van die laag de kleur niet gewijzigd wordt. Het rechterdeel van het menu
toont de mogelijke instellingen voor het geselecteerde symbool in de lijst van symboollagen. Het belangrijkste

is de Symboollaag type keuzeveld, waarmee je een laagtype kunt selecteren. De beschikbare opties zijn
afhankelijk van de het laagtype (Punt, Lijn, Polygoon). De symboollaag type opties zijn beschreven in section
vector_symbol_types. Je kunt ook de symboollaag eigenschappen wijzigen in de rechterkant van de dialoog.
Wanneer je bijvoorbeeld een SVG markerings symbool hebt gekozen voor een vector puntenlaag, is het mogelijk
de kleur ervan te veranderen gebruik makende van het Kleur menu.

11.2.2 Stijl Manager

De Stijl manager is een hulpprogramma, die de symbolen en kleurverlopen beheerd van een stijl. Het geeft
de mogelijkheid om onderdelen toe te voegen of te verwijderen. Om de Stijl manager te open, selecteer het
hoofdmenu Instellingen → Stijl Manager.

11.2.3 Oude Symbologie

Notitie: QGIS 1.8 ondersteund nog de oude symbologie, maar het wordt aangeraden om de nieuwe symbologie
te gaan gebruiken zoals beschreven in vector_new_symbology. In een volgende release zal het gebruik van de
oude symbologie vervallen.
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Figuur 11.13: Line composed from three simple lines

Figuur 11.14: Style Manager to manage symbols and color ramps
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Wanneer je terug wilt gaan naar de oude symbologie, selecteer dan de knop [Oude Symbologie] in het tabblad
Stijl van het menu Laag Eigenschappen.

Je kunt het gebruik van de oude symbologie ook als standaard instellen door het aanvinkvakje Nieuwe gener-
atie symbologie gebruiken voor tekenen niet aan te vinken in het tabblad Rendering te openen via het hoofdmenu
Instellingen → Opties.

De oude QGIS symbologie ondersteunt de volgende renderers:

• Enkel Symbool - Elk object in een laag krijgt hetzelfde symbool.

• Graduated Symbool - Objecten in een laag worden verdeeld in een aantal klassen gebaseerd op de waarden
van een bepaald veld. Elke klasse kun je een ander symbologie geven.

• Continue kleur - Objecten in een laag worden getoond met hetzelfde symbool maar de kleur daarvan is
afhankelijk van de numerieke waarde van een veld.

• Unieke Waarde - Voor elke unieke waarde van een bepaald veld kun je een ander symbologie instellen.

Om de symbologie van een laag te wijzigen, dubbelklik op de laag in de legenda en het menu Laag Eigenschappen
zal openen.

Stijl Opties

Binnen dit menu kun je vectorlagen een stijl geven. Afhankelijk van de geselecteerde rendering kun je ook je
kaartobjecten classificeren en dit middels symbologie weergeven.

De volgende stijlen opties bestaan voor alle renderers:

• Vul opties - Naast het kiezen van een lijn/vlak arcering of volledige vulling kun je kiezen voor Vulstijll:?

Textuur waarna je met de knop een bestand kunt selecteren met je eigen textuur waarmee
de lijn/vlakvulling plaatsvindt. Momenteel worden de bestandsformaten *.jpeg, *.xpm, en *.png on-
dersteund.

• Vulkleur - de kleur waarmee je objecten worden gevuld.

• Omlijning opties

– Omlijning stijl - lijnarcering waarmee de omlijning van je object worden getekend. Je kunt ook ‘geen
pen’ selecteren.

– Omlijning kleur - kleur waarmee de omlijning van je object worden getekend.

– Omlijning breedte - pendikte waarmee de omlijning van je object wordt getekend.

Wanneer je tevreden bent over de gegeven stijl aan een laag, kun je deze ook vastleggen in een bestand met de
bestandsextensie *.qml. Gebruik hiervoor de knop [Stijl Opslaan...]. Met de knop [Stijl laden...] kun je een
opgeslagen stijl voor een laag laden.

Wanneer je wilt dat een bepaalde stijl altijd wordt gebruikt wanneer een laag geladen wordt (dus ook in nieuwe
projecten), gebruik dan de knop [Opslaan Als Standaard]. Wanneer je de stijl hebt gewijzigd en je bent er niet
tevreden over kun je met de knop [Terug naar Standaard Stijl] de stijl terug zetten naar de standaard stijl.

Vector transparantie

QGIS geeft de mogelijkheid om elke vectorlaag transparant te maken. Dit kun je doen met de schuifbalk

Transparantie binnen het tabblad Stijl Dit is erg handig bij het gebruik van overlappende
vectorlagen.

11.2.4 Tabblad Labels

Een label is de tekst die geplaatst wordt bij een object op de kaart. Net als voor de symbologie is er in
QGIS 1.8 een oude en nieuwe methode van het toevoegen van labels aan objecten. Het tabblad Labels bevat de
oude methode voor het toevoegen van labels. De nieuwe manier van het toevoegen van labels, gebeurt vanuit de
werkbalk. De oude manier van labelen zal in een volgende versie van QGIS vervallen.
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We raden dan ook aan gebruik te maken van de nieuwe manier beschreven in Nieuwe Labeling.

Met de oude manier van het toevoegen van labels, vanuit het tabblad Labels, geeft de mogelijkheid om de labels
toe te voegen met een keuzemogelijkheden in lettertype, plaatsing, de uitlijning en het bufferen van de labels. We
zullen als voorbeeld de kaartlaag lakes van labels voorzien. Lakes is de ingelezen shapefile die onderdeel uitmaakt
van de Alaska voorbeeldgegevens QGIS_example_dataset:

1. Laad de Shapefile alaska.shp en de GML file lakes.gml in QGIS

2. Zoom in op een meer (=lake)

3. Selecteer de laag lakes in de legenda

4. Open het menu Laag Eigenschappen (via snelmenu onder rechtermuisknop of door op de laag Lakes te
dubbelklikken

5. Open het tabblad Labels

6. Vink het aanvinkvakje Toon labels aan zodat labels getoond worden

7. Kies het veld te gebruiken in labels in de keuzelijst. In dit geval gebruiken we het veld NAMES, guil-

abel:Veld te gebruiken in labels: Names

8. Vul een standaard waarde in (bijv. ‘Meer’), voor meren die geen naam hebben. Deze standaard waarde
wordt getoond in het kaartbeeld bij objecten, wanneer dat object (een meer) geen naam heeft.

9. Labels kunnen uit meerdere regels bestaan en worden weergegeven wanneer het aanvinkvakje Labels
met meerdere regels is aangevinkt. QGIS zal dan in het veld zoeken naar echte regelafbrekingen en op die
plek in het label zal dan een nieuwe regel beginnen. Een echte regelafbreking is een enkel karakter \n, (geen
twee aparte karakters zoals een \ gevolgd door het karakter n). Om in een attribuut veld regelafbrekingen
in te kunnen brengen, open het tabblad Velden en wijzig van het tekstveld het Wijzig-hulpmiddel van ‘Lijn
wijzigen’ naar ‘Tekstbewerken’.

10. Selecteer de knop [Apply].

Het menu blijft openstaan en de labels worden op de kaart getekend. Waarschijnlijk niet zoals je zou willen, te
groot en verkeerd geplaatst t.o.v. de objecten.

Gebruik de knop [Lettertype] om het menu te openen waarmee je lettertype, grootte en stijl kunt instellen
waarmee de labels getekend worden. Gebruik de knop [Kleur] om de tekstkleur te kiezen. Je kunt ook de
hoek kiezen waarmee labels geplaatst worden.

Daarnaast kun je de positie van het label veranderen ten opzichte van het object:

1. Onder de standaard label opties kies een van de keuzerondjes in de Plaats groep om de plaatsing te wijzigen.
Wij selecteren in dit voorbeeld het keuzerondje Rechts.

2. Je kunt kiezen tussen het gebruik van In punten en Kaarteenheden. Wanneer je kiest voor Kaarteen-
heden dan worden de teksten groter en kleiner bij in- en uitzoomen. Bij de keuze In punten blijft de tekst
even groot. In de meeste gevallen is de keuze In punten de beste keuze.

3. Druk op [Apply] om het resultaat te zien in het kaartbeeld zonder het menu te sluiten.

Het begint er beter uit te zien, maar de labels kunnen beter iets verder van de meren worden geplaatst. Dit
kunnen we doen door onderin het tabblad Labels onder Verspringing aangeven hoeveel de tekst nog verplaatst
moet worden t.o.v. het object. Wanneer we in X-verspringing 5 ingeven (In punten) dan verschuift het label nog
iets naar rechts op en wordt de tekst beter leesbaar geplaatst.

De laatste aanpassing die we zullen gebruiken is om elk label een buffer te geven. Daarmee wordt rond de tekst
een vlak getekend, met ingegeven breedte, in een kleur naar keuze, wat vaak de tekst beter leesbaar maakt in een
wat drukkere kaart, doordat deze er beter uitspringt. Doe het volgende om de labels van de laag Lakes een buffer
te geven:

1. Vink het aanvinkvak Labels met Buffer? aan.

2. Kies een grootte van het buffer (invullen of met de pijltjes verhogen/verlagen).
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3. Kies een achtergrond kleur via de knop [Kleur] onder Buffer. Je kunt zelfs kiezen voor een mate van
transparantie voor de buffer.

4. Druk op [Apply] om het resultaat van de wijzigingen te zien.

Wanneer je niet tevreden bent, verander dan de instellingen en controleer tussendoor de wijzigingen met de knop
[Apply] totdat je wel tevreden bent.

Een buffer van 1 (In punten) geeft vaak al een goed resultaat. Je kunt de buffer ook instellen in kaarteenheden.

De overige instellingen binnen het tabblad Labels bevindt zich onder het tabblad Geavanceerd waarmee je de
eigenschappen van labels kunt instellen met de attribuutwaarden van de vectorlaag.

Het tabblad Labels bevat ook een Voorvertoning waarmee je al een indruk kunt krijgen van hoe het label eruit
gaat zien.

11.2.5 Nieuwe Labeling

Achter de nieuwe knop Labels zit de nieuwe geavanceerdere manier voor het plaatsen van labels van vector punt-
, lijn- en polygoonlagen waarvoor slechts enkele instellingen nodig zijn. Deze nieuwe manier van het plaatsen
van labels zal de huidige oude manier zoals beschreven in Tabblad Labels vervangen. Deze ondersteund ook
Gelijktijdige CRS Transformatie.

Gebruik van de nieuwe manier van labels plaatsen

1. Start QGIS en laad een punt, lijn en polygoon vectorlaag.

2. Selecteer de vectorlaag in de legenda en druk op het Labels in de werkbalk Labels van QGIS.

Het labelen van vector puntlagen

Vink eerst het aanvinkvakje Deze laag labelen en selecteer het veld dat je wilt gebruiken voor de inhoud van

de labels via ‘Veld met labels’. Selecteer wanneer je de een expressie wilt gebruiken voor het opbouwen van
de tekst van labels. Daarna kun je de stijl en bij welke schaal het label zichtbaar is instellen in het tabblad Label
opties (zie Figure_labels_1 ). Kies het tabblad Geavanceerd voor de plaatsing van het label en de de prioriteit.
Voor samengestelde objecten kun je hier bepalen of elk deel zijn eigen label krijgt. Met Maak label op rond teken
kun je het afbreekteken instellen waarmee labels omslaan naar de volgende regel. In het tabblad Data-bepaalde
instellingen kun je velden gebruiken voor het instellen voor eigenschappen zoals lettertype, buffer en plaatsing
eigenschappen die bepalen hoe een label opgemaakt.

Figuur 11.15: Smart labeling of vector point layers

Het labelen van vector lijnlagen

Vink eerst het aanvinkvakje Deze laag labelen in het tabblad Label opties en selecteer een attribuutveld voor
de labels. Hier kun je ook de tekst van labels maken op basis van expressies. Daarna kun je de stijl en bij welke
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schaal het label zichtbaar is instellen. Aanvullende labelopties zijn beschikbaar onder het tabblad Geavanceerd
voor de plaatsing van het label, de labelafstand, of het label zich oriënteerd naar de lijn en de prioriteit. Voor
samengestelde objecten kun je hier bepalen of elk lijndeel zijn eigen label krijgt of dat lijnen als samengevoegd
worden beschouwd zodat er niet meerdere labels naast een lijn worden geplaatst. Daarnaast kun je ook symbolen
op de lijnen plaatsen die deze een richting geven (zie Figure_labels_2). Het is ook mogelijk het labelen van delen
te onderdrukken en een regel afbreekteken in te stellen. Gebruik Data-bepaalde instellingen voor het instellen van
labeleigenschappen gebasseerd op veldwaarden.

Figuur 11.16: Smart labeling of vector line layers

Het labelen van polygoon vectorlagen

Vink eerst het aanvinkvakje Deze laag labelen en selecteer het veld die je daarvoor wilt gebruiken. Ook
hiervoor kun je de tekst maken op basis van regelgebasseerde expressies. In het tabblad Label opties bepaal je de
tekststijl en de schaalgebasseerde zichtbaarheid (zie Figure_labels_3 ). Aanvullende labelopties zijn beschikbaar
onder het tabblad Geavanceerd voor de plaatsing van het label, de labelafstand en de prioriteit. Je kunt hier
aangeven of elk deel van samengestelde objecten een eigen label krijgt. Het is ook mogelijk het labelen van delen
te onderdrukken en een regel afbreekteken in te stellen. Gebruik Data-bepaalde instellingen voor het instellen van
labeleigenschappen gebasseerd op veldwaarden.

Figuur 11.17: Smart labeling of vector polygon layers

De instellingen van de ‘engine’ wijzigen

Via de knop [Instellingen ‘engine’] kun je een aantal eigenschappen wijzigen van de ‘Label engine’, het motortje
achter de functionaliteit van het plaatsen van labels. Zo kun je de zoek modus wijzigen die gebruikt wordt om de
juiste plek te vinden waar het label geplaatst moet worden. Beschikbaar zijn de volgende opties: ‘Chain’ (snel),
Popmusic Tabu, Popmusic Chain, Popmusic Tabu Chain en FALP (snelst).

Je kunt daarnaast het aantal kanditaten waarnaar gekeken moet worden voor het plaatsen van labels voor punt,
lijn en polygoon objecten. Wanneer je alle labels getoond wilt zien, ook wanneer deze elkaar overlappen kun
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Figuur 11.18: Dialog to change label engine settings

je instellen via het aanvinkvakje ‘ Alle labels tonen. De optie Toon label-kandidaten (voor debugging) is niet
alleen voor de ontwikkeling van belang geweest, maar geeft de gebruiker ook beter inzicht wat het effect is van
het wijzigen van de engine instellingen op de plaatsing van labels. De kaders van overwogen plaatsen voor het
plaatsen van labels worden daarbij op de kaart getoond.

Gereserveerde woorden voor gebruik in attribuutvelden voor plaatsing van labels

Er is een lijst van ondersteunde gereserveerde woorden die kunnen worden gebruikt bij het plaatsen van labels
middels ‘Data-bepaalde instellingen’.

• Voor horizontale uitlijning: left, center, right

• Voor verticale uitlijning: bottom, base, half, top

• Kleuren kunnen worden gespecificeerd in svg notation, bijvoorbeeld #ff0000

• Gebruik de booleaanse waarden 1 en 0 of de labels Vet, Cursief, Onderstreept, Doorgestreept moeten
worden weergegeven: 1 = ja (waar), 0 = nee (onwaar)

Een combinatie van gereserveerde woorden kan gebruikt worden in 1 veldwaarde bijv.: base right of bottom
left.

11.2.6 Tabblad velden

In het tabblad Velden kun je eigenschappen van de velden van de geselecteerde vectorlaag veranderen. De

knoppen Nieuwe kolom en Verwijder kolom kunnen worden gebruikt wanneer de vectorlaag eerst bewerkbaar

gemaakt wordt. Met de knop Bewerken aan/uitzetten kun je wisselen tussen het al dan niet kunnen bewerken van
een laag.

Eerst konden alleen kolommen in vectorlagen in PostGIS databases worden toegevoegd en verwijderd, maar wan-
neer QGIS is gebouwd met de OGR functiebibliotheek van GDAL versie >= 1.9, dan kan dat voor bijna alle door
OGR ondersteunde formaten.

Wijzig hulpmiddel

In het tabblad Velden vind je in de lijst van velden ook de kolom Wijzig-hulpmiddel. Deze kolom bevat
knoppen waarmee je zelf meer controle kunt krijgen over welke waarden er in een veld kunnen worden opgevoerd
en op welke manier. Wanneer je in een kolom op de knop [Wijzig-hulpmiddel] drukt, start er een dialoog,
waarmee je verschillende hulpmiddelen voor een veld kunt instellen. Dit zijn de volgende:

• Lijn wijzigen: hiermee kun je een regel tekst voor tekstvelden opvoeren of alleen getallen voor numerieke
velden.
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Figuur 11.19: Dialog to select an edit widget for an attribute column

• Classificatie: Toont een keuzelijst met waarden die al gebruikt zijn voor dat veld wanneer je dat veld ook
hebt gebruikt om daarmee de symbologie te classificeren in het tabblad Stijl. Voor elke ‘unieke waarde’ is
het dan mogelijk een andere symbologie te gebruiken.

• Range: Stel een bereik van waarden in die gebruikt mag worden door een minimum en een maximum
waarde in te vullen. Daarnaast kun je ook aangeven of de waarde kan worden ingegeven via een schuifbalk
of via een spinbox/draaischijf, waarmee je de waarde kunt instellen door deze naar een waarde te draaien.

• Unieke waarden: De gebruiker kan alleen al gebruikte waarden kiezen. Daarnaast kan er voor gekozen
worden om de waarde ‘aanpasbaar’ te maken, daarbij kan de gebruiker de waarden beginnen te typen en
zodra er nog maar 1 mogelijk waarde over blijft zal deze automatisch helemaal worden ingevuld. Kies je
niet voor ‘aanpasbaar’ dan krijg je een keuzeveld.

• Bestandsnaam: Hiermee kun je een bestandsnaam invullen door een bestand te selecteren via de bestand-
skiezer.

• Aanwezige waarden: Hiermee kun je in een keuzeveld een Omschrijving kiezen, en daarmee wordt een
daaraan gekoppelde waarde ingevuld. Daarbij moet je dus eerst een gekoppelde lijst van waarden en om-
schrijvingen laden (vanuit een laag of vanuit een csv bestand) of je kunt deze hier opbouwen.

• Enumeratie: Opent een keuzeveld met waarden die gebruikt kunnen worden. Dit wordt momenteel alleen
ondersteund voor de postgres database.

• Niet aanpasbaar: Wanneer deze is ingesteld is het veld niet aanpasbaar en is deze alleen leesbaar.

• Verborgen: Een verborgen veld is niet zichtbaar. De gebruiker kan de inhoud van het veld niet zien.

• Aanvinkvakje: Toont een aanvinkvakje en je kunt zelf invullen welke waarde wordt ingevuld wanneer deze
aangevinkt en een niet aangevinkt is.

• Tekstbewerken: Dit opent een tekstveld waarin je meerdere regels tekst kunt ingeven.

• Kalender: Opent een kalendercomponent waarmee je een datum kunt kiezen die vervolgens wordt ingevuld.
Het veldtype moet een tekstveld zijn.

• Waarde-relatie: Keuzeveld waarde de waarden zijn ingevuld vanuit een gerelateerde tabel. Je kunt hiervoor
een laag, een sleutelveld en het veld met te kiezen waarden instellen.

• UUID Generator: Genereert een veld waarin automatisch een UUID (Universele Unieke IDentifier), een
unieke waarde die automatisch wordt gegenereerd wanneer het veld, door de gebruiker,niet wordt ingevuld.
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11.2.7 Tabblad Algemeen

Het tabblad Algemeen is voor een vectorlaag bijna hetzelfde als voor een rasterlaag. Je kunt hiermee ver-
schillende zaken instellen:

• Wijzig de zichtbare naam van de laag in de legenda

• Stel een veld dat getoond wordt in het resultaatscherm van Objecten Identificeren

• Stel een speciaal formulier in voor een vectorlaag geschreven met Qt Creator, een onderdeel van de QT
ontwikkeltoolbox die je kunt vinden onder http://qt.digia.com/Product/Developer-Tools/, zie ook forms with
qt designer

• Maak een :guilabel: Ruimtelijke Index aan (alleen voor OGR ondersteunde formaten)

• Voeg een Init functie voor deze laag. Hiermee kun je de initialisatie van bestaande toegekende QGIS hulp-
middelen voor velden overschrijven

• De knop [Update Extents] zal de kleinste rechthoek bepalen waarbinnen alle geometriëen van deze laag
passen

• Bekijk of wijzig de ruimtelijke projectie van deze specifieke vectorlaag, met de knop [Geef het CRS]

Daarnaast kun je met het aanvinkvakje Schaalafhankelijk tonen activeren. Voor het lezen van een aantal
gegevensbronnen (via de provider) kun je aanvullende opties opgeven (bijvoorbeeld de te gebruiken encoding,
oftewel de karakterset codering). Met de knop [Query Bouwer] is het mogelijk om een Query op te bouwen
waarmee slechts een deelverzameling van de gegevens uit de gegevensbron gebruikt wordt in QGIS.

Figuur 11.20: General tab in vector layers properties dialog

11.2.8 Tabblad Metadata

Het tabblad Metadata bevat informatie over de laag. Opslagtype, bron, type geometrie het aantal objecten.
Onder het kopje Extents kun je informatie vinden over het kaartbereik oftewel de grenzen van de kaart en onder
het kopje Ruimtelijk Referentie Systeem vind je informatie over welk coördinaten systeem is gebruikt voor deze
laag. Dit is een snelle manier om informatie te vinden over een laag.

Aanvullend kun je laag een titel en een beschrijving geven. Deze informatie zal mee opgeslagen worden in het
QGIS projectbestand en zal ook gebruikt en zichtbaar worden gemaakt door de QGIS-server.
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Figuur 11.21: Metadata tab in vector layers properties dialog

11.2.9 Tabblad Acties

QGIS geeft de mogelijkheid om een actie te starten waarbij gebruik wordt gemaakt van attribuutwaarden.
Je kunt meerdere acties per vectorlaag aanmaken waarmee je bijvoorbeeld een ander programma kunt aanroepen
waarbij attribuutwaarden als argumenten meegeeft.

Figuur 11.22: Overview action dialog with some sample actions

Acties zijn erg handig wanneer je regelmatig een ander programma wilt starten waarbij je waardes meegeeft
van een vectorlaag. Een voorbeeld is een zoekactie op internet waarbij een waarde van een vectorlaag wordt
meegegeven. Acties kunnen onderverdeeld worden in 6 typen die als volgt gebruik kunnen worden:

• Generiek, Mac, Windows en Unix acties starten een extern process (programma),

• Python acties start de uitvoering van python code,

• Generieke en Python acties zijn overal zichtbaar,
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• Mac, Windows en Unix acties zijn alleen zichtbaar onder die specifieke besturingssystemen (bijv. je kunt
drie ‘Bewerk’ acties maken om een bewerkingsprogramma te openen, maar de gebruiker zullen alleen die
‘Bewerk’actie zien voor hun platform).

Er zijn enkele voorbeelden toegevoegd in de dialoog. Je kunt deze laden door te drukken op [Standaard acties
toevoegen]. Een voorbeeld is een zoekactie gebaseerd op een attribuutwaarde. Dit concept is gebruikt in volgende
discussie.

Het definiëren van Acties

Open het Laag Eigenschappen menu voor een vectorlaag en open het tabblad Acties. Bovenin zie je een lijst van
gedefiniëerde actie (leeg) en onderin kun je onder Actie-eigenschappen een nieuwe actie toevoegen. Geef in het
veld ‘Naam’ een beschrijvende naam voor de nieuwe actie. Vul in het veld ‘Actie’ in ieder geval de naam (en
het pad) van het te starten programma en als argumenten één of meerdere namen van velden waarvan de waarden
worden gebruikt door het programma. Wanneer de actie word gestart dan worden de woorden die beginnen met
een % teken gevolgd door een veldnaam vervangen door de waarde van dat veld. De speciale tekens %% zullen
vervangen worden door de waarde van een nog te selecteren veld in de het scherm Identificatieresultaten of in de
Attributentabel (zie using_actions hieronder). Dubbele aanhalingstekens kunnen worden gebruikt om text samen
te voegen tot één enkel mee te geven argument aan een programma, script of opdracht. Dubbele aanhalingstekens
zullen worden genegeerd wanneer vooraf gegaan door een backslash.

Wanneer je een veldnaam gebruikt waarvan de naam een deel vormt van een ander veldnaam (bijv. col1 en
col10) gebruik dan rechte haken om het veldnaam en het % teken (bijv. [\%col10]). Dit voorkomt dat het
veld %col10 wordt gelezen als veld %col1 met daarachter de tekst 0. De rechte haken zullen verwijderd worden
door QGIS wanneer deze vervangen worden door de veldwaarde. Wanneer je echter rechte haken mee wilt geven
gebruik dan een tweede paar haken, bijvoorbeeld: [[\%col10]].

Het venster Identificatieresultaten heeft een (Afgeleid) deel die gegevens bevat die relevant zijn voor die vectorlaag
type. Ook deze afgeleide velden kunnen worden gebruikt in een actie door de van van het afgeleide veld vooraf
te laten gaan door (Derived).. Een punt vectorlaag heeft bijvoorbeeld de afgeleide velden X en Y. Je kunt die
waarde van die velden als volgt gebruiken in een actie met %(Derived).X en %(Derived).Y. De afgeleide
waarden zijn alleen beschikbaar in het venster Identieficatieresultaten niet in het venster van de Attributentabel.

Twee voorbeeld acties worden hier getoond:

• konqueror http://www.google.com/search?q=%nam

• konqueror http://www.google.com/search?q=%%

In het eerste voorbeeld, wordt de web browser konqueror gestart en een URL meegegeven als argument. Er wordt
gegoogled op de waarde van het veld nam van de vectorlaag. Let op dat de applicatie wel gevonden moet kunnen
worden anders moet je het ook het pad meegeven bij het aanroepen van de applicatie. Om er zeker van te zijn dat
deze werkt, kunnen we de actie herschrijven waarbij we het hele pad meegeven, het eerste voorbeeld wordt dan:
/opt/kde3/bin/konqueror http://www.google.com/search?q=\%nam. Dit zal zeker de web
browser applicatie opstarten wanneer deze actie wordt gestart.

Het tweede voorbeeld gebruikt de %% notatie, waarbij we niet uitgaan van een bepaald veld. Wanneer de actie
wordt gestart, zal %% worden vervangen door de waarde van het geselecteerde veld in de Identificatieresultaten
of van de Attributen tabel. Gebruik van Acties

Acties kunnen worden gestart vanuit het venster Identificatie Resultaten of vanuit het venster Attributen Tabel.

Deze kunnen worden geopend door het icoon Objecten Identificeren of Open attributentabel. Om een actie te starten,
selecteer een record en gebruik de rechtermuis om het snelmenu te starten, selecteer daarin de actie. De acties
komen erin voor met de gegeven naam.

Wanneer je een actie start die de %% notatie gebruikt, selecteer dan eerst het veld dat je wilt meegeven als
argument, in het venster Identificatieresultaten of de dialoog Attribuut tabel zodat de waarde van dat veld wordt
meegegeven aan de actie.

Hier volgt nog een voorbeeld dat gegevens uit een vectorlaag met plantensoorten haalt en deze met de lokatie naar
een bestand schrijft via een de bash opdracht en de echo opdracht (deze bash opdracht werkt alleen onder

en misschien ook onder ). De laag heeft velden met de soortnaam soortnaam, de breedtegraad lat en de
lengtegraad long. Hier volgt de gedefinieerde actie:
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bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"

Na het achtereenvolgens selecteren van een aantal objecten (planten) en het aanroepen van de actie ziet de inhoud
van het bestand er ongeveer zo uit:

Acacia mearnsii -34.0800000000 150.0800000000
Acacia mearnsii -34.9000000000 150.1200000000
Acacia mearnsii -35.2200000000 149.9300000000
Acacia mearnsii -32.2700000000 150.4100000000

Als oefening kunnen we een actie maken voor de vectorlaag lakes waarbij we gegevens opzoeken in google.
Eerst moeten we bepalen wat de URL is waarmee we met een zoekterm kunnen zoeken google. Dat doen we door
een simpele zoekopdracht te geven en vervolgens uit de adresregel van de webbrowser de gebruikte URL over te
nemen. We zien dat het formaat van de URL als volgt is: http://google.com/search?q=qgis, waarin in dit geval
qgis de zoekterm is.

1. Eerst moet de laag lakes zijn geladen.

2. Open de dialoog Laag Eigenschappen door in de legenda te dubbelklikken op de vectorlaag of door via de
rechtermuisknop het snelmenu te open en daarin Eigenschappen te selecteren.

3. Open het tabblad Acties.

4. Geef een naam voor de actie bijvoorbeeld Google Search.

5. Voor de actie moeten we de opdracht geven waarmee de webbrowser wordt opgestart. In dit geval gebruiken
we Firefox. Wanneer het programma niet rechtstreeks kan worden opgestart met alleen het programmanaam
dan dient het volledige pad te worden meegegeven.

6. Geef na de naam van de webbrowser de URL toe waarmee we gaan zoeken in Google zonder zoekterm:
http://google.com/search?q=

7. De tekst in het veld Actie ziet er nu als volgt uit: firefox http://google.com/search?q=

8. Selecteer de keuzelijst die de vectorlaag lakes bevat. Deze keuzelijst staat links van de knop [Voer veld
in].

9. Selecteer in de keuzelijst met veldnamen het veld Names van de vectorlaag lakes en klik op de knop
[Voer veld in].

10. Your action text now looks like this: firefox http://google.com/search?q=%NAMES

11. Als laatste selecteer de knop [Voer actie in] waarna de gemaakte actie wordt toegevoegd aan de lijst van
acties.

Hiermee is deze actie aangemaakt en klaar om te gebruiken. De uiteindelijke tekst van de actie ziet er als volgt
uit:

firefox http://google.com/search?q=%NAMES

We kunnen deze actie nu gebruiken. Sluit de dialoog Laag Eigenschappen. Zorg ervoor dat de laag lakes
geselecteerd is in de legenda en start de functie Objecten Identificeren. Na selectie van een meer zie je dat de actie
beschikbaar is in het resultaat:

Wanneer we de actie selecteren, zal deze de webbrowser opstarten met gegeven URL en zoekterm. De zoekterm
zou uitgebreid kunnen worden door aan de actie ‘+’ toe te voegen en nog een veld mee te geven. Voor de gebruikte
laag heeft dat echter weinig zin.

Je kunt meerdere acties definiëren die getoond worden in het scherm Identificatieresultaten.

Je kunt allerlei toepassingen van acties bedenken. Wanneer je de lokaties van foto’s hebt kun je met een actie die
foto’s openen in een viewer applicatie.

We kunnen ook meer geavanceerde akties te maken, door bijvoorbeeld gebruik te maken van Python acties.

Normaal gebruiken we absolute paden wanneer we een actie maken om een bestand met een externe toepassing
te openen, of eventueel relatieve paden. In het tweede geval is het pad relatief ten opzichte van de locatie van de
externe toepassing. Maar wat wanneer we een relatief pad willen gebruiken ten opzichte van de geopende laag
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Figuur 11.23: Select feature and choose action

(een vectorbestand, zoals een shapefile of een spatialite databasebestand)? De volgende code geeft een mogelijke
oplossing:

command = "firefox";
imagerelpath = "images_test/test_image.jpg";
layer = qgis.utils.iface.activeLayer();
import os.path;
layerpath = layer.source() if layer.providerType() == ’ogr’ else \
(qgis.core.QgsDataSourceURI(layer.source()).database() \
if layer.providerType() == ’spatialite’ else None);
path = os.path.dirname(str(layerpath));
image = os.path.join(path,imagerelpath);
import subprocess;
subprocess.Popen( [command, image ] );

het is goed om te weten dat de actie van het type python is en om de variabelen command en imagerelpath te
wijzigen naar gewenste waarden.

Maar wat als we een relatieve pad nodig hebben ten opzichte van het opgeslagen projectbestand? Dat kan met
volgende python code:

command="firefox";
imagerelpath="images/test_image.jpg";
projectpath=qgis.core.QgsProject.instance().fileName();
import os.path; path=os.path.dirname(str(projectpath)) \
if projectpath != ’’ else None;
image=os.path.join(path, imagerelpath);
import subprocess;
subprocess.Popen( [command, image ] );

Het volgende voorbeeld van een Python actie toont hoe je daarmee nieuwe lagen kunt toevoegen aan het project.
Bijvoorbeeld het volgende project zal respectievelijk een vector- en een rasterlaag toevoegen. De namen van de
bestanden die toegevoegd zullen worden evenals de namen die gegeven wordt aan de lagen, zijn afkomstig uit een
geladen vectorbestand, waarop de actie gedefinieerd is, waarbij filename en layname veldnamen zijn die gebruikt
worden door de actie.

qgis.utils.iface.addVectorLayer(’/yourpath/[% "filename" %].shp’,’[% "layername" %]’, ’ogr’)

Om een raster bestand toe te voegen (in dit voorbeeld een tif bestand), wordt dit:

qgis.utils.iface.addRasterLayer(’/yourpath/[% "filename" %].tif’,’[% "layername" %]’)

11.2.10 Het tabblad Koppelingen

Het tabblad Koppelingen geeft de mogelijkheid om vectorlaag uit te breiden met gegevens uit een gegeven-
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stabel door deze te koppelen. Daarvoor moet er wel een sleutelveld bestaan in zowel de vectorlaag als de gegeven-
stabel met overeenkomstige unieke waarden. QGIS ondersteund momenteel niet spatiale tabel formaten die door
OGR worden ondersteund, tekengescheiden tekst tabellen en PostgreSQL (zie figure_joins_1).

Figuur 11.24: Join an attribute table to an existing vector layer

Daarnaast geeft de dialoog Vectorkoppeling toevoegen de mogelijkheid om:

• Koppellaag in virtueel geheugen ‘cachen’

• Attribuutindex aanmaken op het koppelveld

11.2.11 Het tabblad Diagrammen

Met het tabblad Diagrammen kun je diagrammen in je vectorlaag plaatsen (zie figure_diagrams_1).

De huidige implementatie van diagrammen ondersteunt taartpunt- en tekstdiagrammen. Daarbij kan de tekst van
verschillende veldwaarden onder elkaar getoond worden met een circel of een vierkant en verdelers. De groote
van Diagrammen kan overal gelijk zijn of rechtevenredig verschaald worden naar een veldwaarde. Het plaatsen
van diagrammen werkt samen met de nieuwe manier van labels plaatsen, dat wil zeggen wanneer er tijdens het
renderen (tekenen) een diagram en een label op dezelfde plaats zouden komen te staan, dan kan dat automatisch
worden opgelost. Daarnaast kunnen geplaatste diagram later, door de gebruiker, handmatig verplaatst worden.

We zullen een voorbeeld geven waarbij we in de alaska boundary laag een aantal diagrammen met temperatu-
urgegevens plaatsen. Beide te gebruiken vectorlagen zijn onderdeel van de QGIS sample dataset (zie Voorbeeld
Data).

1. Klik eerst het icoon Vectorlaag Toevoegen, ga naar de folder waarin zich de QGIS sample dataset bevindt en
laad de twee shapefiles alaska.shp en climate.shp.

2. Dubbelklik op de laag climate in de kaartlegenda waarna het menu Laag Eigenschappen opent.

3. Selecteer het tabblad Diagrammen, activeer Toon diagrammen en selecteer Tekstdiagram als Diagram type

4. Als Achtergrondkleur kiezen we cyaan en we zetten het Formaat van de tekst met Vast formaat op 18 mm.

5. Selecteer voor Plaatsing RondomPunt.
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Figuur 11.25: Vector properties dialog with diagram tab

6. In het diagram willen we de waarden van de eerste drie kolommen tonen. T_F_JAN, T_F_JUL en
T_F_MEAN. Selecteer eerst T_F_JAN als attribuut en klic op de groene [+] knop, daarna T_F_JUL en
tenslotte T_F_MEAN.

7. Druk nu op de knop [Apply] om de diagrammen te tonen in het kaartbeeld van QGIS.

8. Je kunt nu de wijzigen aanbrengen, zoals het gebruik van andere kleuren voor de verschillende attribu-
utvelden, of door een andere grootte te kiezen. Figure_diagrams_2 geeft een indruk van het resultaat.

9. Selecteer tenslotte [Ok].

Figuur 11.26: Diagram from temperature data overlayed on a map

In het dialoog die geopend wordt via de menuoptie Instellingen → Opties, bevindt zich het tabblad Overlays waar
een algemeen Plaatsingsalgoritme kan worden gekozen. Het algoritme Middelpunt (snelst) is generiek
voor de overige algoritmes maken gebruik van de PAL functiebibliotheek. Deze houdt rekening met het plaatsen
van diagrammen en labels in verschillende lagen. Voor aanvullende informatie zie Diagram Overlay Plugin.
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11.3 Bewerken

QGIS ondersteund verschillende mogelijkheden om OGR, PostGIS en Spatialite vectorlagen te bewerken.

Notitie: Het bewerken van GRASS vectorlagen gaat anders - zie Digitizing and editing a GRASS vector layer for
details.

Tip: Tegelijk Bewerken
Deze versie van QGIS houdt niet bij of er iemand toevallig hetzelfde object bewerkt. De laatste die zijn bewerkte
object opslaat wint.

11.3.1 Het instellen van de Snapping Toleranties en Zoek Radius

Voordat we de hoekpunten gaan bewerken doen we er goed aan eerst de snapping toleranties en de zoek radius in
te stellen zodat het bewerken van vector laag geometrieën beter zal gaan.

Snapping toleranties

De Snapping tolerantie is de afstand die qg gebruikt om te zoeken naar het dichtsbijzijnde hoekpunt en/of
lijnsegment waar een nieuw hoekpunt geplaatst of een bestaand hoekpunt naar verplaatst moet worden. Wanneer
de muiscursor verder dan die afstand van een bestaand hoekpunt bevindt dan zal het hoekpunt daar geplaatst
worden waar de muiscursor zich bevindt. Binnen die afstand zal deze naar een bestaand hoekpunt ‘snappen’! De
instellingen van de snapping tolerantie heeft effect op een aantal bewerkingstools.

1. Een standaard project snapping tolerantie kan worden ingesteld via het menu Instellingen → Opties. Op
de Mac: ga naar QGIS → Preferences..., onder Linux: Bewerken → Opties. In het tabblad Digi-
taliseren kun je bij de standaard snap modus kiezen tussen Naar hoekpunt, Naar segment en Naar hoekpunt
en segment. Je kunt ook een standaard snapping tolerantie en een zoek radius voor vertex bewerkingen
instellen. De toleraties kunnen ingesteld worden op kaarteenheden of in pixels. Het nadeel van het gebruik
van kaarteenheden is dat je dan telkens na in- en uitzoomen de toleranties telkens moet aanpassen. Bij het
gebruik van pixels heb je daar weinig last van. Bij een kaartschaal van 1:10.000 is een Snapping tolerantie
in kaarteenheden van zo’n 100 meter een werkbare instelling (voor de Alaska voorbeeld dataset).

2. Een kaartlaag gebaseerde snapping tolerantie kan worden ingesteld door te kiezen voor Instellingen →
(of Bestand →) ‘Snapping’-opties... om de snapping modus en tolerantie voor elke laag in te stellen (zie
figure_edit_1 ).

Opm: Indien de laaggebasseerde instellingen zijn gebruikt, zullen deze worden gebruikt in plaats van de standaard
instellingen. Wanneer je één laag moet bewerken waarbij de hoekpunten moeten snappen naar de hoekpunten
van een andere laag, activeer dan snapping voor die andere laag en maak de standaard snappingtoleranties een
stuk kleiner. Daarnaast zal snapping niet plaatsvinden naar lagen die niet aanstaan in de snapping opties voor
kaartlagen, ook niet na het instellen van de standaard snapping toleranties. Dus zorg ervoor dat deze lagen waar
je wel naar toe wilt snappen aangevinkt zijn.

Zoekradius

De zoekradius is de afstand die QGIS gebruikt om het dichtsbijzijnde hoekpunt te vinden wanneer je op de kaart
klikt. Wanneer er zich binnen die afstand geen hoekpunt aangetroffen wordt, dan zal er een melding verschijnen
dat er geen hoekpunt gevonden is om te bewerken. Zowel snap tolerantie als zoek radius kunnen in pixels en
kaarteenheden gegeven worden en het vereist wat uitzoekwerk om de goede instellingen te vinden. Wanneer je
een te grote snap tolerantie instelt, dan heb je een grote kans dat deze naar het verkeerde hoekpunt snapt. Wanneer
de zoek radius te klein is zal deze niets vinden om te verplaatsen.
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Figuur 11.27: Edit snapping options on a layer basis

De zoekradius voor het bewerken van hoekpunten in laageenheden kan worden ingesteld in het tabblad :guil-
abel‘Digitaliseren‘ onder Instellingen → Opties. Dezelfde plaats waar je de standaard snapping tolerantie
instelt.

11.3.2 Zoomen en Kaart verschuiven

Voordat je een laag gaat bewerken, moet je inzoomen op het betreffende gebied. Dit voorkomt dat alle hoekpunten
die je kunt bewerken getekend moeten worden voor de hele laag, dat kost meer tijd.

Naast het gebruik van de knoppen Kaart verschuiven en de Inzoomen / Uitzoomen op de werkbalk kun je ook
het muiswieltje, de spatiebalk en de pijltjestoetsen gebruiken.

Zoomen en de kaart verplaatsen met het muiswieltje

Tijdens het digitaliseren kun je met het ingedrukte muiswieltje binnen de kaart, het kaartbeeld verplaatsen. Wan-
neer je het muiswieltje naar je toe rolt zal het kaartbeeld uitzoomen en wanneer je het muiswieltje van je af rolt
inzoomen. De plaats van de muiscursor zal het centrum van het gebied zijn waar je op in of uitzoomt. Je kunt het
gedrag voor het in- en uitzoomen met het muiswieltje aanpassen onder het tabblad Kaart gereedschap onder het
menu Extra → Opties ....

De kaart verplaatsen met de pijltjestoetsen

Tijdens het digitaliseren kun je het kaartbeeld verplaatsen met behulp van de pijltjestoetsen. Plaats de muiscursor
in het kaartbeeld en druk op de rechter- of de linkerpijltjestoets om het kaartbeeld naar het oosten of het westen
te verplaatsen. Met de pijltjestoets omhoog of omlaag kun je het kaartbeeld naar het noorden of naar het zuiden
verplaatsen.

Met ingedrukte spatiebalk, kun je met de muiscursor het kaartbeeld verplaatsen in de richting waar je de muiscur-
sor naar toe beweegt. Met de toetsen PgUp en PgDown van je toetsenbord kun je in- en uitzoomen op de kaart
zonder je digitaliseer sessie te onderbreken.

11.3.3 Topologische bewerkingen

Vanuit het menu Snapping opties kun je ook instellen of er bij bewerkingen rekening moet worden gehouden met
topologische relaties tussen lagen onderling. Deze dialoog kan worden opgestart vanuit het hoofdmenu via Extra

→ Snapping opties .... Hier kun je het aanvinkvakje Topologisch bewerken aanzetten aanvinken en/of je kunt
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voor polygoonlagen de kolom Voorkom kruisingen aanvinken waarmee voorkomen wordt dat polygoonvlakken
elkaar overlappen.

Topologisch bewerken aanzetten

De optie Topologisch bewerken aanzetten is voor het bewerken en onderhouden van polygoon-objecten met
gedeelde grenzen. QGIS herkent gedeelde grenzen tussen vlakken en wanneer je een hoekpunt van een grens
verplaatst, dan zal QGIS ook direct de geometrie van (het) andere vlakobject(en), waar deze grens een onderdeel
van vormt, aanpassen. Wanneer deze optie aanstaat dan zal tijdens het inbrengen van nieuwe polygoonobjecten het
‘overbodig’ overlappende gedeelte van het nieuwe vlak worden verwijderd en de grens exact aansluitend worden
gemaakt. Zorg er bij het opvoeren van het nieuwe vlak er dan wel voor dat het beginpunt en het eindpunt van de
grens waar de overlapping begint gelijk zijn. Op deze manier kun je veel sneller een gedeelde grens opvoeren die
vaak bestaat uit meerdere punten.

Kruisingen voorkomen

De tweede topologische instelling die je kunt instellen is het aanvinkvakje in de kolom Voorkom kruisingen,
waarbij het aanvinkvakje alleen aanwezig is voor polygonen. Wanneer deze aanwezig is en je voert een polygoon
op waarbij de grens zichzelf snijd waardoor er meer dan 1 aaneengesloten vlak ontstaat, dan zal er direkt een
melding volgen die de gebruiker daarop attendeert, maar die het aanmaken van het object niet voorkomt! Staat het
aanvinkvakje ‘Voorkom kruisingen’ niet aangevinkt, dan blijft die melding achterwege. In de praktijk blijkt dat
deze controle er ook voor zorgt dat binnen een bestaande polygoon, voor een laag waar deze controle voor aanstaat,
niet een andere polygoon kan worden opgevoerd die daar geheel binnen valt. In de engelse handleiding staat
bovendien dat de optie Voorkom kruisingen indien aangezet helpt bij het digitaliseren van aansluitende grenzen,
maar het is de optie Topologisch bewerken aanzetten die daarvoor zorgt.

11.3.4 Het digitaliseren van een bestaande kaartlaag

Standaard staan kaartlagen in QGIS, na het laden, op alleen lezen. Dit voorkomt dat je per ongeluk een kaarlaag
gaat wijzigen. Maar je kunt elke kaartlaag wijzigen, tenminste voor kaartlagen waarvoor het wijzigen van kaart-
lagen ondersteund wordt en wanneer je, op bestandsniveau, schrijfrechten hebt voor die bestanden. Het bewerken
van kaartlagen van PostgreSQL/PostGIS wordt het beste ondersteund.

Het bewerken van vectorlagen is verdeeld over twee werkbalken, de werkbalk Digitaliseren en de werk-
balk Geavanceerd Digitaliseren die beschreven wordt in Geavanceerd Digitaliseren. Je kunt beiden werk-
balken aan-/uitzetten onder Instellingen → Werkbalken →. De werkbalk Digitaliseren biedt het volgende:

Icoon Doel Icoon Doel

Bewerken aan/uitzetten Toevoegen Objecten: Punten

Toevoegen Objecten: Lijnen Toevoegen Objecten: Polygonen

Verplaatsen Object Bewerken van Knooppunten

Verwijderen Geselecteerd(e) Object(en) Knippen van Objecten

Kopiëren van Objecten Plakken van Objecten

Wijzigingen opslaan en doorgaan

De functies van de werkbalk ‘Digitaliseren’

Elke sessie waarbij je een kaartlaag gaat bewerken begint met het schrijfbaar maken van de geselecteerde laag met

Bewerken aan/uitzetten. Deze bestaat als menu-optie in het snelmenu, die je opent met de rechtermuisknop
na het selecteren van een laag in de legenda.

Maar je kunt ook het icoon Bewerken aan/uitzetten kiezen van de werkbalk Digitaliseren om met bewerken te
beginnen of te stoppen. Wanneer het bewerken van een laag aanstaat, zullen er markingen verschijnen voor de
hoekpunten en meer knoppen op de werkbalk zullen actief en beschikbaar worden.
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Tip: Regelmatig Opslaan

Vergeet niet om de knop Aanpassingen Opslaan regelmatig te gebruiken. Deze zal ook controleren of je je gegevens
nog kunt schrijven.

Toevoegen van Objecten

Je kunt de knoppen Object toevoegen, Object toevoegen of Object toevoegen van de werkbalk Digitaliseren ge-
bruiken om QGIS te wijzigen naar de modus Dititaliseren waarbij ook de muisaanwijzer veranderd. Welke knop
op de werkbalk aanwezig is, is afhankelijk van de actieve soort vectorlaag.

Voor elk object begin je eerst met het digitaliseren van de geometrie en vervolgens geef je de attribuutwaarden in.
Door met de linkerknop in het kaartbeeld te klikken digitaliseer je een punt voor de nieuwe geometrie.

Voor lijnen en polygonen, voeg je volgende punten toe door met de linkermuis door te klikken in het kaartbeeld.

Voor het laatste punt, klik je ergens in het kaarbeeld met de rechtermuis. Voor Mac moet je bij het ingeven van
het laatste punt de control toets ingedrukt houden.

Vervolgens opent het venster waarmee je de attribuutwaarden voor het nieuwe object kunt inbrengen. Fig-
ure_edit_2 toont het venster voor het inbrengen voor een nieuwe fictieve rivier. In het tabblad Digitaliseren

tab in het menu :guilabel:‘ Opties‘ Extra → Opties, kun je het de aanvinkvakje Geen attribuut-popus na

het aanmaken van elk kaartobject tonen en Laatst ingevoerde attribuutwaarden gebruiken aanzetten.

Figuur 11.28: Enter Attribute Values Dialog after digitizing a new vector feature

Met de werkbalkknop Object(en) verplaatsen kun je bestaande objecten verplaatsen.

Tip: Soorten Attribuutwaarden
Voor shapefiles dient er controle plaats te vinden voor de attribuutwaarden. Het is daarom niet mogelijk om een
tekstwaarde in te vullen voor een numeriekveld in het formuliervenster Attributen.Wanneer dat toch nodig is, dan
kun je dat naderhand alsnog doen in de dialoog Attribuuttabel.

Bewerken van Knooppunten

Voor het bewerken van geometrie kun je werkbalkknop Knooppunt-gereedschap gebruiken, Je kunt hiermee meerdere
knooppunten van een geometrie selecteren en deze verplaatsen, toevoegen of verwijderen. Het Knooppuntgereed-
schap werkt ook wanneer ‘gelijktijdige CRS-transformatie’ geactiveerd is. Daarnaast blijft de selectie na een
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bewerking gewoon nog actief (in tegenstelling tot de meeste andere gereedschap in QGIS waarbij dat niet het
geval is). Wanneer het Knooppunt-gereedschap geen objecten kon vinden, zal deze een waarschuwing tonen.

Het is belangrijk om eerst de Zoekradius voor hoekaanpassingen op een waarde groter dan 0 te zetten (bijvoorbeeld
10) anders kun je geen knooppunt in QGIS selecteren en volgt er een melding. Zet de zoekradius in het tabblad

Digitaliseren van het menu :guilabel‘Opties‘ te openen via Mac Extra → Opties ....

Tip: Knooppunt markeringen
De huidige versie van QGIS ondersteund drie soorten markeerstijlen voor het weergevan van de hoekpunten:
Semi transparante circel, Kruis en Geen. Om de markeerstijl te wijzigen open het tabblad Digitaliseren in het

menu Opties te openen via Extra Options .... Onder het deel Hoekpunten staan de opties Markerstijl en
Markergrootte waarmee je de markeerstijl kun aanpassen.

Standaard bewerkingen

Start met het activeren van het Kooppunten-gereedschap en selecteer een object door hierop te klikken. Rode vierkan-
tjes verschijnen rond elk knooppunt van dit object.

• Selecteren van knooppunten: Je kunt een enkele knooppunt selecteren door er precies op te klikken.
Wanneer je op de lijn klikt die twee knooppunten verbindt, dan worden beide verbonden knooppunten gese-
lecteerd. Wanneer je een vierkant trekt (met ingehouden linkermuisknop) waarbinnen zich meerdere knoop-
punten bevinden, worden deze knooppunten allemaal geselecteerd. Wanneer een knooppunt geselecteerd is
zal de kleur hiervan blauw worden. Je kunt meer knooppunten aan de bestaande selectie toevoegen door

met ingehouden Ctrl toets, voor command toets, knooppunten te selecteren. Wordt met de Ctrl toets
op een reeds geselecteerd knooppunt geklikt dan wordt deze verwijderd uit de selectie.

• Toevoegen van knooppunten: Om een knooppunt toe te voegen kun je dichtbij of op een lijnstuk klikken.
Het nieuwe knooppunt zal overigens altijd toegevoegd worden op de bestaande lijn en niet op de plaats waar
je met de muis hebt geklikt. Het nieuwe knooppunt kun je daarna verplaatsen indien nodig.

• Verwijderen van knooppunten: Je kunt knooppunten verwijderen door deze eerst te selecteren en daarna

op de Delete toets te drukken. Voor fn + Delete toets. Je kunt met het Knooppunten-gereedschap

geen volledig object verwijderen, zodra je dreigt onder het minimaal aantal benodigde punten voor het
type vectorobject komt, dat je aan het bewerken bent (1 voor punt, 2 voor lijn, 3 voor polygoon) zal het

verwijderen niet doorgaan. Om een volledig object te verwijderen gebruik Geselecteerd(e) object(en) verwijderen.

• Verplaatsen van knooppunten Selecteer eerst alle knooppunten die je wilt verplaatsen. Klik op een gese-
lecteerd knooppunt of een lijnstuk en sleep deze naar de plek waar je alle geselecteerde knooppunten naar
toe wilt verplaatsen. Wanneer snapping is geactiveerd zal de hele selectie zich verplaatsen (‘snappen’) naar
het dichtsbijzijnde knooppunt of lijn.

Elke wijziging die gedaan is met het knooppunten-gereedschap kan ongedaan worden gemaakt met Bewerken →
Ongedaan maken. Daarnaast verschijnt er informatie in het scherm over het knooppunt wanneer je de muisaanwi-
jzer even boven een knooppunt houdt.

Knippen, Kopiëren en Plakken van Objecten

Geselecteerde objecten kunnen geknipt, gekopiëerd en geplakt worden tussen vectorlagen in hetzelfde QGIS

project, maar dan moet de doellaag ook eerst bewerkbaar zijn gemaakt met Bewerken aan/uitzetten.

Objecten kunnen ook geplakt worden in externe applicatie als tekst: De objecten worden daarbij gepresenteerd
in CSV formaat (comma gescheiden waarden) waarbij de geometrie waarden zijn opgeslagen in WKT-formaat
(Well-Known Text formaat, een OGC standaard) waarbij geometrie wordt weergeven in tekst.

In deze versie van QGIS kunnen objecten in tekst formaat niet in een laag van QGIS worden geplakt. Wanneer
komt de kopieer en plakfunctionaliteit van pas? Je kunt meerdere lagen tegelijk bewerkbaar zetten en dan in een
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lege laag voor het opslaan van meren alleen die meren plakt, die je eerst hebt geselecteerd in een laag die veel
meren bevat.

Als voorbeeld zullen we enkele lagen van de laag met meren kopiëren naar een nieuwe laag:

1. Laad de laag van waaruit je objecten wilt kopieëren (de bronlaag)

2. Laad of maak de laag aan waar je naartoe wilt kopiëren (de doellaag)

3. Zet het bewerken aan voor de doellaag

4. Maak de bronlaag de actieve laag door deze te selecteren in de legenda

5. Gebruik het selectiegereedschap Eén object selecteren om object(en) te selecteren in de bronlaag

6. Klik op Kaartobjecten kopiëren

7. Maak nu de doellaag de actieve laag door er op te klikken in de legenda

8. Klik op Kaartobjecten Plakken

9. Zet bewerken voor de laag uit en sla de wijzigingen op

Wat gebeurt er wanneer inhoudelijk de attribuutvelden niet overeenkomen? QGIS zal dan alleen die velden
kopiëren die inhoudelijk overeenkomen en de rest negeren. Wanneer je zeker wilt weten dat de attributen en
de geometrie goed overgezet worden, dan moeten de tabellen inhoudelijk overeenkomen.

Tip: Behoud van eigenschappen geplakte objecten
Wanneer de bronlaag en de doellaag dezelfde kaartprojectie hebben zal na het plakken de geometrie goed be-
houden zijn. Echter wanneer de kaartprojectie van de bron- en de doellaag verschillen dan kan het zijn dat de
geometrie niet exact behouden blijft. Dit komt omdat tijdens de reprojectie er kleine afrondingsverschillen zullen
optreden voor het berekenen van de nieuwe coördinaten.

Verwijderen Geselecteerde Objecten

Wanneer we een polygoon willen verwijderen, kunnen we dat doen door eerst de polygoon te selecteren met het

selectiegereedschap Eén object selecteren. Je kunt ook meerdere objecten selecteren. De geselecteerde objecten

kun je verwijderen met Geselecteerd Object(en) Verwijderen.

Met Kaartobjecten knippen van de werkbalk :guilabel‘Digitaliseren‘ kun je ook objecten verwijderen. Daarbij wor-
den niet alleen de objecten uit de laag gehaald maar ook tijdelijk in het geheugen bewaard in he “ruimtelijke
clipboard”.

Tip: Ondersteuning Verwijderen van Objecten
Het verwijderen van objecten uit een ESRI shapefile werkt alleen wanneer QGIS is gebouwd met GDAL versie
1.3.2 of hoger. De huidige versie van QGIS beschikbaar van de download site zijn gebouwd met recentere versies
van GDAL.

Opslaan van Bewerkte Lagen

Wanneer een laag bewerkbaar is, zullen de wijzigingen in het geheugen van QGIS zijn opgeslagen. Deze zijn dan
nog niet opgeslagen op schijf. Wanneer je tijdens het bewerken de wijzigingen tussendoor wilt opslaan gebruik dan

Wijzigingen opslaan. Wanneer je wisselt naar bewerken uitzetten met Bewerken aan-/uitzetten en er zijn wijzigingen
gedaan, dan zal er de vraag komen of je huidige aanpassingen wilt opslaan.
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Wanneer de wijzigingen niet opgeslagen kunnen worden (bijv. geen schijfruimte meer beschikbaar), dan blijven
de wijzigingen nog bewaard in QGIS. Je kunt dan eerst het probleem oplossen (bijv. schijfruimte beschikbaar
maken) en vervolgens alsnog de wijzigingen bewaren.

Tip: Data Integriteit
Het is altijd een goed idee om een backup te maken van je gegevens voordat je begint met het wijzigen ervan.
Alhoewel de ontwikkelaars van QGIS veel aandacht hebben gegeven aan het behouden van de integriteit van de
gegevens, zijn er geen garantie afgegeven.

11.3.5 Geavanceerd Digitaliseren

Icoon Doel Icoon Doel

Ongedaan maken Opnieuw

Versimpel Object Ring Toevoegen

Onderdeel Toevoegen Verwijder Ring

Verwijder Onderdeel Object vervormen

Verspring Curve Kaartobjecten splitsen

Geselecteerde objecten samenvoegen Puntsymbolen Roteren

Attributen van geselecteerde objecten samenvoegen

Tabel Geavanceerd Bewerken: De werkbalk Geavanceerd Digitaliseren voor vectorlagen

Ongedaan maken en Opnieuw

Ongedaan maken en Opnieuw geven de gebruiker de mogelijkheid om bewerkingen op vectorlagen in stappen
ongedaan te maken of nogmaals uit te voeren. Er is ook een panel aanwezig waarmee je een historie krijgt te zien
van alle bewerkingen (zie Figure_edit_3). Dit panel is standaard niet zichtbaar maar je kunt dit zichtbaar maken
door met de rechtermuis op de toolbar klikken en vervolgens de keuze “Ongedaan maken/Opnieuw” te selecteren
waarna deze actief wordt. Dit kan ook via menuopties Beeld → Panelen → Ongedaan maken/Opnieuw.

Figuur 11.29: Redo and Undo digitizing steps

Wanneer Ongedaan maken wordt gebruikt, zal de status van de objecten weer zijn als voor de laatste bewerking.
Wanneer bewerkingen buiten de normale vectorbewerkingen om worden gedaan, bijvoorbeeld vanuit een plugin,
dan kan het zijn dat deze bewerkingen niet uitgevoerd kunnen worden (dat ligt eraan hoe deze bewerkingen
geprogrammeerd zijn).

Met het panel Ongedaan maken/Opnieuw kun je door te klikken op een bewerking in de lijst direct naar de situatie
terugspringen van voor die bewerking.
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Versimpel Object

Met de Versimpel Object tool kun je het aantal punten waaruit de geometrie van een object bestaat terugbrengen,
zolang het object tussentijds niet wijzigt. Selecteer een object, dit zal worden gehighlight door een rood ‘elastiek’
en een schuifschaal wordt getoond. Door de schuif te verplaatsen kun je zien hoe het object zal veranderen
tijdens het verminderen van aantal punten. Wanneer op de knop [OK] wordt gedrukt zal de nieuwe versimpelde
geometrie worden vastgelegd. Wanneer een object niet kan worden versimpeld (bijv. MultiPolygonen), zal een
melding verschijnen.

Ring Toevoegen

Je kunt aan een polygon ‘gaten’ toevoegen gebruik maken van het icoon Ring Toevoegen. Dit betekent dat je
binnen een bestaande polygoon polygonen kunt toevoegen die fungeren als ‘gaten’. Dus de ruimte tussen de
buitenste polygoon en de binnenste polygonen blijft over als polygoon.

Onderdeel Toevoegen

Met onderdeel toevoegen kun je eiland polygonen toevoegen aan een bestaande polygoon. Het nieuwe eiland
polygoon moet buiten de grens van geselecteerde (multi-)polygoon liggen.

Verwijder Ring

Met Ring Verwijderen kun je een binnenste polygoon ‘gat’ verwijderen binnen een bestaande polygoon. Deze
tool werkt alleen met polygoon lagen. Het zal ook niets veranderen wanneer deze wordt gebruikt voor een eiland
polygoon. Deze tool werkt voor polygoon en multi-polygoon objecten. Voordat je de hoekpunten van een ring
selecteert, wijzig de zoekradius voor hoekpuntaanpassingen.

Verwijder Onderdeel

Met Verwijder Onderdeel kun je delen van een multi-geometrie object verwijderen. Je kunt hiermee niet de laatst
overblijvende polygoon verwijderen. Deze tool werkt voor alle multi-geometrie objecten voor punten, lijnen en
polygonen. Voordat je de hoekpunten van een deel selecteert, wijzig de zoekradius voor hoekpuntaanpassingen.

Object vervormen

Je kunt lijn- en polygoonobjecten vervormen gebruik makende van Objecten vervormen. Hiermee kun je een deel
van een lijn of polygoon vervangen door een nieuw lijnstuk van het eerste tot de laatste snijpunt met de oorspronke-
lijke lijn. Bij polygonen leidt dit soms tot ongewenste resultaten. Het is vooral handig om kleinere lijnstukken van
een polygoon aan te passen, en niet om grote wijzigingen uit te voeren. Het is ook niet toegestaan om meerdere
polygoonringen te doorsnijden aangezien dit een invalide polygoon oplevert.

Je kunt, bijvoorbeeld de grens van een polygoon bewerken met deze tool. Klik eerst aan de binnenkant van de
polygoon vlak bij het punt waar de nieuwe grens moet beginnen, steek daar de grens van de polygoon over en
begin dan met het tekenen van de nieuwe grens buiten de huidige grens van de polygoon. Eindig het toevoegen
van nieuwe grenspunten door het laatste punt aan de binnenkant van de huidige grens te plaatsen met de rechter-
muisknop. Op de snijpunten van de nieuwe met de oude grens zullen door deze functie automatisch nieuwe punten
worden toegevoegd. De polygoon kan ook kleiner worden gemaakt door buiten de huidige grens te beginnen en
binnen de huidige polygoongrens de nieuwe grens te tekenen en met de rechtermuisklik het tekenen te stoppen
buiten de huidige grens.
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Notitie: De tool Objecten vervormen kan het startpunt van een polygoon of een gesloten lijn wijzigen. Dus het
punt dat twee keer voorkomt kan een ander punt zijn. Dit zal geen probleem zijn voor de meeste applicaties, maar
hier dient wel rekening mee worden gehouden.

Verspring Curve

Verspring Curve is een nieuwe functie. Je kunt hiermee lijnen en polygonen parallel aan de huidige laten ver-
springen. De functie werkt voor de laag die bewerkt wordt (de geometriëen worden gewijzigd) of van een andere
alleen-lezen laag waar van het geselecteerde object, een nieuwe versprongen lijn, polygoon wordt toegevoegd aan
de laag die bewerkt wordt. De tool is geschikt voor het aanmaken van op afstand lijnen lagen. De afstand wordt
getoond onderin de taakbalk.

Kaartobjecten splitsen

Je kunt objecten opdelen gebruik maken van Kaartobjecten Splitsen. Je kunt een lijn tekenen over het kaartobject
die je wilt splitsen.

Geselecteerde objecten samenvoegen

Met de functie Geselecteerde objecten samenvoegen kun je objecten samenvoegen die aan elkaar grenzen en dezelfde
attribuutwaarden hebben.

Samenvoegen attribuutwaarden van geselecteerde objecten

Met Attributen van Geselecteerde objecten samenvoegen staat het samenvoegen van attribuutwaarden van objecten toe wan-
neer deze een gezamelijke grens hebben maar waarbij alleen de attribuutwaarden worden samengevoegde zonder
de grenzen samen te voegen.

Puntsymbolen Roteren

De tool Puntsybolen Roteren wordt momenteel alleen ondersteund voor de oude symbologie. Hiermee kun je
puntsymbolen in de kaart laten roteren, tenminste wanneer er voor het object een attribuutveld aanwezig is
waarmee je de rotatie kunt vastleggen en eveneens hebt aangegeven dat dit veld gebruikt moet worden voor rotatie
voor deze puntenlaag, via het tabblad Style‘hebt van ‘Laag Eigenschappen. Anders zal deze tool niet geactiveerd
zijn.

Figuur 11.30: Rotate Point Symbols
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Om de rotatie van een puntobject te wijzigen, selecteer een puntobject in de kaart en roteer deze door de linkermuis
in houden. Een rode pijl met de rotatiewaarde zal getoond worden (zie Figure_edit_4). Wanneer je de linkermuis
loslaat, zal de rotatiewaarde worden bijgewerkt in de attributentabel.

Notitie: Wanneer de Ctrl toets wordt ingehouden, zal de rotatie worden uitgevoerd in stappen van 15 graden.

11.3.6 Het aanmaken van een nieuwe Vectorlaag

QGIS ondersteund het aanmaken van nieuwe Shapefile en SpatiaLite vectorlagen. Het aanmaken van nieuwe
GRASS vectorlagen wordt ondersteund binnen de GRASS-plugin. Zie Creating a new GRASS vector layer voor
meer informatie over het aanmaken van GRASS vectorlagen.

Het aanmaken van een nieuwe Shapefile laag

Om een nieuwe Shape vectorlaag te maken om te bewerken, kies Kaartlagen → Nieuw → Nieuw Shape
Laag.... De dialoog Nieuwe Vectorlaag zal worden getoond zoals in Figure_edit_5. Kies het type vectorlaag
(punt, lijn of polygoon) en de CRS (Coördinaten Referentie Systeem).

QGIS ondersteund nog niet het aanmaken van 2.5D objecten (bijvoorbeeld objecten met X,Y en Z coördinaten).

Figuur 11.31: Creating a new Shapefile layer Dialog

Vervolgens dienen de gewenste attribuutvelden toegevoegd door een naam en een type veld te geven en dan de
knop [Toevoegen] te gebruiken. Standaard wordt een ‘id’ kolom toegevoegd maar deze kan worden verwijderd.

Alleen veldtypes Type: real , Type: integer , en Type: string worden ondersteund.
Aanvullend kun je, afhankelijk van gekozen type, ook een veldlengte en de precisie opgeven van het nieuwe
attribuutveld. Wanneer je tevreden bent klik op [OK] waarna je een lokatie en een bestandsnaam kunt geven
voor de nieuwe aan te maken shapefile. QGIS zal automatisch de bestandsnaamextensie .shp toevoegen aan
gegeven bestandsnaam. Wanneer de laag is aangemaakt, zal deze worden toegevoegd aan de kaart en kun je deze
op dezelfde manier bewerken als beschreven in Het digitaliseren van een bestaande kaartlaag.
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Het aanmaken van een nieuwe Spatialite Laag

Voor het aanmaken van een nieuwe Spatialite laag, kies Kaartlagen → Nieuw → Nieuwe Spatialite Laag....
De dialoog Nieuw SpatiaLite Laag wordt geopend zoals getoond in Figure_edit_6.

Figuur 11.32: Creating a New SpatiaLite layer Dialog

De eerste stap is om een bestaande SpatiaLite database te selecteren of om een nieuwe SpatiaLite database aan te

maken. Dit kan gedaan worden met de browse functie aan de rechterkant van het veld database. Geef een

naam voor die nieuwe laag en geef het type laag en de EPSG SRID. Indien gewenst kun je ook het aanvinkvak
Maak een automatisch ophogen primair sleutelveld aan actief maken.

Om de attribuutvelden voor de nieuwe SpatiaLite laag toe te voegen, geef de naam en de attribuuttype en klik op
de knop [Toevoegen aan attributenlijst]. Wanneer tevreden druk dan op [OK]. QGIS zal automatsche de nieuwe
laag toevoegen aan de kaart en je kunt deze bewerken op dezelfde manier als beschreven in Het digitaliseren van
een bestaande kaartlaag.

De DB Manager kan gebruikt worden voor overig beheer van SpatiaLite lagen, zie DB Manager Plugin.

11.3.7 Werken met de Attributen Tabel

De attributentabel toont de objecten van een geselecteerde laag. Elke regel in de tabel representeert één kaartobject
en elke kolom bevat een attribuutwaarde die een stukje informatie bevat over het object. Objecten in de tabel
kunnen worden opgezocht, geselecteerd, verplaatst en zelfs bewerkt.

Om de attributentabel voor een vector laag te openen, maak de laag actief door deze te selecteren in de legenda.
Open de attributentabel via het menu Kaartlagen → ‘|mActionOpenTable| :menuselection:‘Open Attributentabel.
Het is ook mogelijk om door met de rechtermuis op een laag in de legenda te klikken het snelmenu te openen en

hierin Open Attributentabel te kiezen.

Dit zal een nieuw venster openen die de object attributen van de laag toont (figure_attributes_1). Het aantal
objecten en het aantal geselecteerde objecten wordt getoond in de titel van de attributentabel.

Het selecteren van objecten in een attributentabel

Elke geselecteerde regel in de attributen tabel toont de attributen van een geselecteerd object in de laag. Wanneer
het aantal geselecteerde objecten in de kaart veranderd, zal dit direct worden bijgewerkt in de attributentabel. Ook
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Figuur 11.33: Attribute Table for Alaska layer

wanneer in de attributentabel de selectie wijzigt zal de selectie in de kaart worden bijgewerkt.

Regels kunnen worden geselecteerd door te klikken op het regelnummer aan de linkerkant. Meerdere rijen
kunnen worden geselecteerd met de ingehouden Ctrl toets. Een Opvolgende selectie kan worden gemaakt door
de Shift toets in te drukken en een regelnummer aan de linkerkant. Alle regels tussen de regel waarin zich de
cursor bevindt en de aangeklikte regel worden geselecteerd. Het veranderen van de cursor positie door in een
andere cel van de tabel te klikken, zal de selectie niet aanpassen. Het wijzigen van de selectie in het kaartbeeld,
zal niet de cursorpositie in de attributentabel wijzigen.

De tabel kan gesorteerd worden per kolom, door een kolomhoofd te selecteren. Een kleine pijl wijst de sorteer-
volgorde aan (een pijltje omhoog betekent, de waarden zijn oplopend gesorteerd van boven naar beneden, pijltje
omlaag betekent, de waarden zijn aflopend gesorteerd van boven naar beneden).

Voor een simpele zoekactie op attribuutwaarden op één kolom kan het veld Zoek naar gebruikt worden. Se-
lecteer eerst het veld (kolom) waarin gezocht moet worden met de inhoud van het veld zoek naar en selecteer de
knop [Zoek]. De overeenkomstige rijen worden geselecteerd en het aantal zal weergegeven worden in de titel van
de attributentabel. Voor meer complexe zoekopdrachten gebruik de knop [Geavanceerd Zoeken] die de dialoog
Zoekopdrachtbouwer zal openen welke is beschreven in Zoekopdrachtbouwer.

Om alleen de geselecteerde records te tonen, gebruik het aanvinkvak Alleen selectie tonen. Om verder te

zoeken in de reeds geselecteerde records, gebruik het aanvinkvak Alleen in selectie zoeken. Je kunt de

hoofdlettergevoeligheid voor zoekopdrachten aanzetten met aanvinkvak Hoofdlettergevoelig. De andere knop-
pen linksonderin de attributentabel hebben de volgende functies:

• Deselecteer alles ook met Ctrl+U

• Verplaats selectie naar boven ook met Ctrl+T

• Selectie omdraaien ook met Ctrl+S

• Kopieer geselecteerde rijen naar klembord ook met Ctrl+C

• Zoom kaart naar de geselecteerde rijen ook met Ctrl+J

• Verschuif de kaart naar de geselecteerde rijen ook met Ctrl+P

• Bewerken aan/uitzetten om een veldwaarde te bewerken en ook de functies te activeren die hieronder
beschreven wordt. Ook met Ctrl+E

• Geselecteerde objecten verwijderen ook met Ctrl+D
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• Nieuwe kolom voor PostGIS lagen en voor OGR lagen ook met Ctrl+W

• Verwijder kolom voor PostGIS lagen en voor OGR lagen geopende met GDAL driver versie >= 1.9 ook met
Ctrl+L

• Open veldberekening ook met Ctrl+I

Tip: Overslaan WKT geometry

Wanneer je attribuutgegevens in externe programma’s wilt gebruiken (zoals excel) gebruik de knop
Kopieer geselecteerde rijen naar klembord. De gegevens kunnen gekopieerd worden zonder geometrie informatie wanneer

de optie Extra → Opties → tabblad Algemeen Kopieer geometrie in WKT representatie van attributentabel is
gedeactiveerd.

Opslaan van geselecteerde objecten als nieuwe laag

De geselecteerde objecten kunnen worden opgeslagen in alle door OGR ondersteunde vectorformaten en ook
omgezet naar een ander Coordinaten Referentie Systeem (CRS). Open via de rechtermuis het snelmenu van de
laag en selecteer Selectie opslaan als → om vervolgens een naam voor het uitvoerbestand te geven, het gewenste
formaat en de CRS (zie Legenda). Het is ook mogelijk om OGR creatie opties mee te geven in de dialoog.

Werken met niet spatiale tabellen

QGIS staat ook toe om niet spatiale tabellen te openen. Dit betreffen door OGR ondersteunde tabellen,
tekengescheiden tekst en de PostgreSQL provider. De tabellen kunnen worden gebruikt voor mogelijke veld-
waarden of alleen voor het bekijken en bewerken gebruik makende van de tabellenweergave. Wanneer de tabel

wordt geladen kun je dit zien in de legenda. Wanneer deze tabel wordt geopend met de Open Attributentabel kan
deze bewerkt worden als elke ander laag in de attributentabel.

Als een voorbeeld kun je kolommen van een niet spatiale tabel gebruiken om tijdens het digitaliseren de in te
geven waarde voor een veld te beperken tot een set mogelijke attribuutwaarden of een waardenbereik. Voor meer
informatie zie ook Tabblad velden.

11.4 Zoekopdrachtbouwer

De zoekopdrachtbouwer geeft de mogelijkheid om van een tabel een subset te maken gebruik makende van een
soort SQL WHERE opdracht waarbij het resultaat wordt getoond in het hoofdscherm. Het resultaat van de zoekop-
dracht, kan opgeslagen worden als een nieuwe vectorlaag.

11.4.1 Zoekopdracht

Open de dialoog van de attributentabel via het icoon Open Attributentabel van de werkbalk. Klik op de
knop [Geavanceerd Zoeken] om de Zoekopdrachtbouwer te openen. Bijvoorbeeld wanneer je een laag
woonplaatsen met een veld aantal_inwoners hebt kun je de grotere woonplaatsen eruit selecteren door
aantal_inwoners > 100000 in te vullen in het SQL where tekstinvoer gedeelte van de zoekopdracht-
bouwer. Figure_attributes_2 toont een voorbeeld van de zoekopdrachtbouwer met gegevens van een PosGIS laag
met attributen afkomstig van een PostgreSQL database. De onderdelen velden, waarden en operatoren helpen de
gebruiker met het opbouwen van een SQL-achtige zoekopdracht.

Velden bevat een lijst van alle attribuutvelden van de vectorlaag uit de attributentabel. Om een attributenveld toe te
voegen aan de SQL where tekstinvoer gedeelte, dubbelklik op de naam in de lijst van veldnamen. Je kunt normaal
gesproken verschillende velden, waarden en operators gebruiken om een zoekopdracht op te bouwen maar je kunt
deze ook rechtsstreeks in het SQL where tekstinvoer gedeelte intypen.
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Figuur 11.34: Query Builder

Waarden geeft een lijst van de waarden van een attributentabel. Om lijst te verkrijgen van alle mogelijke waarden
van een attribuut, selecteer eerst het attribuut in de lijst Velden en druk vervolgens op de knop [Alles]. Om een
lijst op te bouwen met de 25 eerste unieke waarden van een attribuutveld, selecteer eerst het atribuut in de lijst
Velden en druk vervolgens op de knop [Voorbeeld]. Om een waarde toe te voegen aan het SQL where tekstinvoer
gedeelte, dubbelklik op de waarde in de lijst van waarden.

Operatoren bevat alle operatoren die gebruikt kunnen worden. Om een operator toe te voegen aan het SQL
where tekstinvoer gedeelte druk op de bijbehorende knop. Beschikbaar zijn relationele operatoren ( = , > , ...), de
tekstvergelijkingsoperator (LIKE) en logische operatoren (AND, OR, ...).

De knop [Test] toont een melding met het aantal objecten die het resultaat zullen zijn van gegeven zoekopdracht,
wat erg handig is tijdens het proces van het opbouwen van een zoekopdracht. De knop [Leegmaken] zal de inhoud
van het SQL where invoertekst gedeelte leegmaken. De knop [Opslaan...] en de knop [Laden...] kunnen gebruikt
worden om een de huidige zoekopdracht op te slaan en om deze later weer te laden. Met de knop [OK] worden de
objecten die voldoen aan de zoekopdracht geselecteerd en het venster gesloten. De knop [Cancel] sluit het venster
zonder de huidige selectie te veranderen.

Tip: Wijzigen van de Laag Definitie
Je kunt de laag definitie zelf veranderen door de SQL zoekopdracht te wijzigen zodat er een subset vanuit objecten
wordt geladen. Om dit te doen, open de dialoog Laag Eigenschappen door in de legende te dubbelklikken op de
vectorlaag en dan vervolgens in het tabblad Algemeen met de knop [Query bouwer] de zoekopdrachtbouwer te
starten. Zie Het Vector Eigenschappen Menu voor meer informatie.

11.4.2 Selectie

Met QGIS is het mogelijk om de selectie visueel zichtbaar te maken gebruik makende van een vergelijkbare inter-
face die gebruikt is in Zoekopdrachtbouwer. In hierboven geschreven deel het doel van de zoekopdrachtbouwer
is om alle geselecteerde objecten die voldoen aan de selectiecriteria in de selectiekleur geel weer te geven. De
weergave van de overige objecten wijzigt niet.

Een andere mogelijkheid om een selectie te maken is door met de rechtermuisknop een laag te selecteren en
vervolgens in het snelmenu Query ... te kiezen. Hiermee worden alleen die objecten die voldoen aan de gemaakte
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zoekopdracht getoond in het kaartbeeld. Objecten die niet voldoen aan de zoekopdracht worden niet getoont. Dit
is dezelfde functie die achter de knop [Query bouwer] zit die je kunt vinden in het tabblad Algemeen van de
Dialoog Laag Eigenschappen. Deze werkt voor alle door QGIS ondersteunde vectorformaten.

11.4.3 Opslaan van geselecteerde objecten als een nieuwe laag

De geselecteerde objecten kunnen opgeslagen worden in elk door de OGR driver ondersteund vectorformaat en
ook getransformeerd naar een ander Coördinaten Referentie Systeem (CRS) indien gewenst. Met de rechtermuis
open het snelmenu van de laag en selecteer daarin Selectie opslaan als ... → om een naam, een vectorformaat en
een CRS te kiezen (zie Legenda). Het is ook mogelijk om OGR creatie opties mee te geven via de dialoog.

11.5 Veld berekening

De knop Veld berekening in de attributen tabel geeft de mogelijkheid om berekeningen uit te voeren van bestaanden
attribuutwaarden of gedefinieerde functies, bijvoorbeeld om de lengte of oppervlakte van de geometrie. Het
resultaat kan in een nieuw attribuutveld worden vastgelegd, of het kan gebruikt worden om de waarden in een
bestaand attribuutveld bij te werken.

De vectorlaag moet eerst in de modus bewerken staan voordat het icoon veld berekening geactiveerd is zodat je
deze kunt selecteren (zie .figure_attributes_3_). In de dialoog kun je aangeven of je alleen geselecteerde objecten
wilt bijwerken, of dat een nieuw attribuutveld moet worden aangemaakt waarin de resultaten van de berekening
zullen worden toegevoegd of de berekening gebruikt zal worden om de inhoud van een bestaand attribuutveld te
vernieuwen.

Figuur 11.35: Field Calculator

Wanneer je ervoor kiest een nieuw veld toe te voegen, dient een veldnaam, een veldtype (geheel getal, decimaal
getal of tekst), de totale veldlengte en de precisie te worden gegeven (zie figure_attributes_3). Wanneer je bijvoor-
beeld voor een veldlengte van 10 en een precisie van 3 kiest betekent dit dat je 6 tekens voor de punt, daarna de
punt en daarachter nog 3 tekens voor de precisie.

De Functielijst bevat zowel functies, velden en waarden. Bekijk de help functie in de Help Geselecteerde Functie
(indien aanwezig). In Expressie kun je de expressie van de berekening die je aan het opbouwen bent met behulp
van de Functielijst. Voor de meest gebruikte operatoren zie Operatoren.
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In de Functielijst, klik op Velden en Waarden om alle attribuutvelden van de geselecteerde tabel te doorzoeken.
Dubbelklik op een attribuutveld om deze toe te voegen aan de expressie invoertekst. Om een expressie op te
bouwen kun je ook rechtsstreeks invoeren van het invoertekstvak van expressie. Gebruik de rechtermuisknop om
de waarden van een attribuutveld te tonen, je kunt dan kiezen tussen Laad top 10 unieke waarden en laad alle
unieke waarden. Aan de rechterkant opent vervolgens de lijst van unieke veldwaarden. Om een waarde aan het
tekstvak Expressie toe te voegen, dubbelklik op de naam in de lijst van Veldwaarden.

De groepen Operatoren, Berekening, Conversies, String, Geometrie en Record bieden verschillende functies. In
Operatoren vind je een aantal eenvoudige wiskundige functies. Onder Berekening vind je meer (geometrische)
wiskundige functies. Onder Conversies bevat functies om een datatype om te zetten naar een ander datatype.
Onder de String vind je tekst functies. Onder de Record groep vind je functie om een veld toe te voegen die een
opeenvolgende unieke nummering bevat. Om een functie toe te voegen aan het Expressie tekstvak dubbelklikt
men de functie.

Een kort voorbeeld illustreert het gebruik van veld berekening. We will de lengte van de railroads laag van
de QGIS sample dataset berekenen:

1. Laad de shapefile railroads.shp in QGIS en selecteer Open Attribuut Tabel.

2. Klik op Bewerken aan/uitzetten en open de dialoog Veld berekening met Veld berekening.

3. Selecteer het aanvinkvak Create a new field‘Nieuw veld aanmaken om berekeningen op te slaan in het
nieuwe veld.

4. Voeg lengte toe als resultaatveld, selecteer Decimaal getal (real) als veldtype en geef een
veldlengte op van 10 en een precisie van 3.

5. Klik nu op de functie $length in de Geometry groep om deze toe te voegen als $length in de veld
berekenings expressie tekstinvoer gedeelte en druk op [OK].

6. Je kunt nu de nieuwe kolom lengte in de attributen tabel terugvinden.

De beschikbare functies worden hieronder gegeven.

column name "column name" value of the field column name
’string’ a string value
NULL null value
a IS NULL a has no value
a IS NOT NULL a has a value
a IN (value[,value]) a is below the values listed
a NOT IN (value[,value]) a is not below the values listed
a OR b a or *b* is true
a AND b a and *b* is true
NOT a inverted truth value of a
sqrt(a) square root of a
sin(a) sinus of a
cos(a) cosinus of b
tan(a) tangens of a
asin(a) arcussinus of a
acos(a) arcuscosinus of a
atan(a) arcustangens of a
to int(a) convert string a to integer
to real(a) convert string a to real
to string(a) convert number a to string
lower(a) convert string a to lower case
upper(a) convert string a to upper case
length(a) length of string a
atan2(y,x) arcustangens of y/x using the signs of the two

arguments to determine the quadrant of the result
replace(*a*, replacethis, withthat) replace this with that in string a
regexp_replace(a,this,that) replace the regular expression this with that
substr(*a*,from,len) len characters of string *a* starting from from

(first character index is 1)
a || b concatenate strings a and b
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$rownum number current row
$area area of polygon
$perimeter perimeter of polygon
$length length of line
$id feature id
$x x coordinate of point
$y y coordinate of point
xat(n) X coordinate of the point of an n-th line (indeces

start at 0; negative values refer to the line end)
yat(n) y coordinate of the point of an n-th line (indeces

start at 0; negative values refer to the line end)
a = b a and b are equal
a != b and a <> b a and b are not equal
a >= b a is larger than or equal to b
a <= b a is less than or equal to b
a > b a is larger than b
a < b a is smaller than b
a ~ b a matches the regular expression b
a LIKE b a equals b
a ILIKE b a equals b (without regard to case-sensitive)
a |wedge| b a raised to the power of b
a * b a multiplied by b
a / b a divided by b
a + b a plus b
a - b a minus b
+ a positive sign
- a negative value of a

De Functielijst van Veldberekening met de Help Geselecteerde Functie, Operatoren en Expressie zijn ook

beschikbaar vanuit het tabblad Stijl van de Laag Eigenschappen en de Expressie Gebaseerde Labels via de

in de Labels van de standaard applicatie gebruikmakend van de nieuwe symbologie.
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Werken met Raster data

12.1 Werken met Raster Data

Dit hoofdstuk beschrijft hoe je raster kaartlagen kunt visualiseren en de eigenschappen ervan kunt veranderen.
QGIS gebruikt de GDAL functiebibliotheek om raster data te lezen en weg te schrijven,zoals Arc/Info Binary
Grid, Arc/Info ASCII Grid, GeoTIFF, Erdas Imagine en vele andere. GRASS raster ondersteuning wordt geleverd
door een aparte QGIS data plugin. De raster data kunnen ook als ‘alleen lezen’ in QGIS worden geladen vanuit
zip en gzip archiefbestanden.

Op het moment van schrijven worden meer dan 100 raster formaten ondersteund door de GDAL biblio-
theek (zie GDAL-SOFTWARE-SUITE Literature and Web References). Een volledige lijst is beschikbaar op
http://www.gdal.org/formats_list.html.

Notitie: NB Niet alle formaten uit de lijst werken ook gegarandeerd in QGIS, om verschillende redenen. Som-
mige formaten vereisen bijvoorbeeld externe commerciële bibliotheken; het kan ook zijn dat of de GDAL instal-
latie van het besturingssysteem het formaat dat je wil gebruiken niet ondersteunt. Alleen de uitgebreid geteste
formaten verschijnen in de lijst met bestandsformaten wanneer je een raster in QGIS wil laden. Andere, niet
geteste rasterformaten kunnen worden geladen met het GDAL [Alle bestanden] filter.

Werken met GRASS raster data wordt beschreven in hoofdstuk GRASS GIS Integration.

12.1.1 Wat zijn raster data?

Raster data in GIS bestaan uit cellen die gerangschikt zijn in rijen en kolommen en die objecten op, boven of
onder het aardoppervlak representeren. Alle cellen in het raster hebben dezelfde grootte en de cellen zijn meestal
rechthoekig (in QGIS zijn ze altijd rechthoekig). Typische voorbeelden van raster datasets zijn Remote Sensing
data zoals luchtfoto’s, satellietbeelden en gemodelleerde gegevens zoals een hoogtemodel.

Anders dan bij vector data is een cel in een rasterbestand niet gekoppeld aan een achterliggende tabel met at-
tributen. De geografie van een raster dataset wordt vastgelegd door een pixel resolutie en de X en Y coördinaat
van één van de hoekpunten van de kaartlaag.Deze eigenschappen zorgen ervoor dat QGIS het raster correct op de
kaart kan positioneren.

Om de rasterdata correct af te beelden maakt QGIS gebruik van georeferentie informatie in het rasterbestand zelf
(bijvoorbeeld GeoTiff) of in een bijbehorende ‘world file’.

12.1.2 Raster data laden in QGIS

Raster kaartlagen worden aan de kaart toegevoegd met de Rasterlaag Toevoegen knop of via het menu: Kaartlaag →

Rasterlaag toevoegen. Door ingedrukt houden van de Control of Shift toets en aanklikken van meerdere
bestanden in het dialoogscherm Open een GDAL ondersteunde Raster Databron kunnen meerdere kaartlagen
tegelijk worden toegevoegd.
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Als een raster kaartlaag in de kaart is geladen kun je rechts klikken op de laagnaam het dialoogscherm met
laageigenschappen opvragen, of een kaartlaag-specifieke actie uitvoeren (bijvoorbeeld: naar de kaartlaag zoomen,
verwijderen of hernoemen).

Rechter muisknop menu voor raster kaartlagen

• Zoom naar laagextent

• Zoom naar beste schaal (100%)

• Toon in Overzichtskaart

• Verwijder

• Instellen laag- CRS

• Project CRS van laag overnemen

• Eigenschappen

• Hernoem

• Kopiëer Stijl

• Nieuwe Groep toevoegen

• Alles uitklappen

• Alles inklappen

• Vernieuw volgorde tekenen

12.2 Raster Eigenschappen Dialoog

Om de eigenschappen van een rasterlaag te bekijken en in te stellen, dubbelklik op de naam van een rasterlaag in
de legenda of selecteer de laag en gebruik de rechtermuisknop en kies Eigenschappen van het snelmenu:

Dit zal de dialoog Raster Laag Eigenschappen openen (zie figure_raster_1).

De dialoog bevat verschillende tabbladen:

• Stijl

• Transparantie

• Kleurenkaart

• Algemeen

• Metadata

• Pyramiden

• Histogram

12.2.1 Tabblad Stijl

QGIS kan rasterlagen op twee verschillende manieren renderen (tekenen):

1. Enkelbands - ¨één band van de afbeelding zal in grijswaarden, pseudocolor of freak out worden getekend.

2. Driebands kleur - drie banden van de afbeelding zullen worden getekend waarbij elke band staat voor de
rode, groene of blauwe component die worden gebruikt om een kleurenafbeelding op te bouwen.

Voor beide soorten rendering kan het kleurenpalet geïnverteerd (=omgedraaid) worden door het aanvinkvak
.|checkbox| Inverteer kleurenpalet te activeren.

Enkelbands Renderen
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Figuur 12.1: Raster Layers Properties Dialog

Deze selectie geeft je twee mogelijkheden om uit te kiezen. Als eerste kun je de band kiezen die je wilt gebruiken
voor het renderen (indien de dataset meer dan één band heeft).

De tweede optie geeft een selectie van beschikbare kleurentabellen om mee te renderen.

De volgende instellingen zijn beschikbaar via de uitklaplijst Kleurenpalet

• Grijstinten (standaard)

• Pseudocolor

• Freak Out

• Kleurenkaart

Wanneer de ‘Kleurenkaart’ wordt gekozen van de keuzelijst Kleurenpalet , dan wordt ook het tabblad
Kleurenkaart actief. Voor meer informatie zie Kleurenkaart.

QGIS kan de getoonde data van een rasterlaag beperken tot alleen het tonen van die pixels waarvan de waarden
binnen een gegeven standaard deviatie van het gemiddelde van de laag liggen.

Dit is handig wanneer één of twee cellen abnormaal hoge waarden bevatten in een rastergrid die een negatieve
impact heeft op het renderen van het raster. Deze optie is alleen beschikbaar voor pseudocolor en freak out
afbeeldingen.

Driebands kleur

Deze selectie geeft een groot aantal opties waarmee de weergave van de rasterlaag gewijzigd kan worden. Je kunt
bijvoorbeeld de kleurenband van de standaard RGB-volgorde naar iets anders wijzigen.

Ook is het schalen van kleuren mogelijk.

Tip: Het tonen van een enkelbands of meerbands Raster
Wanneer je een enkele band raster wilt tonen (bijvoorbeeld de Rode) van een multibands afbeelding, zou je denken
dat je de Groene en Blauwe band uitschakeld. Maar dit is niet de goede manier. Om de Rode band te tonen, zet
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het imagetype naar grijstinten en selecteer Rood als de te gebruiken band voor Grijstinten.

Contrastverhoging

Notitie: Wanneer een GRASS raster wordt toegevoegd, zal de optie Contrastverhoging altijd op automatisch
gezet worden op stretch to min max ook al is er gekozen onder de QGIS algemene instellingen gekozen voor een
andere waarde.

12.2.2 Tabblad Transparantie

QGIS heeft de mogelijkheid om elke rasterlaag to tonen met verschillende transparantie percentages. Gebruik
de transparantie schuifschaal om aan te geven in welke mate de onderliggende lagen zichtbaar worden onder de
huidige rasterlaag. Dit komt goed van pas om verschillende rasterlagen over elkaar heen te leggen, bijvoorbeeld
een schaduwrijke reliëfkaart met een geklassificeerde rasterkaart. Dat zal er voor zorgen dat de kaart er meer
driedimensionaal uitziet.

Daarnaast kun je aangeven welke rasterwaarde als geen data behandeld moet worden. Dit kan handmatig

ingegeven worden of via het icoon Waarden gebruiken uit de kaart.

En nog flexibelere manier om de transparantie te regelen kan gedaan worden via Aangepaste transparantie opties.
De transparantie voor elke pixelwaarde kan hier worden ingesteld.

Als voorbeeld willen we de transparantie van het water van het voorbeeld rasterbestand landcover.tif in-
stellen op 20%. Daarvoor zijn de volgende stappen nodig:

1. Laad het rasterbestand landcover.

2. Open de dialoog Eigenschappen door te dubbelklikken op de rasterlaag in de legenda of via het snelmenu
die via de rechtermuisknop in de legenda geopend wordt voor geselecteerde rasterlaag en te kiezen voor
Eigenschappen.

3. Selecteer het tabblad Transparantie

4. Klik op de knop Voeg handmatig waarden toe. En nieuwe regel zal worden toegevoegd aan de Transparantie
pixellijst.

5. Geef de raster waarde (we gebruiken hier 0) en pas daarvan de transparatie aan naar 20 %.

6. Druk op de knop [Apply] en controleer het resultaat van de kaart.

Stappen 4 en 5 kunnen herhaald worden om meer waarden toe te voegen met een aangepaste transparantie.

Het is eenvoudig om een aangepaste transparantie op te zetten, maar dit is aardig wat werk. De knop
Naar bestand exporteren geeft dan ook de mogelijkheid om de Transparantie pixellijst op te slaan naar bestand. Met

de knop van bestand importeren kun de transparantie lijst weer laden en wordt deze toegepast op de huidige raster-
laag.

12.2.3 Kleurenkaart

Het tabblad Kleurenkaart is alleen beschikbaar wanneer je hebt gekozen het raster als enkelbands te renderen
binnen het tabblad Stijl (zie Tabblad Stijl).

Er zijn drie manieren van kleurinterpolatie mogelijk:

1. Discreet

2. Lineair

3. Exact
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De knop [Item toevoegen] voegt een kleur toe aan een kleurentabel. De knop [Item verwijderen] verwijderd een
kleur van een kleurentabel en de knop [Sorteren] sorteert de kleurentabel op basis van de pixelwaarde gegeven
in de kolom Waarde. Door te dubbelklikken op de kolom Waarde kun je ook een specifieke waarde toevoegen.
Door te dubbelklikken op de kolom Kleur opent de dialoog Select Color waarin je een kleur kunt kiezen die van
toepassing is op gegeven waarde.. Daarnaast kun je ook elke kleur een Label geven maar deze waarde zal niet
getoond worden wanneer de tool Objecten Identificeren wordt gebruikt.

De knop Laad kleurenpalet van band , zal proberen om de kleurentabel van de rasterkaart te laden (wanneer die een

band heeft). Je kunt de knoppen Exporteer kleurenpalet naar bestand en Laad kleurenpalet van bestand gebruiken om een
kleurentabel te exporteren en weer in te laden.

Via het menuonderdeel Genereer nieuw kleurenpalet kun je een nieuwe gecategoriseerde kleurtabel aanmaken. Je

hoeft alleen het veld aantal entries in te vullen, druk daarna op de knop Classificeren. Momenteel is er
slecht een keuzemogelijkheid voor het keuzeveld Classificatie modus - gelijk interval

12.2.4 Tabblad Algemeen

Het tabblad Algemeen toont informatie over de geselecteerde rasterlaag, waaronder de bron en de naam waarmee
deze in de legenda wordt weergegeven (wat kan worden aangepast). Dit tabblad toont ook een ‘thumbnail’, een
kleine afbeelding van de laag, het gebruikte legenda symbool en het kleurenpalet.

Daarnaast kunnen schaalafhankelijke zichtbaarheden worden ingesteld in dit tabblad. Vink daarvoor het aan-
vinkvak schaalafhankelijke zichtbaarheid aan en stel het bereik van de schalen waarvoor de data getoond moet
worden op de kaart.

Ook het Coordinaten Referentie Systeem (CRS) wordt hier weergegeven als een PROJ.4-tekst. Deze kan worden
aangepast via de knop [Opgeven...].

12.2.5 Tabblad Metadata

Het tabblad Metadata toont veel informatie over de rasterlaag, inclusief statistieken over elke band in de huidige
rasterlaag. Statistieken worden verzameld wanneer nodig, het is dus best mogelijk dat voor een gegeven laag de
statistieken nog niet zijn verzameld of inmiddels verouderd zijn.

Dit tabblad is hoofdzakelijk ter informatie. Je kunt geen gegevens wijzigen binnen dit tabblad.

12.2.6 Tabblad Pyramiden

Rasterlagen met een hoge resolutie, kunnen het navigeren binnen QGIS langzaam maken. Door het aanmaken
van lagere resolutie kopiëen (pyramiden), kan de performance van QGIS aanzienlijk worden verbeterd aangezien
QGIS de kopie met de meest geschikte resolutie selecteerd voor elk zoom niveau.

Je moet schrijfrechten hebben op de folder waarin de originel rasterdata is opgeslagen om pyramiden te bouwen.

Verschilldende resampling methoden kunnen worden gebruikt om pyramiden te berekenen:

• Gemiddelde

• Nearest Neighbour

Wanneer het aanvinkvak Interne pyramiden aanmaken indien mogelijk is geactiveerd zal QGIS de pyramiden
intern in de rasterdata zelf op te slaan.

Merk op dat het bouwen van pyramiden de originele databestanden kan veranderen en dat interne aangemaakt
pyramiden niet meer verwijderd kunnen worden. Het is dan ook altijd verstandig om van het origineel (zonder
pyramiden) eerst een kopie te maken en te bewaren.
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12.2.7 Tabblad Histogram

Het tabblad Histogram toont de verdeling van de banden of kleuren in de rasterlaag. Deze grafieken worden
automatisch aangemaakt wanneer het tabblad Histogram. Alle bestaande banden worden gezamelijk getoond.
Van het histogram kan een afbeelding worden opgeslagen met de knop mActionFileSave|.

12.3 Rasterberekeningen

Rasterberekeningen, welke men kan vinden in het menu Raster (zie figure_raster_2).is een menu waarmee
berekeningen kan uitvoren met bestaande raster pixel waarden. De resultaten kan men opslaan in een nieuw
raster in een formaat dat wordt ondersteund door GDAL.

Figuur 12.2: Raster Calculator

De lijst Raster banden bevat all geladen rasterlagen die kunnen worden gebruikt. Dubbelklik op de rasterlaag in
de lijst om een raster toe te voegen aan het tekstvak Rasterberekeningen Expressie. Je kunt vervolgens de opera-
toren gebruiken om een berekening expressie op te bouwen of je kunt deze rechtsstreeks typen in het tekstvak.

In het deel Resultaatlaag kun je instellingen geven voor de resulterende rasterlaag. Je kunt voor de grootte van
het te berekenen gebied een rasterlaag of X,Y coördinaten en Rijen en Kolommen gebruiken om de resolutie te
bepalen voor de te schrijven laag. Wanneer de te verwerken laag een andere resolutie heeft, dan zullen de waarden
worden bepaald met het ‘Nearest neigbor’ Algoritme.

Het onderdeel Operatoren bevat alle operatoren die gebruikt kunnen worden. Dubbelklik op een operator om deze
toe te voegen aan het tekstvak Rasterberekening expressie. Zowel wiskundige (+, -, *, ... ) als trigonometrische
functies (sin, cos, tan, ... ) zijn beschikbaar.

Door het aanvinkvak :guilabel:‘Voeg resultaat toe aan project’ zal de resultaatlaag automatisch worden
toegevoegd aan de legenda en kan deze zichtbaar worden gemaakt.

12.3.1 Voorbeelden

Omzetten hoogtewaarden van meter naar voet
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Voor het omzetten van een hoogteraster van meters naar voet kun je de omrekeningsfaktor 3.28 gebruiken. De
expressie is:

elevation@1 * 3.28

Een uitknipmasker gebruiken

Wanneer van een hoogte rasterkaart, dat deel wilt uitknippen dat boven 0 meter hoogte ligt, kunt je de volgende
expressie gebruiken om in één keer een uitknipmasker te maken en het resultaat te schrijven naar een nieuwe
rasterkaart.

(elevation@1 >= 0) * elevation@1

Voor elke pixel met een waarde groter of gelijk aan 0, wordt de waarde 1 anders 0. Daarmee maak je een uitknip-
masker.
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Werken met OGC Data

13.1 Working with OGC Data

QGIS supports WMS and WFS as data sources.

13.1.1 What is OGC Data

The Open Geospatial Consortium (OGC), is an international organization with more than 300 commercial, gov-
ernmental, nonprofit and research organizations worldwide. Its members develop and implement standards for
geospatial content and services, GIS data processing and exchange.

Describing a basic data model for geographic features an increasing number of specifications are developed to
serve specific needs for interoperable location and geospatial technology, including GIS. Further information can
be found under http://www.opengeospatial.org/.

Important OGC specifications are:

• WMS — Web Map Service

• WFS — Web Feature Service

• WCS — Web Coverage Service

• CAT — Web Catalog Service

• SFS — Simple Features for SQL

• GML — Geography Markup Language

OGC services are increasingly being used to exchange geospatial data between different GIS implementations
and data stores. QGIS can now deal with three of the above specifications, being SFS (through support of the
PostgreSQL / PostGIS data provider, see Section PostGIS kaartlagen), WFS and WMS as a client.

13.1.2 WMS Client

Overview of WMS Support

QGIS currently can act as a WMS client that understands WMS 1.1, 1.1.1 and 1.3 servers. It has particularly been
tested against publicly accessible servers such as DEMIS.

WMS servers act upon requests by the client (e.g. QGIS) for a raster map with a given extent, set of layers,
symbolization style, and transparency. The WMS server then consults its local data sources, rasterizes the map,
and sends it back to the client in a raster format. For QGIS this would typically be JPEG or PNG.

WMS is generically a REST (Representational State Transfer) service rather than a fully-blown Web Service. As
such, you can actually take the URLs generated by QGIS and use them in a web browser to retrieve the same
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images that QGIS uses internally. This can be useful for troubleshooting, as there are several brands of WMS
servers in the market and they all have their own interpretation of the WMS standard.

WMS layers can be added quite simply, as long as you know the URL to access the WMS server, you have a
serviceable connection to that server, and the server understands HTTP as the data transport mechanism.

Selecting WMS Servers

The first time you use the WMS feature, there are no servers defined.

Begin by clicking the Add WMS layer button inside the toolbar, or through the Layer → Add WMS Layer... menu.

The dialog Add Layer(s) from a Server for adding layers from the WMS server appears. You can add some servers
to play with by clicking the [Add default servers] button. This will add two WMS demo servers for you to use, the
WMS servers of the DM Solutions Group and Lizardtech. To define a new WMS server in the tab Layers, select
the [New] button. Then enter the parameters to connect to your desired WMS server, as listed in table_OGC_1:

Name A name for this connection. This name will be used in the Server Connections drop-down
box so that you can distinguish it from other WMS Servers.

URL URL of the server providing the data. This must be a resolvable host name; the same
format as you would use to open a telnet connection or ping a host.

Username Username to access a secured WMS-server. This parameter is optional.
Password Password for a basic authenticated WMS-server. This parameter is optional.

Ignore GetMap
URI

Ignore GetMap URI reported in capabilities, use given URI from URL-field above.

Ignore
GetFeatureInfo
URI

Ignore GetFeatureInfo URI reported in capabilities , use given URI from URL-field
above

Table OGC 1: WMS Connection Parameters

If you need to set up a proxy-server to be able to receive WMS-services from the internet, you can add your
proxy-server in the options. Choose menu Settings → Options and click on the tab Network & Proxy. There you

can add your proxy-settings and enable them by setting the Use proxy for web access. Make sure that you

select the correct proxy type from the Proxy type dropdown menu.

Once the new WMS Server connection has been created, it will be preserved for future QGIS sessions.

Tip: On WMS Server URLs
Be sure, when entering in the WMS server URL, that you have the base URL. For example, you shouldn’t have
fragments such as request=GetCapabilities or version=1.0.0 in your URL.

Loading WMS Layers

Once you have successfully filled in your parameters you can select the [Connect] button to retrieve the capabil-
ities of the selected server. This includes the Image encoding, Layers, Layer Styles and Projections. Since this is
a network operation, the speed of the response depends on the quality of your network connection to the WMS
server. While downloading data from the WMS server, the download progress is visualized in the left bottom of
the WMS dialog.

Your screen should now look a bit like figure_OGR_1, which shows the response provided by the DM Solutions
Group WMS server.

Image Encoding

The Image encoding section now lists the formats that are supported by both the client and server. Choose one
depending on your image accuracy requirements.

Tip: Image Encoding
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Figuur 13.1: Dialog for adding a WMS server, showing its available layers

You will typically find that a WMS server offers you the choice of JPEG or PNG image encoding. JPEG is a lossy
compression format, whereas PNG faithfully reproduces the raw raster data.

Use JPEG if you expect the WMS data to be photographic in nature and/or you don’t mind some loss in picture
quality. This trade-off typically reduces by 5 times the data transfer requirement compared to PNG.

Use PNG if you want precise representations of the original data, and you don’t mind the increased data transfer
requirements.

Options

The Options field provides a text field where you can add a Layer name for the WMS-layer. This name will be
presented in the legend after loading the layer.

Below the layer name you can define Tile size, if you want to set tile sizes (eg. 256x256) to split up the WMS
request into multiple requests.

The Feature limit for GetFeatureInfo defines what features from the server to query.

If you select a WMS from the list a field with the default projection, provided by the mapserver, appears. If the
[Change...] button is active, you can click on it and change the default projection of the WMS to another CRS,
provided by the WMS server.

Layer Order

The tab Layer Order lists the selected layers available from the current connected WMS server. You may notice
that some layers are expandable, this means that the layer can be displayed in a choice of image styles.

You can select several layers at once, but only one image style per layer. When several layers are selected, they
will be combined at the WMS Server and transmitted to QGIS in one go.

Tip: WMS Layer Ordering
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WMS layers rendered by a server are overlaid in the order listed in the Layers section, from top to bottom of the
list. If you want to change the overlay order, you can use the tab Layer Order.

Transparency

In this version of QGIS, the Global transparency setting from the Layer Properties is hard-coded to be always on,
where available.

Tip: WMS Layer Transparency
The availability of WMS image transparency depends on the image encoding used: PNG and GIF support trans-
parency, whilst JPEG leaves it unsupported.

Coordinate Reference System

A Coordinate Reference System (CRS) is the OGC terminology for a QGIS Projection.

Each WMS Layer can be presented in multiple CRSs, depending on the capability of the WMS server.

To choose a CRS, select [Change...] and a dialog similar to Figure Projection 3 in Werken met Projecties will
appear. The main difference with the WMS version of the screen is that only those CRSs supported by the WMS
Server will be shown.

Server-Search

Within QGIS you can search for WMS-servers. Figure_OGC_2 shows the tab Server Search with the Add Layer(s)
from a Server dialog.

Figuur 13.2: Dialog for searching WMS servers after some keywords

As you can see it is possible to enter a search-string in the text field and hit the [Search] button. After a short while
the search result will be populated into the list below the text field. Browse the result list and inspect your search
results within the table. To visualize the results, select a table entry, press the [Add selected row to WMS-list]
button and change back to the tab Layers. QGIS automatically has updated your server list and the selected search
result is already enabled in the list of saved WMS-servers in the Layers tab. You only need to request the list of
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layers by clicking the [Connect] button. This option is quite handy when you want to search maps by specific
keywords.

Basically this option is a frontend to the API of http://geopole.org.

Tilesets

When using WMS-C (Cached WMS) Services like http://labs.metacarta.com/wms-c/Basic.py you are able to
browse through the tab Tilesets given by the server. Additional information like tile size, formats and supported
CRS are listed in this table. In combination with this feature you can use the tile scale slider from the View → Tile
scale slider, which gives you the available scales from the tileserver with nice slider docked in.

Using the Identify Tool

Once you have added a WMS server, and if any layer from a WMS server is queryable, you can then use the
Identify tool to select a pixel on the map canvas. A query is made to the WMS server for each selection made. The
results of the query are returned in plain text. The formatting of this text is dependent on the particular WMS
server used. Viewing Properties

Once you have added a WMS server, you can view its properties by right-clicking on it in the legend, and selecting
Properties. Metadata Tab

The tab Metadata displays a wealth of information about the WMS server, generally collected from the Capabil-
ities statement returned from that server. Many definitions can be cleaned by reading the WMS standards (see
OPEN-GEOSPATIAL-CONSORTIUM Literature and Web References), but here are a few handy definitions:

• Server Properties

– WMS Version — The WMS version supported by the server.

– Image Formats — The list of MIME-types the server can respond with when drawing the map.
QGIS supports whatever formats the underlying Qt libraries were built with, which is typically at least
image/png and image/jpeg.

– Identity Formats — The list of MIME-types the server can respond with when you use the Identify
tool. Currently QGIS supports the text-plain type.

• Layer Properties

– Selected — Whether or not this layer was selected when its server was added to this project.

– Visible — Whether or not this layer is selected as visible in the legend. (Not yet used in this version
of QGIS.)

– Can Identify — Whether or not this layer will return any results when the Identify tool is used on it.

– Can be Transparent — Whether or not this layer can be rendered with transparency. This version of
QGIS will always use transparency if this is Yes and the image encoding supports transparency

– Can Zoom In — Whether or not this layer can be zoomed in by the server. This version of QGIS
assumes all WMS layers have this set to Yes. Deficient layers may be rendered strangely.

– Cascade Count — WMS servers can act as a proxy to other WMS servers to get the raster data for a
layer. This entry shows how many times the request for this layer is forwarded to peer WMS servers
for a result.

– Fixed Width, Fixed Height — Whether or not this layer has fixed source pixel dimensions. This
version of QGIS assumes all WMS layers have this set to nothing. Deficient layers may be rendered
strangely.

– WGS 84 Bounding Box — The bounding box of the layer, in WGS 84 coordinates. Some WMS
servers do not set this correctly (e.g. UTM coordinates are used instead). If this is the case, then
the initial view of this layer may be rendered with a very ‘zoomed-out’ appearance by QGIS. The
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WMS webmaster should be informed of this error, which they may know as the WMS XML elements
LatLonBoundingBox, EX_GeographicBoundingBox or the CRS:84 BoundingBox.

– Available in CRS — The projections that this layer can be rendered in by the WMS server. These are
listed in the WMS-native format.

– Available in style — The image styles that this layer can be rendered in by the WMS server.

WMS Client Limitations

Not all possible WMS Client functionality had been included in this version of QGIS. Some of the more notable
exceptions follow.

Editing WMS Layer Settings

Once you’ve completed the Add WMS layer procedure, there is no ability to change the settings. A workaround is
to delete the layer completely and start again.

WMS Servers Requiring Authentication

Currently public accessible and secured WMS-services are supported. The secured WMS-servers can be accessed
by public authentication. You can add the (optional) credentials when you add a WMS-server. See section Select-
ing WMS Servers for details.

Tip: Accessing secured OGC-layers
If you need to access secured layers with other secured methods than basic authentication, you could use InteProxy
as a transparent proxy, which does support several authentication methods. More information can be found at the
InteProxy manual found on the website http://inteproxy.wald.intevation.org.

Tip: QGIS WMS Mapserver
From Version 1.7.0 QGIS has its own implementation of a WMS 1.3.0 Mapserver. Read more about this at chapter
QGIS Server.

13.1.3 WFS and WFS-T Client

In QGIS, a WFS layer behaves pretty much like any other vector layer. You can identify and select features and
view the attribute table. Since QGIS 1.6 editing (WFS-T) is also supported.

In general adding a WFS layer is very similar to the procedure used with WMS. The difference is there are no
default servers defined, so we have to add our own.

Loading a WFS Layer

As an example we use the DM Solutions WFS server and display a layer. The URL is:
http://www2.dmsolutions.ca/cgi-bin/mswfs_gmap

1. Click on the Add WFS Layer tool on the Layers toolbar, the dialog Add WFS Layer from a Server appears

2. Click on [New]

3. Enter ‘DM Solutions’ as name

4. Enter the URL (see above)

5. Click [OK]

6. Choose ‘DM Solutions’ from the Server Connections combobox

7. Click [Connect]

8. Wait for the list of layers to be populated
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9. Select the Parks layer in the list

10. Click [Apply] to add the layer to the map

Note that proxy-settings you have set in your preferences are also recognized.

Figuur 13.3: Adding a WFS layer

You’ll notice the download progress is visualized in the left bottom of the QGIS main window. Once the layer is
loaded, you can identify and select a province or two and view the attribute table.

Only WFS 1.0.0 is supported. At this point there have not been many tests against WFS versions implemented in
other WFS-servers. If you encounter problems with any other WFS-server, please do not hesitate to contact the
development team. Please refer to Section Mailinglijsten for further information about the mailinglists.

Tip: Finding WFS Servers
You can find additional WFS servers by using Google or your favorite search engine. There are a number of lists
with public URLs, some of them maintained and some not.

13.2 QGIS Server

QGIS Server is an open source WMS 1.3 and WFS 1.0.0 implementation which, in addition, implements advanced
cartographic features for thematic mapping. The QGIS Server is a FastCGI/CGI (Common Gateway Interface)
application written in C++ that works together with a webserver (e.g. Apache, Lighttpd). It is funded by the EU
projects Orchestra, Sany and the city of Uster in Switzerland.

It uses QGIS as backend for the GIS logic and for map rendering. Furthermore the Qt library is used for graphics
and for platform independent C++ programming. In contrast to other WMS software, the QGIS Server uses carto-
graphic rules as a configuration language, both for the server configuration and for the user-defined cartographic
rules.

Moreover, the QGIS Server project provides the ‘Publish to Web’ plugin, a plugin for QGIS desktop which exports
the current layers and symbology as a web project for QGIS Server (containing cartographic visualization rules
expressed in SLD).

As QGIS desktop and QGIS Server use the same visualization libraries, the maps that are published on the web
look the same as in desktop GIS. The ‘Publish to Web’ plugin currently supports basic symbolization, with more
complex cartographic visualization rules introduced manually. As the configuration is performed with the SLD
standard and its documented extensions, there is only one standardised language to learn, which greatly simplifies
the complexity of creating maps for the Web.

In one of the following manuals we will provide a sample configuration to set up a QGIS Server. But for now we
recommend to read one of the following URLs to get more information:
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• http://karlinapp.ethz.ch/qgis_wms/

• http://hub.qgis.org/projects/quantum-gis/wiki/QGIS_Server_Tutorial

• http://linfiniti.com/2010/08/qgis-mapserver-a-wms-server-for-the-masses/

13.2.1 Sample installation on Debian Squeeze

At this point we will give a short and simple sample installation howto for Debian Squeeze. Many other OS
provide packages for QGIS Server, too. If you have to build it all from source, please refer to the URLs above.

Apart from qgis and qgis-mapserver you need a webserver, in our case apache2. You can install all pack-
ages with aptitude or apt-get install together with other necessary dependency packages. After installation you
should test, if the webserver and qgis server works as expected. Make sure the apache server is running with
/etc/init.d/apache2 start. Open a web browser and type URL: http://localhost. If apache is
up, you should see the message ‘It works!’.

Now we test the qgis server installation. The qgis_mapserv.fcgi is available at
/usr/lib/cgi-bin/qgis_mapserv.fcgi and provides a standard wms that shows the state boundaries
of Alaska. Add the WMS with the URL http://localhost/cgi-bin/qgis_mapserv.fcgi as
described in Selecting WMS Servers.

Figuur 13.4: Standard WMS with USA boundaries included in the qgis server (KDE)

13.2.2 Creating a WMS/WFS from a QGIS project

To provide a new qgis wms/wfs server we have to create a qgis project file with some data. Here we use the
‘alaska’ shapefile from the qgis_sample_dataset. Define the colors and styles of the layers in QGIS and define the
project CRS, if not already done.

Then open the OWS Server tab in the menu Settings → Project Properties and define the general fields under
‘Service Capabilities’. For WMS Capabilities define ‘Coordinate System Restrictions’ and ‘Advertised Ex-

tend’. Additionally you can enable the checkbox Add WKT geometry to feature into response to make the lay-
ers queryable and add a ‘Maximum width’ and height that can be requested. For WFS Capabilities you only
need to select the layers that you want to provide as WFS. Now save the session in a project file alaska.qgs.
To provide the project as a WMS/WFS, we create a new folder /usr/lib/cgi-bin/project with admin
privileges and add the project file alaska.qgs and a copy of the qgis_mapserv.fcgi file - that’s all.

Now we test our project WMS and WFS, add the WMS and WFS as described in Loading WMS Layers and WFS
and WFS-T Client to QGIS and load the WMS. The URL is:
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Figuur 13.5: Definitions for a qgis project WMS/WFS server (KDE)

http://localhost/cgi-bin/project/qgis_mapserv.fcgi
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Werken met GPS Data

14.1 GPS Plugin

14.1.1 What is GPS?

GPS, the Global Positioning System, is a satellite-based system that allows anyone with a GPS receiver to find
their exact position anywhere in the world. It is used as an aid in navigation, for example in airplanes, in boats and
by hikers. The GPS receiver uses the signals from the satellites to calculate its latitude, longitude and (sometimes)
elevation. Most receivers also have the capability to store locations (known as waypoints), sequences of locations
that make up a planned route and a tracklog or track of the receivers movement over time. Waypoints, routes and
tracks are the three basic feature types in GPS data. QGIS displays waypoints in point layers while routes and
tracks are displayed in linestring layers.

14.1.2 Loading GPS data from a file

There are dozens of different file formats for storing GPS data. The format that QGIS uses is called GPX (GPS
eXchange format), which is a standard interchange format that can contain any number of waypoints, routes and
tracks in the same file.

To load a GPX file you first need to load the plugin. Plugins → Plugin Manager... opens the Plugin Manager

Dialog. Activate the GPS Tools checkbox. When this plugin is loaded two buttons with a small handheld GPS
device will show up in the toolbar:

• Create new GPX Layer

• GPS Tools

For working with GPS data we provide an example GPX file available in the QGIS sample dataset:
qgis_sample_data/gps/national_monuments.gpx. See Section Voorbeeld Data for more informa-
tion about the sample data.

1. Click on the GPS Tools icon and open the Load GPX file tab (see figure_GPS_1).

2. Browse to the folder qgis_sample_data/gps/, select the GPX file national_monuments.gpx
and click [Open].

Use the [Browse...] button to select the GPX file, then use the checkboxes to select the feature types you want
to load from that GPX file. Each feature type will be loaded in a separate layer when you click [OK]. The file
national_monuments.gpx only includes waypoints.

Notitie: GPS units allow to store data in different coordinate systems. When downloading a GPX file (from
your GPS unit or a web site) and then loading it in Quantum GIS, be sure that the data stored in the GPX
file uses WGS84 (latitude/longitude). Quantum GIS expects this and it is the official GPX specification. See
http://www.topografix.com/GPX/1/1/
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Figuur 14.1: The GPS Tools dialog window

14.1.3 GPSBabel

Since QGIS uses GPX files you need a way to convert other GPS file formats to GPX. This can be done for many
formats using the free program GPSBabel, which is available at http://www.gpsbabel.org. This program can also
transfer GPS data between your computer and a GPS device. QGIS uses GPSBabel to do these things, so it is
recommended that you install it. However, if you just want to load GPS data from GPX files you will not need it.
Version 1.2.3 of GPSBabel is known to work with QGIS, but you should be able to use later versions without any
problems.

14.1.4 Importing GPS data

To import GPS data from a file that is not a GPX file, you use the tool Import other file in the GPS Tools dialog.
Here you select the file that you want to import (and the file type), which feature type you want to import from it,
where you want to store the converted GPX file and what the name of the new layer should be. Note that not all
GPS data formats will support all three feature types, so for many formats you will only be able to choose between
one or two types.

14.1.5 Downloading GPS data from a device

QGIS can use GPSBabel to download data from a GPS device directly as new vector layers. For this we use the
Download from GPS tab of the GPS Tools dialog (see Figure_GPS_2). Here, we select the type of GPS device,
the port that it is connected to (or usb if your GPS supports this), the feature type that you want to download, the
GPX file where the data should be stored, and the name of the new layer.

Figuur 14.2: The download tool

The device type you select in the GPS device menu determines how GPSBabel tries to communicate with your
GPS device. If none of the available types work with your GPS device you can create a new type (see section
Defining new device types).
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The port may be a file name or some other name that your operating system uses as a reference to the physical
port in your computer that the GPS device is connected to. It may also be simply usb, for usb enabled GPS units.

• On Linux this is something like /dev/ttyS0 or /dev/ttyS1

• On Windows it is COM1 or COM2.

When you click [OK] the data will be downloaded from the device and appear as a layer in QGIS.

14.1.6 Uploading GPS data to a device

You can also upload data directly from a vector layer in QGIS to a GPS device using the Upload to GPS tab of the
GPS Tools dialog. To do this you simply select the layer that you want to upload (which must be a GPX layer),
your GPS device type, and the port (or usb) that it is connected to. Just as with the download tool you can specify
new device types if your device isn’t in the list.

This tool is very useful in combination with the vector editing capabilities of QGIS. It allows you to load a map,
create waypoints and routes, and then upload them and use them on your GPS device.

14.1.7 Defining new device types

There are lots of different types of GPS devices. The QGIS developers can’t test all of them, so if you have one
that does not work with any of the device types listed in the Download from GPS and Upload to GPS tools you
can define your own device type for it. You do this by using the GPS device editor, which you start by clicking
the [Edit devices] button in the download or the upload tabs.

To define a new device you simply click the [New device] button, enter a name, a download command and an
upload command for your device, and click the [Update device] button. The name will be listed in the device
menus in the upload and download windows, and can be any string. The download command is the command that
is used to download data from the device to a GPX file. This will probably be a GPSBabel command, but you can
use any other command line program that can create a GPX file. QGIS will replace the keywords %type, %in,
and %out when it runs the command.

%type will be replaced by -w if you are downloading waypoints, -r if you are downloading routes and -t if
you are downloading tracks. These are command line options that tell GPSBabel which feature type to download.

%in will be replaced by the port name that you choose in the download window and %out will be replaced
by the name you choose for the GPX file that the downloaded data should be stored in. So if you create a device
type with the download command gpsbabel %type -i garmin -o gpx %in %out (this is actually the
download command for the predefined device type ‘Garmin serial’) and then use it to download waypoints from
port /dev/ttyS0 to the file output.gpx, QGIS will replace the keywords and run the command gpsbabel
-w -i garmin -o gpx /dev/ttyS0 output.gpx.

The upload command is the command that is used to upload data to the device. The same keywords are used, but
%in is now replaced by the name of the GPX file for the layer that is being uploaded, and %out is replaced by
the port name.

You can learn more about GPSBabel and it’s available command line options at http://www.gpsbabel.org.

Once you have created a new device type it will appear in the device lists for the download and upload tools.

14.2 Live GPS tracking

To activate Live GPS tracking in QGIS you need to select Settings → GPS information. You will get a new
docked window on the left side of the canvas.

There are 4 possible screens in this GPS tracking window:

• GPS position coordinates and for manually entering Vertices and Features.
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• GPS signal strength of satellite connections.

• GPS polar screen showing number and polar position of satellites.

• GPS options screen (see figure_gps_options).

With a plugged in GPS receiver (has to be supported by your operating system) a simple click on [Connect] con-
nects the GPS to QGIS. A second click (now on [Disconnect]) disconnects the GPS-receiver from your computer.
For GNU/Linux gpsd support is integrated to support connection to most GPS receivers. Therefore you first have
to configure gpsd properly to connect QGIS to it.

Waarschuwing: If you want to record your position to the canvas you have to create a new vector layer first
and switch it to editable status to be able to record your track.

14.2.1 Position and additional attributes

If the GPS is receiving signals from satellites you will see your position in latitude, longitude and altitude
together with additional attributes.

Figuur 14.3: GPS tracking position and additional attributes

14.2.2 GPS signal strength

Here you can see the signal strenght of the satellites you are receiving signals from.

Figuur 14.4: GPS tracking signal strength
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14.2.3 GPS polar window

If you want to know where in the sky all the connected satellites are, you have to switch to the polar screen.
You can also see the ID numbers of the satellites you are receiving signals from.

Figuur 14.5: GPS tracking polar window

14.2.4 GPS options

In case of connection problems you can switch between:

• Autodetect

• Internal,

• Serial device

• gpsd (selecting Host, Port and Device your GPS is connected to).

A click on [Connect] again initiates the connection to the GPS receiver.

Figuur 14.6: GPS tracking options window

You can activate Automatically save added features when you are in editing mode. Or you can can activate

Automatically add points to the map canvas with a certain width and color.
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Activating Cursor you can use a slider to shrink and grow the position cursor on the
canvas.

Activating Map centering allows to decide in which way the canvas will be updated. This includes ‘always’,
‘when leaving’ if your recorded coordinates start either to move out of canvas or ‘never’ to keep map extent.

Finally you can activate Log file and define a path and a file where log messages about the gps tracking a
logged.

If you want to set a feature manually you have to go back to Position and click on [Add Point] or [Add track
point].
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GRASS GIS Integration

The GRASS plugin provides access to GRASS GIS (see GRASS-PROJECT Literature and Web References)
databases and functionalities. This includes visualization of GRASS raster and vector layers, digitizing vector
layers, editing vector attributes, creating new vector layers and analysing GRASS 2D and 3D data with more than
300 GRASS modules.

In this Section we’ll introduce the plugin functionalities and give some examples on managing and working with
GRASS data. Following main features are provided with the toolbar menu, when you start the GRASS plugin, as
described in section Starting the GRASS plugin :

• Open mapset

• New mapset

• Close mapset

• Add GRASS vector layer

• Add GRASS raster layer

• Create new GRASS vector

• Edit GRASS vector layer

• Open GRASS tools

• Display current GRASS region

• Edit current GRASS region

15.1 Starting the GRASS plugin

To use GRASS functionalities and/or visualize GRASS vector and raster layers in QGIS, you must select and load

the GRASS plugin with the Plugin Manager. Therefore click the menu Plugins → Manage Plugins, select
GRASS and click [OK].

You can now start loading raster and vector layers from an existing GRASS LOCATION (see section Loading
GRASS raster and vector layers). Or you create a new GRASS LOCATION with QGIS (see section Creating
a new GRASS LOCATION) and import some raster and vector data (see Section Importing data into a GRASS
LOCATION) for further analysis with the GRASS Toolbox (see section The GRASS toolbox).
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15.2 Loading GRASS raster and vector layers

With the GRASS plugin, you can load vector or raster layers using the appropriate button on the toolbar menu.
As an example we use the QGIS alaska dataset (see Section Voorbeeld Data). It includes a small sample GRASS
LOCATION with 3 vector layers and 1 raster elevation map.

1. Create a new folder grassdata, download the QGIS alaska dataset qgis_sample_data.zip from
http://download.osgeo.org/qgis/data/ and unzip the file into grassdata.

2. Start QGIS.

3. If not already done in a previous QGIS session, load the GRASS plugin clicking on Plugins → Manage

Plugins and activate GRASS. The GRASS toolbar appears in the QGIS main window.

4. In the GRASS toolbar, click the Open mapset icon to bring up the MAPSET wizard.

5. For Gisdbase browse and select or enter the path to the newly created folder grassdata.

6. You should now be able to select the LOCATION alaska and the MAPSET demo.

7. Click [OK]. Notice that some previously disabled tools in the GRASS toolbar are now enabled.

8. Click on Add GRASS raster layer, choose the map name gtopo30 and click [OK]. The elevation layer will
be visualized.

9. Click on Add GRASS vector layer, choose the map name alaska and click OK. The alaska boundary vector
layer will be overlayed on top of the gtopo30 map. You can now adapt the layer properties as described
in chapter Het Vector Eigenschappen Menu, e.g. change opacity, fill and outline color.

10. Also load the other two vector layers rivers and airports and adapt their properties.

As you see, it is very simple to load GRASS raster and vector layers in QGIS. See following sections for editing
GRASS data and creating a new LOCATION. More sample GRASS LOCATIONs are available at the GRASS
website at http://grass.osgeo.org/download/data.php.

Tip: GRASS Data Loading
If you have problems loading data or QGIS terminates abnormally, check to make sure you have loaded the
GRASS plugin properly as described in section Starting the GRASS plugin.

15.3 GRASS LOCATION and MAPSET

GRASS data are stored in a directory referred to as GISDBASE. This directory often called grassdata, must
be created before you start working with the GRASS plugin in QGIS. Within this directory, the GRASS GIS
data are organized by projects stored in subdirectories called LOCATION. Each LOCATION is defined by its
coordinate system, map projection and geographical boundaries. Each LOCATION can have several MAPSETs
(subdirectories of the LOCATION) that are used to subdivide the project into different topics, subregions, or as
workspaces for individual team members (Neteler & Mitasova 2008 Literature and Web References). In order to
analyze vector and raster layers with GRASS modules, you must import them into a GRASS LOCATION (This
is not strictly true - with the GRASS modules r.external and v.external you can create read-only links
to external GDAL/OGR-supported data sets without importing them. But because this is not the usual way for
beginners to work with GRASS, this functionality will not be described here.).

15.3.1 Creating a new GRASS LOCATION

As an example here is how the sample GRASS LOCATION alaska, which is projected in Albers Equal Area
projection with unit feet was created for the QGIS sample dataset. This sample GRASS LOCATION alaska
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Figuur 15.1: GRASS data in the alaska LOCATION

will be used for all examples and exercises in the following GRASS GIS related chapters. It is useful to download
and install the dataset on your computer Voorbeeld Data).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. Visualize the alaska.shp Shapefile (see Section Het laden van een Shapefile) from the QGIS alaska
dataset Voorbeeld Data.

3. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

4. Select an existing GRASS database (GISDBASE) folder grassdata or create one for the new LOCATION
using a file manager on your computer. Then click [Next].

5. We can use this wizard to create a new MAPSET within an existing LOCATION (see section Adding a new
MAPSET) or to create a new LOCATION altogether. Click on the radio button Create new location (see
figure_grass_location_2).

6. Enter a name for the LOCATION - we used alaska and click [Next].

7. Define the projection by clicking on the radio button Projection to enable the projection list.

8. We are using Albers Equal Area Alaska (feet) projection. Since we happen to know that it is represented
by the EPSG ID 2964, we enter it in the search box. (Note: If you want to repeat this process for another

LOCATION and projection and haven’t memorized the EPSG ID, click on the projector icon in the lower
right-hand corner of the status bar (see Section Werken met Projecties)).

9. In Filter insert 2964 to select the projection.

10. Click [Next].

11. To define the default region, we have to enter the LOCATION bounds in north, south, east, and west direc-
tion. Here we simply click on the button Set current QGIS extent, to apply the extend of the loaded layer
alaska.shp as the GRASS default region extend.

12. Click [Next].

13. We also need to define a MAPSET within our new LOCATION. You can name it whatever you like - we
used demo (When creating a new LOCATION). GRASS automatically creates a special MAPSET called
PERMANENT designed to store the core data for the project, its default spatial extend and coordinate system
definitions (Neteler & Mitasova 2008 Literature and Web References)

14. Check out the summary to make sure it’s correct and click [Finish].
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15. The new LOCATION alaska and two MAPSETs demo and PERMANENT are created. The currently
opened working set is MAPSET demo, as you defined.

16. Notice that some of the tools in the GRASS toolbar that were disabled are now enabled.

Figuur 15.2: Creating a new GRASS LOCATION or a new MAPSET in QGIS

If that seemed like a lot of steps, it’s really not all that bad and a very quick way to create a LOCATION. The
LOCATION alaska is now ready for data import (see section Importing data into a GRASS LOCATION). You
can also use the already existing vector and raster data in the sample GRASS LOCATION alaska included in
the QGIS alaska dataset Voorbeeld Data and move on to Section The GRASS vector data model.

15.3.2 Adding a new MAPSET

A user has only write access to a GRASS MAPSET he created. This means that besides access to his own MAPSET,
each user can read maps in other user’s MAPSETs, but he can modify or remove only the maps in his own MAPSET.

All MAPSETs include a WIND file that stores the current boundary coordinate values and the currently selected
raster resolution (Neteler & Mitasova 2008 Literature and Web References, see Section The GRASS region tool).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

3. Select the GRASS database (GISDBASE) folder grassdata with the LOCATION alaska, where we
want to add a further MAPSET, called test.

4. Click [Next].

5. We can use this wizard to create a new MAPSET within an existing LOCATION or to create a new
LOCATION altogether. Click on the radio button Select location (see figure_grass_location_2) and click
[Next].

6. Enter the name text for the new MAPSET. Below in the wizard you see a list of existing MAPSETs and
its owners.

7. Click [Next], check out the summary to make sure it’s all correct and click [Finish].

15.4 Importing data into a GRASS LOCATION

This Section gives an example how to import raster and vector data into the alaskaGRASS LOCATION provided
by the QGIS alaska dataset. Therefore we use a landcover raster map landcover.img and a vector GML File
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lakes.gml from the QGIS alaska dataset Voorbeeld Data.

1. Start QGIS and make sure the GRASS plugin is loaded.

2. In the GRASS toolbar, click the Open MAPSET icon to bring up the MAPSET wizard.

3. Select as GRASS database the folder grassdata in the QGIS alaska dataset, as LOCATION alaska,
as MAPSET demo and click [OK].

4. Now click the Open GRASS tools icon. The GRASS Toolbox (see section The GRASS toolbox) dialog
appears.

5. To import the raster map landcover.img, click the module r.in.gdal in the Modules Tree tab. This
GRASS module allows to import GDAL supported raster files into a GRASS LOCATION. The module
dialog for r.in.gdal appears.

6. Browse to the folder raster in the QGIS alaska dataset and select the file landcover.img.

7. As raster output name define landcover_grass and click [Run]. In the Output tab you see
the currently running GRASS command r.in.gdal -o input=/path/to/landcover.img
output=landcover_grass.

8. When it says Succesfully finished click [View output]. The landcover_grass raster layer is now
imported into GRASS and will be visualized in the QGIS canvas.

9. To import the vector GML file lakes.gml, click the module v.in.ogr in the Modules Tree tab. This
GRASS module allows to import OGR supported vector files into a GRASS LOCATION. The module dialog
for v.in.ogr appears.

10. Browse to the folder gml in the QGIS alaska dataset and select the file lakes.gml as OGR file.

11. As vector output name define lakes_grass and click [Run]. You don’t have to care about the other
options in this example. In the Output tab you see the currently running GRASS command v.in.ogr -o
dsn=/path/to/lakes.gml output=lakes_grass.

12. When it says Succesfully finished click [View output]. The lakes_grass vector layer is now imported
into GRASS and will be visualized in the QGIS canvas.

15.5 The GRASS vector data model

It is important to understand the GRASS vector data model prior to digitizing.

In general, GRASS uses a topological vector model.

This means that areas are not represented as closed polygons, but by one or more boundaries. A boundary between
two adjacent areas is digitized only once, and it is shared by both areas. Boundaries must be connected and closed
without gaps. An area is identified (and labeled) by the centroid of the area.

Besides boundaries and centroids, a vector map can also contain points and lines. All these geometry elements
can be mixed in one vector and will be represented in different so called ‘layers’ inside one GRASS vector map.
So in GRASS a layer is not a vector or raster map but a level inside a vector layer. This is important to distinguish
carefully (Although it is possible to mix geometry elements, it is unusual and even in GRASS only used in special
cases such as vector network analysis. Normally you should prefere to store different geometry elements in
different layers.).

It is possible to store several ‘layers’ in one vector dataset. For example, fields, forests and lakes can be stored in
one vector. Adjacent forest and lake can share the same boundary, but they have separate attribute tables. It is also
possible to attach attributes to boundaries. For example, the boundary between lake and forest is a road, so it can
have a different attribute table.

The ‘layer’ of the feature is defined by ‘layer’ inside GRASS. ‘Layer’ is the number which defines if there are
more than one layer inside the dataset, e.g. if the geometry is forest or lake. For now, it can be only a number, in
the future GRASS will also support names as fields in the user interface.
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Attributes can be stored inside the GRASS LOCATION as DBase or SQLITE3 or in external database tables, for
example PostgreSQL, MySQL, Oracle, etc.

Attributes in database tables are linked to geometry elements using a ‘category’ value.

‘Category’ (key, ID) is an integer attached to geometry primitives, and it is used as the link to one key column in
the database table.

Tip: Learning the GRASS Vector Model
The best way to learn the GRASS vector model and its capabilities is to download one of the many GRASS
tutorials where the vector model is described more deeply. See http://grass.osgeo.org/gdp/manuals.php for more
information, books and tutorials in several languages.

15.6 Creating a new GRASS vector layer

To create a new GRASS vector layer with the GRASS plugin click the Create new GRASS vector toolbar icon. Enter
a name in the text box and you can start digitizing point, line or polygon geometries, following the procedure
described in Section Digitizing and editing a GRASS vector layer.

In GRASS it is possible to organize all sort of geometry types (point, line and area) in one layer, because GRASS
uses a topological vector model, so you don’t need to select the geometry type when creating a new GRASS vector.
This is different from Shapefile creation with QGIS, because Shapefiles use the Simple Feature vector model (see
Section Het aanmaken van een nieuwe Vectorlaag).

Tip: Creating an attribute table for a new GRASS vector layer
If you want to assign attributes to your digitized geometry features, make sure to create an attribute table with
columns before you start digitizing (see figure_grass_digitizing_5).

15.7 Digitizing and editing a GRASS vector layer

The digitizing tools for GRASS vector layers are accessed using the Edit GRASS vector layer icon on the toolbar.
Make sure you have loaded a GRASS vector and it is the selected layer in the legend before clicking on the edit
tool. Figure figure_grass_digitizing_2 shows the GRASS edit dialog that is displayed when you click on the edit
tool. The tools and settings are discussed in the following sections.

Tip: Digitizing polygons in GRASS
If you want to create a polygon in GRASS, you first digitize the boundary of the polygon, setting the mode to ‘No
category’. Then you add a centroid (label point) into the closed boundary, setting the mode to ‘Next not used’.
The reason is, that a topological vector model links attribute information of a polygon always to the centroid and
not to the boundary.

Toolbar

In figure_grass_digitizing_1 you see the GRASS digitizing toolbar icons provided by the
GRASS plugin. Table table_grass_digitizing_1 explains the available functionalities.

Figuur 15.3: GRASS Digitizing Toolbar
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Icon Tool Purpose

New Point Digitize new point

New Line Digitize new line

New
Boundary

Digitize new boundary (finish by selecting new tool)

New
Centroid

Digitize new centroid (label existing area)

Move vertex Move one vertex of existing line or boundary and identify new position

Add vertex Add a new vertex to existing line

Delete vertex Delete vertex from existing line (confirm selected vertex by another click)

Move
element

Move selected boundary, line, point or centroid and click on new position

Split line Split an existing line to 2 parts

Delete
element

Delete existing boundary, line, point or centroid (confirm selected element by another
click)

Edit
attributes

Edit attributes of selected element (note that one element can represent more features,
see above)

Close Close session and save current status (rebuilds topology afterwards)

Table GRASS Digitizing 1: GRASS Digitizing Tools

Category Tab

The Category tab allows you to define the way in which the category values will be assigned to a new geometry
element.

Figuur 15.4: GRASS Digitizing Category Tab

• Mode: what category value shall be applied to new geometry elements.

– Next not used - apply next not yet used category value to geometry element.

– Manual entry - manually define the category value for the geometry element in the ‘Category’-entry
field.

– No category - Do not apply a category value to the geometry element. This is e.g. used for area
boundaries, because the category values are connected via the centroid.

• Category - A number (ID) is attached to each digitized geometry element. It is used to connect each
geometry element with its attributes.

• Field (layer) - Each geometry element can be connected with several attribute tables using different GRASS
geometry layers. Default layer number is 1.
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Tip: Creating an additional GRASS ‘layer’ with QGIS
If you would like to add more layers to your dataset, just add a new number in the ‘Field (layer)’ entry box and
press return. In the Table tab you can create your new table connected to your new layer.

Settings Tab

The Settings tab allows you to set the snapping in screen pixels. The threshold defines at what distance new points
or line ends are snapped to existing nodes. This helps to prevent gaps or dangles between boundaries. The default
is set to 10 pixels.

Figuur 15.5: GRASS Digitizing Settings Tab

Symbology Tab

The Symbology tab allows you to view and set symbology and color settings for various geometry types and their
topological status (e.g. closed / opened boundary).

Figuur 15.6: GRASS Digitizing Symbolog Tab

Table Tab

The Table tab provides information about the database table for a given ‘layer’. Here you can add new columns to
an existing attribute table, or create a new database table for a new GRASS vector layer (see Section Creating a
new GRASS vector layer).

Tip: GRASS Edit Permissions
You must be the owner of the GRASS MAPSET you want to edit. It is impossible to edit data layers in a MAPSET
that is not yours, even if you have write permissions.
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Figuur 15.7: GRASS Digitizing Table Tab

15.8 The GRASS region tool

The region definition (setting a spatial working window) in GRASS is important for working with raster layers.
Vector analysis is by default not limited to any defined region definitions. But all newly-created rasters will have
the spatial extension and resolution of the currently defined GRASS region, regardless of their original extension
and resolution. The current GRASS region is stored in the $LOCATION/$MAPSET/WIND file, and it defines
north, south, east and west bounds, number of columns and rows, horizontal and vertical spatial resolution.

It is possible to switch on/off the visualization of the GRASS region in the QGIS canvas using the
Display current GRASS region button.

With the Edit current GRASS region icon you can open a dialog to change the current region and the symbology of
the GRASS region rectangle in the QGIS canvas. Type in the new region bounds and resolution and click [OK].
It also allows to select a new region interactively with your mouse on the QGIS canvas. Therefore click with the
left mouse button in the QGIS canvas, open a rectangle, close it using the left mouse button again and click [OK].

The GRASS module g.region provide a lot more parameters to define an appropriate region extend and reso-
lution for your raster analysis. You can use these parameters with the GRASS Toolbox, described in Section The
GRASS toolbox.

15.9 The GRASS toolbox

The Open GRASS Tools box provides GRASS module functionalities to work with data inside a selected GRASS
LOCATION and MAPSET. To use the GRASS toolbox you need to open a LOCATION and MAPSET where you
have write-permission (usually granted, if you created the MAPSET). This is necessary, because new raster or
vector layers created during analysis need to be written to the currently selected LOCATION and MAPSET.

The GRASS Shell inside the GRASS Toolbox provides access to almost all (more than 330) GRASS modules
through a command line interface. To offer a more user friendly working environment, about 200 of the available
GRASS modules and functionalities are also provided by graphical dialogs within the GRASS plugin Toolbox.

15.9.1 Working with GRASS modules

The GRASS Shell inside the GRASS Toolbox provides access to almost all (more than 300) GRASS modules in
a command line interface. To offer a more user friendly working environment, about 200 of the available GRASS
modules and functionalities are also provided by graphical dialogs.

A complete list of GRASS modules available in the graphical Toolbox in QGIS version 1.8.0 is available in the
GRASS wiki ( http://grass.osgeo.org/wiki/GRASS-QGIS_relevant_module_list).
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Figuur 15.8: GRASS Toolbox and Module Tree

It is also possible to customize the GRASS Toolbox content. This procedure is described in Section Customizing
the GRASS Toolbox.

As shown in figure_grass_toolbox_1 , you can look for the appropriate GRASS module using the thematically
grouped Modules Tree or the searchable Modules List tab.

Clicking on a graphical module icon a new tab will be added to the toolbox dialog providing three new sub-tabs
Options, Output and Manual.

Options

The Options tab provides a simplified module dialog where you can usually select a raster or vector layer visualized
in the QGIS canvas and enter further module specific parameters to run the module.

The provided module parameters are often not complete to keep the dialog clear. If you want to use further module
parameters and flags, you need to start the GRASS Shell and run the module in the command line.

A new feature in QGIS 1.8.0 is the support for a show advanced options button below the simplified module dialog
in the Options tab. At the moment it is only added to the module v.in.ascii as an example use, but will probably
be part of more / all modules in the GRASS toolbox in future versions of QGIS. This allows to use the complete
GRASS module options without the need to switch to the GRASS Shell.

Output

The Output tab provides information about the output status of the module. When you click the [Run] button, the
module switches to the Output tab and you see information about the analysis process. If all works well, you will
finally see a Successfully finished message.

Manual

The Manual tab shows the HTML help page of the GRASS module. You can use it to check further module
parameters and flags or to get a deeper knowledge about the purpose of the module. At the end of each module
manual page you see further links to the Main Help index, the Thematic index and the Full index.
These links provide the same information as if you use the module g.manual.

Tip: Display results immediately
If you want to display your calculation results immediately in your map canvas, you can use the ‘View Output’
button at the bottom of the module tab.

15.9.2 GRASS module examples

The following examples will demonstrate the power of some of the GRASS modules.
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Figuur 15.9: GRASS Toolbox Module Options

Figuur 15.10: GRASS Toolbox Module Output
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Figuur 15.11: GRASS Toolbox Module Manual

Creating contour lines

The first example creates a vector contour map from an elevation raster (DEM). Assuming you have the Alaska
LOCATION set up as explained in Section Importing data into a GRASS LOCATION.

• First open the location by clicking the Open mapset button and choosing the Alaska location.

• Now load the gtopo30 elevation raster by clicking Add GRASS raster layer and selecting the gtopo30
raster from the demo location.

• Now open the Toolbox with the Open GRASS tools button.

• In the list of tool categories double click Raster → Surface Management → Generate vector contour lines.

• Now a single click on the tool r.contour will open the tool dialog as explained above Working with GRASS
modules. The gtopo30 raster should appear as the Name of input raster.

• Type into the Increment between Contour levels the value 100. (This will create contour lines at
intervals of 100 meters.)

• Type into the Name for output vector map the name ctour_100.

• Click [Run] to start the process. Wait for several moments until the message Successfully finished
appears in the output window. Then click [View Output] and [close].

Since this is a large region, it will take a while to display. After it finishes rendering, you can open the layer
properties window to change the line color so that the contours appear clearly over the elevation raster, as in Het
Vector Eigenschappen Menu.

Next zoom in to a small mountainous area in the center of Alaska. Zooming in close you will notice that the
contours have sharp corners. GRASS offers the v.generalize tool to slightly alter vector maps while keeping their
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overall shape. The tool uses several different algorithms with different purposes. Some of the algorithms (i.e.
Douglas Peuker and Vertex reduction) simplify the line by removing some of the vertices. The resulting vector
will load faster. This process will be used when you have a highly detailed vector, but you are creating a very
small scale map, so the detail is unnecessary.

Tip: The simplify tool
Note that the QGIS fTools plugin has a Simplify geometries → tool that works just like the GRASS v.generalize
Douglas-Peuker algorithm.

However, the purpose of this example is different. The contour lines created by r.contour have sharp angles
that should be smoothed. Among the v.generalize algorithms there is Chaikens which does just that (also Hermite
splines). Be aware that these algorithms can add additional vertices to the vector, causing it to load even more
slowly.

• Open the GRASS toolbox and double click the categories Vector → Develop map → Generalization, then
click on the v.generalize module to open its options window.

• Check that the ‘ctour_100’ vector appears as the Name of input vector.

• From the list of algorithms choose Chaiken’s. Leave all other options at their default, and scroll down to the
last row to enter in the field Name for output vector map ‘ctour_100_smooth’, and click [Run].

• The process takes several moments. Once Successfully finished appears in the output windows,
click [View output] and then [close].

• You may change the color of the vector to display it clearly on the raster background and to contrast with
the original contour lines. You will notice that the new contour lines have smoother corners than the original
while staying faithful to the original overall shape.

Figuur 15.12: GRASS module v.generalize to smooth a vector map

Tip: Other uses for r.contour
The procedure described above can be used in other equivalent situations. If you have a raster map of precipitation
data, for example, then the same method will be used to create a vector map of isohyetal (constant rainfall) lines.
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Creating a Hillshade 3D effect

Several methods are used to display elevation layers and give a 3D effect to maps. The use of contour lines as
shown above is one popular method often chosen to produce topographic maps. Another way to display a 3D
effect is by hillshading. The hillshade effect is created from a DEM (elevation) raster by first calculating the slope
and aspect of each cell, then simulating the sun’s position in the sky and giving a reflectance value to each cell.
Thus you get sun facing slopes lighted and the slopes facing away from the sun (in shadow) are darkened.

• Begin this example by loading the gtopo30 elevation raster. Start the GRASS toolbox and under the
Raster category double click to open Spatial analysis → Terrain analysis.

• Then click r.shaded.relief to open the module.

• Change the azimuth angle 270 to 315.

• Enter gtopo30_shade for the new hillshade raster, and click [Run].

• When the process completes, add the hillshade raster to the map. You should see it displayed in grayscale.

• To view both the hill shading and the colors of the gtopo30 together shift the hillshade map below the
gtopo30 map in the table of contents, then open the Properties window of gtopo30, switch to the
transparency tab and set its transparency level to about 25%.

You should now have the gtopo30 elevation with its colormap and transparency setting displayed above the
grayscale hillshade map. In order to see the visual effects of the hillshading, turn off the gtopo30_shade map,
then turn it back on.

Using the GRASS shell

The GRASS plugin in QGIS is designed for users who are new to GRASS, and not familiar with all the modules
and options. As such, some modules in the toolbox do not show all the options available, and some modules do
not appear at all. The GRASS shell (or console) gives the user access to those additional GRASS modules that
do not appear in the toolbox tree, and also to some additional options to the modules that are in the toolbox with
the simplest default parameters. This example demonstrates the use of an additional option in the r.shaded.relief
module that was shown above.

Figuur 15.13: The GRASS shell, r.shaded.relief module

The module r.shaded.relief can take a parameter zmult which multiplies the elevation values relative to the X-Y
coordinate units so that the hillshade effect is even more pronounced.

• Load the gtopo30 elevation raster as above, then start the GRASS toolbox and click on the
GRASS shell. In the shell window type the command r.shaded.relief map=gtopo30
shade=gtopo30_shade2 azimuth=315 zmult=3 and press [Enter].
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• After the process finishes shift to the Browse tab and double click on the new gtopo30_shade2 raster to
display in QGIS.

• As explained above, shift the shaded relief raster below the gtopo30 raster in the Table of Contents, then
check transparency of the colored gtopo30 layer. You should see that the 3D effect stands out more strongly
compared to the first shaded relief map.

Figuur 15.14: Displaying shaded relief created with the GRASS module r.shaded.relief

Raster statistics in a vector map

The next example shows how a GRASS module can aggregate raster data and add columns of statistics for each
polygon in a vector map.

• Again using the Alaska data, refer to Importing data into a GRASS LOCATION to import the trees shapefile
from the shapefiles directory into GRASS.

• Now an intermediary step is required: centroids must be added to the imported trees map to make it a
complete GRASS area vector (including both boundaries and centroids).

• From the toolbox choose Vector → Manage features, and open the module v.centroids.

• Enter as the output vector map ‘forest_areas’ and run the module.

• Now load the forest_areas vector and display the types of forests - deciduous, evergreen, mixed -

in different colors: In the layer Properties window, Symbology tab, choose from Legend type
‘Unique value’ and set the Classification field to ‘VEGDESC’. (Refer to the explanation of the symbology
tab :ref:sec_symbology in the vector section).

• Next reopen the GRASS toolbox and open Vector → Vector update by other maps.

• Click on the v.rast.stats module. Enter gtopo30, and forest_areas.

• Only one additional parameter is needed: Enter column prefix elev, and click [run]. This is a computa-
tionally heavy operation which will run for a long time (probably up to two hours).

• Finally open the forest_areas attribute table, and verify that several new columns have been added
including elev_min, elev_max, elev_mean etc. for each forest polygon.
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15.9.3 Working with the GRASS LOCATION browser

Another useful feature inside the GRASS Toolbox is the GRASS LOCATION browser. In figure_grass_module_7
you can see the current working LOCATION with its MAPSETs.

In the left browser windows you can browse through all MAPSETs inside the current LOCATION. The right
browser window shows some meta information for selected raster or vector layers, e.g. resolution, bounding box,
data source, connected attribute table for vector data and a command history.

Figuur 15.15: GRASS LOCATION browser

The toolbar inside the Browser tab offers following tools to manage the selected LOCATION:

• Add selected map to canvas

• Copy selected map

• Rename selected map

• Delete selected map

• Set current region to selected map

• Refresh browser window

The Rename selected map and Delete selected map only work with maps inside your currently selected
MAPSET. All other tools also work with raster and vector layers in another MAPSET.

15.9.4 Customizing the GRASS Toolbox

Nearly all GRASS modules can be added to the GRASS toolbox. A XML interface is provided to parse the pretty
simple XML files which configures the modules appearance and parameters inside the toolbox.

A sample XML file for generating the module v.buffer (v.buffer.qgm) looks like this:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">
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<option key="input" typeoption="type" layeroption="layer" />
<option key="buffer"/>
<option key="output" />

</qgisgrassmodule>

The parser reads this definition and creates a new tab inside the toolbox when you select the module. A more
detailed description for adding new modules, changing the modules group, etc. can be found on the QGIS wiki at
http://hub.qgis.org/projects/quantum-gis/wiki/Adding_New_Tools_to_the_GRASS_Toolbox
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OpenStreetMap

In recent years, the OpenStreetMap project has gained popularity because in many countries no free geodata such
as digital roadmaps are available. The objective of the OSM project is to create a free editable map of the world
from GPS data, aerial photography or from local knowledge. To support this objective, QGIS provides a plugin
that enables its users to work with OSM data.

The OpenStreetMap plugin, a core QGIS plugin, provides the basic functionalities for OSM data manipulation;
this includes data loading, importing, saving, downloading, editing and uploading data back to the OpenStreetMap
server. While implementing the OSM plugin an inspiration was taken from existing OSM data editors. The
purpose was to combine their functionalities to get the best possible result.

The following section gives a brief introduction to principles of the OSM project.

Parts of the following paragraphs are copied from the OpenStreetMap web site at http://www.openstreetmap.org.

16.1 The OpenStreetMap project

OpenStreetMap is a project to create a free editable map of the world. The maps are created using data from
portable GPS devices, aerial photography, other free sources or simply from local knowledge. The project was
started because most maps have legal or technical restrictions on their use, restricting people from using them in
creative, productive, or unexpected ways. Both rendered images and the vector dataset of OSM are available for
download under a Creative Commons Attribution ShareAlike 2.0 license.

OpenStreetMap was inspired by sites such as Wikipedia - the map display (see Figure_OpenStreetMap_1 ) features
a prominent Edit tab and a full revision history is maintained. Registered users can upload GPS track logs and edit
the vector data using the given editing tools.

OSM data primitive is an object class that can be stored via the API in the server. The three supported types of
data are: Node, Way and Relation.

• A node is a latitude/longitude pair of coordinates. It is used as building a block for other features and as a
feature itself (Points Of Interest), if they are tagged as required.

• A way is a list of at least two nodes that describe a linear feature such as a street, or similar. Nodes can be
members of multiple ways.

• A relation is a group of zero or more primitives with associated roles. It is used to specify relationships
between objects, and may also model an abstract object.

Several different logical features in a common map ‘Point Of Interest’, ‘Street’, ‘Tram Line’, ‘Bus Stop’ etc.) are
defined by these primitives. Map features are well-known in the OSM community and are stored as tags, based on
a key and a value. OSM is usually distributed in XML format. XML payload is used for the communication with
the OSM server as well.
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Figuur 16.1: OpenStreetMap data in the web

16.2 QGIS - OSM Connection

The first part of this section describes how OSM data primitives are displayed in QGIS vector layers. As previously
mentioned, OSM data consists of Nodes, Ways and Relations. In QGIS, they are displayed in three different layer
types: Point layer, Line layer and Polygon layer. It is not possible to remove any of these layers and work with the
other ones.

• A Point layer displays all features of type Node that stands alone. That means that only Nodes that are not
included in any Way belongs to the Point layer.

• A Line layer displays those OSM features of type Way that are not closed. That means, none of these Ways
starts and ends with the same Node.

• A Polygon layer displays all Ways that are not included in Line layer.

OpenStreetMap has one more data primitive in addition to the three mentioned above. This is called Relation.
There is purposely no vector layer to display Relations. A Relation defines a connection between any number of
data primitives. After a Point, Line or Polygon is identified on a map, the plugin shows a list of all relations which
the identified feature is part of.

It was challenging to design the connection between OSM data and the standard QGIS editing tools. These tools
are made to edit a single vector layer at a time, no matter of what feature types it displays. This means that if OSM
data are loaded to QGIS through the plugin, you could (theoretically) edit the Point layer, Line layer or Polygon
layer with these standard tools separately.

A Line layer consists of two different types of OSM features, Ways and Nodes. In OSM format, a Way is composed
of Nodes. If you start editing a Line layer and change the shape of some line, your action affects not only the
OSM Way, but also the OSM Nodes that are part of it.

QGIS standard editing tools cannot tell the OSM provider, which members of which line has changed and how.
It can tell only what’s the new geometry of which line, and that’s not enough to propagate changes to the OSM
database correctly. The Line layer does also not know the identifiers of the line members. The same problem
occurs when you try to edit the Polygon layer.
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For this reason, the OSM plugin need its own tools for editing OSM data. While they are used, the OSM layers
can be changed correctly. The Plugin editing tools consists of tools for Point, Line, Polygon and Relation creation,
deletion and moving.

Notitie: To create a connection between the OSM plugin and standard editing tools, changes in QuantumGIS
core code would be necessary.

16.3 Installation

The OpenStreetMap plugin is a core plugin inside QGIS. The ‘OpenStreetMap’ plugin can be selected in the
Plugin Manager as described in section Loading a QGIS Core Plugin.

16.4 Basic user interface

The first time the OSM plugin is started (and after the first data are loaded), several new OSM plugin icons appear
in the QGIS toolbar menu together with new dock windows as shown in figure_OpenStreetMap_2.

Figuur 16.2: OSM plugin user interface

16.4.1 OSM Features widget

The OSM Feature widget helps to identify OSM features. It shows basic information on the feature type and
identifier as well as information on who has changed a feature, and when. The OSM Feature widget also provides
all editing tools (in the top part of it). More information on those tools can be found in the sections below. The
widget is initially disabled. It activates itself after successful loading some OSM data.

16.4.2 OSM Undo/Redo widget

This Undo/Redo widget is used to undo and redo edit actions. It consists not only a classic Undo and Redo button,
but also shows a list with a brief description of the edit actions that were done. The OSM Undo/Redo widget is
initially closed. You can show it using a button on the OSM Feature widget.
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16.4.3 Toolbar menu icons

Load OSM from file is used to load data from a special OpenStreetMap XML file.

Show/Hide OSM Feature Manager is used to show or hide the OSM Feature widget. The OSM Feature widget is a panel
that helps with OSM feature identification and with OSM data editing.

Download OSM data is used to download data from the OpenStreetMap server.

Upload OSM data is used to upload changes (on current data).

Import data from a layer is used to import data from a vector layer. At least one vector layer must be loaded and
current OSM data must be selected.

Save OSM to file is used to save OSM data back to an XML file.

More detailed information on all the widgets, buttons and dialogs can be found in appropriate sections of this
plugin section according to their functionality (editing, identification, etc.).

16.5 Loading OSM data

The first action that should be done after starting the OSM Plugin is opening data from an OSM file. OSM data
can be import as shapefile or downloaded directly from the OpenStreetMap server. Here we are focusing on the
first mentioned method.

To load data from a file use the Load OSM from file icon. If there is no such button, maybe someone disabled
OpenStreetMap toolbar in your QGIS installation. You can enable it again selecting Settings → Toolbars →
OpenStreetMap.

Figuur 16.3: Load OSM data dialog

The purpose of its elements is explained below.

OpenStreetMap file to load: Click on the button to select the file:.osm file you want to load data from.

Add columns for tags: This option determines a connection between OSM and QGIS data. Each feature of OSM
data has some tags (pairs of key and value), that define the feature properties. Each feature of a QGIS vector layer
also has its attributes (key and value). With this option you can define which properties of OSM objects should be
visible when displaying detailed information about QGIS features.
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Replace current data: Checking this option means that new data should replace current data the user is working
with. Layers of current data will be removed and new ones will be loaded. When loading OSM data for the first
time, this option is not active, because there is nothing to replace.

Use custom renderer: This option determines how many details of the map will be used. There are three pre-
defined OSM styles for map displaying. Use ‘Small scale’ if you want to view OSM data at low level, to see all
details and to edit something. If not you can use ‘Medium scale’ or ‘Large scale’. QGIS 1.8.0 doesn’t support
changing the renderer style dynamically.

Click [OK] to load your data. If this is the first time the OSM file is loaded, the plugin must first parse the database.
This may take few seconds or minutes - it depends on the amount of loaded data.

16.6 Viewing OSM data

After the OSM data are loaded, you can identify map features using the appropriate tool. Use the Identify feature

button on the top-left of the OSM Feature widget. Using this tool you can easily explore all map objects. When
the mouse cursor is placed over an object, you can see all information on it directly in the OSM Feature widget.
There is also a dynamic rubberband displayed on the map so that the user is able to determine which feature is
currently identified.

The Properties tab of the widget contains of all feature tags. Clicking on the Relation tab shows you a list of all
relations connected with identified feature.

If you want to hold a feature for a while to be able to read its properties and relations, move the mouse cursor at the
same time, try left-clicking while you are over the feature. Identification process will stop until next left-clicking.

Sometimes there is more than one feature at a point where left-clicking was performed. This happens especially
when clicking on cross-roads or if you did not zoom enough into the map. In this situation only one of such
features is identified (and marked with the rubberband) but the plugin remembers all of them. Then (still in the
pause mode) you can cycle through the identified features by right-clicking.

16.7 Editing basic OSM data

‘Basic data’ in this context means non-relational OSM features - nodes and ways. If you prefer to examine how
to perform relational editing, skip this section and move on to the next one.

Basic data editing is a key part of the OSM Plugin. You can change the property, position or shape of any existing
basic feature. You can remove features or add new ones. All changes on nodes and ways are remembered by
Undo/Redo all changes can be easily uploaded to the OpenStreetMap server.

16.7.1 Changing feature tags

Changing the property/tag of an OSM feature can be done directly in the table of feature tags. The Tags table of
basic features can be found on the OSM Feature widget. Don’t forget to identify feature first.

If you want to change a tag value, just double-click in the appropriate row of column ‘Value’ and type, or select a

new value. If you want to remove a tag, click in the relevant row, then use the button Remove selected tags on the
right bottom under the table.

To add new tags just type the key and value into the last row of the table where ‘<next tag value>’ is written.
Notice that you cannot change the key of an existing tag pair. Conveniently, there are some combo boxes of all
existing tag keys and their typical values.
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Figuur 16.4: Changing an OSM feature tag

16.7.2 Point creation

For point creation there is a Create point button on the OSM Feature widget. To create some points, just click on
the button and start clicking on the map. If your cursor is over some map feature, the feature is marked/identified
immediately. If you click on the map when a line or polygon is marked, a new point is created directly on such
line or polygon as its new member. If your cursor is over an existing point, a new point cannot be created. In such
case the OSM plugin will show following message:

Figuur 16.5: OSM point creation message

The mechanism of helping a user to hit the line or polygon is called snapping and is enabled by default. If you
want to create a point very close to some line (but not on it) you must disable snapping by holding the Ctrl key
first.

16.7.3 Line creation

For line creation, there is a Create Line button on the OSM Feature widget. To create a line just click the button
and start left-clicking on the map. Each of your left-clicks is remembered as a vertex of the new line. Line creation
ends when the first right-click is performed. The new line will immediately appear on the map.

Notitie: A Line with less than two members cannot be created. In such case the operation is ignored.
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Snapping is performed to all map vertices - points from the Point vector layer and all Line and Polygon members.
Snapping can be disabled by holding the Ctrl key.

16.7.4 Polygon creation

For polygon creation there is a Create polygon button on the OSM Feature widget. To create a polygon just click
the button and start left-clicking on the map. Each of your left-clicks is remembered as a member vertex of the
new polygon. The Polygon creation ends when first right-click is performed. The new polygon will immediately
appear on the map. Polygon with less than three members cannot be created. In such case operation is ignored.
Snapping is performed to all map vertexes - points (from Point vector layer) and all Line and Polygon members.
Snapping can be disabled by holding the Ctrl key.

16.7.5 Map feature moving

If you want to move a feature (no matter what type) please use the Move feature button from the OSM Feature
widget menu. Then you can browse the map (features are identified dynamically when you go over them) and
click on the feature you want to move. If a wrong feature is selected after your click, don’t move it from the place.
Repeat right-clicking until the correct feature is identified. When selection is done and you move the cursor, you
are no more able to change your decision what to move. To confirm the move, click on the left mouse button. To
cancel a move, click another mouse button.

If you are moving a feature that is connected to another features, these connections won’t be damaged. Other
features will just adapt themselves to a new position of a moved feature.

Snapping is also supported in this operation, this means:

• When moving a standalone (not part of any line/polygon) point,snapping to all map segments and vertices
is performed.

• When moving a point that is a member of some lines/polygons,snapping to all map segments and vertices
is performed, except for vertices of point parents.

• When moving a line/polygon, snapping to all map vertices is performed. Note that the OSM Plugin tries
to snap only to the 3 closest-to-cursor vertices of a moved line/polygon, otherwise the operation would by
very slow. Snapping can be disabled by holding Ctrl key during the operation.

16.7.6 Map feature removing

If you want to remove a feature, you must identify it first. To remove an identified feature, use the
Remove this feature button on the OSM Feature widget. When removing a line/polygon, the line/polygon itself is
deleted, so are all its member points that doesn’t belong to any other line/polygon.

When removing a point that is member of some lines/polygons, the point is deleted and the geometries of parent
lines/polygons are changed. The new parent geometry has less vertices than the old one.

If the parent feature was a polygon with three vertexes, its new geometry has only two vertexes. And because
there cannot exist polygon with only two vertices, as described above, the feature type is automatically changed
to Line.

If the parent feature was a line with two vertexes, its new geometry has only one vertex. And because there cannot
exist a line with only one vertex, the feature type is automatically changed to Point.

16.8 Editing relations

Thanks to existence of OSM relations we can join OSM features into groups and give them common properties -
in such way we can model any possible map object: borders of a region (as group of ways and points), routes of a
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bus, etc. Each member of a relation has its specific role. There is a pretty good support for OSM Relations in our
plugin. Let’s see how to examine, create, update or remove them.

16.8.1 Examining relation

If you want to see relation properties, first identify one of its members. After that open the Relations tab on the
OSM Feature widget. At the top of the tab you can see a list of all relations the identified feature is part of. Please
choose the one you want to examine and look at its information below. In the first table called ‘Relation tags’ you
find the properties of the selected relation. In the table called ‘Relation members’ you see brief information on the
relation members. If you click on a member, the plugin will make a rubberband on it in the map.

16.8.2 Relation creation

There are 2 ways to create a relation:

1. You can use the Create relation button on OSM Feature widget.

2. You can create it from the Relation tab of OSM Feature widget using the Add relation button.

In both cases a dialog will appear. For the second case, the feature that is currently identified is automatically
considered to be the first relation member, so the dialog is prefilled a little. When creating a relation, please select
its type first. You can select one of predefined relation types or write your own type. After that fill the relation
tags and choose its members.

If you have already selected a relation type, try using the Generate tags button. It will generate typical tags to
your relation type. Then you are expected to enter values to the keys. Choosing relation members can be done

either by writing member identifiers, types and roles or using the Identify tool and clicking on map.

Finally when type, tags and members are chosen, the dialog can be submitted. In such case the plugin creates a
new relation for you.

16.8.3 Changing relation

If you want to change an existing relation, identify it first (follow steps written above in Section Examining

relation). After that click on the Edit relation button. You will find it on the OSM Feature widget. A new dialog
appears, nearly the same as for the ‘create relation’ action. The dialog is pre-filled with information on given
relations. You can change relation tags, members or even its type. After submitting the dialog your changes will
be committed.

16.9 Downloading OSM data

To download data from OpenStreetMap server click on the Download OSM data button. If there is no such button,
the OSM toolbar may be disabled in your QGIS instalation. You can enable it again at Settings → Toolbars →
OpenStreetMap . After clicking the button a dialog occurs and provides following functionalities:

Extent: Specifies an area to download data from intervals of latitude and longitude degrees. Because there is some
restriction of OpenStreetMap server on how much data can be downloaded, the intervals must not be too wide.

More detailed info on extent specification can is shown after clicking the Help button on the right.

Download to: Here you are expected to write a path to the file where data will be stored. If you can’t remember

the structure of your disk, don’t panic. The browse button will help you.
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Figuur 16.6: OSM download dialog

Open data automatically after download: Determines, if the download process should be followed by loading

the data process or not. If you prefer not to load data now, you can do it later by using the Load OSM from file

button.

Replace current data: This option is active only if Open data automatically after download is checked.
Checking this option means that downloaded data should replace current data we are working with now. Layers of
the current data will be removed and new ones will be loaded. When starting QGIS and downloading OSM data
for the first time, this option is initially inactive, because there is nothing to replace.

Use custom renderer: This option is active only if the Open data automatically after download checkbox
is checked. It determines how many details will be in the map. There are three predefined OSM styles for map
displaying. Use ‘Small scale’ if you want to view OSM data at low level, to see all details and to edit something.
If not you can use ‘Medium scale’ or ‘Large scale’. QGIS 1.8.0 does not support changing the renderer style
dynamically.

Click the [Download] button to start the download process.

A progress dialog will continuously inform you about how much of data is already downloaded. When an error
occurs during the download process, a dialog tells you why. When action finishes successfully both the progress
dialog and download dialog will close themselves.

16.10 Uploading OSM data

Note that the upload is always done on current OSM data. Before opening the OSM Upload dialog, please be sure
that you really have the right active layer with OSM data.

To upload current data to the OSM server click on the Upload OSM data button. If there is no such button, OSM
toolbar in your QGIS installation is disabled. You can enable it again in Settings → Toolbars → OpenStreetMap .
After clicking the [Upload] button a new dialog will appear.

At the top of the dialog you can check, if you are uploading the correct data. There is a short name of a current
database. In the table you find information on how many changes will be uploaded. Statistics are displayed
separately for each feature type.

In the ‘Comment on your changes’ box you can write brief information on meaning of your upload operation.
Just write in brief what data changes you’ve done or let the box empty. Fill ‘OSM account’ arrays so that the
server could authenticate you. If you don’t have an account on the OSM server, it’s the best time to create one at
http://www.openstreetmap.org. Finally use [Upload] to start an upload operation.
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Figuur 16.7: OSM upload dialog

16.11 Saving OSM data

To save data from a current map extent to an XML file click on the Save OSM to file button. If there is no such
button, the OSM toolbar in your QuantumGIS installation is probably disabled. You can enable it again in Settings
→ Toolbars → OpenStreetMap. After clicking on the button a new dialog appears.

Figuur 16.8: OSM saving dialog

Select features you want to save into XML file and the file itself. Use the [OK] button to start the operation. The
process will create an XML file, in which OSM data from your current map extent are represented. The OSM
version of the output file is 0.6. Elements of OSM data (<node>, <way>, <relation>) do not contain information
on their changesets and uids. This information are not compulsory yet, see DTD for OSM XML version 0.6. In
the output file OSM elements are not ordered.

Notice that not only data from the current extent are saved. Into the output file the whole polygons and lines are
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saved even if only a small part of them is visible in the current extent. For each saved line/polygon all its member
nodes are saved too.

16.12 Import OSM data

To import OSM data from an opened non-OSM vector layer follow this instructions. Choose current OSM data

by clicking on one of their layers. Click on the Import data from a layer button. If there is no such button, someone
has probably disabled the OpenStreetMap toolbar in your QGIS installation. You can enable it again in Settings
→ Toolbars → OpenStreetMap.

After clicking on the button following message may show up:

Figuur 16.9: OSM import message dialog

In such case there is no vector layer currently loaded. The import must be done from a loaded layer - please load a
vector layer from which you want to import data. After a layer is opened, your second try should give you a better
result (don’t forget to mark the current OSM layer again):

Figuur 16.10: Import data to OSM dialog

Use the submit dialog to start the process of OSM data importing. Reject it if you are not sure you want to import
something.
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SEXTANTE

17.1 Introduction

This chapter introduces SEXTANTE, the powerful geospatial analysis framework of QGIS. SEXTANTE is a
geoprocessing environment that can be used to call native and third party algorithms from QGIS, making your
spatial analysis tasks more productive and easy to accomplish.

In the following sections we will review how to use the graphical elements of SEXTANTE and take the most out
of each one of them

17.1.1 Basic elements of the SEXTANTE GUI

There are four basic elements in the SEXTANTE GUI, which are used to run SEXTANTE algorithms for different
purposes. Choosing one tool or another will depend on the kind of analysis that is to be performed and the
particular characteristics of each user and project. All of them (except for the batch processing interface, which is
called from the toolbox, as we will see) can be accessed from the SEXTANTE menu item (you will see more than
four entries. The remaining ones are not used to execute algorithms and will be explained later in this chapter).

• The SEXTANTE toolbox. The main element of the SEXTANTE GUI, it is used to execute a single algorithm
or run a batch process based on that algorithm.

Figuur 17.1: SEXTANTE Toolbox

• The SEXTANTE graphical modeler. Several algorithms can be combined graphically using the modeler to
define a workflow, creating a single process that involves several sub-processes

• The SEXTANTE history manager. All actions performed using any of the aforementioned elements are
stored in a history file and can be later easily reproduced using the history manager
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Figuur 17.2: SEXTANTE Models

Figuur 17.3: SEXTANTE History
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• The SEXTANTE batch processing interface manager. This interface allows you to execute batch processes
and automate the execution of a single algorithm on multiple datasets.

Figuur 17.4: SEXTANTE Batch Processing

Along the following sections we will review each one of this elements in detail.

17.2 The SEXTANTE toolbox

17.2.1 Introduction

The Toolbox is the main element of the SEXTANTE GUI, and the one that you are more likely to use in your daily
work. It shows the list of all available algorithms grouped in different blocks, and is the access point to run them
whether as a single process or as a batch process involving several executions of a same algorithm on different
sets of inputs.

Figuur 17.5: SEXTANTE Toolbox

The toolbox contains all the algorithms available, divided into groups. Each group represents a so-called ‘algo-
rithm provider’, which is a set of algorithms coming from the same source, for instance, from a third-party ap-
plication with geoprocessing capabilities. Some of this groups represent algorithms from one of such third-party
applications (like SAGA, GRASS or R), while other contain algorithms directly coded along with SEXTANTE
elements, not relying on any additional software. Currently, these providers all reuse code from already exist-
ing QGIS plugins (more specifically, from the fTools vector library shiped along with QGIS and the contributed
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mmqgis plugin that you can install using the Plugin Manager), making them more useful, since they can be exe-
cuted from elements such as the modeler or the batch processing interface, which we will soon describe.

Additionally, two more providers can be found, namely ‘Models’ and ‘Scripts’. This providers include user-
created algorithms, and allow you to define your own workflows and processing tasks. We will devote a full
section to them a bit later.

In the upper part of the toolbox you can find a text box. To reduce the number of algorithms shown in the toolbox
and make it easier to find the one you need, you can enter any word or phrase on the text box. Notice that, as you
type, the number of algorithms in the toolbox is reduced to just those which contain the text you have entered in
their names.

To execute an algorithm, just double-click on its name in the toolbox.

17.2.2 The algorithm dialog

Once you double-click on the name of the algorithm that you want to execute, a dialog similar to the next one is
shown (in this case, the dialog corresponds to the SAGA ‘Convergence index’ algorithm).

Figuur 17.6: Parameters Dialog

This dialog is used to set the input values that the algorithm needs to be executed. It shows a table where input
values and configuration parameters are to be set. It, of course, has a different content depending on the require-
ments of the algorithm to be executed, and is created automatically based on those requirements. On the left side,
the name of the parameter is shown. On the right side the value of the parameter can be set.

Although the number and type of parameters depend on the characteristics of the algorithm, the structure is similar
for all of them. The parameters found on the table can be of one of the following types.

• A raster layer, to select from a list of all the ones available (currently opened) in QGIS. The selector contains
as well a button on its right-hand side, to let you select filenames that represent layers currently not loaded
in QGIS.

• A vector layer, to select from a list of all the ones available in the QGIS. Layers not loaded in QGIS can
be selected as well, as in the case of raster layers, but only if the algorithm does not require a table field
selected from the attributes table of the layer. In that case, only opened layers can be selected, since they
need to be open so as to retrieve the list of field names available.

You will see a button by each vector layer selector. If the algorithm contains several of them, you will be
able to toggle just one of them. If the button corresponding to a vector input is toggled, the algorithm will
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be executed iteratively on each one of its features. We will see more about this kind of execution at the end
of this section.

• A table, to select from a list of all the ones available in QGIS. Non-spatial tables are loaded into QGIS like
vector layers, and in fact they are treated as such by the program. Currently, the list of available tables that
you will see when executing a SEXTANTE algorithm that needs one of them is restricted to tables coming
from files in DBase (.dbf) or Comma-Separated Values (.csv) formats.

• An option, to choose from a selection list of possible options.

• A numerical value, to be introduced in a text box. You will find a button by its side. Clicking on it you
will see a dialog that allows you to enter a mathematical expression, so you can use it as a handy calculator.
Some useful variables related to data loaded into QGIS can be added to your expression, so you can select
a value derived from any of this variables such as the cellsize of a layer or the northern most coordinate of
another one.

Figuur 17.7: Number Selector

• A range, with min and max values to be introduced in two text boxes.

• A text string, to be introduced in a text box.

• A field, to choose from the attributes table of a vector layer or a single table selected in another parameter.

• A Coordinate Reference System (CRS). You can type the EPSG code directly in the text box, or select it
from the CRS selection dialog that appear when you click on the button on the right-hand size

• A extent, to be entered by four number representing its xmin, xmax, ymin, ymax limits. Clicking on the
button on the right-hand side of the value selector, a pop-up menu will appear, giving you two option: to
select the value from a layer or the current canvas extent, or to define it by dragging directly onto the map
canvas.

Figuur 17.8: SEXTANTE Extent

If you select the first option, you will see a window like the next one.
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Figuur 17.9: SEXTANTE Extent List

If you select the second one, the parameters window will hide itself, so you can click and drag onto the
canvas. Once you have defined the selected rectangle, the dialog will reappear, containing the values in the
extent text box.

Figuur 17.10: Extent Drag

• A list of elements (whether raster layers, vector ones or tables), to select from the list of the ones available
in QGIS. To make the selection, click on the small button on the left side of the corresponding row to see a
dialog like the following one.

• A small table to be edited by the user. These are used to define parameters like lookup tables or convolution
kernels, among others.

Click on the button on the right side to see the table and edit its values.

Depending on the algorithm, the number of rows can be modified or not, using the buttons on the right side
of the window.

You will find a [Help] button in the lower part of the parameters dialog. If a help file is available, it will be
shown, giving you more information about the algorithms and detailed descriptions of what each parameter does.
Unfortunately, most algorithms lack good documentation, but if you feel like contributing to the project, this would
be a good place to start.

A note on projections

SEXTANTE — and also most of the external applications whose algorithms are available from SEXTANTE —
does not perform any reprojection on input layers and assumes that all of them are already in a common coordinate
system and ready to be analized. Whenever you use more than one layer as input to an algorithm, whether vector
or raster, it is up to you to make sure that they are all in the same coordinate system.
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Figuur 17.11: Multiple Selection

Figuur 17.12: Fixed Table
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Note that, due to QGIS’s ‘on-the-fly’ reprojecting capabilities, although two layers might seem to overlap and
match, that might not be true if their original coordinates are used without reprojecting them onto a common coor-
dinate system. That reprojection should be done manually and then use the resulting files as input to SEXTANTE.
Also note that the reprojection process can be performed with SEXTANTE, which incorporates tools to do so.

17.2.3 Data objects generated by SEXTANTE algorithms

Data objects generated by SEXTANTE can be of any of the following types:

• A raster layer

• A vector layer

• A table

• An HTML file (used for text and graphical outputs)

They are all saved to disk (there are no in-memory results), and the parameters table will contain a text box
corresponding to each one of these outputs, where you can type the output channel to use for saving it. An output
channel contains the information needed to save the resulting object somewhere. In the most usual case, you will
save it to a file, but the architecture of SEXTANTE allows for any other way of storing it. For instance, a vector
layer can be stored in a database or even uploaded to a remote server using a WFS-T service. Although solutions
like these are not yet implemented, SEXTANTE is prepared to handle them, and we expect to add new kinds of
output channels in a near feature.

To select an output channel, just click on the button on the right side of the text box. That will open a save-file
dialog, where you can select the desired filepath. Supported file extensions are shown in the file format selector of
the dialog, depending on the kind of output and the algorithm.

The format of the output is defined by the filename extension. The supported formats depend on the ones supported
by the algorithm itself. To select a format, just select the corresponding file extension (or add it if you are directly
typing the filepath instead). If the extension of the filepath you entered does not match any of the supported ones,
a default extension (usually .dbf for tables, .tif for raster layers and .shp for vector ones) will be appended
to the filepath and the file format corresponding to that extension will be used to save the layer or table.

If you do not enter any filename, the result will be saved as a temporary file and in the corresponding default file
format, and will be deleted once you exit QGIS (take care with that in case you save your project and it contains
temporary layers).

You can set a default folder for output data objects. Go to the configuration dialog (you can open it from the
SEXTANTE menu), and in the General group you will find a parameter named Output folder. This output folder
is used as the default path in case you type just a filename with no path (i.e. myfile.shp) when executing an
algorithm.

Apart from raster layers and tables, SEXTANTE also generates graphics and texts as HTML files. These results
are shown at the end of the algorithm execution in a new dialog. This dialog will keep the results produced
by SEXTANTE during the current session, and can be shown at any time by selecting in menu SEXTANTE →
SEXTANTE results viewer.

Some external applications might have files (with no particular extension restrictions) as output, but they do not
belong to any of the categories above. Those outut files will not be processed by QGIS (opened or included into the
current QGIS project), since most of the times correspond to file formats or elements not supported by QGIS. This
is, for instance, the case with LAS files used for LiDAR data. The files get created, but you won’t see anything
new in your QGIS working session.

For all the other types of outputs, you will find a check box that you can use to tell SEXTANTE not whether to
load the file once it is generated by the algorithm or not. By default, all files are opened.

SEXTANTE does not support optional outputs, so all outputs are created, but you can uncheck the corresponding
check box if you are not interested in a given output, which virtually makes it behave like an optional output
(although the layer is created anyway, but if you leave the text box empty, it will be saved to a temporary file and
deleted once you exit QGIS)
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17.2.4 Configuring SEXTANTE

As it has been mentioned, the configuration menu gives access to a new dialog where you can configure how
SEXTANTE works. Configuration parameters are structured in separate blocks that you can select on the left-
hand side of the dialog.

Along with the aforementioned Output folder entry, the General block contains parameters for setting the default
rendering style for SEXTANTE layers (that is, layers generated by using algorithms from any of the SEXTANTE
components). Just create the style you want using QGIS, save it to a file, and then enter the path to that file in the
settings so SEXTANTE can use it. Whenever a layer is loaded by SEXTANTE and added to the QGIS canvas, it
will be rendered with that style.

Rendering stlyes can be configured individually for each algorithm and each one of its outputs. Just right-click on
the name of the algorithm in the toolbox and select Edit rendering styles. You will see a dialog like the one shown
next.

Figuur 17.13: Rendering Styles

Select the style file (.qml) that you want for each output and press [OK].

Other configuration parameters in the General group are explained below:

• Use filename as layer name. The name of each resulting layer created by SEXTANTE is defined by the
algorithm generating it. In some cases, a fixed name might be used, that meaning that the same name will be
used, no matter which input layer is used. In other cases, the name might depend on the name of the input
layer or some of the parameters used to run the algorithm. If this checkbox is checked, the name will be
taken from the output filename instead. Notice, that, if the output is saved to a temporary file, the filename
of this temporary file is usually long and meaningless one intended to avoid collision with other already
existing filenames.

• Use only selected features. If this option is selected, whenever a vector layer is used as input for an
algorithm, only its selected features will be used. If the layer has no selected features, all of them will be
used.

Apart from the General block in the settings dialog, you will also find one for each algorithm provider. They
contain an Activate item that you can use to make algorithms appear or not in the toolbox. Also, some algo-
rithm providers have their own configuration items, that we will explain later when covering particular algorithm
providers.
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17.3 The SEXTANTE graphical modeler

17.3.1 Introduction

The graphical modeler allows to create complex models using a simple and easy-to-use interface. When working
with a GIS, most analysis operations are not isolated, but part of a chain of operations instead. Using the graphical
modeler, that chain of processes can be wrapped into a single process, so it is easier and more convenient to
execute than a single process later on a different set on inputs. No matter how many steps and different algorithms
it involves, a model is executed as a single algorithm, thus saving time and effort, specially for larger models.

The modeler can be opened from the SEXTANTE menu, but also from the toolbox. In the Modeler branch of the
algorithms tree you will find a group named Tools, which contains an entry called Create new model.

The modeler has a working canvas where the structure of the model and the workflow it represents are shown. On
the left part of the window, a panel with two tabs can be used to add new elements to the model.

Figuur 17.14: Modeler

Creating a model involves two steps:

1. Definition of necessary inputs*. These inputs will be added to the parameters window, so the user can set
their values when executing the model. The model itself is a SEXTANTE algorithm, so the parameters
window is generated automatically as it happens with all the algorithms included in SEXTANTE.

2. Definition of the workflow. Using the input data of the model, the workflow is defined adding algorithms
and selecting how they use those inputs or the outputs generated by other algorithms already in the model.

17.3.2 Definition of inputs

The first step to create a model is to define the inputs it needs. The following elements are found in the Inputs tabs
on the left side of the modeler window:

• Raster layer

• Vector layer

• String

• Table field

• Table

• Numerical value

• Boolean value
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Double-clicking on any of them, a dialog is shown to define its characteristics. Depending on the parameter itself,
the dialog will contain just one basic element (the description, which is what the user will see when executing the
model) or more of them. For instance, when adding a numerical value, as it can be seen in the next figure, apart
from the description of the parameter you have to set a default value and a range of valid values.

Figuur 17.15: Model Parameters

For each added input, a new element is added to the modeler canvas.

Figuur 17.16: Model Parameters

17.3.3 Definition of the workflow

Once the inputs have been defined, it is time to define the algorithms to apply on them. Algorithms can be found
in the Algorithms tab, grouped much in the same way as they are in the toolbox.

Figuur 17.17: Model Parameters

To add an algorithm, double-click on its name. An execution dialog will appear, with a content similar to the
one found in the execution panel that SEXTANTE shows when executing the algorithm from the toolbox. the one
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shown next correspond to the SAGA ‘Convergence index’ algorithm, the same one we saw in the section dedicated
to the SEXTANTE toolbox.

Figuur 17.18: Model Parameters

As you can see, some differences exist. Instead of the file output box that was used to set the filepath for output
layers and tables, a simple text box is. If the layer generated by the algorithm is just a temporary result that will
be used as the input of another algorithm and should not be kept as a final result, just do not edit that textbox.
Typing anything on it means that the result is a final one, and the text that you supply will be the description for
the output, which will be the one the user will see when executing the model.

Selecting the value of each parameter is also a bit different, since there are importante differences between the
context of the modeler and the toolbox one. Let’s see how to introduce the values for each type of parameter.

• Layers (raster and vector) and tables. They are selected from a list, but in this case the possible values are
not the layers or tables currently loaded in QGIS, but the list of model inputs of the corresponding type, or
other layers or tables generated by algorithms already added to the model.

• Numerical values. Literal values can be introduced directly on the textbox. But this textbox is also a list
that can be used to select any of the numerical value inputs of the model. In this case, the parameter will
take the value introduced by the user when executing the model.

• String. Like in the case of numerical values, literal strings can be typed, or an input string can be selected.

• Table field. The fields of the parent table or layer cannot be known at design-time, since they depend of the
selection of the user each time the model is executed. To set the value for this parameter, type the name of
a field directly in the textbox, or use the list to select a table field input already added to the model. The
validity of the selected field will be checked by SEXTANTE at run-time.

Once all the parameter have been assigned valid values, click on [OK] and the algorithm will be added to the
canvas. It will be linked to all the other elements in the canvas, whether algorithms or inputs, which provide
objects that are used as inputs for that algorithm.

Elements can be dragged to a different position within the canvas, to change the way the module structure is
displayed and make it more clear and intuitive. Links between elements are update automatically.

You can run your algorithm anytime clicking on the [Run] button. However, in order to use it from the toolbox, it
has to be saved and the modeler dialog closed, to allow the toolbox to refresh its contents.
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Figuur 17.19: Model Parameters

17.3.4 Saving and loading models

Use the [Save] button to save the current model and the [Open] one to open any model previously saved. Model
are saved with the .model extension. If the model has been previously saved from the modeler window, you will
not be prompted for a filename, since there is already a file associated with that model, and it will be used.

Before saving a model, you have to enter a name and a group for it, using the text boxes in the upper part of the
window.

Models saved on the models folder (the default folder when you are prompted for a filename to save the model)
will appear in the toolbox in the corresponding branch. When the toolbox is invoked, SEXTANTE searches the
models folder for files with .model extension and loads the models they contain. Since a model is itself a
SEXTANTE algorithm, it can be added to the toolbox just like any other algorithm.

The models folder can be set from the SEXTANTE configuration dialog, under the Modeler group.

Models loaded from the models folder appear not only in the toolbox, but also in the algorithms tree in the
Algorithms tab of the modeler window. That means that you can incorporate a model as a part of a bigger model,
just as you add any other algorithm.

In some cases, SEXTANTE might not be able to load a model because it cannot find all the algorithms included
in its workflow. If you have used a given algorithm as part of your model, it should be available (that is, it
should appear on the toolbox) in order to load that model. Deactivating an algorithm provider in the SEXTANTE
configuration window renders all the algorithms in that provider unusable by the modeler, which might cause
problems when loading models. Keep that in mind when you have trouble loading or executing models.

17.3.5 Editing a model

You can edit the model you are currently creating, redefining the workflow and the relationships between the
algorithms and inputs that define the model itself.

If you right-click on an algorithm in the canvas representing the model, you will see a context menu like the one
shown next:

Selecting the Remove option will cause the selected algorithm to be removed. An algorithm can be removed only
if there are no other algorithms dependind on it. That is, if no output from the algorithm is used in a different one
as input. If you try to remove an algorithm that has others depending on it, SEXTANTE will show you a warning
message like the one you can see below:

Selecting the Edit option or simply double-clicking on the algorithm icon will show the parameters dialog of the
algorithm, so you can change the inputs and parameter values. Not all input elements available in the model will
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Figuur 17.20: Modeler Right Click

Figuur 17.21: Cannot Delete ALG

appear in this case as available inputs. Layers or values generated at a more advanced step in the workflow defined
by the model will not be available if they cause circular dependencies.

Select the new values and then click on the [OK] button as usual. The connections between the model elements
will change accordingly in the modeler canvas.

17.3.6 Activating and deactivating algorithms

Algorithms can be deactivated in the modeler, so they will not be executed once the model is run. This can be
used to test just a given part of the model, or when you do not need all the outputs it generates.

To deactivate an algorithm, right-click on its icon in the model canvas and select the Deactivate option. You will
see that the algorithm is represented now with a red label under its name indicating that is not active.

Figuur 17.22: Deactivate

All algorithms depending (directly or undirectly) on that algorithm will also appear as inactive, since they cannot
be executed now.

To activate an algorithm, just right–click on its icon and select the Activate option.

17.3.7 Editing model help files and meta-information

You can document your models from SEXTANTE. Just click on the [Edit model help] button and a dialog like
the one shown next will appear.

On the right-hand side you will see a simple HTML page, created using the description of the input parameters
and outputs of the algorithm, along with some additional items like a general description of the model or its author.
The first time you open the help editor all those descriptions are empty, but you can edit them using the elements
on the left-hand side of the dialog. Select an element on the upper part and the write its description in the texbox
below.
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Figuur 17.23: Help Edition

Model help is saved in a file in the same folder as the model itself. You do not have to worry about saving it, since
it is done automatically.

17.3.8 About available algorithms

You might notice that some algorithms that can be be executed from the toolbox do not appear in the list of
available ones when you are designing a model. To be included in a model, and algorithm must have a correct
semantic, so as to be properly linked to other in the workflow. If an algorithm does not have such well-defined
semantic (for instance, if the number of output layers cannot be know in advance), then it is not possible to use it
within a model, and thus does not appear in the list of them that you can find in the modeler dialog.

Additionaly, you will see some algorithms in the modeler that are not found in the toolbox. This algorithms are
meant to be used exclusively as part of a model, and they are of no interest in a different context. The ‘Calculator’
algorithm is an example of that. It is just a simple arithmetic calculator that you can use to modify numerical
values (entered by the user or generated by some other algorithm). This tools is really useful within a model, but
outside of that context, it doesn’t make too much sense.

17.3.9 SEXTANTE models as Python code

This feature is temporarily unavailable

Along with the tab that contains the graphical design of the model, you will find another one containing a Python
script which performs the same task as the model itself. Using that code, you can create a console script (we
will explain them later in this same manual) and modify it to incorporate actions and methods not available in the
graphical modeler, such as loops or conditional sentences.

This feature is also a very practical way of learning how to use SEXTANTE from the console and how to create
SEXTANTE algorithms using Python code, so you can use it as a learning tool when you start creating your own
SEXTANTE scripts.

You will find a button below the text field containing the Python code. Click on it to directly create a new script
from that code, without having to copy and paste it in the SEXTANTE script editor.

17.4 The SEXTANTE batch processing interface

17.4.1 Introduction

SEXTANTE algorithms (including models) can be executed as a batch process. That is, they can be executed
using not a single set of inputs, but several of them, executing the algorithm as many times as needed. This is
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useful when processing large amounts of data, since it is not necessary to launch the algorithm many times from
the toolbox.

To execute an algorithm as a batch process, right-click on its name in the toolbox and select the Execute as batch
process option in the pop-up menu that will appear.

Figuur 17.24: Batch Processing Right Click

17.4.2 The parameters table

Executing a batch process is similar to performing a single execution of an algorithm. Parameter values have to
be defined, but in this case we need not just a single value for each parameter, but a set of them instead, one for
each time the algorithm has to be executed. Values are introduced using a table like the one shown next.

Figuur 17.25: Batch Processing

Each line of this table represents a single execution of the algorithm, and each cell contains the value of one of the
parameters. It is similar to the parameters dialog that you see when executing an algorithm from the toolbox, but
with a different arrangement.

By default, the table contains just two rows. You can add or remove rows using the buttons on the lower part of
the window.

Once the size of the table has been set, it has to be filled with the desired values.

17.4.3 Filling the parameters table

For most parameters, setting its value is trivial. Just type the value or select it from the list of available options,
depending on the parameter type.

The main differences are found for parameters representing layers or tables, and for output filepaths. Regarding
input layers and tables, when an algorithm is executed as part of a batch process those input data objects are taken
directly from files, and not from the set of them already opened in QGIS. For this reason, any algorithm can be
executed as a batch process even if no data objects at all are opened and the algorithm cannot be run from the
toolbox.
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Filenames for input data objects are introduced directly typing or, more conveniently, clicking on the button on
the right hand of the cell, which shows a typical file chooser dialog. Multiple files can be selected at once. If the
input parameter represents a single data object and several files are selected, each one of them will be put in a
separate row, adding new ones if needed. If it represents a multiple input, all the selected files will be added to a
single cell, separated by semicolons (;).

Output data objects are always saved to a file and, unlike when executing an algorithm from the toolbox, saving to
a temporary one is not permitted. You can type the name directly or use the file chooser dialog that appears when
clicking on the accompanying button.

Once you select the file, a new dialog is shown to allow for autocompletion of other cells in the same column
(same parameter).

Figuur 17.26: Batch Processing Save

If the default value (‘Do not autocomplete’) is selected, SEXTANTE will just put the selected filename in the
selected cell from the parameters table. If any of the other options is selected, all the cells below the selected one
will be automatically filled based on a defined criteria. This way, it is much easier to fill the table, and the batch
process can be defined with less effort.

Automatic filling can be done simply adding correlative numbers to the selected filepath, or appending the value
of another field at the same row. This is particularly useful for naming output data object according to input ones.

Figuur 17.27: Batch Processing File Path

17.4.4 Executing the batch process

To execute the batch process once you have introduced all the necessary values, just click on [OK]. SEXTANTE
will show the progress of the global batch process in the progress bar in the lower part of the dialog.

17.5 Using SEXTANTE from the console

17.5.1 Introduction

The console allows advanced users to increase their productivity and perform complex operations that cannot be
performed using any of the other elements of the SEXTANTE GUI. Models involving several algorithms can be
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defined using the command-line interface, and additional operations such as loops and conditional sentences can
be added to create more flexible and powerful workflows.

There is not a SEXTANTE console in QGIS, but all SEXTANTE commands are available instead from QGIS
built-in Python console. That means that you can incorporate those command to your console work and connect
SEXTANTE algorithms to all the other features (including methods from the QGIS API) available from there.

The code that you can execute from the Python console, even if it does call any SEXTANTE method, can be
converted into a new SEXTANTE algorithm that you can later call from the toolbox, the graphical modeler or any
other SEXTANTE component, just like you do with any other SEXTANTE algorithm. In fact, some algorithms
that you can find in the toolbox, like all the ones in the mmqgis group, are simple scripts.

In this chapter we will see how to use SEXTANTE from the QGIS Python console, and also how to write your
own algorithms using Python.

17.5.2 Calling SEXTANTE from the Python console

The first thing you have to do is to import the SEXTANTE functions with the following line:

>>> import sextante

Now, there is basically just one (interesting) thing you can do with SEXTANTE from the console: to execute an
algorithm. That is done using the runalg() method, which takes the name of the algorithm to execute as its first
parameter, and then a variable number of additional parameter depending on the requirements of the algorithm.
So the first thing you need to know is the name of the algorithm to execute. That is not the name you see in the
toolbox, but rather a unique command–line name. To find the right name for your algorithm, you can use the
algslist() method. Type the following line in you console:

>>> sextante.alglist()

You will see something like this.

Accumulated Cost (Anisotropic)---------------->saga:accumulatedcost(anisotropic)
Accumulated Cost (Isotropic)------------------>saga:accumulatedcost(isotropic)
Add Coordinates to points--------------------->saga:addcoordinatestopoints
Add Grid Values to Points--------------------->saga:addgridvaluestopoints
Add Grid Values to Shapes--------------------->saga:addgridvaluestoshapes
Add Polygon Attributes to Points-------------->saga:addpolygonattributestopoints
Aggregate------------------------------------->saga:aggregate
Aggregate Point Observations------------------>saga:aggregatepointobservations
Aggregation Index----------------------------->saga:aggregationindex
Analytical Hierarchy Process------------------>saga:analyticalhierarchyprocess
Analytical Hillshading------------------------>saga:analyticalhillshading
Average With Mask 1--------------------------->saga:averagewithmask1
Average With Mask 2--------------------------->saga:averagewithmask2
Average With Thereshold 1--------------------->saga:averagewiththereshold1
Average With Thereshold 2--------------------->saga:averagewiththereshold2
Average With Thereshold 3--------------------->saga:averagewiththereshold3
B-Spline Approximation------------------------>saga:b-splineapproximation
...

That’s a list of all the available algorithms, alphabetically ordered, along with their corresponding command-line
names.

You can use a string as a parameter for this method. Instead of returning the full list of algorithm, it will only
display those that include that string. If, for instance, you are looking for an algorithm to calculate slope from a
DEM, type alglist("slope") to get the following result:

DTM Filter (slope-based)---------------------->saga:dtmfilter(slope-based)
Downslope Distance Gradient------------------->saga:downslopedistancegradient
Relative Heights and Slope Positions---------->saga:relativeheightsandslopepositions
Slope Length---------------------------------->saga:slopelength
Slope, Aspect, Curvature---------------------->saga:slopeaspectcurvature
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Upslope Area---------------------------------->saga:upslopearea
Vegetation Index[slope based]----------------->saga:vegetationindex[slopebased]

This result might change depending on the algorithms you have available.

It is easier now to find the algorithm you are looking for and its command-line name, in this case
saga:slopeaspectcurvature.

Once you know the command-line name of the algorithm, the next thing to do is to know the right syntax to
execute it. That means knowing which parameters are needed and the order in which they have to be passed when
calling the runalg() method. SEXTANTE has a method to describe an algorithm in detail, which can be used
to get a list of the parameters that an algorithms require and the outputs that it will generate. To do it, you can use
the alghelp(name_of_the_algorithm) method. Use the command-line name of the algorithm, not the
full descriptive name.

Calling the method with saga:slopeaspectcurvature as parameter, you get the following description.

>>> sextante.alghelp("saga:slopeaspectcurvature")
ALGORITHM: Slope, Aspect, Curvature

ELEVATION <ParameterRaster>
METHOD <ParameterSelection>
SLOPE <OutputRaster>
ASPECT <OutputRaster>
CURV <OutputRaster>
HCURV <OutputRaster>
VCURV <OutputRaster>

Now you have everything you need to run any algorithm. As we have already mentioned, there is only one single
command to execute algorithms: runalg(). Its syntax is as follows:

>>> sextante.runalg{name_of_the_algorithm, param1, param2, ..., paramN,
Output1, Output2, ..., OutputN)

The list of parameters and outputs to add depends on the algorithm you want to run, and is exactly the list that the
alghelp() method gives you, in the same order as shown.

Depending on the type of parameter, values are introduced differently. The next one is a quick review of how to
introduce values for each type of input parameter

• Raster Layer, Vector Layer or Table. Simply use a string with the name that identifies the data object to use
(the name it has in the QGIS Table of Contents) or a filename (if the corresponding layer is not opened, it
will be opened, but not added to the map canvas). If you have an instance of a QGIS object representing the
layer, you can also pass it as parameter. If the input is optional and you do not want to use any data object,
use None.

• Selection. If an algorithm has a selection parameter, the value of that parameter should be entered using an
integer value. To know the available options, you can use the algoptions command, as shown in the
following example:

>>> sextante.algoptions("saga:slopeaspectcurvature")
METHOD(Method)

0 - [0] Maximum Slope (Travis et al. 1975)
1 - [1] Maximum Triangle Slope (Tarboton 1997)
2 - [2] Least Squares Fitted Plane (Horn 1981, Costa-Cabral & Burgess 1996)
3 - [3] Fit 2.Degree Polynom (Bauer, Rohdenburg, Bork 1985)
4 - [4] Fit 2.Degree Polynom (Heerdegen & Beran 1982)
5 - [5] Fit 2.Degree Polynom (Zevenbergen & Thorne 1987)
6 - [6] Fit 3.Degree Polynom (Haralick 1983)

In this case, the algorithm has one of such such parameters, with 7 options. Notice that ordering is zero-
based.

• Multiple input. The value is a string with input descriptors separated by semicolons. As in the case of single
layers or tables, each input descriptor can be the data object name, or its filepath.

17.5. Using SEXTANTE from the console 177



QGIS User Guide, Release 1.8

• Table Field from XXX. Use a string with the name of the field to use. This parameter is case-sensitive.

• Fixed Table. Type the list of all table values separated by commas and enclosed between quotes. Values
start on the upper row and go from left to right. You can also use a 2D array of value representing the table.

• CRS. Enter the EPSG code number of the desired CRS.

• Extent. You must use a string with xmin, xmax, ymin and ymax values separated by commas.

Boolean, file, string and numerical parameters do not need any additional explanations.

Input parameters such as strings booleans or numerical values have default values. To use them, use None in the
corresponding parameter entry.

For output data objects, type the filepath to be used to save it, just as it is done from the toolbox. If you want to
save the result to a temporary file, use None. The extension of the file determines the file format. If you enter a
file extension not included in the ones supported by the algorithm, the default file format for that output type will
be used, and its corresponding extension appended to the given filepath.

Unlike when an algorithm is executed from the toolbox, outputs are not added to the map canvas if you execute
that same algorithm from the Python console. If you want to add an output to it, you have to do it yourself after
running the algorithm. To do so, you can use QGIS API commands, or, even easier, use one of the handy methods
provided by SEXTANTE for such task.

The runalg() method returns a dictionary with the output names (the ones shown in the algorithm description)
as keys and the filepaths of those outputs as values. To add all the outputs generated by an algorithm, pass that
dictionary to the loadFromAlg() method. You can also load an individual layer passing its filepath to the
load() method.

17.5.3 Creating scripts and running them from the toolbox

You can create your own algorithms by writing the corresponding Python code and adding a few extra lines to
supply additional information needed by SEXTANTE. You can find a Create new script under the tools group in
the script algorithms block of the toolbox. Double click on it to open the script edition dialog. That’s where you
should type your code. Saving the script from there in the scripts folder (the default one when you open the
save file dialog), with .py extension, will automatically create the corresponding algorithm.

The name of the algorithm (the one you will see in the toolbox) is created from the filename, removing its extension
and replacing low hyphens with blank spaces.

Let’s have the following code, which calculates the Topographic Wetness Index (TWI) directly from a DEM

##dem=raster
##twi=output
ret_slope = sextante.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = sextante.runalg("saga:catchmentarea(mass-fluxmethod)", dem,

0, False, False, False, False, None, None, None, None, None)
sextante.runalg("saga:topographicwetnessindex(twi), ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

As you can see, it involves 3 algorithms, all of them coming from SAGA. The last one of them calculates de TWI,
but it needs a slope layer and a flow accumulation layer. We do not have these ones, but since we have the DEM,
we can calculate them calling the corresponding SAGA algorithms.

The part of the code where this processing takes place is not difficult to understand if you have read the previous
sections in this chapter. The first lines, however, need some additional explanation. They provide SEXTANTE
the information it needs to turn your code into an algorithm that can be run from any of its components, like the
toolbox or the graphical modeler.

These lines start with a double Python comment symbol and have the following structure:

[parameter_name]=[parameter_type] [optional_values]

Here is a list of all the parameter types that SEXTANTE supports in its scripts, their syntax and some examples.
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• raster. A raster layer

• vector. A vector layer

• table. A table

• number. A numerical value. A default value must be provided. For instance, depth=number 2.4

• string. A text string. As in the case of numerical values, a default value must be added. For instance,
name=string Victor

• boolean. A boolean value. Add True or False after it to set the default value. For example,
verbose=boolean True

• multiple raster. A set of input raster layers.

• multiple vector. A set of input vector layers.

• field. A field in the attributes table of a vector layer. The name of the layer has to be added after the
field tag. For instance, if you have declared a vector input with mylayer=vector, you could use
myfield=field mylayer to add a field from that layer as parameter.

• folder. A folder

• file. A filename

The parameter name is the name that will be shown to the user when executing the algorithm, and also the variable
name to use in the script code. The value entered by the user for that parameter will be assigned to a variable with
that name.

When showing the name of the parameter to the user, SEXTANTE will edit it to improve its appearance, replacing
low hyphens with blankspaces. So, for instance, if you want the user to see a parameter named A numerical
value, you can use the variable name A_numerical_value.

Layers and tables values are strings containing the filepath of the corresponding object. To turn them into a QGIS
object, you can use the sextante.getObjectFromUri() function. Multiple inputs also have a string value,
which contains the filepaths to all selected object, separated by semicolons.

Outputs are defined in a similar manner, using the following tags:

• output raster

• output vector

• output table

• output html

• output file

• output number

• output string

The value assigned to the output variables is always a string with a filepath. It will correspond to a temporary
filepath in case the use has not entered any output filename.

When you declare an output, SEXTANTE will try to add it to QGIS once the algorithm is finished. That is the
reason why, although the runalg() method does not load the layers it produces, the final TWI layer will be
loaded, since it is saved to the file entered by the user, which is the value of the corresponding output.

Do not use the load() method in your script algorithms, but just when working with the console line. If a layer
is created as output of an algorithm, it should be declared as such. Otherwise, you will not be able to properly
use the algorithm in the modeler, since its syntax (as defined by the tags explained above) will not match what the
algorithm really creates.

Hidden outputs (numbers and strings) do not have a value. Instead, it is you who has to assign a value to them. To
do so, just set the value of a variable with the name you used to declare that output. For instance, if you have used
this declaration,
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##average=output number

the following line will set the value of the output to 5:

average = 5

In addition to the tags for parameters and outputs, you can also define the group under which the algorithm will
be shown, using the group tag.

If you algorithm takes a long time to process, it is a good idea to inform the user. You have a global named
progress available, with two available methods: setText(text) and setPercentage(percent) to
modify the progress text and the progress bar.

Several examples are provided with SEXTANTE. Please, check them to see real examples of how to create algo-
rithms using this feature of SEXTANTE. You can right-click on any script algorithm and select Edit script to edit
its code or just to see it.

17.5.4 Documenting your scripts

As in the case of models, you can create additional documentation for your script, to explain what they do and
how to use them. In the script editing dialog you will find a [Edit script help] button. Click on it and it will take
you to the help editing dialog. Check the chapter about the graphical modeler to know more about this dialog and
how to use it.

Help files are saved in the same folder as the script itself, adding the .help extension to the filename. Notice that
you can edit your script’s help before saving it for the first time. If you later close the script editing dialog without
saving the script (i.e. you discard it), the help content you wrote will be lost. If your script was already saved and
is associated to a filename, saving is done automatically.

17.6 The SEXTANTE history manager

17.6.1 The SEXTANTE history

Every time you execute a SEXTANTE algorithm, information about the process is stored in the SEXTANTE
history manager. Along with the parameters used, the date and time of the execution are also saved.

This way, it is easy to track the and control all the work that has been developed using SEXTANTE, and easily
reproduce it.

The SEXTANTE history manager is a set of registry entries grouped according to their date of execution, making
it easier to find information about an algorithm executed at any particular moment.

Figuur 17.28: History
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Process information is kept as a command-line expression, even if the algorithm was launched from the toolbox.
This makes it also useful for those learning how to use the command-line interface, since they can call an algorithm
using the toolbox and then check the history manager to see how that same algorithm could be called from the
command line.

Apart from browsing the entries in the registry, processes can be re-executed, simply double-clicking on the
corresponding entry.

Along with algorithm executions, SEXTANTE communicates with the user using the other groups of the registry,
namely Errors, Warnings and Information. In case something is not working properly, having a look at the Errors
might help you to see what is happening. If you get in contact with a SEXTANTE developer to report a bug or
error, the information in that group will be very useful for him to find out what is going wrong.

When executing third party algorithms, this is usually done calling their command-line interfaces, which com-
municate with the user using the console. Although that console is not shown, a full dump of it is stored in the
Information group each time you run one of those algorithms. If, for instance, you are having problems executing
a SAGA algorithm, look for an entry name ‘SAGA execution console output’ to check all the messages generated
by SAGA and try to find out where the problem is.

Some algorithms, even if they can produce a result with the given input data, might add comments or additional
information to Warning in case they detect potential problems from that data, in order to warn you about them.
Make sure you check those messages in case you are having unexpected results.

17.7 Configuring external applications

17.7.1 Introduction

SEXTANTE can be extended using additional applications, calling them from within SEXTANTE. Currently,
SAGA, GRASS, OTB(Orfeo Toolbox) and R are supported, along with some other command-line applications
that provide spatial data analysis functionalities. Algorithms relying on an external application are managed by
their own algorithm provider.

This chapter will show you how to configure SEXTANTE to include these additional applications, and will explain
some particular features of the algorithm based on them. Once you have correctly configured the system, you will
be able to execute external algorithms from any SEXTANTE component like the toolbox or the graphical modeler,
just like you do with any other SEXTANTE geoalgorithm.

By default, all algorithms that rely on an external appplication not shipped with QGIS are not enabled. You can
enable them in the SEXTANTE configuration dialog. Make sure that the corresponding application is already
installed in your system. Enabling an algorithm provider without installing the application it needs will cause the
algorithms to appear in the toolbox, but an error will be thrown when you try to execute them.

This is because the algorithm descriptions (needed to create the parameters dialog and give SEXTANTE the
information it needs about the algorithm) are not included with each appllication, but with SEXTANTE instead.
That is,they are part of SEXTANTE, so you have them in your installation even if you have not installed any other
software. Running the algorithm, however, needs the application binaries to be installed in your system.

A note on file formats

When using an external software, opening a file in QGIS does not mean that it can be opened and processed as well
on that other software. In most cases, it can read what you have opened in QGIS, but in some cases, that might not
be the case. When using databases or uncommon file formats, whether for raster of vector layers, problems might
arise. If that happens, try to use well known file formats that you are sure that are understood by both programs,
and check to console output (in the history and log dialog) for knowing more about what is going wrong.

Using GRASS raster layers is, for instance, one case in which you might have trouble and not be able to complete
your work if you call an external algorithm using such a layer as input. For this reason, these layers will not
appear as available to SEXTANTE algorithms (we are currently working on solving this, and expect to have it
ready soon).
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You should, however, find no problems at all with vector layers, since SEXTANTE automatically converts from
the original file format to one accepted by the external application before passing the layer to it. This adds an extra
processing time, which might be significant if the layer has a large size, so do not be surprised if it takes more to
process a layer from a DB connection that one of a similar size stored in a shapefile.

Providers not using external applications can process any layer that you can open in QGIS, since they open it for
analysis trough QGIS.

Regarding output formats, raster layers can be saved as TIFF (.tif) files, while vector layers are saved as
shapefiles (.shp). These have been chosen as the ‘lingua franca’ between supported third party applications and
QGIS. If the output filename that you select is not one of the above, it will be modified, adding the corresponding
suffix, and the default file format will be used.

In the case of GDAL, the number of supported output formats is larger. When you open the file selection dialog,
you will see that you have more formats (and their corresponding extensions available). For more information
about which formats are supported, check the GDAL documentation.

A note on vector layer selections

By default, when an external algorithm takes a vector layer, it will use all its features, even if a selection exist
in QGIS. You can make an external algorithm aware of that selection by checking the Use selected features in
external applications item in the General settings group. When you do so, each time you execute an external
algorithm that uses a vector layer, the selected features of that layer will be exported to a new layer, and the
algorithm will work with that new layer instead.

Notice that if you select this option, a layer with no selection will behave like a layer with all its features selected,
not like an empty layer.

17.7.2 SAGA

SAGA algorithms can be run from SEXTANTE if you have SAGA installed in your system and you configure
SEXTANTE properly so it can find SAGA executables. In particular, the SAGA command-line executable is
needed to run SAGA algorithms. SAGA binaries are not included with SEXTANTE, so you have to download and
install the software yourself. Please check the SAGA website at for more information. SAGA 2.0.8 is needed.

Once SAGA is installed, and if you are running Windows, open the SEXTANTE configuration dialog. In the
SAGA block you will find a setting named SAGA Folder. Enter the path to the folder where SAGA is installed.
Close the configuration dialog and now you are ready to run SAGA algorithms from SEXTANTE.

In case you are using Linux, there is no need to configure that, and you will not see those folders. Instead, you
must make sure that SAGA is properly installed and its folder is added to the PATH environment variable. Just
open a console and type saga_cmd to check that the system can found where SAGA binaries are located.

About SAGA grid system limitations

Most of SAGA algorithms that require several input raster layers, require them to have the same grid system. That
is, to cover the same geographic area and have the same cellsize, so their corresponding grids match. When calling
SAGA algorithms from SEXTANTE, you can use any layer, regardless of its cellsize and extent. When multiple
raster layers are used as input for a SAGA algorithm, SEXTANTE resamples them to a common grid system and
then passes them to SAGA (unless the SAGA algorithm can operate with layers from different grid systems).

The definition of that common grid system is controlled by the user, and you will find several parameters in the
SAGA group of the setting window to do so. There are two ways of setting the target grid system:

• Setting it manually. You define the extent setting the values of the following parameters:

– Resampling min X

– Resampling max X

– Resampling min Y
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– Resampling max Y

– Resampling cellsize

Notice that SEXTANTE will resample input layers to that extent, even if they do not overlap with it.

• Setting it automatically from input layers. To select this option, just check the Use min covering grid system
for resampling option. All the other settings will be ignored and the minimum extent that covers all the
input layers will be used. The cellsize of the target layer is the maximum of all cellsizes of the input layers.

For algorithms that do not use multiple raster layers, or for those that do not need a unique input grid system, no
resampling is performed before calling SAGA, and those parameters are not used.

Limitations for multi-band layers

Unlike QGIS, SAGA has no support for multiband layers. If you want to use a multiband layer (such as
an RGB or multispectral image), you first have to split it into singlebanded images. To do so, you can use
the ‘SAGA/Grid - Tools/Split RGB image’ algorithm (which creates 3 images from an RGB image) or the
‘SAGA/Grid - Tools/Extract band’ algorithm (to extract a single band).

Limitations in cellsize

SAGA assumes that raster layers have the same cellsize in the X and Y axis. If you are working with a layer
with different values for its horizontal and vertical cellsizes, you might get unexcepted results. In this case, a
warning will be added to the SEXTANTE log, indicating that an input layer might not be suitable to be processed
by SAGA.

Logging

When SEXTANTE calls SAGA, it does it using its command-line interface, thus passing a set of commands to
perform all the required operation. SAGA show its progress by writing information to the console, which includes
the percentage of processing already done, along with additional content. This output is filtered by SEXTANTE
and used to update the progress bar while the algorithm is running.

Both the commands sent by SEXTANTE and the additional information printed by SAGA can be logged along
with other SEXTANTE log messages, and you might find them useful to track in detailed what is going on when
SEXTANTE runs a SAGA algorithm. You will find two settings, namely Log console output and Log execution
commands to activate that logging mechanism.

Most other providers that use an external application and call it through the command-line have similar options,
so you will find them as well in other places in the SEXTANTE settings list.

17.7.3 R and R scripts

R integration in SEXTANTE is different from that of SAGA in that there is not a predefined set of algorithms you
can run (except for a few examples). Instead, you should write your scripts and call R commands, much like you
would do from R, and in a very similar manner to what we saw in the chapter dedicated to SEXTANTE scripts.
This chapter shows you the syntax to use to call those R commands from SEXTANTE and how to use SEXTANTE
objects (layers, tables) in them.

The first thing you have to do, as we saw in the case of SAGA, is to tell SEXTANTE where you R binaries are
located. You can do so using the R folder entry in the SEXTANTE configuration dialog. Once you have set that
parameter, you can start creating your own R scripts and executing them.

Once again, this is different in Linux, and you just have to make sure that the R folder is included in the PATH
environment variable. If you can start R just typing R in a console, then you are ready to go.

To add a new algorithm that calls an R function (or a more complex R script that you have developed and you
would like to have available from SEXTANTE), you have to create a script file that tells SEXTANTE how to
perform that operation and the corresponding R commands to do so.
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Script files have the extension .rsx and creating them is pretty easy if you just have a basic knowledge of R
syntax and R scripting. They should be stored in the R scripts folder. You can set this folder in the R settings
group (available from the SEXTANTE settings dialog), just like you do with the folder for regular SEXTANTE
scripts.

Let’s have a look at a very simple file script file, which calls the R method spsample to create a random grid
within the boundary of the polygons in a given polygon layer. This method belong to the maptools package.
Since almost all the algorithms that you might like to incorporate into SEXTANTE will use or generate spatial
data, knowledge of spatial packages like maptools and, specially, sp, is mandatory.

##polyg=vector
##numpoints=number 10
##output=output vector
##sp=group
pts=spsample(polyg,numpoints,type="random")
output=SpatialPointsDataFrame(pts, as.data.frame(pts))

The first lines, which start with a double Python comment sign (##), tell SEXTANTE the inputs of the algorithm
described in the file and the outputs that it will generate. They work exactly with the same syntax as the SEX-
TANTE scripts that we have already seen, so they will not be described here again. Check the corresponding
section for more information.

When you declare an input parameter, SEXTANTE uses that information for two things: creating the user interface
to ask the user for the value of that parameter and creating a corresponding R variable that can be later used as
input for R commands.

In the above example, we are declaring an input of type vector named polyg. When executing the algorithm,
SEXTANTE will open in R the layer selected by the user and store it in a variable also named polyg. So the
name of a parameter is also the name of the variable that we can use in R for accesing the value of that parameter
(thus, you should avoid using reserved R words as parameter names).

Spatial elements such as vector and raster layers are read using the readOGR() and readGDAL() commands
(you do not have to worry about adding those commands to your description file, SEXTANTE will do it) and
stored as Spatial*DataFrame objects. Table fields are stored as strings containing the name of the selected
field.

Tables are opened using the read.csv() command. If a table entered by the user is not in CSV format, it will
be converted prior to importing it in R.

Knowing that, we can now understand the first line of our example script (the first line not starting with a Python
comment).

pts=spsample(polyg,numpoints,type="random")

The variable polygon already contains a SpatialPolygonsDataFrame object, so it can be used to call the
spsample method, just like the numpoints one, which indicates the number of points to add to the created
sample grid.

Since we have declared an output of type vector named out, we have to create a variable named out and store a
Spatial*DataFrame object in it (in this case, a SpatialPointsDataFrame). You can use any name for
your intermediate variables. Just make sure that the variable storing your final result has the same name that you
used to declare it, and contains a suitable value.

In this case, the result obtained from the spsample method has to be converted explicitly into a
SpatialPointsDataFrame object, since it is itself an object of class ppp, which is not a suitable class
to be retuned to SEXTANTE.

If you algorithm does not generate any layer, but a text result in the console instead, you have to tell SEXTANTE
that you want the console to be shown once the execution is finished. To do so, just start the command lines that
produce the results you want to print with the > (‘greater’) sign. The output of all other lines will not be shown.
For instance, here is the description file of an algorithms that performs a normality test on a given field (column)
of the attributes of a vector layer:
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##layer=vector
##field=field layer
##nortest=group
library(nortest)
>lillie.test(layer[[field]])

The output ot the last line is printed, but the output of the first is not (and neither are the outputs from other
command lines added automatically by SEXTANTE).

If your algorithm creates any kind of graphics (using the plot() method), add the following line:

##showplots

This will cause SEXTANTE to redirect all R graphical outputs to a temporary file, which will be later opened once
R execution has finished.

Both graphics and console results will be shown in the SEXTANTE results manager.

For more information, please check the script files provided with SEXTANTE. Most of them are rather simple and
will greatly help you understand how to create your own ones.

17.7.4 GRASS

Configuring GRASS is not much different from configuring SAGA. First, the path to the GRASS folder has to be
defined, but only if you are running Windows. Additionaly, a shell interpreter (usually msys.exe, which can be
found in most GRASS for Windows distributions) has to be defined and its path set up as well.

By default, SEXTANTE tries to configure its GRASS connector to use the GRASS distribution that ships along
with QGIS. This should work without problems in most systems, but if you experience problems, you might have
to do it manually. Also, if you want to use a different GRASS version, you can change that setting and point to
the folder where that other version is kept. GRASS 6.4 is needed for algorithms to work correctly.

If you are running Linux, you just have to make sure that GRASS is correctly installed, and that it can be run
without problem from a console.

GRASS algorithms use a region for calculations. This region can be defined manually using values similar to
the ones found in the SAGA configuration, or automatically, taking the minimum extent that covers all the input
layers used to execute the algorithm each time. If this is the behaviour you prefer, just check the Use min covering
region option in the GRASS configuration parameters.

GRASS includes help files describing each algorithm. If you set the GRASS help folder parameter, SEXTANTE
will open them when you use the [Show help] button from the parameters window of the algorithm.

The last parameter that has to be configured is related to the mapset. A mapset is needed to run GRASS, and
SEXTANTE creates a temporary one for each execution. You have to tell SEXTANTE if the data you are working
with uses geographical (lat/lon) coordinates or projected ones.

17.7.5 GDAL

No additional configuration is needed to run GDAL algorithms, since it is already incorporated to QGIS and
SEXTANTE can infere its configuration from it.

17.7.6 Orfeo ToolBox

Orfeo ToolBox (OTB) algorithms can be run from SEXTANTE if you have OTB installed in your system and
configured SEXTANTE properly so it can find all necessary files (command-line tools and libraries). Please note
that OTB binaries are not included in SEXTANTE, so you have to download and install the software yourself.
Please check the OTB website for more information.
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Once OTB is installed, start QGIS, open the SEXTANTE configuration dialog and configure OTB algorithm
provider. In the Orfeo Toolbox (image analysis) block you will find all settings related to OTB. First ensure that
algorithms are enabled.

Then configure path to the folder where OTB command-line tools and libraries are installed:

• usually OTB applications folder point to /usr/lib/otb/applications and OTB command line
tools folder is /usr/bin

• if you use OSGeo4W installer, than install otb-bin package and enter
C:\OSGeo4W\apps\orfeotoolbox\applications as OTB applications folder and
C:\OSGeo4W\bin as OTB command line tools folder

17.7.7 TauDEM

To use this provider you need to install TauDEM command line tools.

Windows

Please visit TauDEM homepage for installation instructions and precompiled binaries for 32bit and 64bit systems.
IMPORTANT: you need TauDEM 5.0.6 executables, version 5.2 currently not supported.

Linux

There are no packages for most Linux distribution, so you should compile TauDEM by yourself. As TauDEM
uses MPICH2, first install it using your favorite package manager. Also TauDEM works fine with OpenMPI, so
you can use it instead of MPICH2.

Download TauDEM 5.0.6 source code and extract files in some folder.

Open linearpart.h file and add after line

#include "mpi.h"

add new line with

#include <stdint.h>

so you’ll get

#include "mpi.h"
#include <stdlib.h>

Save changes and close file. Now open tiffIO.h, find line #include "stdint.h" and replace quotes
("") with <>, so you’ll get

#include <stdint.h>

Save changes and close file. Create build directory and cd into it

mkdir build
cd build

Configure your build with command

CXX=mpicxx cmake -DCMAKE_INSTALL_PREFIX=/usr/local ..

and then compile

make

Finaly, to install TauDEM into /usr/local/bin, run
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sudo make install
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Print Composer

The print composer provides growing layout and printing capabilities. It allows you to add elements such as the
QGIS map canvas, legend, scalebar, images, basic shapes, arrows and text labels. You can size, group, align and
position each element and adjust the properties to create your layout. The layout can be printed or exported to
image formats, Postscript, PDF or to SVG (export to SVG is not working properly with some recent Qt4 versions.
You should try and check individual on your system). You can save the layout as template and load it again in
another session. See a list of tools in table_composer_1:

Icon Purpose Icon Purpose

Load from template Save as template

Export to an image format Export as PDF

Export print composition to SVG Print or export as Postscript

Zoom to full extent Zoom in

Zoom out Refresh view

Revert last change Restore last change

Add new map from QGIS map canvas Add image to print composition

Add label to print composition Add new legend to print composition

Add new scalebar to print composition Add basic shape to print composition

Add arrow to print composition Add attribute table to print composition

Select/Move item in print composition Move content within an item

Group items of print composition Ungroup items of print composition

Raise selected items Lower selected items

Move selected items to top Move selected items to bottom

Align selected items left Align selected items right

Align selected items center Align selected items center vertical

Align selected items top Align selected items bottom

Table Composer 1: Print Composer Tools

All Print Composer tools are available in menus and as icons in a toolbar. The toolbar can be switched off and on
using the right mouse button holding the mouse over the toolbar.
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18.1 Open a new Print Composer Template

Before you start to work with the print composer, you need to load some raster and vector layers in the QGIS map
canvas and adapt their properties to suite your own convenience. After everything is rendered and symbolized to

your liking you click the New Print Composer icon in the toolbar or choose File → New Print Composer.

18.2 Using Print Composer

Opening the print composer provides you with a blank canvas to which you can add the current QGIS map canvas,
legend, scalebar, images, basic shapes, arrows and text. Figure_composer_1 shows the initial view of the print

composer with an activated Snap to grid mode but before any elements are added.

Figuur 18.1: Print Composer

The print composer provides three tabs:

• The Composition tab allows you to set paper size, orientation, the print quality for the output file in dpi and

to activate snapping to a grid of a defined resolution. Please note, the Snap to grid feature only works,

if you define a grid resolution > 0. Furthermore you can also activate the Print as raster checkbox. This
means all elements will be rastered before printing or saving as Postscript of PDF.

• The Item Properties tab displays the properties for the selected map element. Click the Select/Move item

icon to select an element (e.g. legend, scalebar or label) on the canvas. Then click the Item Properties tab
and customize the settings for the selected element.

• The Command history tab displays a history of all changes applied to the print composer layout. With a
mouse click it is possible to undo and redo layout steps back and forth to a certain status.

You can add multiple elements to the composer. It is also possible to have more than one map view or legend or
scalebar in the print composer canvas. Each element has its own properties and in the case of the map, its own
extent. If you want to remove any elements from the composer canvas you can do that with the Delete or the
Backspace key.
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18.3 Adding a current QGIS map canvas to the Print Composer

Click on the Add new map toolbar button in the print composer toolbar, to add the QGIS map canvas. Now drag a
rectangle on the composer canvas with the left mouse button to add the map. To display the current map, you can
choose between three different modes in the map Item Properties tab:

• Rectangle is the default setting. It only displays an empty box with a message ‘Map will be printed here’.

• Cache renders the map in the current screen resolution. If case you zoom in or out the composer window,
the map is not rendered again but the image will be scaled.

• Render means, that if you zoom in or out the composer window, the map will be rendered again, but for
space reasons, only up to a maximum resolution.

Cache is default preview mode for newly added print composer maps.

You can resize the map element by clicking on the Select/Move item button, selecting the element, and dragging
one of the blue handles in the corner of the map. With the map selected, you can now adapt more properties in the
map Item Properties tab.

To move layers within the map element select the map element, click the Move item content icon and move the
layers within the map element frame with the left mouse button. After you found the right place for an element,
you can lock the element position within the print composer canvas. Select the map element and click on the right

mouse button to Lock the element position and again to unlock the element. You can lock the map element also

activating the Lock layers for map item checkbox in the Map dialog of the Item Properties tab.

Notitie: QGIS is now able to show labels from the new labeling plugin also in the map composer, but it is not yet
scaled correctly. So it might be necessary to switch back to the standard labeling in some cases.

18.3.1 Map item properties tab — Map and Extents dialog

Map dialog

The Map dialog of the map Item Properies tab provides following functionalities (see figure_composer_2):

Figuur 18.2: Map Dialog

• The Preview area allows to define the preview modes ‘Rectangle’, ‘Cache’ and ‘Render’, as described
above. Click on the [Update preview] button to apply changes to the map view.

• The Map area allows to resize the map element specifying the width and height or the scale. The field

Rotation allows to rotate the map element content clockwise in degrees. Note, a coordinate frame

can only be added with the default value 0. Furthermore you can enable the checkboxes Lock layers for

map items and Draw map canvas items.
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If you change the view on the QGIS map canvas by zooming or panning or changing vector or raster properties,
you can update the print composer view selecting the map element in the print composer and clicking the [Update
preview] button.

Extents dialog

The Extents dialog of the map item tab provides following functionalities (see Figure figure_composer_3)):

Figuur 18.3: Extents Dialog

• The Map extent area allow to specify the map extent using Y and X min/max values or clicking the [Set to
map canvas extent] button.

If you change the view on the QGIS map canvas by zooming or panning or changing vector or raster properties,
you can update the print composer view selecting the map element in the print composer and clicking the [Update
preview] button in the map Item Properties tab (see Figure figure_composer_2 a)).

18.3.2 Map item properties tab — Grid and General options dialog

Grid dialog

The Grid dialog of the map Item Properties tab provides following functionalities (see Figure_composer_4):

Figuur 18.4: Grid Dialog

• The Show grid checkbox allows to overlay a grid to the map element. As grid type you can specify to
use solid line or cross. Furthermore you can define an interval in X and Y direction, an X and Y offset, and
the width used for cross or line grid type.

• The Draw annotation checkbox allows to add coordinates to the map frame. The annotation can be
drawn inside or outside the map frame. The annotation direction can be defined as horizontal, vertical,
horizontal and vertical, or boundary direction. And finally you can define the grid color, the annotation font,
the annotation distance from the map frame and the precision of the drawn coordinates.

General options dialog
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The General options dialog of the map Item Properties tab provides following functionalities (see Fig-
ure_composer_5):

Figuur 18.5: General Options Dialog

• Here you can define color and outline width for the element frame, set a background color and opacity for
the map canvas. The [Position and size] button opens the Set item position dialog and allows to set the map
canvas position using reference points or coordinates. Furthermore you can select or unselect to display the

element frame with the Show frame checkbox. With the Item ID you can create a relationship to the
other print composer items.

18.4 Adding other elements to the Print Composer

Besides adding a current QGIS map canvas to the Print Composer, it is also possible to add, position, move and
customize legend, scalebar, images and label elements.

18.4.1 Label item properties tab - Label and General options dialog

To add a label, click the Add label icon, place the element with the left mouse button on the print composer
canvas and position and customize their appearance in the label Item Properties tab.

Label dialog

The Label dialog of the label item tab provides following functionalities:

Figuur 18.6: Label Options Dialog

• The Label dialog offers to add text labels to the composer canvas. You can define the horizontal and vertical
alignment, select font and font color for the text and it is possible to define a text margin in mm.
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General options dialog

The General options dialog of the label Item Properties tab provides following functionalities:

Figuur 18.7: General Options Dialog

• Here you can define color and outline width for the element frame, set a background color and opacity for
the label. The Position button opens the Set items position dialog and allows to set the map canvas position
using reference points or coordinates. Furthermore you can select or unselect to display the element frame

with the Show frame checkbox. Use the Item ID to create a relationship to other print composer items.

18.4.2 Image item properties tab - Picture options and General options dialog

To add an image, click the Add image icon, place the element with the left mouse button on the print composer
canvas and position and customize their appearance in the image Item Properties tab.

Picture options dialog

The Picture options dialog of the image Item Properties tab provides following functionalities (see fig-
ure_composer_5 a):

Figuur 18.8: Picture Options Dialog Dialog

• The Preloaded Images field then shows all pictures stored in the selected directories.

• The Options area shows the current selected picture and allows to define width, height and clockwise

rotation of the picture. It is also possible to add a user specific SVG path. Activating the Sync with map
checkbox synchronizes the rotation of a picture in the QGIS map canvas (i.e. a rotated north arrow) with
the appropriate print composer image.
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• The Search directories area allows to add and remove directories with images in SVG format to the picture
database.

General options dialog

The General options dialog of the image Item Properties tab provides following functionalities:

Figuur 18.9: General Options Dialog Dialog

• Here you can define color and outline width for the element frame, set a background color and opacity for
the picture. The [Position and size] button opens the Set item position dialog and allows to set the map
canvas position using reference points or coordinates. Furthermore you can select or unselect to display the

element frame with the Show frame checkbox. With the Item ID you can create a relationship to other
print composer items.

18.4.3 Legend item properties tab - General, Legend items and Item option dia-
log

To add a map legend, click the Add new legend icon, place the element with the left mouse button on the print
composer canvas and position and customize their appearance in the legend Item Properties tab.

General dialog

The General dialog of the legend item tab provides following functionalities (see figure_composer_10):

Figuur 18.10: General Dialog

• Here you can adapt the legend title. You can change the font of the legend title, layer and item name. You
can change width and height of the legend symbol and you can add layer, symbol, icon label and box space.
Since QGIS 1.8, you can wrap the text of the legend title to a given character.
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Legend items dialog

The Legend items dialog of the legend Item Properties tab provides following functionalities (see fig-
ure_composer_11):

Figuur 18.11: Legend Items Dialog

• The legend items window lists all legend items and allows to change item order, edit layer names, remove
and restore items of the list. After changing the symbology in the QGIS main window you can click on
[Update] to adapt the changes in the legend element of the print composer. The item order can be changed
using the [Up] and [Down] buttons or with ‘drag and drop’ functionality.

General options dialog

The General options dialog of the legend Item Properties tab provides following functionalities (see fig-
ure_composer_12):

Figuur 18.12: General Options Dialog

• Here you can define color and outline width for the element frame, set a background color and opacity for
the legend. The [Position and size] button opens the Set item position dialog and allows to set the map
canvas position using reference points or coordinates. Furthermore you can select or unselect to display the

element frame with the Show frame checkbox. Use the Item ID to create a relationship to other print
composer items.

18.4.4 Scalebar item properties tab - Scalebar and General options dialog

To add a scalebar, click the Add new scalebar icon, place the element with the left mouse button on the print
composer canvas and position and customize their appearance in the scalebar Item Properties tab.

Scalebar dialog
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The Scalebar dialog of the scalebar Item Properties tab provides following functionalities (see fig-
ure_composer_13):

Figuur 18.13: Scalebar Options Dialog

• The Scalebar dialog allows to define the segment size of the scalebar in map units, the map units used per
bar units, and how many left and right segments units from 0 should be used.

• You can define the scalebar style, available is single and double box, line ticks middle, up and down and a
numeric style.

• Furthermore you can define height, line width, label and box space of the scalebar. Add a unit label and
define the scalebar font and color.

General options dialog

The General options dialog of the scalebar Item Properties tab provides following features (see figure_composer_7
b)):

Figuur 18.14: General Options Dialog

• Here you can define color and outline width for the element frame, set a background color and opacity for
the scalebar. The [Position and size] button opens the Set items position dialog and allows to set the map
canvas position using reference points or coordinates. Furthermore you can select or unselect to display the

element frame with the Show frame checkbox. With the Item ID you can create a relationship to the
other print composer items.

18.5 Navigation tools

For map navigation the print composer provides 4 general tools:

• Zoom in
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• Zoom out

• Zoom to full extend

• Refresh the view (if you find the view in an inconsistent state)

18.6 Revert and Restore tools

During the layout process it is possible to revert and restore changes. This can be done with the revert and restore
tools:

• Revert last changes

• Restore last changes

or by mouse click within the Command history tab (see figure_composer_9).

Figuur 18.15: Command history in the Print Composer

18.7 Add Basic shape and Arrow

It is possible to add basic shapes (Ellipse, Rectangle, Triangle) and arrows to the print composer canvas.

The Shape dialog allows to draw an ellipse, rectangle, or triangle in the print composer canvas. You can define its
outline and fill color, the outline width and a clockwise rotation.

The Arrow dialog allows to draw an arrow in the print composer canvas. You can define color, outline and arrow
width and it is possible to use a default marker and no marker and a SVG marker. For the SVG marker you can
additionally add a SVG start and end marker from a directory on your computer.

18.8 Add attribute table values

It is possible to add parts of a vector attribute table to the print composer canvas.

Table dialog
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Figuur 18.16: Shape Dialog

Figuur 18.17: Arrow Dialog

The Table dialog of the attribute table item tab provides following functionalities (see figure_composer_20):

Figuur 18.18: Table Dialog

• The Table dialog allows to select the vector layer and columns of the attribute table. Attribute columns can
be sorted and you can define to show its values ascending or descending.

• You can define the maximum number of rows to be displayed and if attributes are only shown for visible
features of the current composer canvas.

• Additionally you can define the grid characteristics of the table and the header and content font.

General options dialog

The General options dialog of the attribute table item tab provides following functionalities (see fig-
ure_composer_21):

• Here you can define color and outline width for the element frame, set a background color and opacity
for the table. The [Position and size] button opens the Set item position dialog and allows to set the map
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Figuur 18.19: General Options Dialog

canvas position using reference points or coordinates. Furthermore you can select or unselect to display the

element frame with the Show frame checkbox. Use the Item ID to create a relationship to the other print
composeritems.

18.9 Raise, lower and align elements

Raise or lower functionalities for elements are inside the Raise selected items pulldown menu. Choose an element
on the print composer canvas and select the matching functionality to raise or lower the selected element compared
to the other elements (see table_composer_1).

There are several alignment functionalities available within the Align selected items pulldown menu (see ta-
ble_composer_1). To use an alignment functionality , you first select some elements and then click on the matching
alignment icon. All selected will then be aligned within to their common bounding box.

18.10 Creating Output

Figure_composer_22 shows the print composer with an example print layout including each type of map element
described in the sections above.

Figuur 18.20: Print Composer with map view, legend, scalebar, coordinates and text added
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The print composer allows you to create several output formats and it is possible to define the resolution (print
quality) and paper size:

• The Print icon allows to print the layout to a connected printer or a Postscript file depending on installed
printer drivers.

• The Export as image icon exports the composer canvas in several image formats such as PNG, BPM, TIF,
JPG,...

• The Export as PDF saves the defined print composer canvas directly as a PDF.

• The Export as SVG icon saves the print composer canvas as a SVG (Scalable Vector Graphic).

Notitie: Currently the SVG output is very basic. This is not a QGIS problem, but a problem of the underlaying
Qt library. This will hopefully be sorted out in future versions.

18.11 Saving and loading a print composer layout

With the Save as template and Load from template icons you can save the current state of a print composer session
as a .qpt template and load the template again in another session.

The Composer Manager button in the QGIS toolbar and in File → Composer Manager allows to add a new com-
poser template or to manage already existing templates.

Figuur 18.21: The Print Composer Manager
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Plugins

19.1 QGIS Plugins

QGIS has been designed with a plugin architecture. This allows many new features/functions to be easily added
to the application. Many of the features in QGIS are actually implemented as either core or external plugins.

• Core Plugins are maintained by the QGIS Development Team and are automatically part of every QGIS
distribution. They are written in one of two languages: C++ or Python. More information about core plugins
are provided in Section Using QGIS Core Plugins

• External Plugins are currently all written in Python. They are stored in external repositories and maintained
by the individual authors. They can be added to QGIS using the Python Plugin Installer. More information
about external plugins is provided in Section Loading an external QGIS Plugin.

19.1.1 Managing Plugins

Managing plugins in general means loading or unloading them using the Plugin Manager. External plugins can
be installed and directly activated or uninstalled using the Python Plugin Installer. To deactivate and reactivate
external plugins, the Plugin Manager is used again.

Loading a QGIS Core Plugin

Loading a QGIS Core Plugin is done from the main menu Plugins → Manage Plugins

The Plugin Manager lists all the available plugins and their status (loaded or unloaded), including all core plugins
and all external plugins that have been installed and automatically activated using the Python Plugin Installer (see
Section Loading an external QGIS Plugin). Those plugins that are already loaded have a check mark to the left of
their name. Figure_plugins_1 shows the Plugin Manager dialog.

To enable a particular plugin, click on the checkbox to the left of the plugin name, and click [OK]. When you exit
the application, a list of loaded plugins is retained, and the next time you run QGIS these plugins are automatically
loaded.

Tip: Crashing Plugins
If you find that QGIS crashes on startup, a plugin may be at fault. You can stop all plugins from loading by editing
your stored settings file (see Opties for location). Locate the plugins settings and change all the plugin values to
false to prevent them from loading.

For example, to prevent the ‘Delimited text’ plugin from loading, the entry in
$HOME/.config/QuantumGIS/qgis.conf on Linux should look like this: Add Delimited Text
Layer=false.

Do this for each plugin in the [Plugins] section. You can then start QGIS and add the plugins one at a time from
the Plugin Manager to determine which plugin is causing the problem.
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Figuur 19.1: Plugin Manager

Loading an external QGIS Plugin

External QGIS plugins are written in Python. They are by default stored in either the ‘Official’ QGIS Repository,
or in various other external repositories maintained by individual authors. The ‘Official’ QGIS Repository is added
by default in Python Plugin installer.

Detailed documentation about the usage, minimum QGIS version, homepage, authors, and other important in-
formation are provided for the ‘Official’ QGIS Repository at http://plugins.qgis.org/plugins/. For other external
repositories, they might be available with the external plugins themselves. In general it is not included in this
manual.

Notitie: Updates of core python plugins may be available in this repository as external overlays.

Notitie: fTools, Mapserver Export, and the Plugin Installer are Python plugins, but they are also part of the
QGIS sources, and are automatically loaded and enabled inside the QGIS Plugin Manager (see Section Loading
an external QGIS Plugin).

Currently there are over 150 external plugins available from the ‘Official’ QGIS Repository. Some of these plugins
offer functionality that will be required by many users (for example: providing the user with the ability to view and
edit OpenStreetMap data, or to add GoogleMap layers) while others offer very specialized functions (for example:
Calculate economic pipe diameters for water supply networks).

It is, however, quite straightforward to search through all the available external plugins by providing keywords,
choosing a named repository and/or filtering on the status of plugins (currently installed or uninstalled in your
system). Searching and filtering is done from the QGIS Python Plugin Installer (see figure_plugins_2).

Tip: Add more repositories
To add external author repositories, open the Plugin Installer (Plugins → Fetch Python Plugins), go to the tab
Repositories, and click [Add]. If you do not want one or more of the added repositories, they can be disabled via
the [Edit...] button, or completely removed with the [Delete] button.

There is only one step required to integrate external plugins into QGIS:

• Download an external plugin from a repository using the Python Plugin Installer (see Using the QGIS
Python Plugin Installer). The new external plugin will be added to the list of available plugins in the Plugin
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Manager and is automatically loaded.

Using the QGIS Python Plugin Installer

In order to download and install an external Python plugin, go to Plugins → Fetch Python Plugins. The Plugin
Installer window will appear (figure_plugins_2) with the tab Plugins, containing a list of all locally installed
Python plugins, as well as plugin available in remote repositories.

Figuur 19.2: Installing external python plugins

Each plugin can be either:

• not installed - this means the plugin is available in the repository, but is not installed yet. In order to install
it, select the plugin from the list and click the button [Install plugin].

• new - this means that the plugin is newly available in the repository.

• installed - this indicates that the plugin is already installed. If it is also available in any repository the
[Reinstall plugin] button will be enabled. If the available version is older than the installed version, the
[Downgrade plugin] button will appear instead.

• upgradeable - this means that the plugin is installed, but there is an updated version available. In this case,
the [Upgrade plugin] and [Upgrade all] buttons will be enabled.

• invalid - this means that the plugin is installed, but is unavailable or broken. The reason will be explained
in the plugin description field.

Plugins tab

To install a plugin, select it from the list and click the [Install plugin] button. The plugin is then activated and
installed in its own directory.

• Linux and other unices

– /share/qgis/python/plugins

– $HOME/.qgis/python/plugins

• Mac OS X

– /Contents/MacOS/share/qgis/python/plugins

– /Users/$USERNAME/.qgis/python/plugins

• Windows

– C:\Program Files\QGIS\python\plugins

– C:\Documents and Settings\$USERNAME\.qgis\python\plugins
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If the installation is successful, a confirmation message will appear.

If the installation fails, the reason for the failure will be displayed in a warning dialog. Most often, errors are the
result of connection problems and/or missing Python modules. In the former case you will likely need to wait
before trying the install again, in the latter case, you should install the missing modules relevant to your operating
system prior to using the plugin. For Linux, most required modules should be available via a package manager.
For install instructions in Windows visit the module home page.

If you are using a proxy, you may need to configure it under Edit → Options (Gnome, OSX) or Settings → Options
(KDE, Windows)‘ on the Proxy tab.

The [Uninstall plugin] button is enabled only if the selected plugin is installed and is not a core plugin. Note
that if you have installed an update to a core plugin, you can uninstall this update with the [Uninstall plugin] and
revert to the version shipped with Quantum GIS. This default version however, cannot be uninstalled.

Repositories tab

The second tab Repositories, contains a list of plugin repositories available for the Plugin Installer. By default,
only the QGIS Official Repository is enabled. You can add several user-contributed repositories, including the
central QGIS Contributed Repository and other external repositories by clicking the [Add ...] button. The added
repositories contain a large number of useful plugins which are not maintained by the QGIS Development Team.
As such, we cannot take any responsibility for them. You can also manage the repository list manually, that is
add, remove, and edit the entries. Temporarily disabling a particular repository is possible by clicking the [Edit
...] button.

Options tab

The Options tab is where you can configure the settings of the Plugin Installer. The Check for updates on
startup checkbox tells QGIS to automatically look for plugin updates and news. By default, if this feature is
enabled all repositories listed and enabled in the Repositories tab are checked for updates each time the program
is started. The frequency of update checking can be adjusted using the dropdown menu, and may be adjusted
from once a day right up to once a month. If a new plugin or update is available for one of the installed plugins, a
notification will appear in the Status Bar. If the checkbox is disabled, looking for updates and news is performed
only when the Plugin Installer is manually launched from the menu.

Although the plugin installer update can handle ports different from 80, some internet connections will cause
problems when attempting to automatically check for updates. In these cases, a Looking for new plugins... indi-
cator will remain visible in the Status Bar during your entire QGIS session, and may cause a program crash when
exiting. In this case please disable the checkbox.

In addition, you may specify the type of plugins that are displayed by the Python Plugin Installer. Under Allowed
plugins, you can specify whether you would like to:

• Only show plugins from the official repository

• Show all plugins except those marked as experimental

• Show all plugins, even those marked as experimental

Tip: Using experimental plugins
Experimental plugins are generally unsuitable for production use. These plugins are in the early stages of devel-
opment, and should be considered ‘incomplete’ or ‘proof of concept’ tools. The QGIS development team does not
recommend installing these plugins unless you intend to use them for testing purposes.

19.1.2 Data Providers

Data Providers are ‘special’ plugins that provides access to a data store. By default, QGIS supports PostGIS layers
and disk-based data stores supported by the GDAL/OGR library. A Data Provider plugin extends the ability of
QGIS to use other data sources.

Data Provider plugins are registered automatically by QGIS at startup. They are not managed by the Plugin
Manager but used behind the scenes when a data type is added as a layer in QGIS.
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19.2 Using QGIS Core Plugins

Icon Plugin Description Manual Reference

Add Delimited Text
Layer

Loads text files containing x,y
coordinates

Delimited Text Plugin

Coordinate Capture Capture mouse coordinate in different
CRS

Coordinate Capture Plugin

DB Manager Manage your databases within QGIS DB Manager Plugin
Diagram Overlay Add Diagrams for vectors Diagram Overlay Plugin

DXF2Shape
Converter

Converts from DXF to SHP file format Dxf2Shp Converter Plugin

eVis Event Visualization Tool eVis Plugin

fTools A suite of vector tools fTools Plugin

GPS Tools Tools for loading and importing GPS
data

GPS Plugin

GRASS GRASS functionality GRASS GIS Integration

GDAL Tools GDAL raster functionality GDAL Tools Plugin

Georeferencer
GDAL

Georeference Raster with GDAL Georeferencer Plugin

Heatmap Create heatmap raster from input vector
points

Heatmap Plugin

Interpolation plugin Interpolation on base of vertices of a
vector layer

Interpolation Plugin

MapServer Export
Plugin

Export a QGIS project file to a
MapServer map file

MapServer Export Plugin

Offline Editing Offline editing and synchronizing with
database

Offline Editing Plugin

OpenStreetMap Access OpenStreetMap OpenStreetMap

Oracle Spatial
Georaster

Access Oracle Spatial GeoRasters Oracle GeoRaster Plugin

Plugin Installer Download and install python plugins Using the QGIS Python Plugin
Installer

Raster Terrain
Analysis

Compute geomorphological features
from DEMs

Raster Terreinanalyses Plugin

Road graph Plugin Shortest path analysis Road Graph Plugin

SPIT Shapefile to PostGIS Import Tool Het importeren van gegevens in
PostgreSQL

SQL Anywhere
plugin

Access SQL anywhere DB SQL Anywhere Plugin

Spatial Query Spatial queries on vectors Spatial Query Plugin

Zonal Statistics Calculate raster statistics for vector
polygons

Zonal Statistics Plugin
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19.3 Coordinate Capture Plugin

The coordinate capture plugin is easy to use and provides the ability to display coordinates on the map canvas for
two selected Coordinate Reference Systems (CRS).

Figuur 19.3: Coordinate Capture Plugin

1. Start QGIS, select Project Properties from the Settings (KDE, Windows) or File (Gnome, OSX) menu

and click on the Projection tab. As an alternative you can also click on the CRS status icon in the lower
right-hand corner of the statusbar.

2. Click on the Enable on the fly projection checkbox and select a projected coordinate system of your
choice (see also Werken met Projecties).

3. Load the coordinate capture plugin in the Plugin Manager (see Loading a QGIS Core Plugin) and ensure

that the dialog is visible by going to View → Panels and ensuring that Coordinate Capture is enabled.
The coordinate capture dialog appears as shown in Figure figure_coordinate_capture_1.

4. Click on the Click to the select the CRS to use for coordinate display icon and select a different CRS from the one you
selected above.

5. To start capturing coordinates, click on [Start capture]. You can now click anywhere on the map canvas
and the plugin will show the coordinates for both of your selected CRS.

6. To enable mouse coordinate tracking click the mouse tracking icon.

7. You can also copy selected coordinates to the clipboard.

19.4 DB Manager Plugin

The DB Manager Plugin is officially part of QGIS core and intends to replace the SPIT Plugin and the PostGIS
Manager Plugin and additionally to integrate all other database formats supported by QGIS in one user interface.

The DB Manager Plugin provides several features. You can drag layers from the QGIS Browser into the DB
Manager and it will import your layer into your spatial database. You can drag and drop tables between spatial
databases and they will get imported. You can also use the DB Manager to execute SQL queries against your
spatial database and then view the spatial output for queries by adding the results to QGIS as a query layer.

The Database menu allows to connect to an existing database, to start the SQL-window and to exit the DB Manager
Plugin. The Schema menu includes tools to create and delete (empty) schemas and, if topology is available (e.g.
PostGIS 2) to start a TopoViewer. The menu Table allows to create and edit tables and to delete tables and views. It
is also possible to empty tables and to move tables from one to another schema. Finally you can also run Vacuum
Analyze and add Versioning Support to a table.

The Tree window lists all existing databases supported by QGIS. With a double-click you can connect to the
database. With the right-mouse button you can rename and delete existing schemas and tables. Tables can also be
added to the QGIS canvas with the context menu.
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Figuur 19.4: DB Manager dialog (KDE)

If connected to a database, the main window of the DB Manager offers three tabs. The Info tab provides informa-
tion about the table and its geometry as well as about existing Fields, Constraints and Indexes. It also allows to
run Vacuum Analyze and to create a spatial index on a selected table, if not already done. The Table tab shows all
attributes and the Preview tab renders the geometries as preview.

19.5 Delimited Text Plugin

The Delimited Text plugin allows you to load a delimited text file as a layer in QGIS.

19.5.1 Requirements

To view a delimited text file as layer, the text file must contain:

1. A delimited header row of field names. This must be the first line in the text file.

2. The header row must contain an X and Y field. These fields can have any name.

3. The x and y coordinates must be specified as a number. The coordinate system is not important.

As an example of a valid text file we import the elevation point data file elevp.csv coming with the QGIS
sample dataset (See Section Voorbeeld Data):

X;Y;ELEV
-300120;7689960;13
-654360;7562040;52
1640;7512840;3
[...]

Some items of note about the text file are:

1. The example text file uses ; (semicolon) as delimiter. Any character can be used to delimit the fields.

2. The first row is the header row. It contains the fields X, Y and ELEV.

3. No quotes (") are used to delimit text fields.

4. The x coordinates are contained in the X field.

5. The y coordinates are contained in the Y field.

19.5.2 Using the Plugin

To use the plugin you must first enable it as described in Section Managing Plugins.
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Click the new toolbar icon Add Delimited Text Layer to open the Delimited Text dialog as shown in fig-
ure_delimited_text_1.

Figuur 19.5: Delimited Text Dialog

First select the file (e.g., qgis_sample_data/csv/elevp.csv) to import by clicking on the [Browse]
button. Once the file is selected, the plugin attempts to parse the file using the last used delimiter, in this case a
semicolon (;). To properly parse the file, it is important to select the correct delimiter. To change the delimiter to
tab use \t (this is a regular expression for the tab character).

Once the file is parsed, choose the X and Y fields from the dropdown lists and if available also the WKT field for
the CRS information. Finally enter a Layer name (e.g., elevp ) as shown in figure_delimited_text_1 . To add the
layer to the map, click [OK]. The delimited text file now behaves as any other map layer in QGIS.

19.6 Diagram Overlay Plugin

The Diagram Overlay Plugin allows you to add a graphic overlay to a vector layer (see figure_overlay_1).
It provides additional and not yet implemented features to the Diagrams tab, described in secion Het tabblad
Diagrammen.

Before starting, the Diagram Overlay Plugin needs to be activated using the Plugin Manager (see Section Loading
a QGIS Core Plugin). It will then appear as Overlay tab in the Layer Properties dialog next to the Diagrams tab.

The Overlay tab provides support for Pie charts, Bar charts and proportional SVG symbols.

Similar to the Diagrams tab, we will demonstrate an example and overlay the alaska boundary layer a piechart
diagram showing some temperature data from a climate vector layer. Both vector layers are part of the QGIS
sample dataset (see Section Voorbeeld Data).

1. First click on the Load Vector icon, browse to the QGIS sample dataset folder and load the two vector
shape layers alaska.shp and climate.shp.
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Figuur 19.6: Vector properties dialog with overlay tab

2. Double click the climate layer in the map legend to open the Layer Properties dialog.

3. Click on the Overlay tab, activate Display diagrams and select ‘Pie Chart’ from Diagram type
combobox.

4. We want to display the values of the three columns T_F_JAN, T_F_JUL and T_F_MEAN. First select
T_F_JAN as Attributes and click the [Add] button, then T_F_JUL and finally T_F_MEAN.

5. Diagram size is based on linear scaling of a classification attribute. We choose T_F_JUL, click on [Find

maximum value] and set size to 20 and Size unit to ‘Millimeter’.

6. Now click [Apply] to display the diagram in the QGIS main window.

7. You can now adapt the chart size, or change the attribute colors double clicking on the color values in the
attribute field. Figure_overlay_2 gives an impression.

8. Finally click [Ok].

Figuur 19.7: Pie chart diagram from temperature data overlayed on a map

Additionally in the Settings → Options dialog, there is a Overlay tab where it is possible to select the placement
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algorithm of the diagrams. The ‘Central point’ method is a generic one, the others use algorithms of the PAL
library. They also consider diagram objects and labels in different layers.

19.7 Dxf2Shp Converter Plugin

The dxf2shape converter plugin can be used to convert vector data from DXF to Shapefile format. It requires the
following parameters to be specified before running:

Figuur 19.8: Dxf2Shape Converter Plugin

• Input DXF file: Enter path to the DXF file to be converted

• Output Shp file: Enter desired name of the Shapefile to be created

• Output file type: Specify the geometry type of the output Shapefile. Currently supported types are polyline,
polygon, and point.

• Export text labels: When this checkbox is enabled, an additional Shapefile point layer will be created, and
the associated dbf table will contain information about the “TEXT” fields found in the dxf file, and the text
strings themselves.

19.7.1 Using the Plugin

1. Start QGIS, load the Dxf2Shape plugin in the Plugin Manager (see Section Loading a QGIS Core Plugin)

and click on the Dxf2Shape Converter icon which appears in the QGIS toolbar menu. The Dxf2Shape plugin
dialog appears as shown in Figure_dxf2shape_1.

2. Enter input DXF file, a name for the output Shapefile and the Shapefile type.

3. Enable the Export text labels checkbox if you want to create an extra point layer with labels.

4. Click [OK].

19.8 eVis Plugin

The Biodiversity Informatics Facility at the American Museum of Natural History’s (AMNH) Center for Biodi-
versity and Conservation (CBC) (this section is derived from Horning, N., K. Koy, P. Ersts. 2009. eVis (v1.1.0)
User’s Guide. American Museum of Natural History, Center for Biodiversity and Conservation. Available from
http://biodiversityinformatics.amnh.org/, and released under the GNU FDL.) has developed the Event Visualiza-
tion Tool (eVis), another software tool to add to the suite of conservation monitoring and decision support tools for
guiding protected area and landscape planning. This plugin enables users to easily link geocoded (i.e., referenced
with latitude and longitude or X and Y coordinates) photographs, and other supporting documents, to vector data
in QGIS.
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eVis is now automatically installed and enabled in new versions of QGIS, and as with all plugins, it can be disabled
and enabled using the Plugin Manager (See Managing Plugins).

The eVis plugin is made up of three modules: the ‘Database Connection tool’, ‘Event ID tool’, and the ‘Event
Browser’. These work together to allow viewing of geocoded photographs and other documents that are linked to
features stored in vector files, databases, or spreadsheets.

19.8.1 Event Browser

The Event Browser module provides the functionality to display geocoded photographs that are linked to vector
features displayed in the QGIS map window. Point data, for example, can be from a vector file that can be input
using QGIS or it can be from the result of a database query. The vector feature must have attribute information
associated with it to describe the location and name of the file containing the photograph and, optionally, the
compass direction the camera was pointed when the image was acquired. Your vector layer must be loaded into
QGIS before running the Event Browser.

Launch the Event Browser module

To launch the Event browser module either click on the eVis Event Browser icon or click on Database → eVis →
eVis Event Browser. This will open the Generic Event Browser window.

The Generic Event Browser window has three tabs displayed at the top of the window. The Display tab is used
to view the photograph and its associated attribute data. The Options tab provides a number of settings that can
be adjusted to control the behavior of the eVis plugin. Lastly, the Configure External Applications tab is used to
maintain a table of file extensions and their associated application to allow eVis to display documents other than
images.

Understanding the Display window

To see the Display window click on the Display tab in the Generic Event Browser window. The Display window
is used to view geocoded photographs and their associated attribute data.

1. Display window: A window where the photograph will appear.

2. Zoom in button: Zoom in to see more detail. If the entire image cannot be displayed in the display window,
scroll bars will appear on the left and bottom sides of the window to allow you to pan around the image.

3. Zoom out button: Zoom out to see more area.

4. Zoom to full extent button: Displays the full extent of the photograph.

5. Attribute information window: All of the attribute information for the point associated with the photo-
graph being viewed is displayed here. If the file type being referenced in the displayed record is not an
image but is of a file type defined in the Configure External Applications tab then when you double-click
on the value of the field containing the path to the file the application to open the file will be launched to
view or hear the contents of the file. If the file extension is recognized the attribute data will be displayed in
green.

6. Navigation buttons: Use the Previous and Next buttons to load the previous or next feature when more
than one feature is selected.

7. Feature indicator: This heading indicates which feature is being displayed and how many features are
available for display.

Understanding the Options window

1. File path: A dropdown list to specify the attribute field that contains the directory path or URL for the
photographs or other documents being displayed. If the location is a relative path then the checkbox must
be clicked. The base path for a relative path can be entered in the Base Path text box below. Information
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Figuur 19.9: The eVis display window

Figuur 19.10: The eVis Options window
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about the different options for specifying the file location are noted in the section Specifying the location
and name of a photograph below.

2. Compass bearing display field: A dropdown list to specify the attribute field that contains the compass
bearing associated with the photograph being displayed. If compass bearing information is available it is
necessary to click the checkbox to the left of the dropdown menu title.

3. Compass offset setting: Compass offsets can be used to compensate for declination (adjust bearings col-
lected using magnetic bearings to true north bearings). Click the Manual radiobutton to enter the offset
in the text box or click the From Attribute radiobutton to select the attribute field containing the offsets.
For both of these options east declinations should be entered using positive values and west declinations
should use negative values.

4. Directory base path: The base path onto which the relative path defined in Figure_eVis_2 (A) will be
appended.

5. Replace path: If this checkbox is checked, only the file name from the A will be appended to the Base Path.

6. Apply rule to all documents: If checked, the same path rules that are defined for photographs will be used
for non-image documents such as movies, text documents, and sound files. If not checked the path rules
will only apply to photographs and other documents will ignore the Base Path parameter.

7. Save settings: If the checkbox is checked the values for the associated parameters will be saved for the next
session when the window is closed or when the [Save] button below is pressed.

8. Reset values: Resets the values on this line to the default setting.

9. Restore faults: This will reset all of the fields to their default settings. It has the same effect as clicking all
of the [Reset] buttons.

10. Save: This will save the settings without closing the Options pane.

Understanding the Configure External Applications window

Figuur 19.11: The eVis External Applications window

1. File reference table: A table containing file types that can be opened using eVis. Each file type needs a
file extension and the path to an application that can open that type of file. This provides the capability of
opening a broad range of files such as movies, sound recordings, and text documents instead of only images.

2. Add new file type: Add a new file type with a unique extension and the path for the application that can
open the file.

3. Delete current row: Delete the file type highlighted in the table and defined by a file extension and a path
to an associated application.

19.8.2 Specifying the location and name of a photograph

The location and name of the photograph can be stored using an absolute or relative path or a URL if the pho-
tograph is available on a web server. Examples of the different approaches are listed in Table evis_examples.
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X Y FILE BEARING
780596 1784017 C:\Workshop\eVis_Data\groundphotos\DSC_0168.JPG 275
780596 1784017 /groundphotos/DSC_0169.JPG 80
780819 1784015 http://biodiversityinform.org/testdata/DSC_0170.JPG 10
780596 1784017 pdf:http://www.test.com/attach.php?attachment_id-12 76

19.8.3 Specifying the location and name of other supporting documents

Supporting documents such as text documents, videos, and sound clips can also be displayed or played by eVis.
To do this it is necessary to add an entry in the file reference table that can be accessed from the Configure External
Applications window in the Generic Event Browser that matches the file extension to an application that can be
used to open the file. It is also necessary to have the path or URL to the file in the attribute table for the vector
layer. One additional rule that can be used for URLs that don’t contain a file extension for the document you want
to open is to specify the file extension before the URL. The format is — file extension:URL. The URL
is preceded by the file extension and a colon, and is particularly useful for accessing documents from Wikis and
other web sites that use a database to manage the web pages (see Table evis_examples).

19.8.4 Using the Generic Event Browser

When the Event Browser window opens a photograph will appear in the display window if the document refer-
enced in the vector file attribute table is an image and if the file location information in the Options window is
properly set. If a photograph is expected and it does not appear it will be necessary to adjust the parameters in the
Options window.

If a supporting document (or an image that does not have a file extension recognized by eVis) is referenced in the
attribute table the field containing the file path will be highlighted in green in the attribute information window if
that file extension is defined in the file reference table located in the Configure External Applications window. To
open the document double-click on the green-highlighted line in the attribute information window. If a supporting
document is referenced in the attribute information window and the file path is not highlighted in green then it
will be necessary to add an entry for the file’s filename extension in the Configure External Applications window.
If the file path is highlighted in green but does not open when double-clicked it will be necessary to adjust the
parameters in the Options window so the file can be located by eVis.

If no compass bearing is provided in the Options window a red asterisk will be displayed on top of the vector
feature that is associated with the photograph being displayed. If a compass bearing is provided then an arrow
will appear pointing in the direction indicated by the value in the compass bearing display field in the Generic
Event Browser window. The arrow will be centered over the point that is associated with the photograph or other
document.

To close the Generic Event Browser window click on the [Close] button from the Display window.

19.8.5 Event ID Tool

The ‘Event ID’ module allows you to display a photograph by clicking on a feature displayed in the QGIS map
window. The vector feature must have attribute information associated with it to describe the location and name
of the file containing the photograph and optionally the compass direction the camera was pointed when the image
was acquired. This layer must be loaded into QGIS before running the ‘Event ID’ tool.

Launch the Event ID module

To launch the ‘Event ID’ module either click on the Event ID icon or click on Plugins → eVis → Event ID Tool.
This will cause the cursor to change to an arrow with an ‘i’ on top of it signifying that the ID tool is active.

To view the photographs linked to vector features in the active vector layer displayed in the QGIS map window,
move the Event ID cursor over the feature and then click the mouse. After clicking on the feature, the Generic
Event Browser window is opened and the photographs on or near the clicked locality are available for display
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in the browser. If more than one photograph is available, you can cycle through the different features using the
[Previous] and [Next] buttons. The other controls are described in the ref:evis_browser section of this guide.

19.8.6 Database connection

The ‘Database Connection’ module provides tools to connect to and query a database or other ODBC resource,
such as a spreadsheet.

eVis can directly connect to four types of databases: Microsoft Access, PostgreSQL, MySQL, SQLite, and can
also read from ODBC connections. When reading from an ODBC database (such as an Excel spreadsheet) it is
necessary to configure your ODBC driver for the operating system you are using.

Launch the Database Connection module

To launch the ‘Database Connection’ module either click on the appropriate icon eVis Database Connection or click
on Plugins → eVis → Database Connection. This will launch the Database Connection window. The window
has three tabs: Predefined Queries, Database Connection, and SQL Query. The Output Console window at the
bottom of the window displays the status of actions initiated by the different sections of this module.

Connect to a database

Click on the Database Connection tab to open the database connection interface. Next, use the Database Type

combobox to select the type of database that you want to connect to. If a password or username is
required, that information can be entered in the Username and Password textboxes.

Enter the database host in the Database Host textbox. This option is not available if you selected “MS Access” as
the database type. If the database resides on your desktop you should enter “localhost”.

Enter the name of the database in the Database Name textbox. If you selected “ODBC” as the database type, you
need to enter the data source name.

When all of the parameters are filled in, click on the [Connect] button. If the connection is successful, a message
will be written in the Output Console window stating that the connection was established. If a connection was not
established you will need to check that the correct parameters were entered above.

1. Database Type: A dropdown list to specify the type of database that will be used.

2. Database Host: The name of the database host.

3. Port The port number if a MySQL or PostgreSQL database type is selected.

4. Database Name The name of the database.

5. Connect A button to connect to the database using the parameters defined above.

6. Output Console The console window where messages related to processing are displayed.

7. Username: Username for use when a database is password protected.

8. Password: Password for use when a database is password protected.

9. Predefined Queries: Tab to open the “Predefined Queries” window.

10. Database Connection: Tab to open the “Database Connection” window.

11. SQL Query: Tab to open the “SQL Query” window.

12. Help: Displays the on line help.

13. OK: Close the main “Database Connection” window.
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Figuur 19.12: The eVis Database connection window

Running SQL queries

SQL queries are used to extract information from a database or ODBC resource. In eVis the output from these
queries is a vector layer added to the QGIS map window. Click on the SQL Query tab to display the SQL query
interface. SQL commands can be entered in this text window. A helpful tutorial on SQL commands is available at
http://www.w3schools.com/sql. For example, to extract all of the data from a worksheet in an Excel file, select
* from [sheet1$] where sheet1 is the name of the worksheet.

Click on the [Run Query] button to execute the command. If the query is successful a Database File Selection
window will be displayed. If the query is not successful an error message will appear in the Output Console
window.

In the Database File Selection window, enter the name of the layer that will be created from the results of the
query in the Name of New Layer textbox.

1. SQL Query Text Window: A screen to type SQL queries.

2. Run Query: Button to execute the query entered in the SQL Query Window.

3. Console Window: The console window where messages related to processing are displayed.

4. Help: Displays the on line help.

5. OK: Closes the main Database Connection window.

Use the X Coordinate and Y Coordinate comboboxes to select the field from the database that
store the X (or longitude) and Y (or latitude) coordinates. Clicking on the [OK] button causes the vector layer
created from the SQL query to be displayed in the QGIS map window.

To save this vector file for future use, you can use the QGIS ‘Save as...’ command that is accessed by right clicking
on the layer name in the QGIS map legend and then selecting ‘Save as...’

Tip: Creating a vector layer from a Microsoft Excel Worksheet
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Figuur 19.13: The eVis SQL query tab

When creating a vector layer from a Microsoft Excel Worksheet you might see that unwanted zeros (“0”) have
been inserted in the attribute table rows beneath valid data.This can be caused by deleting the values for these cells
in Excel using the Backspace key. To correct this problem you need to open the Excel file (you’ll need to close
QGIS if there if you are connected to the file to allow you to edit the file) and then use Edit → Delete to remove
the blank rows from the file. To avoid this problem you can simply delete several rows in the Excel Worksheet
using Edit → Delete before saving the file.

Running predefined queries

With predefined queries you can select previously written queries stored in XML format in a file. This is partic-
ularly helpful if you are not familiar with SQL commands. Click on the Predefined Queries tab to display the
predefined query interface.

To load a set of predefined queries click on the Open File icon. This opens the Open File window which is used
to locate the file containing the SQL queries. When the queries are loaded their titles, as defined in the XML
file, will appear in the dropdown menu located just below the Open File icon, the full description of the query is
displayed in the text window under the dropdown menu.

Select the query you want to run from the dropdown menu and then click on the SQL Query tab to see that the
query has been loaded into the query window. If it is the first time you are running a predefined query or are
switching databases, you need to be sure to connect to the database.

Click on the [Run Query] button in the SQL Query tab to execute the command. If the query is successful a
Database File Selection window will be displayed. If the query is not successful an error message will appear in
the Output Console window.

1. Open Query File: Launches the “Open File” file browser to search for the XML file holding the predefined
queries.

2. Predefined Queries: A dropdown list with all of the queries defined by the predefined queries XML file.
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Figuur 19.14: The eVis Predefined queries tab

3. Query description: A short description of the query. This description is from the predefined queries XML
file.

4. Console Window: The console window where messages related to processing are displayed.

5. Help: Displays the on line help.

6. OK: Closes the main “Database Connection” window.

XML format for eVis predefined queries

The XML tags read by eVis
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Tag Description
query Defines the beginning and end of a query statement.
shortde-
scription

A short description of the query that appears in the eVis dropdown menu.

descrip-
tion

A more detailed description of the query displayed in the Predefined Query text window.

database-
type

The database type as defined in the Database Type dropdown menu in the Database Connection
tab.

database-
port

The port as defined in the Port textbox in the Database Connection tab.

database-
name

The database name as defined in the Database Name textbox in the Database Connection tab.

databaseuser-
name

The database username as defined in the Username textbox in the Database Connection tab.

databasep-
assword

The database password as defined in the Password textbox in the Database Connection tab.

sqlstate-
ment

The SQL command.

autocon-
nect

A flag (“true”” or “false”) to specify if the above tags should be used to automatically connect to
database without running the database connection routine in the Database Connection tab.

A complete sample XML file with three queries is displayed below:

<?xml version="1.0"?>
<doc>
<query>
<shortdescription>Import all photograph points</shortdescription>
<description>This command will import all of the data in the SQLite database to QGIS

</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\textbackslash Workshop/textbackslash

eVis\_Data\textbackslash PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID</sqlstatement>
<autoconnect>false</autoconnect>

</query>
<query>
<shortdescription>Import photograph points "looking across Valley"</shortdescription>
<description>This command will import only points that have photographs "looking across

a valley" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS=’Looking across
valley’</sqlstatement>

<autoconnect>false</autoconnect>
</query>
<query>

<shortdescription>Import photograph points that mention "limestone"</shortdescription>
<description>This command will import only points that have photographs that mention

"limestone" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
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<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS like ’%limestone%’
</sqlstatement>

<autoconnect>false</autoconnect>
</query>

</doc>

19.9 fTools Plugin

The goal of the fTools python plugin is to provide a one-stop resource for many common vector-based GIS tasks,
without the need for additional software, libraries, or complex workarounds. It provides a growing suite of spatial
data management and analysis functions that are both fast and functional.

fTools is now automatically installed and enabled in new versions of QGIS, and as with all plugins, it can be
disabled and enabled using the Plugin Manager (See Section Loading a QGIS Core Plugin). When enabled, the
fTools plugin adds a Vector menu to QGIS, providing functions ranging from Analysis and Research Tools to
Geometry and Geoprocessing Tools, as well as several useful Data Management Tools.

19.9.1 Analysis tools

Icon Tool Purpose

Distance
Matrix

Measure distances between two point layers, and output results as a) Square distance
matrix, b) Linear distance matrix, or c) Summary of distances. Can limit distances to
the k nearest features.

Sum line
length

Calculate the total sum of line lengths for each polygon of a polygon vector layer.

Points in
polygon

Count the number of points that occur in each polygon of an input polygon vector layer.

List unique
values

List all unique values in an input vector layer field

Basic
statistic

Compute basic statistics (mean, std dev, N, sum, CV) on an input field.

Nearest
Neighbor
analysis

Compute nearest neighbor statistics assess the level of clustering in a point vector layer

Mean
coordinate(s)

Compute either the normal or weighted mean center of an entire vector layer, or
multiple features based on a unique ID field.

Line
intersections

Locate intersections between lines, and output results as a point shapefile. Useful for
locating road or stream intersections, ignores line intersections with length > 0.

Table Ftools 1: fTools Analysis tools

222 Hoofdstuk 19. Plugins



QGIS User Guide, Release 1.8

19.9.2 Research tools

Icon Tool Purpose

Random selection Randomly select n number of features, or n percentage of features

Random selection
within subsets

Randomly select features within subsets based on a unique ID field.

Random points Generate pseudo-random points over a given input layer.

Regular points Generate a regular grid of points over a specified region and export them as a
point shapefile.

Vector grid Generate a line or polygon grid based on user specified grid spacing.

Select by location Select features based on their location relative to another layer to form a new
selection, or add or subtract from the current selection.

Polygon from layer
extent

Create a single rectangular polygon layer from the extent of an input raster or
vector layer.

Table Ftools 2: fTools Research tools

19.9.3 Geoprocessing tools

Icon Tool Purpose

Convex hull(s) Create minimum convex hull(s) for an input layer, or based on an ID field.

Buffer(s) Create buffer(s) around features based on distance, or distance field.

Intersect Overlay layers such that output contains areas where both layers intersect.

Union Overlay layers such that output contains intersecting and non-intersecting areas.

Symmetrical
difference

Overlay layers such that output contains those areas of the input and difference
layers that do not intersect.

Clip Overlay layers such that output contains areas that intersect the clip layer.

Difference Overlay layers such that output contains areas not intersecting the clip layer.

Dissolve Merge features based on input field. All features with identical input values are
combined to form one single feature.

Table Ftools 3: fTools Geoprocessing tools
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19.9.4 Geometry tools

Icon Tool Purpose

Check geometry Check polygons for intersections, closed-holes, and fix node ordering.

Export/Add
geometry columns

Add vector layer geometry info to point (XCOORD, YCOORD), line
(LENGTH), or polygon (AREA, PERIMETER) layer.

Polygon centroids Calculate the true centroids for each polygon in an input polygon layer.

Delaunay
triangulation

Calculate and output (as polygons) the delaunay triangulation of an input point
vector layer.

Voronoi Polygons Calculate voronoi polygons of an input point vector layer.

Simplify geometry Generalize lines or polygons with a modified Douglas-Peucker algorithm.
Densify geometry Densify lines or polygons by adding vertices

Multipart to
singleparts

Convert multipart features to multiple singlepart features. Creates simple
polygons and lines.

Singleparts to
multipart

Merge multiple features to a single multipart feature based on a unique ID field.

Polygons to lines Convert polygons to lines, multipart polygons to multiple singlepart lines.

Lines to polygons Convert lines to polygons, multipart lines to multiple singlepart polygons.

Extract nodes Extract nodes from line and polygon layers and output them as points.

Table Ftools 4: fTools Geometry tools

Notitie: The Simplify geometry tool can be used to remove duplicate nodes in line and polygon geometries, just
set the Simplify tolerance parameter to 0 and this will do the trick.

19.9.5 Data management tools

Icon Tool Purpose

Define
projection

Specify the CRS for shapefiles whose CRS has not been defined.

Join
attributes by
location

Join additional attributes to vector layer based on spatial relationship. Attributes from
one vector layer are appended to the attribute table of another layer and exported as a
shapefile.

Split vector
layer

Split input layer into multiple separate layers based on input field.

Merge
shapefiles to
one

Merge several shapefiles within a folder into a new shapefile based on the layer type
(point, line, area).

Create
spatial index

Create a spatial index for OGR supported formats.

Table Ftools 5: fTools Data management tools
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19.10 GDAL Tools Plugin

19.10.1 What is GDALTools?

The GDAL Tools plugin offers a GUI to the collection of tools in the Geospatial Data Abstraction Library,
http://gdal.osgeo.org . These are raster management tools to query, re-project, warp and merge a wide variety
of raster formats. Also included are tools to create a contour (vector) layer, or a shaded relief from a raster DEM,
and to make a vrt (Virtual Raster Tile in XML format) from a collection of one or more raster files. These tools
are available when the plugin is installed and activated.

The GDAL Library

The GDAL library consists of a set of command line programs, each with a large list of options. Users comfortable
with running commands from a terminal may prefer the command line, with access to the full set of options. The
GDALTools plugin offers an easy interface to the tools, exposing only the most popular options.

19.10.2 List of GDAL tools

Figuur 19.15: The GDALTools menu list

Projections

Warp
(Reproject)

This utility is an image mosaicing, reprojection and warping utility. The program can
reproject to any supported projection, and can also apply GCPs stored with the image if the
image is “raw” with control information. For more information you can read on the GDAL
website http://www.gdal.org/gdalwarp.html

Assign
projection

This tool allows to assign projection to rasters that already georeferenced but miss projection
information. Also with it help it is possible to alter existing projection definition. Both single
file and batch mode are supported. For more information please visit utility page at GDAL site
http://www.gdal.org/gdalwarp.html

Extract
projection

This utility helps you to extract projection information from an input file. If you want to
extract projection from a whole directory you can use the Batch mode. It creates both .prj
and .wld files.
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Conversion

Rasterize
This program burns vector geometries (points, lines and polygons) into the raster band(s) of a
raster image. Vectors are read from OGR supported vector formats. Note that the vector data
must in the same coordinate system as the raster data; on the fly reprojection is not provided. For
more information see http://www.gdal.org/gdal_rasterize.html

Poly-
gonize

This utility creates vector polygons for all connected regions of pixels in the raster sharing a
common pixel value. Each polygon is created with an attribute indicating the pixel value of that
polygon. The utility will create the output vector datasource if it does not already exist,
defaulting to ESRI shapefile format. See also http://www.gdal.org/gdal_polygonize.html

Translate
This utility can be used to convert raster data between different formats, potentially performing
some operations like subsettings, resampling, and rescaling pixels in the process. For more
information you can read on http://www.gdal.org/gdal_translate.html

RGB
to PCT

This utility will compute an optimal pseudo-color table for a given RGB image using a median
cut algorithm on a downsampled RGB histogram. Then it converts the image into a
pseudo-colored image using the color table. This conversion utilizes Floyd-Steinberg dithering
(error diffusion) to maximize output image visual quality. The utility is also desribed at
http://www.gdal.org/rgb2pct.html

PCT
to RGB

This utility will convert a pseudocolor band on the input file into an output RGB file of the
desired format. For more information see http://www.gdal.org/pct2rgb.html

Extraction

Con-
tour

This program generates a vector contour file from the input raster elevation model (DEM). On
http://www.gdal.org/gdal_contour.html you can find more information.

Clip-
per

This utility allows to clip (extract subset) raster using selected extent or based on mask layer
bounds. More information can be found at http://www.gdal.org/gdal_translate.html.
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Analysis

Sieve This utility removes raster polygons smaller than a provided threshold size (in pixels) and
replaces them with the pixel value of the largest neighbor polygon. The result can be written
back to the existing raster band, or copied into a new file. For more information see
http://www.gdal.org/gdal_sieve.html .

Near
Black

This utility will scan an image and try to set all pixels that are nearly black (or nearly white)
around the edge to exactly black (or white). This is often used to “fix up” lossy compressed
aerial photos so that color pixels can be treated as transparent when mosaicing. See also
http://www.gdal.org/nearblack.html .

Fill
nodata

This utility fills selection raster regions (usually nodata areas) by interpolation from valid
pixels around the edges of the area. On http://www.gdal.org/gdal_fillnodata.html you can
find more information.

Proximity This utility generates a raster proximity map indicating the distance from the center of each
pixel to the center of the nearest pixel identified as a target pixel. Target pixels are those in
the source raster for which the raster pixel value is in the set of target pixel values. For more
information see http://www.gdal.org/gdal_proximity.html .

Grid This utility creates regular grid (raster) from the scattered data read from the OGR
datasource. Input data will be interpolated to fill grid nodes with values, you can choose from
various interpolation methods. The utility is also described on the GDAL website
http://www.gdal.org/gdal_grid.html .

DEM
terrain
models

Tools to analyze and visualize DEMs. It can create a shaded relief, a slope, an aspect, a color
relief, a Terrain Ruggedness Index, a Topographic Position Index and a roughness map from
any GDAL-supported elevation raster. For more information you can read on
http://www.gdal.org/gdaldem.html

Miscellaneous

Build
Virtual
Raster

This program builds a VRT (Virtual Dataset) that is a mosaic of the list of input gdal datasets.
See also http://www.gdal.org/gdalbuildvrt.html .

Merge This utility will automatically mosaic a set of images. All the images must be in the same
coordinate system and have a matching number of bands, but they may be overlapping, and at
different resolutions. In areas of overlap, the last image will be copied over earlier ones. The
utility is also described on http://www.gdal.org/gdal_merge.html .

Information
This utility lists various information about a GDAL supported raster dataset. On
http://www.gdal.org/gdalinfo.html you can find more information.

Build
Overviews

The gdaladdo utility can be used to build or rebuild overview images for most supported file
formats with one of several downsampling algorithms. For more information see
http://www.gdal.org/gdaladdo.html .

Tile
Index

This utility builds a shapefile with a record for each input raster file, an attribute containing
the filename, and a polygon geometry outlining the raster. See also
http://www.gdal.org/gdaltindex.html .
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19.11 Georeferencer Plugin

The Georeferencer Plugin is a tool for generating world files for rasters. It allows you to reference rasters to
geographic or projected coordinate systems by creating a new GeoTiff or by adding a world file to the existing
image. The basic approach to georeferencing a raster is to locate points on the raster for which you can accurately
determine their coordinates.

Features
Icon Purpose Icon Purpose

Open raster Start georeferencing

Generate GDAL Script Load GCP Points

Save GCP Points As Transformation settings

Add Point Delete Point

Move GCP Point Pan

Zoom In Zoom Out

Zoom To Layer Zoom Last

Zoom Next Link Georeferencer to QGIS

Link QGIS to Georeferencer

Table Georeferencer 1: Georeferencer Tools

19.11.1 Usual procedure

As X and Y coordinates (DMS (dd mm ss.ss), DD (dd.dd) or projected coordinates (mmmm.mm) which corre-
spond with the selected point on the image, two alternative procedures can be used:

• The raster itself sometimes provides crosses with coordinates “written” on the image. In this case you can
enter the coordinates manually.

• Using already georeferenced layers, this can be either vector or raster data that contain the same ob-
jects/features that you have on the image that you want to georeference and the projection you want to
have your image. In this case you can enter the coordinates by clicking on the reference dataset loaded in
QGIS map canvas.

The usual procedure for georeferencing an image involves selecting multiple points on the raster, specifying their
coordinates, and choosing a relevant transformation type. Based on the input parameters and data, the plugin will
compute the world file parameters. The more coordinates you provide, the better the result will be.

The first step is to start QGIS, load the Georeferencer Plugin (see Section Loading a QGIS Core Plugin) and click

on the Georeferencer icon which appears in the QGIS toolbar menu. The Georeferencer Plugin dialog appears as
shown in figure_georeferencer_1.

For this example, we are using a topo sheet of South Dakota from SDGS. It can later be visualized to-
gether with the data from the GRASS spearfish60 location. You can download the topo sheet here:
http://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz.

Entering ground control points (GCPs)

1. To start georeferencing an unreferenced raster, we must load it using the button. The raster will show
up in the main working area of the dialog. Once the raster is loaded, we can start to enter reference points.
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Figuur 19.16: Georeferencer Plugin Dialog

2. Using the Add Point button, add points to the main working area and enter their coordinates (see Figure
figure_georeferencer_2). For this procedure you have three options:

• Click on a point in the raster image and enter the X and Y coordinates manually.

• Click on a point in the raster image and choose the button from map canvas to add the X and Y coordi-
nates with the help of a georeferenced map already loaded in the QGIS map canvas.

• With the button, you can move the GCPs in both windows, if they are at the wrong place.

3. Continue entering points. You should have at least 4 points, and the more coordinates you can provide, the
better the result will be. There are additional tools on the plugin dialog to zoom and pan the working area
in order to locate a relevant set of GCP points.

Figuur 19.17: Add points to the raster image

The points that are added to the map will be stored in a separate text file ([filename].points) usually
together with the raster image. This allows us to reopen the Georeferencer plugin at a later date and add new
points or delete existing ones to optimize the result. The points file contains values of the form: mapX, mapY,

pixelX, pixelY. You can use the Load GCP Points and Save GCP Points buttons to manage the files.

Within the GCP table you can click on a column header and therewith enable e.g. numerical sorting. The GCP list
is automatically updated.

Defining the transformation settings

After you have added your GCPs to the raster image, you need to define the transformation settings for the
georeferencing process.
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Figuur 19.18: Defining the georeferencer transformation settings

Available Transformation algorithms

Depending on how many ground control point you have captured, you may want to use different transformation
algorithms. Choice of transformation algorithm is also dependent on the type and quality of input data and the
amount of geometric distortion that you are willing to introduce to final result.

Currently, following algorithms are available:

• The Linear algorithm is used to create a world-file, and is different from the other algorithms, as it does
not actually transform the raster. This algorithm likely won’t be sufficient if you are dealing with scanned
material.

• The Helmert transformation performs simple scaling and rotation transformations.

• The Polynomial algorithms 1-3 are among the most widely used algorithms for georeferencing, and each
one differs by the degree of distortion introduced to match source and destination ground control points.
The most widely used polynomial algorithm is the second order polynomial transformation, which allows
some curvature. First order polynomial transformation (affine) preserves colliniarity and allows scaling,
translation and rotation only.

• The Thin plate spline (TPS) algorithm is a more modern georeferencing method, which is able to intro-
duce local deformations in the data. This algorithm is useful when very low quality originals are being
georeferenced.

• The Projective transformation is a linear rotation and translation of coordinates.

Define the Resampling method

The type of resampling you choose will likely depending on your input data and the ultimate objective of the
exercise. If you don’t want to change statistics of the image, you might want to choose ‘Nearest neighbour’,
whereas a ‘Cubic resampling’ will likely provide a more smoothed result.

It is prossible to choose between five different resampling methods.

1. Nearest neighbour

2. Linear

3. Cubic
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4. Cubic Spline

5. Lanczos

Define the transformation settings

There are several options that need to be defined for the georeferenced output raster.

• The checkbox Create world file is only available, if you decide to use the linear transformation type,
because this means that the raster image actually won’t be transformed. In this case, the field Output raster
is not activated, because only a new world-file will be created.

• For all other transformation type you have to define an Output raster. As default a new file ([file-
name]_modified) will be created in the same folder together with the original raster image.

• As a next step you have to define the Target SRS (Spatial Reference System) for the georeferenced raster
(see section Werken met Projecties).

• If you like, you can generate a pdf map and also a pdf report. The report includes information about the
used transformation parameters. An image of the residuals and a list with all GCPs and their RMS errors.

• Furthermore you can activate the Set Target Resolution checkbox and define pixel resolution of the
output raster. Default horizontal and vertical resolution is 1,

• The Use 0 for transparency when needed can be activated, if pixels with the value 0 shall be visualized
transparent. In our example toposheet all white areas would be transparent.

• Finally Load in QGIS when done loads the output raster automatically into the QGIS map canvas when
the transformation is done.

Show and adapt raster properties

Clicking on the Raster properties dialog in the Settings menu opens the raster properties of the layer that you want
to georeference.

Configure the georeferencer

• You can define if you want to show GCP coordiniates and/or IDs.

• As residual units pixels and map units can be chosen.

• For the PDF report a left and right margin can be defined and you can also set the paper size for the PDF
map.

• Finally you can activate to show georeferencer window docked.

Running the transformation

After all GCPs have been collected and all transformation settings are defined, just press the button
Start georeferencing to create the new georeferenced raster.

19.12 Interpolation Plugin

The Interplation plugin can be used to generate a TIN or IDW interpolation of a point vector layer. It is very
simple to handle and provides an intuitive graphical user interface for creating interpolated raster layers (See
Figure_interpolation_1). The plugin requires the following parameters to be specified before running:
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• Input vector layer: Specify the input point vector layer(s) from a list of loaded point layers. If several
layers are specified, then data from all layers is used for interpolation. Note: It is possible to insert lines or
polygons as constraints for the triangulation, by specifying either “points”, “structure lines” or “break lines”

in the Type combobox.

• Interpolation attribute: Select attribute column to be used for interpolation or enable the Use Z-
Coordinate checkbox to use the layers stored Z values.

• Interpolation Method: Select interpolation method. This can be either ‘Triangulated Irregular Network
(TIN)’ or ‘Inverse Distance Weighted (IDW)’.

• Number of columns/rows: Specify the number row and colums for the output raster file.

• Output file: Specify a name for the output raster file.

Figuur 19.19: Interpolation Plugin

19.12.1 Using the plugin

1. Start QGIS and load a point vector layer (e.g., elevp.csv).

2. Load the Interpolation plugin in the Plugin Manager (see Section Loading a QGIS Core Plugin) and click

on the Interpolation icon which appears in the QGIS toolbar menu. The Interpolation plugin dialog appears
as shown in Figure_interpolation_1.

3. Select an input layer (e.g., elevp ) and column (e.g., ELEV) for interpolation.

4. Select an interpolation method (e.g. ‘Triangulated Irregular Network (TIN)’), and specify a cellsize of 5000
as well as the raster output filename (e.g., elevation_tin).

5. Click [OK].

6. For the current example, double click elevation_tin in the layer list to open the raster Layer Properties

dialog and select ‘Pseudocolor’ as Color Map in the Symbology tab. Or you can define a new color
table as described in section Werken met Raster data.

19.13 MapServer Export Plugin

You can use QGIS to ‘compose’ your map by adding and arranging layers, symbolizing them, customizing the
colors and then creating a map file for MapServer.

Notitie: Currently the plugin only works when you use ‘Old Symbology’ in QGIS. ‘New Symbology’ is not yet
supported.
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19.13.1 Creating the Project File

The MapServer Export Plugin operates on a saved QGIS project file and not on the current contents of the map
canvas and legend. This has been a source of confusion for a number of users. As described below, before you start
using the MapServer Export Plugin, you need to arrange the raster and vector layers you want to use in MapServer
and save this status in a QGIS project file.

Figuur 19.20: Arrange raster and vector layers for QGIS project file

In this example, we demonstrate the four steps required to create a simple project file which can be used to create
the MapServer map file. We use raster and vector files from the QGIS sample dataset Voorbeeld Data.

1. Add the raster layer landcover.tif clicking on the Add Raster Layer icon.

2. Add the vector Shapefiles lakes.shp, majrivers.shp and airports.shp from the QGIS sample

dataset clicking on the Add Vector Layer icon.

3. Change the colors and symbolize the data as you like (for example see figure_mapserver_export_1)

4. Save a new project named mapserverproject.qgs using File → Save Project.

19.13.2 Creating the Map File

To use the Mapserver Export plugin from within QGIS, you need to enable the MapServer Export Plugin first
using the Plugin Manager (see Loading a QGIS Core Plugin).
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Figuur 19.21: Export to MapServer Dialog

Map file Enter the name for the map file to be created. You can use the button at the right to browse for
the directory where you want the map file created.

Qgis
project
file

Enter the full path to the QGIS project file (.qgs) you want to export. You can use the button at
the right to browse for the QGIS project file.

Map
Name

A name for the map. This name is prefixed to all images generated by the mapserver.

Map
Width

Width of the output image in pixels.

Map
Height

Height of the output image in pixels.

Map
Units

Units of measure used for output.

Image
type

Format for the output image generated by MapServer

Web
Template

Full path to the MapServer template file to be used with the map file

Web
Header

Full path to the MapServer header file to be used with the map file

Web
Footer

Full path to the MapServer footer file to be used with the map file

Only the inputs Map file and QGIS project file are required to create a map file, however by omitting the other
parameters, you may end up creating a non-functional map file, depending on your intended use. Although QGIS
is good at creating a map file from your project file, it may require some tweaking to get the results you want. For
this example, we will create a map file using the project file mapserverproject.qgs we just created (see
Figure_mapserver_export_2):

1. Click the MapServer Export icon in the toolbar menu to start the MapServer dialog (see Fig-
ure_mapserver_export_2).

2. Enter the name (e.g., qgisproject.map) for your new map file.

3. Browse and find the QGIS project file (e.g., mapserverproject.qgs) you previously saved.

4. Enter a name (e.g., MyMap) for the map.

5. Enter the width and height (e.g., 600 for the width and 400 for the height) for your output image.

6. For this example, the layers are in meters, so we change the units to meters.

234 Hoofdstuk 19. Plugins



QGIS User Guide, Release 1.8

7. Choose png for the image type.

8. Click [OK] to generate the new map file qgisproject.map. QGIS displays the success of your efforts.

Figuur 19.22: Export to MapServer Succesfull Dialog

You can view the map file in any text editor or visualizer. If you take a look, you’ll notice that the export tool adds
the metadata needed to enable our map file for WMS.

19.13.3 Troubleshooting

If you get error messages from mapserver like:

loadSymbolSet(): Unable to access file. (./symbols/symbols.txt)

or:

msLoadFontset(): Unable to access file. Error opening fontset ./fonts/fonts.txt.

This means that that the map file is requesting for fonts or symbol definition files but that Mapserver cannot find
those.

Either comment the lines containing those names in the map file (this is possible if you do not have labels or use
styles from the symbols.txt). Or create those files (see below).

The most simple fonts.txt file (because arial is used in the QGIS generated map files) contains the following
line

# either relative to the map file or a full path:
arial /usr/share/fonts/truetype/msttcorefonts/arial.ttf

The most simple symbols.txt file contains the definition of a circle symbol (because a circle symbol is used
for point layers)

SYMBOLSET
SYMBOL
NAME "circle"
TYPE ellipse
FILLED true
POINTS
1 1
END
END

END
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19.13.4 Testing the Map File

We can now test our work.

If the map file is accessible for you mapserver cgi you can use the one of the url’s from the success dialog.

Another option is using the shp2img tool to create an image from the map file. The shp2img utility is part of
MapServer and FWTools. To create an image from our map:

• Open a terminal window

• If you didn’t save your map file in your home directory, change to the folder where you saved it.

• Run shp2img -m qgisproject.map -o mapserver\_test.png and display the image

This creates a PNG with all the layers included in the QGIS project file. In addition, the extent of the PNG will be
the same as when we saved the project. As you can see in figure_mapserver_export_4, all information except the
airport symbols are included.

Figuur 19.23: Test PNG created by shp2img with all MapServer Export layers

19.13.5 Using Map File

If you plan to use the map file to serve WMS requests, you probably don’t have to tweak anything. If you plan to
use it with a mapping template or a custom interface, you may have a bit of manual work to do. To see how easy
it is to go from QGIS to serving maps on the web, take a look at Christopher Schmidt’s 5 minute flash video. He
used an older version of QGIS (version 0.8), but the demo applies equally well to newer versions.

19.14 Offline Editing Plugin

For data collection, it is a common situation to work with a laptop or a cell phone offline in the field. Upon
returning to the network, the changes need to be synchronized with the master data source, e.g. a PostGIS database.
If several persons are working simultaneously on the same datasets, it is difficult to merge the edits by hand, even
if people don’t change the same features.

The Offline Editing Plugin automates the synchronisation by copying the content of a datasource (usually PostGIS
or WFS-T) to a SpatiaLite database and storing the offline edits to dedicated tables. After being connected to the
network again, it is possible to apply the offline edits to the master dataset.
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19.14.1 Using the plugin

• Open some vector layers, e.g. from a PostGIS or WFS-T datasource

• Save it as a project

• Press the Convert to offline project icon and select the layers to save. The content of the layers is saved to
SpatiaLite tables.

• Edit the layers offline.

• After being connected again, upload the changes with the Synchronize button.

Figuur 19.24: Create an offline project from PostGIS or WFS layers

19.15 Oracle GeoRaster Plugin

In Oracle databases, raster data can be stored in SDO_GEORASTER objects available with the Oracle Spatial

extension. In QGIS, the OracleGeoRasterPlugin is supported by GDAL, and depends on Oracle’s database product
being installed and working on your machine. While Oracle is proprietary software, they provide their software
free for development and testing purposes. Here is one simple example of how to load raster images to GeoRaster:

$ gdal_translate -of georaster input_file.tif geor:scott/tiger@orcl

This will load the raster into the default GDAL_IMPORT table, as a column named RASTER.

19.15.1 Managing connections

Firstly, the Oracle GeoRaster Plugin must be enabled using the Plugin Manager (see Section Loading a QGIS
Core Plugin). The first time you load a GeoRaster in QGIS, you must create a connection to the Oracle database

that contains the data. To do this, begin by clicking on the Select GeoRaster toolbar button, it will open the Select
Oracle Spatial GeoRaster dialog window. Click on [New] to open the dialog window, and specify the connection
parameters (See Figure_oracle_raster_1):

• Name: Enter a name for the database connection
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• Database instance: Enter the name of the database that you will connect to

• Username: Specify your own username that you will use to access the database

• Password: The password associated with your username that is required to access the database

Figuur 19.25: Create Oracle connection dialog

Now, back on the main Oracle Spatial GeoRaster dialog window (see Figure_oracle_raster_2), use the drop-down
list to choose one connection, and use the [Connect] button to establish a connection. You may also [Edit] the
connection by opening the previous dialog and making changes to the connection information, or use the [Delete]
button to remove the connection from the drop-down list.

19.15.2 Selecting a GeoRaster

Once a connection has been established, the sub-datasets window will show the names of all the tables that contains
GeoRaster columns in that database in the format of a GDAL subdataset name.

Click on one of the listed subdatasets and then click on [Select] to choose the table name. Now another list of
subdatasets will show with the names of GeoRaster columns on that table. This is usually a short list, since most
users will not have more than one or two GeoRaster columns on the same table.

Click on one of the listed subdatasets and then click on [Select] to choose one of the the table/column combination.
The dialog will now show all the rows that contains GeoRaster objects. Note that the subdataset list will now show
the Raster Data Table and Raster Id’s pairs.

At anytime the Selection entry can be edited in order to go directly to a known GeoRaster or to go back to the
beginning and select another table name.

The Selection data entry can also be used to enter a Where clause at the end of the iden-
tification string, e.g. geor:scott/tiger@orcl,gdal_import,raster,geoid=. See
http://www.gdal.org/frmt_georaster.html for more information.

19.15.3 Displaying GeoRaster

Finally, by selecting a GeoRaster from the list of Raster Data Table and Raster Id’s, the raster image will be loaded
into QGIS.

The Select Oracle Spatial GeoRaster dialog can be closed now and next time it opens it will keep the same
connection, and will show the same previous list of subdataset making it very easy to open up another image from
the same context.

Notitie: GeoRasters that contains pyramids will display much faster but the pyramids need to be generated
outside of QGIS using Oracle PL/SQL or gdaladdo.

The following is example using gdaladdo:
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Figuur 19.26: Select Oracle GeoRaster dialog

gdaladdo georaster:scott/tiger@orcl,georaster\_table,georaster,georid=6 \
-r nearest 2 4 6 8 16 32

This is an example using PL/SQL:

$ sqlplus scott/tiger
SQL> DECLARE
gr sdo_georaster;

BEGIN
SELECT image INTO gr FROM cities WHERE id = 1 FOR UPDATE;
sdo_geor.generatePyramid(gr, ’rLevel=5, resampling=NN’);
UPDATE cities SET image = gr WHERE id = 1;
COMMIT;

END;

19.16 Raster Terreinanalyses Plugin

Met de Raster Terreinanalyses Plugin kunnen berekeningen worden gedaan op basis van een digitaal ter-
reinmodel (DEM). Het werkt heel eenvoudig met behulp van de grafische interface waarmee nieuwe rasterlagen
kunnen worden gemaakt (Zie Figure_raster_terrain_1).

Beschrijving van de analyses:

• Slope: Berekent de hellingshoek van het terrein in graden (gebaseerd op een schatting van de eerste orde
afgeleide).

• Aspect: Berekent de richting van de afloop van het terrein in graden (met de klok mee vanaf het Noorden).

• Hillshade: Berekent de schaduw waarmee een beter 3-dimensionaal beeld van het terrein kan worden
gegeven.

• Ruggedness Index: Een berekening van terreinverschillen zoals beschreven door Riley et al. (1999). Voor
elke gridcel worden de hoogteverschillen met de 8 aangrenzenden cellen opgeteld.

• Relief: Genereert een hoogtekaart met kleur en schaduw op basis van een DEM. Daarbij wordt op basis van
de data bepaald hoe de hoogten worden geclassificeerd.
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Figuur 19.27: Raster Terrain Modelling Plugin (slope calculation)

19.16.1 Gebruik van de plugin

1. Start QGS en voeg de rasterlaag gtopo30 uit de GRASS voorbeeldlocatie toe.

2. Laadt de Raster Terreinanalyses Plugin met de Plugin-manager (zie hoofdstuk Loading a QGIS Core Plugin)

3. Selecteer de gewenste analyse via het menu (bijv. Raster → Terrain Analysis → Slope →). Het dialoogven-
ster Slope verschijnt zoals te zien is in Figure_raster_terrain_1.

4. Voer een map en bestandsnaam in.

5. Klik [OK].

19.17 Heatmap Plugin

De Heatmap plugin geeft de mogelijkheid om een heatmap te creeeren vanuit een vector punten kaartlaag. Een
heatmap (hittekaart) is een rasterkaart die de dichtheid of relevantie van puntgerelateerde gegevens toont. Het
resultaat geeft de “hotspots” weer.

19.17.1 De Heatmap plugin activeren

Eerst dient deze standaard plugin geactiveerd te worden gebruik makende van de Plugin Manager (zie par. Loading
a QGIS Core Plugin). Na activatie is het icoon van de heatmap plugin zichtbaar op de Raster werkbalk.

Selecteer via het menu Beeld → Werkbalken → Raster om de Raster werkbalk te activeren wanneer deze nog niet
actief is.

19.17.2 Gebruik van de Heatmap plugin

Het Heatmap icoon op de Raster werkbalk start de dialoog van de Heatmap plugin (zie figure_heatmap_2).

Het dialoog heeft de volgende opties:
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• Input punten-vectorlaag dialoog: Hiermee selecteer je een geladen punten vector kaartlaag.

• Output Raster: Via de browse knop kun je naar een folder navigeren en een naam geven aan het
rasterbestand dat gegenereerd zal worden. Het is niet nodig een bestandsextensie mee te geven

• Uitvoerformaat: Selectie van het soort rasterbestand. Alhoewel uit alle door GDAL ondersteunde formaten
gekozen kan worden is het GeoTIFF formaten in de meeste gevallen het beste formaat. Dit formaat onder-
steund, bijvoorbeeld ondersteuning voor het toevoegen van interne overzichtsrasters zodat kaarten sneller
getekend worden, wat veelal ontbreekt voor andere raster formaten.

• Straal: Geef hiermee de straal in meters of kaarteenheden. Wanneer de straal te klein worden gekozen krijg
je geen mooie heatmap. In plaatsen waar meer circels elkaar rond puntwaarden elkaar overlappen zullen
fellere hotspots ontstaan!

• Afnamewaarde: gebruik dit veld om aan te geven in welke mate de hitte afneemt vanuit het centrum.

– Wanneer 0 wordt gegeven (= minimum) zal de hitte geconcentreerd zijn in het centrum en volledig
gedoofd zijn aan de rand van gegeven straal.

– Wanneer 10 wordt gegeven (=maximum) is de hitte het sterkst aan de rand en in het centrum is deze
volledig gedoofd. Hogere waarden ingeven mag maar heeft geen effect.

– Wanneer 1 wordt gegeven dan is de hitte gelijk verdeeld over de circel.

– Wanneer een negatieve afnamewaarde is gegeven zal er een Coolmap in plaats van een Heatmap wor-
den gegenereerd!

Wanneer het aanvinkvakje Geavanceerd is aangevinkt zal dit toegang geven tot extra geavanceerde instellin-
gen.

• Rij en Kolom kunnen worden gebruikt om de pixelgrootte van het te genereren raster in te stellen. Meer rijen
en kolommen betekent een kleinere pixelgrootte en de bestandsgrootte van het raster die gegenereerd wordt
zal groeien en de generatie zal meer tijd kosten. Wanneer het aantal rijen wordt verdubbeld zal automatisch
ook het aantal kolommen worden verdubbeld. De celgrootte (hoogte/breedte) zal worden gehalveerd. De
grootte van de rasterkaart blijft hetzelfde!

• Celgrootte X en Celgrootte Y beinvloeden rechtsstreeks de pixelgrootte. Het aantal rijen en kolommen zal
mee wijzigen.

De punten vector laag kan attribuutvelden bevatten die gebruikt kunnen worden voor het aanmaken van de
heatmap:

• Gebruik straal uit veld: Zet de straal vanuit een attribuutveld.

• Gebruik gewicht uit veld: Hiermee wordt de wegingsfactor gezet vanuit een attribuutveld.

Wanneer het ouput raster is gegeven, kan de [OK] knop gebruikt worden om een heatmap te maken. Het eerste
resultaat is een grijs vlak dat nog een nabehandeling nodig heeft om er een heatmap van te maken.

Waarschuwing: Wijzigen van de raster formaat eigenschappen
Wanneer de raster formaat eigenschappen worden gewijzigd, heeft dit invloed op het eindresultaat van de
heatmap. De hotspot gebieden zullen veranderen in grootte.

19.17.3 Creatie van de Heatmap

Als voorbeeld zal de airports vector punten laag van de QGIS voorbeeld dataset worden gebruikt (zie
Voorbeeld Data). Een andere goede QGIS tutorial voor het maken van heatmaps kan gevonden worden op
http://qgis.spatialthoughts.com.

Figure_Heatmap_1 toont de vliegvelden van Alaska.

1. Selecteer de Heatmap knop. De heatmap dialoog wordt geopend (zie Figure_Heatmap_2).
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Figuur 19.28: Airports of Alaska

2. Voor het veld Input punten-vectorlaag selecteer airport uit de lijst van geladen vector lagen
met punten in het huidige project.

3. Voor het veld Output Raster geef de naam en folder van het uitvoer raster bestand gebruik makende van de

browse knop . Geef het uitvoerbestand de naam heatmap_airports, het geven van een bestand-
sextensie is niet nodig.

4. Voor het veld Uitvoerformaat kies GeoTIFF.

5. Voor het veld Straal geef 1000000 meter.

6. De standaardwaarde 0.1 voor het veld Afnamewaarde is prima.

7. Druk vervolgens op [OK] om de nieuwe raster map te genereren en te laden (zie Figure_Heatmap_3).

Figuur 19.29: The Heatmap Dialog

Het resultaat na het laden is waarschijnlijk niet wat er van verwacht wer. Het is nog steeds een grijs vlak zonder
enige variatie. Eerst dient de laag zelf nog aanvullend geconfigureerd worden voordat de heatmap zal verschijnen.

1. Open de dialoog Eigenschappen voor de laag heatmap_airports (selecteer de laag
heatmap_airports, druk op de rechtermuisknop en selecteer in het snelmenu Eigenschappen).

2. Selecteer het tabblad Stijl.

3. Onder het deel Enkelbands eigenschappen wijzig het veld Kleurenpalet van ‘Grijstinten’ naar
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Figuur 19.30: The heatmap after loading looks like a grey surface

‘Pseudocolor’.

4. Druk op de knop [Apply].

5. Ga vervolgens naar het tabblad Transparantie en zet de schuifschaal Globale
transparantie naar 40%.

6. Selecteer [OK]

Het resultaat wordt getoond in Figure_Heatmap_4.

Figuur 19.31: Final result of heatmap created of airports of Alaska

19.18 Road Graph Plugin

The Road Graph Plugin is a C++ plugin for QGIS, that calculates the shortest path between two points on any
polyline layer and plots this path over the road network.

Main features:

• calculate path, it’s length and travel time

• optimize by length or by travel time

• export path to a vector layer
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Figuur 19.32: Road Graph Plugin

• highlight roads directions (this is slow and used mainly for debug purposes and for the settings testing)

As a roads layer you can use any polyline vector layer in any QGIS supported format. Two lines with a common
point are considered connected. Please note, it is required to use layer CRS as project CRS while editing roads
layer. This is due to the fact that recalculation of the coordinates between different CRS introduce some errors
that can result in discontinuities, even when ‘snapping’ is used.

In the layer attribute table the following fields can be used:

• speed on road section — numeric field;

• direction — any type, that can be casted to string. Forward and reverse directions are correspond to the
one-way road, both directions — two-way road

If some fields don’t have any value or do not exist — default values are used. You can change defaults and some
plugin settings in plugin settings dialog.

19.18.1 Using the plugin

After plugin activation you will see an additional panel on the left side of the main QGIS window. Now make
some definitions to the Road graph plugin settings dialog in the menu Vector → Road Graph.

Select a Start and a Stop point in the road network layer and click on [Calculate].

19.19 Spatial Query Plugin

The Spatial Query plugin allows to make a spatial query (select features) in a target layer with reference to another
layer. The functionality is based on the GEOS library and depends on the selected source feature layer.

Possible operators are:

• Contains

• Equals

• Overlap
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• Crosses

• Intersects

• Is disjoint

• Touches

• Within

19.19.1 Using the plugin

As an example we want to find regions in the Alaska dataset that contain airports. Following steps are necessary:

1. Start QGIS and load the vector layers regions.shp and airports.shp.

2. Load the Spatial Query plugin in the Plugin Manager (see Section Loading a QGIS Core Plugin) and click

on the Spatial Query icon which appears in the QGIS toolbar menu. The plugin dialog appears.

3. Select layer regions as source layer and airports as reference feature layer.

4. Select ‘Contains’ as operator and click [Apply].

Now you get a list of feature IDs from the query and you have several options as shown in figure_spatial_query_1.

• Click on the Create layer with list of items

• Select an ID from the list and click on Create layer with selected

• Select the ‘Remove from current selection’ in the field And use the result to .

• Additionally you can Zoom to item or display Log messages.

Figuur 19.33: Spatial Query analysis - regions contain airports

19.20 SPIT Plugin

QGIS comes with a plugin named SPIT (Shapefile to PostGIS Import Tool). SPIT can be used to load multiple
shapefiles at one time and includes support for schemas. To use SPIT, open the Plugin Manager from the Plugins
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menu, check the box next to the SPIT plugin and click [OK]. The SPIT icon will be added to the plugin
toolbar.

To import a shapefile, click on the SPIT tool in the toolbar to open the SPIT - Shapefile to PostGIS Import
Tool dialog. Select the PostGIS database you want to connect to and click on [Connect]. If you want, you can
define or change some import options. Now you can add one or more files to the queue by clicking on the [Add]
button. To process the files, click on the [OK] button. The progress of the import as well as any errors/warnings
will be displayed as each shapefile is processed.

Figuur 19.34: Using SPIT Plugin to import Shape files to PostGIS

Tip: Importing Shapefiles Containing PostgreSQL Reserved Words
If a shapefile is added to the queue containing fields that are reserved words in the PostgreSQL database a dialog
will popup showing the status of each field. You can edit the field names prior to import and change any that are
reserved words (or change any other field names as desired). Attempting to import a shapefile with reserved words
as field names will likely fail.

19.21 SQL Anywhere Plugin

SQL Anywhere is a proprietary relational database management system (RDBMS) from Sybase. SQL Anywhere
includes spatial support including OGC, shape files etc. and built in functions to export to KML, GML and SVG
formats.

Figuur 19.35: SQL Anywhere dialog (KDE)
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The SQL Anywhere allows to connect to spatialy enabled SQL Anywhere databases. The Add SQL Anywhere
layer dialog is similar in functionality to the dialogs for PostGIS and SpatiaLite.

19.22 Zonal Statistics Plugin

With the Zonal Statistics Plugin you can analyze the results of a thematic classification. It allows to calculate several
values of the pixels of a raster layer with the help of a polygonal vector layer (see figure_zonal_statistics). You can
calculate the sum, the mean value and the total count of the pixels that are within a polygon. The plugin generates
output columns in the vector layer with a user-defined prefix.

Figuur 19.36: Zonal statistics dialog (KDE)
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HOOFDSTUK 20

Ondersteuning

20.1 Mailinglijsten

QGIS is constant in ontwikkeling. Mocht je hulp nodig hebben of tegen fouten aanlopen, meld je dan aan op
de qgis-users mailinglijst. Je vragen zullen dan door meerdere mensen worden gelezen en ook anderen kunnen
profiteren van de antwoorden.

20.1.1 qgis-users [Engelstalig]

Deze mailinglijst wordt gebruikt voor algemene vragen en discussies over QGIS en vragen over in-
stallatie en gebruik. Je kunt je aanmelden voor de qgis-users mailinglijst via de volgende link:
http://lists.osgeo.org/mailman/listinfo/qgis-user

20.1.2 osgeo.nl

Voor nederlandstaligen is er de osgeo.nl mailinglijst. Op deze lijst worden algemene vragen en discussies gevoerd
in het nederlands en komen specifieke nederlandse onderwerpen aan bod zoals het Rijksdriehoekstelsel. Je kunt
je aanmelden voor de osgeo.nl mailinglijst via http://lists.osgeo.org/mailman/listinfo/dutch

20.1.3 qgis-developer [Engelstalig]

Ben je ontwikkelaar en loop je tegen technische vragen aan? Meld je dan aan op de qgis-developer mailinglijst:
http://lists.osgeo.org/mailman/listinfo/qgis-developer

20.1.4 qgis-commit [Geautomatiseerd]

Telkens wanneer er door een ontwikkelaar een wijziging wordt gemaakt voor QGIS wordt er een bericht
geplaatst op deze lijst. Wil je bij blijven met elke wijziging in de broncode? Meld je dan aan voor deze lijst:
http://lists.osgeo.org/mailman/listinfo/qgis-commit

20.1.5 qgis-trac [Geautomatiseerd]

Deze lijst geeft technische meldingen gerelateerd aan QGIS weer. Dit zijn onder andere foutenrapporten, taken
en wijzigingsverzoeken alsmede de oplossingen. Deze lijst is niet bedoeld voor gebruikers of ontwikkelaars om
berichten te plaatsen. Wil je op de hoogte blijven van de (technische) ontwikkelactiviteiten dan kun je je aanmelden
voor deze lijst: http://lists.osgeo.org/mailman/listinfo/qgis-trac
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20.1.6 qgis-community-team [Engelstalig]

Op deze lijst komen onderwerpen als documentatie, ondersteuning, gebruikershandleiding en aan QGIS
gerelateerde websites aan bod. Ook wordt hier informatie uitgewisseld over blogs, mailinglijsten en
vertalingen. Wil je meehelpen aan een van de handleidingen? Meld je dan aan voor deze lijst:
http://lists.osgeo.org/mailman/listinfo/qgis-community-team

20.1.7 qgis-release-team [Engelstalig]

Op deze lijst worden meldingen geplaatst over nieuwe versies, versies voor de verschillende besturingssystemen
(o.a. Windows, Mac en Linux) en de ontwikkelplanning in het algemeen. Je kunt je aanmelden voor deze lijst op:
http://lists.osgeo.org/mailman/listinfo/qgis-release-team

20.1.8 qgis-tr [Engelstalig]

Deze mailinglijst is voor vertalingen en vertalers. Als je mee wilt werken aan de vertalingen van de QGIS appli-
catie of de handleidingen, meld je dan aan op: http://lists.osgeo.org/mailman/listinfo/qgis-tr

20.1.9 qgis-edu [Engelstalig]

Deze mailinglijst is specifiek voor discussies in relatie tot QGIS in het onderwijs. Als je wilt (mee)werken aan
lesmateriaal of eigen lesmateriaal wilt delen, meld je dan aan op: http://lists.osgeo.org/mailman/listinfo/qgis-edu

20.1.10 qgis-psc [Engelstalig]

Deze mailinglijst wordt gebruikt door de stuurgroep van QGIS om de strategie te bespreken en de dagelijkse gang
van zaken rond het project. Je kunt je aanmelden voor deze lijst op: http://lists.osgeo.org/mailman/listinfo/qgis-psc

Iedereen is welkom op de mailinglijsten van QGIS. Zorg wel dat je de juiste onderwerpen in de juiste lijsten
aandraagt. Het is belangrijk dat QGIS gebruikers en ontwikkelaars elkaar helpen. Mocht je vragen tegenkomen
op een van de lijsten die je kunt beantwoorden, neem dan een paar minuten de tijd en help anderen! Op de
mailinglijsten van qgis-commit en qgis-trac worden automatisch gegenereerde berichten geplaatst en zijn niet
bedoeld om zelf berichten op te plaatsen.

20.2 IRC

De mensen van QGIS kunnen ook worden benaderd op IRC. Je kunt deelnemen aan de live discussie in het
#qgis kanaal op irc.freenode.net. De voertaal op dit kanaal is engels. Wil je op een nederlandstalig IRC kanaal
praten over QGIS? Dat kan op irc.freenode.net in het kanaal #osgeonl. Commerciële ondersteuning voor QGIS is
eveneens beschikbaar. Bekijk de website http://qgis.org/en/commercial-support.html voor meer informatie.

Discussie op IRC gemist? De #qgis discussie wordt bewaard op http://logs.qgis.org en de #osgeonl discussie op
http://irclogs.geoapt.com/osgeonl/.

20.3 Meldingen Volgsysteem

Hoewel de qgis-users mailinglijst de juiste plek is voor vragen als ‘Hoe doe ik XYZ met QGIS‘ is het handig om
gevonden fouten in QGIS te kunnen rapporteren. Je kunt deze foutmeldingen indienen op de QGIS Bug tracker
(het foutmeldingen volgsysteem) op http://hub.qgis.org/projects/quantum-gis/issues. Doe een melding altijd in het
engels en gebruik een geldig e-mail adres zodat je op de hoogte blijft van de voortgang.

Houdt er rekening mee dat fouten die jij belangrijk vindt niet altijd de hoogste prioriteit zullen krijgen. Sommige
fouten vereisen een complexe, tijdrovende oplossing en de bereidheid van ontwikkelaars om hier aan te werken
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kan niet worden gegarandeerd. Wil je dat een fout snel en goed wordt opgelost? Je kunt aanbieden (een deel van)
de ontwikkelkosten te vergoeden. Dit zou de oplossing mogelijk kunnen versnellen.

Verzoeken om nieuwe functionaliteit kunnen ook worden aangedragen in het meldingen volgsysteem. Plaats een
melding altijd in het engels en kies als type Feature.

Heb je een fout gevonden en zelf opgelost, dan kun je ook een patch indienen. Dit kun je eveneens indienen
op het meldingen volgsysteem van redmine op http://hub.qgis.org/projects/quantum-gis/issues. Vink dan ook het
aanvinkvakje Patch supplied aan voordat je de foutmelding daadwerkelijk submit. Een ontwikkelaar zal
een review uitvoeren op geboden oplossing en deze (bij acceptatie) verwerken in de QGIS applicatie. Hou er
rekening mee dat je patch niet onmiddelijk wordt verwerkt, ontwikkelaars worden vaak opgehouden door andere
verplichtingen.

20.4 Blog

De QGIS-community heeft een engelstalige weblog op http://www.qgis.org/planet waarop interessante artikelen
te lezen zijn van gebruikers en ontwikkelaars.die ook gevoed wordt door ander blogs van de community. Heb
je zelf een QGIS blog dan kun je deze hier aan toevoegen. Zo is er ook een nederlandstalig blog beschikbaar
op http://www.qgis.nl met interessante artikelen voor gebruikers en ontwikkelaars. Mocht je zelf iets interessants
willen plaatsen, neem dan contact op via de website!

20.5 Plugins

Op http://plugins.qgis.org [Engelstalig] vind je de QGIS plugins. De website toont een overzicht van stabiele and
experimentele QGIS plugins.

20.6 Wiki

Er is een engelstalige wiki beschikbaar op http://hub.qgis.org/projects/quantum-gis/wiki. Hier kun je waarde-
volle informatie vinden maar ook plaatsen over ontwikkeling, uitrol, links naar downloads, vertaal tips enzovoort.
Bekijk ‘m, je kunt er pareltjes aan informatie vinden!
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Appendix

21.1 GNU General Public License

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not
allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast,
the GNU General Public License is intended to guarantee your freedom to share and change free software–to
make sure the software is free for all its users. This General Public License applies to most of the Free Software
Foundation’s software and to any other program whose authors commit to using it. (Some other Free Software
Foundation software is covered by the GNU Library General Public License instead.) You can apply it to your
programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed
to make sure that you have the freedom to distribute copies of free software (and charge for this service if you
wish), that you receive source code or can get it if you want it, that you can change the software or use pieces of
it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to
surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients
all the rights that you have. You must make sure that they, too, receive or can get the source code. And you must
show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you
legal permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no
warranty for this free software. If the software is modified by someone else and passed on, we want its recipients
to know that what they have is not the original, so that any problems introduced by others will not reflect on the
original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redis-
tributors of a free program will individually obtain patent licenses, in effect making the program proprietary. To
prevent this, we have made it clear that any patent must be licensed for everyone’s free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow. TERMS AND CONDITIONS
FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder
saying it may be distributed under the terms of this General Public License. The “Program”, below, refers to
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any such program or work, and a “work based on the Program” means either the Program or any derivative
work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim
or with modifications and/or translated into another language. (Hereinafter, translation is included without
limitation in the term “modification”.) Each licensee is addressed as “you”.

Activities other than copying, distribution and modification are not covered by this License; they are outside
its scope. The act of running the Program is not restricted, and the output from the Program is covered only
if its contents constitute a work based on the Program (independent of having been made by running the
Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice
and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any
warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty
protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the
Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided
that you also meet all of these conditions:

(a) You must cause the modified files to carry prominent notices stating that you changed the files and the
date of any change.

(b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived
from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under
the terms of this License.

(c) If the modified program normally reads commands interactively when run, you must cause it, when
started running for such interactive use in the most ordinary way, to print or display an announcement
including an appropriate copyright notice and a notice that there is no warranty (or else, saying that
you provide a warranty) and that users may redistribute the program under these conditions, and telling
the user how to view a copy of this License. (Exception: if the Program itself is interactive but does
not normally print such an announcement, your work based on the Program is not required to print an
announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not
derived from the Program, and can be reasonably considered independent and separate works in themselves,
then this License, and its terms, do not apply to those sections when you distribute them as separate works.
But when you distribute the same sections as part of a whole which is a work based on the Program, the
distribution of the whole must be on the terms of this License, whose permissions for other licensees extend
to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you;
rather, the intent is to exercise the right to control the distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work
based on the Program) on a volume of a storage or distribution medium does not bring the other work under
the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or exe-
cutable form under the terms of Sections 1 and 2 above provided that you also do one of the following:

(a) Accompany it with the complete corresponding machine-readable source code, which must be dis-
tributed under the terms of Sections 1 and 2 above on a medium customarily used for software inter-
change; or,

(b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no
more than your cost of physically performing source distribution, a complete machine-readable copy
of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange; or,
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(c) Accompany it with the information you received as to the offer to distribute corresponding source
code. (This alternative is allowed only for noncommercial distribution and only if you received the
program in object code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an
executable work, complete source code means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to control compilation and installation of the ex-
ecutable. However, as a special exception, the source code distributed need not include anything that is
normally distributed (in either source or binary form) with the major components (compiler, kernel, and
so on) of the operating system on which the executable runs, unless that component itself accompanies the
executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then
offering equivalent access to copy the source code from the same place counts as distribution of the source
code, even though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so long as such parties remain in
full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law
if you do not accept this License. Therefore, by modifying or distributing the Program (or any work based
on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for
copying, distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically
receives a license from the original licensor to copy, distribute or modify the Program subject to these terms
and conditions. You may not impose any further restrictions on the recipients’ exercise of the rights granted
herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise)
that contradict the conditions of this License, they do not excuse you from the conditions of this License.
If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other
pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a
patent license would not permit royalty-free redistribution of the Program by all those who receive copies
directly or indirectly through you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance
of the section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or
to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the
free software distribution system, which is implemented by public license practices. Many people have
made generous contributions to the wide range of software distributed through that system in reliance on
consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute
software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this
License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copy-
righted interfaces, the original copyright holder who places the Program under this License may add an
explicit geographical distribution limitation excluding those countries, so that distribution is permitted only
in or among countries not thus excluded. In such case, this License incorporates the limitation as if written
in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.
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Each version is given a distinguishing version number. If the Program specifies a version number of this
License which applies to it and “any later version”, you have the option of following the terms and conditions
either of that version or of any later version published by the Free Software Foundation. If the Program
does not specify a version number of this License, you may choose any version ever published by the Free
Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are
different, write to the author to ask for permission. For software which is copyrighted by the Free Software
Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision
will be guided by the two goals of preserving the free status of all derivatives of our free software and of
promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR
THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTH-
ERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE
THE PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IM-
PLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABIL-
ITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFEC-
TIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDIS-
TRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, IN-
CLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO
LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU
OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PRO-
GRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBIL-
ITY OF SUCH DAMAGES.

Quantum GIS Qt exception for GPL

In addition, as a special exception, the QGIS Development Team gives permission to link the code
of this program with the Qt library, including but not limited to the following versions (both free
and commercial): Qt/Non-commerical Windows, Qt/Windows, Qt/X11, Qt/Mac, and Qt/Embedded
(or with modified versions of Qt that use the same license as Qt), and distribute linked combinations
including the two. You must obey the GNU General Public License in all respects for all of the code
used other than Qt. If you modify this file, you may extend this exception to your version of the file,
but you are not obligated to do so. If you do not wish to do so, delete this exception statement from
your version.

21.2 GNU Free Documentation License

Version 1.3, 3 November 2008

Copyright 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc

<http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not
allowed.

Preamble

The purpose of this License is to make a manual, textbook, or other functional and useful document “free” in the
sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying
it, either commercially or noncommercially. Secondarily, this License preserves for the author and publisher a
way to get credit for their work, while not being considered responsible for modifications made by others.
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This License is a kind of “copyleft”, which means that derivative works of the document must themselves be free
in the same sense. It complements the GNU General Public License, which is a copyleft license designed for free
software.

We have designed this License in order to use it for manuals for free software, because free software needs free
documentation: a free program should come with manuals providing the same freedoms that the software does.
But this License is not limited to software manuals; it can be used for any textual work, regardless of subject
matter or whether it is published as a printed book. We recommend this License principally for works whose
purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work, in any medium, that contains a notice placed by the copyright
holder saying it can be distributed under the terms of this License. Such a notice grants a world-wide, royalty-free
license, unlimited in duration, to use that work under the conditions stated herein. The Document, below, refers
to any such manual or work. Any member of the public is a licensee, and is addressed as “you”. You accept the
license if you copy, modify or distribute the work in a way requiring permission under copyright law.

A “Modified Version” of the Document means any work containing the Document or a portion of it, either copied
verbatim, or with modifications and/or translated into another language.

A “Secondary Section” is a named appendix or a front-matter section of the Document that deals exclusively
with the relationship of the publishers or authors of the Document to the Document’s overall subject (or to related
matters) and contains nothing that could fall directly within that overall subject. (Thus, if the Document is in part
a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be
a matter of historical connection with the subject or with related matters, or of legal, commercial, philosophical,
ethical or political position regarding them.

The “Invariant Sections” are certain Secondary Sections whose titles are designated, as being those of Invariant
Sections, in the notice that says that the Document is released under this License. If a section does not fit the
above definition of Secondary then it is not allowed to be designated as Invariant. The Document may contain
zero Invariant Sections. If the Document does not identify any Invariant Sections then there are none.

The “Cover Texts” are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in
the notice that says that the Document is released under this License. A Front-Cover Text may be at most 5 words,
and a Back-Cover Text may be at most 25 words.

A “Transparent” copy of the Document means a machine-readable copy, represented in a format whose specifi-
cation is available to the general public, that is suitable for revising the document straightforwardly with generic
text editors or (for images composed of pixels) generic paint programs or (for drawings) some widely available
drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of formats
suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup, or ab-
sence of markup, has been arranged to thwart or discourage subsequent modification by readers is not Transparent.
An image format is not Transparent if used for any substantial amount of text. A copy that is not “Transparent” is
called Opaque.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format,
LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML,
PostScript or PDF designed for human modification. Examples of transparent image formats include PNG, XCF
and JPG. Opaque formats include proprietary formats that can be read and edited only by proprietary word pro-
cessors, SGML or XML for which the DTD and/or processing tools are not generally available, and the machine-
generated HTML, PostScript or PDF produced by some word processors for output purposes only.

The “Title Page” means, for a printed book, the title page itself, plus such following pages as are needed to hold,
legibly, the material this License requires to appear in the title page. For works in formats which do not have any
title page as such, “Title Page” means the text near the most prominent appearance of the work’s title, preceding
the beginning of the body of the text.

The “publisher” means any person or entity that distributes copies of the Document to the public.

A section “Entitled XYZ” means a named subunit of the Document whose title either is precisely XYZ or contains
XYZ in parentheses following text that translates XYZ in another language. (Here XYZ stands for a specific
section name mentioned below, such as “Acknowledgements”, “Dedications”, “Endorsements”, or “History”.)
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To “Preserve the Title” of such a section when you modify the Document means that it remains a section “Entitled
XYZ” according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License applies to the
Document. These Warranty Disclaimers are considered to be included by reference in this License, but only as
regards disclaiming warranties: any other implication that these Warranty Disclaimers may have is void and has
no effect on the meaning of this License.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially, provided
that this License, the copyright notices, and the license notice saying this License applies to the Document are
reproduced in all copies, and that you add no other conditions whatsoever to those of this License. You may not
use technical measures to obstruct or control the reading or further copying of the copies you make or distribute.
However, you may accept compensation in exchange for copies. If you distribute a large enough number of copies
you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY

If you publish printed copies (or copies in media that commonly have printed covers) of the Document, numbering
more than 100, and the Document’s license notice requires Cover Texts, you must enclose the copies in covers
that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts
on the back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The
front cover must present the full title with all words of the title equally prominent and visible. You may add other
material on the covers in addition. Copying with changes limited to the covers, as long as they preserve the title
of the Document and satisfy these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many
as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include
a machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a
computer-network location from which the general network-using public has access to download using public-
standard network protocols a complete Transparent copy of the Document, free of added material. If you use the
latter option, you must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to
ensure that this Transparent copy will remain thus accessible at the stated location until at least one year after the
last time you distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large
number of copies, to give them a chance to provide you with an updated version of the Document.

4. MODIFICATIONS

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above,
provided that you release the Modified Version under precisely this License, with the Modified Version filling the
role of the Document, thus licensing distribution and modification of the Modified Version to whoever possesses
a copy of it. In addition, you must do these things in the Modified Version:

1. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of
previous versions (which should, if there were any, be listed in the History section of the Document). You
may use the same title as a previous version if the original publisher of that version gives permission.

2. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifi-
cations in the Modified Version, together with at least five of the principal authors of the Document (all of
its principal authors, if it has fewer than five), unless they release you from this requirement.

3. State on the Title page the name of the publisher of the Modified Version, as the publisher.

4. Preserve all the copyright notices of the Document.

5. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

6. Include, immediately after the copyright notices, a license notice giving the public permission to use the
Modified Version under the terms of this License, in the form shown in the Addendum below.
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7. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the
Document’s license notice.

8. Include an unaltered copy of this License.

9. Preserve the section Entitled “History”, Preserve its Title, and add to it an item stating at least the title, year,
new authors, and publisher of the Modified Version as given on the Title Page. If there is no section Entitled
“History” in the Document, create one stating the title, year, authors, and publisher of the Document as
given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

10. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the
Document, and likewise the network locations given in the Document for previous versions it was based
on. These may be placed in the “History” section. You may omit a network location for a work that was
published at least four years before the Document itself, or if the original publisher of the version it refers
to gives permission.

11. For any section Entitled “Acknowledgements” or “Dedications”, Preserve the Title of the section, and pre-
serve in the section all the substance and tone of each of the contributor acknowledgements and/or dedica-
tions given therein.

12. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section
numbers or the equivalent are not considered part of the section titles.

13. Delete any section Entitled “Endorsements”. Such a section may not be included in the Modified Version.

14. Do not retitle any existing section to be Entitled “Endorsements” or to conflict in title with any Invariant
Section.

15. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and
contain no material copied from the Document, you may at your option designate some or all of these sections
as invariant. To do this, add their titles to the list of Invariant Sections in the Modified Version’s license notice.
These titles must be distinct from any other section titles.

You may add a section Entitled “Endorsements”, provided it contains nothing but endorsements of your Modified
Version by various parties—for example, statements of peer review or that the text has been approved by an
organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover
Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one
of Back-Cover Text may be added by (or through arrangements made by) any one entity. If the Document already
includes a cover text for the same cover, previously added by you or by arrangement made by the same entity you
are acting on behalf of, you may not add another; but you may replace the old one, on explicit permission from
the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names for
publicity for or to assert or imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS

You may combine the Document with other documents released under this License, under the terms defined in
section 4 above for modified versions, provided that you include in the combination all of the Invariant Sections
of all of the original documents, unmodified, and list them all as Invariant Sections of your combined work in its
license notice, and that you preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be
replaced with a single copy. If there are multiple Invariant Sections with the same name but different contents,
make the title of each such section unique by adding at the end of it, in parentheses, the name of the original author
or publisher of that section if known, or else a unique number. Make the same adjustment to the section titles in
the list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections Entitled “History” in the various original documents, forming
one section Entitled “History”; likewise combine any sections Entitled “Acknowledgements”, and any sections
Entitled “Dedications”. You must delete all sections Entitled “Endorsements”.

6. COLLECTIONS OF DOCUMENTS
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You may make a collection consisting of the Document and other documents released under this License, and
replace the individual copies of this License in the various documents with a single copy that is included in the
collection, provided that you follow the rules of this License for verbatim copying of each of the documents in all
other respects.

You may extract a single document from such a collection, and distribute it individually under this License,
provided you insert a copy of this License into the extracted document, and follow this License in all other respects
regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and independent documents or works, in
or on a volume of a storage or distribution medium, is called an “aggregate” if the copyright resulting from the
compilation is not used to limit the legal rights of the compilation’s users beyond what the individual works permit.
When the Document is included in an aggregate, this License does not apply to the other works in the aggregate
which are not themselves derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document
is less than one half of the entire aggregate, the Document’s Cover Texts may be placed on covers that bracket
the Document within the aggregate, or the electronic equivalent of covers if the Document is in electronic form.
Otherwise they must appear on printed covers that bracket the whole aggregate.

8. TRANSLATION

Translation is considered a kind of modification, so you may distribute translations of the Document under the
terms of section 4. Replacing Invariant Sections with translations requires special permission from their copyright
holders, but you may include translations of some or all Invariant Sections in addition to the original versions of
these Invariant Sections. You may include a translation of this License, and all the license notices in the Document,
and any Warranty Disclaimers, provided that you also include the original English version of this License and the
original versions of those notices and disclaimers. In case of a disagreement between the translation and the
original version of this License or a notice or disclaimer, the original version will prevail.

If a section in the Document is Entitled “Acknowledgements”, “Dedications”, or “History”, the requirement (sec-
tion 4) to Preserve its Title (section 1) will typically require changing the actual title.

9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided under this License.
Any attempt otherwise to copy, modify, sublicense, or distribute it is void, and will automatically terminate your
rights under this License.

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated
(a) provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b)
permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days
after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies
you of the violation by some reasonable means, this is the first time you have received notice of violation of this
License (for any work) from that copyright holder, and you cure the violation prior to 30 days after your receipt
of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies
or rights from you under this License. If your rights have been terminated and not permanently reinstated, receipt
of a copy of some or all of the same material does not give you any rights to use it.

10. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address
new problems or concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that a particular
numbered version of this License “or any later version” applies to it, you have the option of following the terms
and conditions either of that specified version or of any later version that has been published (not as a draft) by the
Free Software Foundation. If the Document does not specify a version number of this License, you may choose
any version ever published (not as a draft) by the Free Software Foundation. If the Document specifies that a

260 Hoofdstuk 21. Appendix

http://www.gnu.org/copyleft/


QGIS User Guide, Release 1.8

proxy can decide which future versions of this License can be used, that proxy’s public statement of acceptance
of a version permanently authorizes you to choose that version for the Document.

11. RELICENSING

“Massive Multiauthor Collaboration Site” (or “MMC Site”) means any World Wide Web server that publishes
copyrightable works and also provides prominent facilities for anybody to edit those works. A public wiki that
anybody can edit is an example of such a server. A “Massive Multiauthor Collaboration” (or “MMC”) contained
in the site means any set of copyrightable works thus published on the MMC site.

“CC-BY-SA” means the Creative Commons Attribution-Share Alike 3.0 license published by Creative Commons
Corporation, a not-for-profit corporation with a principal place of business in San Francisco, California, as well as
future copyleft versions of that license published by that same organization.

“Incorporate” means to publish or republish a Document, in whole or in part, as part of another Document.

An MMC is “eligible for relicensing” if it is licensed under this License, and if all works that were first published
under this License somewhere other than this MMC, and subsequently incorporated in whole or in part into the
MMC, (1) had no cover texts or invariant sections, and (2) were thus incorporated prior to November 1, 2008.

The operator of an MMC Site may republish an MMC contained in the site under CC-BY-SA on the same site at
any time before August 1, 2009, provided the MMC is eligible for relicensing.

ADDENDUM: How to use this License for your documents

To use this License in a document you have written, include a copy of the License in the document and put the
following copyright and license notices just after the title page:

Copyright © YEAR YOUR NAME. Permission is granted to copy, distribute and/or modify this
document under the terms of the GNU Free Documentation License, Version 1.3 or any later version
published by the Free Software Foundation; with no Invariant Sections, no Front-Cover Texts, and no
Back-Cover Texts. A copy of the license is included in the section entitled “GNU Free Documentation
License”.

If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts, replace the “with ... Texts.” line with
this:

with the Invariant Sections being LIST THEIR TITLES, with the Front-Cover Texts being LIST, and
with the Back-Cover Texts being LIST.

If you have Invariant Sections without Cover Texts, or some other combination of the three, merge those two
alternatives to suit the situation.

If your document contains nontrivial examples of program code, we recommend releasing these examples in
parallel under your choice of free software license, such as the GNU General Public License, to permit their use
in free software.
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